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A Bio-Rad™ műszaki ügyfélszolgálata
A Bio-Rad műszaki ügyfélszolgálati (Technical Support) részlege az Amerikai Egyesült Államokban csendes-
óceáni időzóna szerint hétfőtől péntekig, 05:00-től 17:00-ig tart nyitva.

Telefon: +1-800-424-6723, 2-es mellék

E-mail: Support@bio-rad.com (kizárólag az amerikai egyesült államokbeli és a kanadai ügyfelek részére)

Ha Ön az Amerikai Egyesült Államokon vagy Kanadán kívülről szeretne műszaki segítséget kérni, vegye fel a
kapcsolatot a helyi műszaki ügyfélszolgálati irodával, vagy kattintson a Contact us (Kapcsolatfelvétel)
hivatkozásra a bio-rad.com webhelyen.

Figyelmeztetés
A jelen kiadványt sem részben, sem egészben nem szabad a Bio-Rad Laboratories, Inc. írásbeli engedélye
nélkül semmilyen formában vagy eszközzel (sem elektronikusan, semmechanikusan) sokszorosítani vagy
továbbítani, ideértve a fénymásoló, adatrögzítő vagy bármilyen információtároló vagy -lekérdező
rendszereket.

A Bio-Rad fenntartja a jogot, hogy termékeit és szolgáltatásait bármikor módosítsa. A jelen útmutató értesítés
nélkül megváltozhat. Habár a jelen dokumentum elkészítése során fontos szempont volt a pontosság, a Bio-
Rad nem vállal felelősséget sem az esetleges hibákért vagy hiányosságokért, sem a jelen dokumentumban
szereplő információk alkalmazásából vagy felhasználásából eredő semmilyen esetleges kárért.

A BIO-RAD a Bio-Rad Laboratories, Inc. védjegye.

A SYBR a Thermo Fisher Scientific Inc.

Az EvaGreen a Biotium, Inc. védjegye.

A jelen dokumentumban szereplő egyes védjegyek a tulajdonosaik tulajdonát képezik.

Copyright © 2022, jogtulajdonos: Bio-Rad Laboratories, Inc.. Minden jog fenntartva.

http://www.bio-rad.com/


Rendeltetésszerű használat

Rendeltetésszerű használat
A CFX Opus Dx valós idejű PCR-rendszerTM és a CFX Maestro Dx szoftver, Security EditionTM
fluoreszcencia-alapú PCR-tesztek elvégzésére szolgál a nukleinsav-szekvenciák kimutatása és
mennyiségi meghatározása által. A rendszert és a szoftvert kizárólag képzett laboratóriumi technikusok
használhatják in vitro diagnosztikai célra. A rendszereket kizárólag olyan – harmadik felek által készített –
diagnosztikai nukleinsavtesztekkel szabad használni, amelyeket diagnosztikai célokra gyártottak és ezt
jelző címkével láttak el.

Szimbólumjegyzék

Gyártó Tétel száma

Felhasználhatóság lejárata In vitro diagnosztikai használatra

Hőmérsékleti határérték Katalógusszám

Olvassa el a használati utasítást Vizsgálatok száma

A következő eszközökkel
használható: Sorozatszám
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Csak előírt használatra Latexet tartalmaz

CE-jelzés – Rendelet
(EU) 2017/746 IVDR

Fordítások
A termékdokumentumok további nyelveken is rendelkezésre állhatnak az elektronikus adathordozókon.

iv | CFX Maestro Dx SE szoftver



Módosítási előzmények

Módosítási előzmények

Dokumentum Dátum A változás leírása

CFXMaestro Dx szoftver,
Security EditionFelhasználói
útmutató, 2.0

(Dokumentum azonosítója:
10000135620)

2020. december „A” verzió, első kiadás

CFX Maestro Dx szoftver,
Security Edition Felhasználói
útmutató, 2.3

(Dokumentum azonosítója:
10000135620)

2022. május n Frissítve a CFX Opus Deepwell Dx-hez

n Frissített szimbólumjegyzék táblázata

n Kiberbiztonsági megjegyzés hozzáadva a
Bevezetéshez

n Dokumentumvezérlő frissítés (D-től E-ig)

Felhasználói útmutató | v



vi | CFX Maestro Dx SE szoftver



Tartalomjegyzék
Rendeltetésszerű használat iii
Szimbólumjegyzék iii
Fordítások iv
Módosítási előzmények v

Biztonsági és szabályozási megfelelőség 17
Biztonsági figyelmeztető címkék 17
Biztonsági és szabályozási megfelelőség 19
Biztonsági megfelelőség 19
Elektromágneses összeférhetőség (EMC) 20
EMC figyelmeztetések és megjegyzések 21
A környezetre vonatkozó követelmények 22

Veszélyek 23
Biológiai veszélyek 23
Kémiai veszélyek 24
Robbanékonysággal vagy gyúlékonysággal kapcsolatos veszélyek 24
Elektromos veszélyek 25

Szállítás 25
Akkumulátor 25
Ártalmatlanítás 25
Jótállás 26

1. fejezet Bevezetés 27
A CFXMaestro Dx szoftver, Security Edition főbb jellemzői 29
További információk 29

2. fejezet A CFX Maestro Dx szoftver, Security Edition telepítése 31
Rendszerkövetelmények 32
A CFX Maestro Dx SE szoftver telepítése 34
Csatlakoztatott műszerek észlelése 36

Szoftverfájlok 37

Felhasználói útmutató | vii



Tartalomjegyzék

3. fejezet A CFX Maestro Dx szoftver, Security Edition felhasználói fiókjainak kezelése39
A CFXMaestro Dx szoftver, Security Edition elindítása 40
Microsoft Windows felhasználók hozzáadása a CFX Maestro Dx szoftver, Security Editiont futtató
számítógéphez 42
A CFX Maestro Dx szoftver, Security Edition felhasználóinak létrehozása és törlése 44
A CFX Maestro Dx szoftver, Security Edition felhasználói szerepköreinek kezelése 46
A szerepköre és engedélyei megtekintése 47

4. fejezet A CFX Maestro Dx szoftver, Security Edition használata 49
Biztonságos fájlok 49

5. fejezet A munkaterület 59
A Home (Kezdőlap) ablak 60
A Startup Wizard (Indítási varázsló) 61
A Protocol Editor (Protokollszerkesztő) ablak 62
A Plate Editor (Lemezszerkesztő) ablak 63
A Data Analysis (Adatelemzés) ablak 64

6. fejezet A Home (Kezdőlap) ablak 65
A Home (Kezdőlap) ablak 66
A File (Fájl) menü parancsai 67
A View (Nézet) menüpont parancsai 67
A User (Felhasználó) menüpont parancsai 68
A Run (Futtatás) menüpont parancsai 69
A Tools (Eszközök) menü parancsai 69
A Help (Segítség) menüpont parancsai 70
Az eszköztár parancsai 71
A Startup Wizard (Indítási varázsló) 72
Állapotsor 72
Detected Instruments (Felismert készülékek) panel 73
Készülék tulajdonságainak megtekintése 76

Előkészületek 78
Reakció-törzsoldat létrehozása 78
Új festékek kalibrálása 81
Felhasználói beállítások 84

viii | CFX Maestro Dx SE szoftver



Tartalomjegyzék

7. fejezet Protokollok létrehozása 103
Paraméterek és tartományok a protokoll lépéseihez 104
A Protocol Editor (Protokollszerkesztő) ablak 106
A File (Fájl) menü parancsai 107
A Settings (Beállítások) menüpont parancsa 107
A Tools (Eszközök) menü parancsai 107
Az eszköztár parancsai 107
Protokollszerkesztési vezérlőelemek 108

Protokoll létrehozása a Protocol Editor (Protokollszerkesztő) eszközzel 112
Új protokollfájl megnyitása a Protocol Editor (Protokollszerkesztő) eszközzel 112
Meglévő protokoll megnyitása a Protocol Editor (Protokollszerkesztő) eszközzel 114
Új protokoll beállítása 115
Lépések hozzáadása egy protokollhoz 117
Gradienslépés beillesztése 118
GOTO (LÉPJ) lépés beillesztése 119
Olvadási görbe lépés beillesztése 120
Lemezleolvasási lépés hozzáadása vagy eltávolítása 122
A lépésbeállítások módosítása 122
Lépés törlése 123
Protokoll másolása, exportálása vagy nyomtatása 123

Protokoll létrehozása a Protocol AutoWriter (Automatikus protokollíró) eszközzel 124
A Ta kalkulátor használata 126
Tudnivalók a Ta kalkulátorról 126

8. fejezet Lemezek előkészítése 131
A Plate Editor (Lemezszerkesztő) ablak 132
A File (Fájl) menü parancsai 132
Az Edit (Szerkesztés) menü parancsai 133
A Settings (Beállítások) menü parancsai 133
Az Editing Tools (Szerkesztőeszközök) menü parancsai 134
Az eszköztár parancsai 134

Lemezfájl létrehozása a Plate Editor (Lemezszerkesztő) eszközzel 136
Új lemezfájl megnyitása a Plate Editor (Lemezszerkesztő) ablakban 136
Meglévő lemezfájl megnyitása a Plate Editor (Lemezszerkesztő) eszközben 138
Új lemezfájl beállítása 139

Felhasználói útmutató | ix



Tartalomjegyzék

Opcionális paraméterek hozzárendelése a lemezfájlhoz 147
Cél hozzárendelése cellákhoz 147
Mintanév hozzárendelése cellákhoz 150
Biológiai csoportok cellához rendelése 151
Technikai replikátumok számainak cellákhoz rendelése 154
Hígítási sor hozzárendelése standard mintatípusokhoz 155
Cellatartalmak másolása egy másik cellába 157
Megjegyzés hozzáadása egy cellához 157
Összes tartalom törlése cellákból 158

Kísérleti beállítások módosítása 160
Cellacsoportok létrehozása 163
Jelstílusok módosítása 165
Lemez megtekintése, exportálása és importálása táblázatos formátumban 167
Lemezelrendezés létrehozása a Plate Setup Wizard (Lemezbeállítási varázsló) eszközzel 169
A Plate Setup Wizard (Lemezbeállítási varázsló) használata 169

9. fejezet Kísérletek futtatása 173
A Run Setup (Futtatás beállításai) ablak 174
A Run Setup (Futtatás beállításai) ablak megnyitása 175

A Protocol (Protokoll) fül 176
A Plate (Lemez) fül 179
A Start Run (Futtatás indítása) fül 182
Kísérlet futtatása 183

A Run Details (Futtatás részletei) párbeszédpanel 185
A Run Status (Futás állapota) fül 185
A Real-time Status (Valós idejű státusz) fül 188
A Time Status (Időstátusz) fül 191

PrimePCR-kísérletek végzése 192
Önálló adatok továbbítása elemzésre 194
Adatok továbbítása e-mailben 194
Adatok átvitele a CFX Opus Dx valós idejű PCR-rendszerről 194
Adatátvitel a CFX Maestro Dx szoftver, Security Editiontermékkel 196
Adatok továbbítása USB-meghajtó segítségével 196
Adatátvitel megosztott hálózati meghajtóval CFX Opus Dx valós idejű PCR-rendszer
termékeket használva 197

x | CFX Maestro Dx SE szoftver



Tartalomjegyzék

Adatfájl létrehozása 197

10. fejezet Az adatelemzés áttekintése 199
Data Analysis (Adatelemzés) ablak 199
A Data Analysis (Adatelemzés) eszköztár 200
Data Analysis (Adatelemzés) menüsor 201
A fülek 205
Step Number Selector (Lépésszámválasztó) 205
Cellacsoportok megtekintése a Data Analysis (Adatelemzés) ablakban 206
Cellatartalmak módosítása futtatás után 206

Adatelemzési beállítások 208
A küszöbérték módosítása 208
Kiindulási értékbeállítások 208
Analysis Mode (Analízis-üzemmód) 209
Vizsgálandó ciklusok 210

Cellaválasztó 211
A cellaválasztó jobb egérgombbal kattintással elérhető menüpontjai 212
Cellák ideiglenes kizárása az elemzésből 213

Diagramok 214
Diagrameszközök 214
Egy terület felnagyítása a diagramon 222
Diagramok másolása Microsoft-fájlba 222
A diagramoknál a jobb egérgombbal kattintva elérhető közös menüpontok 222

Táblázatok 224
A táblázatoknál jobb egérgombbal kattintva elérhető közös menüpontok 224

Exportálás 226
Az összes adatlap exportálása 226
RDML-fájlok exportálása 227
Egyedi exportfájl létrehozása 228
Exportálás egy LIMS-mappába 230
Seegene formátumú adatok exportálása 230

11. fejezet Az adatelemzéssel kapcsolatos részletek 231
A Quantification (Kvantifikáció) fül 232
Fluorofórokra vonatkozó opciók 233
A Trace Styles (Jelstílusok) párbeszédpanel 233

Felhasználói útmutató | xi



Tartalomjegyzék

Log Scale (Logaritmikus skála) opció 235
Standard Curve Chart (Standardgörbe-diagram) 236
Az Amplification (Sokszorosítás) diagramnál elérhető menüpontok 237
A Quantification (Kvantifikáció) fülön található táblázat 237

A Quantification Data (Kvantifikációs adatok) fül 239
A Results (Eredmények) táblázat 239
A Standard Curve Results (Standard görbe eredményei) táblázat 241
A Plate (Lemez) táblázat 242
Az RFU (RFE) táblázat 243

A Melt Curve (Olvadási görbe) fül 244
Olvadásigörbe-adatok módosítása 246

A Melt Curve Data (Olvadásigörbe-adatok) fül 247
A Melt Peaks (Olvadási csúcsok) táblázat 247
A Plate (Lemez) táblázat 248
Az RFU (RFE) táblázat 249
A -d(RFU)/dT (-d(RFE)/dT) táblázat 250

Az End Point (Végpont) fül 251
Eredményül kapott adatok 252
A végponti adatelemzés módosítása 254
RFE-táblázat a végponti elemzéshez 254

Az Allelic Discrimination (Alléldiszkrimináció) fül 255
Az alléldiszkriminációra vonatkozó adatok módosítása 256
A diagramoknál elérhető menüpontok 257
Az Allelic Discrimination (Alléldiszkrimináció) táblázat 257

A Custom Data View (Egyéni adatnézet) fül 259
Egyéni adatnézet létrehozása 260

A QC (Minőség-ellenőrzés) fül 261
A minőség-ellenőrzési kritériumok módosítása 262
A minőség-ellenőrzést sikertelen eredménnyel záró cellák kizárása 262

A Run Information (Futtatási információk) fül 263
Adatelemzési jelentések 264
Az adatelemzési jelentések kategóriái 265
Adatelemzési jelentés létrehozása 268
Cellacsoport-jelentések létrehozása 270

xii | CFX Maestro Dx SE szoftver



Tartalomjegyzék

12. fejezet Génexpressziós elemzés 271
Lemezbeállítás a génexpresszió-elemzéshez 271
Irányított lemezbeállítás 272
Génexpressziós diagramok 273
Grafikus ábrázolás 275
A diagramnézet módosítása és jegyzettel való ellátása 277
Génexpressziós adatok módosítása 283
Kísérlet beállításai 285
A jobb egérgombbal kattintva elérhető menüpontok 287
Adattáblázat 288
Show Details (Részletek megjelenítése) opció 290

Klasztergram 292
Beállítások 292
A jobb egérgombbal kattintással elérhető menüpontok 292
Adattáblázat 292

Pontszórási diagram 293
Beállítások 293
A jobb egérgombbal kattintással elérhető menüpontok 293
Adattáblázat 294

A Results (Eredmények) táblázat 295
Génvizsgálat 296
Futtatások közötti kalibrálás 296
A Gene Study (Génvizsgálat) párbeszédpanel 297
A Study Setup (Vizsgálat beállítása) fül 297
Génvizsgálat előkészítése 298
A Study Analysis (Vizsgálati elemzés) fül 299
Génvizsgálat-jelentések kategóriái 300
Génvizsgálat-jelentés létrehozása 303

A. függelék Adatelemzési számítások 305
A reakció hatásfoka 305
Relative Quantity 305
Relatív mennyiség egy kontroll kiválasztásakor 306
A relatív mennyiség szórása 306
Hatásfokkal korrigált Cq (CqE) 307

Felhasználói útmutató | xiii



Tartalomjegyzék

A közepes hatásfokkal korrigált Cq (MCqE) 307
Normalizált expresszió 308
A biológiai csoportokra vonatkozó expresszió és relatív mennyiség 309

Normalizált expresszió egy kontroll kiválasztásakor 309
A normalizált expresszió szórása 310
A legmagasabb expressziószintre skálázott normalizált expresszió 311
A legalacsonyabb expressziószintre skálázott normalizált expresszió 311
Az átlagos expressziószintre skálázott normalizált expresszió 311
A skálázott normalizált expresszió szórása 313
Hibasávok a szóráshoz (lg) és a középérték standard hibájához (lg) 314
Fold Change (A változás szorzója) 315
Korrigált értékek kiszámítására szolgáló képletek 316
Konfidenciaintervallum számítása biológiai csoport elemzéséhez 317
Dobozdiagram-számítások 317

B. függelék Auditnaplók 319
Auditnaplók megtekintése 319
Auditálható események 321

C. függelék LIMS-integráció 325
LIMS-kompatibilis adatfájlok létrehozása 325
A LIMS-mappa és az adatexportálási lehetőségek beállítása 325
LIMS-protokoll létrehozása 327
LIMS-fájl létrehozása 327
LIMS-futtatás indítása 332
Adatok exportálása egy LIMS rendszerbe 333

D. függelék A CFX Maestro Dx szoftver, Security Edition termék hibáinak elhárítása 335
Engedélyezőlista, a CFX Maestro Dx szoftver, Security Edition fájljai és mappái 335
Alkalmazásnapló 336
Az Alkalmazás és a Firmware naplófájljainak lekérdezése 337

Hibaelhárítás 337
Áramkimaradás 337
Fájlok átvitele a CFX Maestro Dx SE szoftvert futtató számítógépre 338
A CFX Maestro Dx szoftver, Security Edition kézi telepítése 338
Az illesztőprogramok újratelepítése 339

xiv | CFX Maestro Dx SE szoftver



Tartalomjegyzék

E. függelék Bio-Rad Free and Open-Source Notices for PCR Products 341
Software Notices 342
ZedGraph 342

Standard Open License Text 342
LGPL-2.1 342

F. függelék Irodalomjegyzék 355

Felhasználói útmutató | xv



Tartalomjegyzék

xvi | CFX Maestro Dx SE szoftver



Biztonsági és szabályozási megfelelőség
A CFX Opus 96 Dx, CFX Opus 384 Dx és CFX Opus Deepwell Dx valós idejű PCR-rendszerek (az
útmutatóban CFX Opus Dx rendszer) működés közben nagyon gyorsan felmelegszenek és lehűlnek. A
valós idejű PCR-rendszer biztonságos üzemeltetéséhez a Bio-Rad nyomatékosan javasolja, hogy tartsa
be a jelen szakaszban és a kézikönyvben egyéb helyeken felsorolt biztonsági előírásokat.

Biztonsági figyelmeztető címkék
A CFX Opus Dx rendszer és ebben a kézikönyvben található figyelmeztető címkék sérülési veszélyekre
figyelmeztetnek. Az 1. táblázat az egyes biztonsági figyelmeztető címkéket határozza meg.

Ikon Jelentés

A CFX Opus Dx rendszer üzemeltetése e kézikönyv elolvasása nélkül személyi
sérülés veszélyével járhat. Ha a készüléket nem a jelen kézikönyvben vagy a Bio-
Rad által megadott módon használja, az a műszer védelmi funkcióinak
károsodásához vagy letiltásához vezethet.

Maga a CFX Opus Dx rendszer nem jelent biológiai vagy radioaktív veszélyt. Ezek
a veszélyek csak akkor adnak okot aggodalomra, ha a vizsgált mintákkal a
rendszerbe kerülnek. Biológiailag veszélyes vagy radioaktív minták kezelésekor
tartsa be a laboratóriumára és tartózkodási helyére vonatkozó ajánlott
óvintézkedéseket és irányelveket. Az irányelveknek tartalmazniuk kell a tisztítási,
ellenőrzési és ártalmatlanítási módszereket az Ön által használt veszélyes
anyagokhoz.

Ezenkívül, amint azt a fentiekben megállapítottuk, kis eséllyel robbanás
következhet be, illetve a folyadékok vagy a gőzök kijuthatnak a mintatartályból.
Veszélyes anyagokkal végzett munka során a kijutó anyagok okozta sérülés
kockázatához hozzáadódik annak kockázata, hogy maguk a veszélyes anyagok is
szétszóródhatnak a készülékben és körülötte. A felhasználóknak megfelelő
óvintézkedéseket kell tenniük egy ilyen helyzet esetére.

1. táblázat Általános biztonsági figyelmeztetések
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Biztonsági és szabályozási megfelelőség

Ikon Jelentés

A CFX Opus Dx rendszer működési hőmérséklete elég magas ahhoz, hogy súlyos
égési sérüléseket okozzon. A fedél felnyitása és a minták eltávolítása előtt mindig
várja meg, hogy a mintablokk lehűljön a szobahőmérsékletre. A mintablokk
lehűlése után a környező területek, valamint a fűtőlemez jó ideig forró maradhat.
Olyan helyzetekben, amikor nincs elegendő idő a készülék lehűléséhez,
védőfelszerelések, például hőálló kesztyű vagy „sütőkesztyű” használata ajánlott.

Az olyan rendszer biztonságáért és teljesítményéért, melynek része a CFX Opus
Dx rendszer, kizárólag a rendszer összeszerelője felelős.

A CFX Opus Dx rendszer normál működés közben annyira felforrósodhat, hogy a
mintákban lévő folyadékok felforrnak vagy elpárolognak, és a mintatartályokban
túlnyomás alakulhat ki. A mintatartályok meghibásodhatnak; ez szivárgáshoz,
folyadékpermetezéshez vagy robbanásveszélyes repedéshez vezethet, és gőzök
vagy folyadékok juthatnak a készülékbe és környezetébe.

A használóknak a sérülés elkerülése érdekében a készüléket mindig csukott
fedéllel kell működtetniük, vagy védőszemüveget, hőálló kesztyűt és egyéb
személyi védőfelszerelést kell viselniük. Ha a műszert kinyitja, amíg a minták még
forrók, például egy futtatás megszakítása után, a nyomás alatt lévő edényekből a
folyadék szivároghat, permetezhet vagy kiszóródhat. A fedél felnyitása előtt mindig
hagyja kihűlni a mintákat.

A felhasználó semmiképpen se futtassa a reakciót nyitott, laza, átlyukadt vagy más
módon sérült fedéllel vagy tömítéssel, mert ez növeli a veszélyes repedés vagy
robbanás valószínűségét.

A felhasználó semmiképpen nem futtathatja a reakciót olyan illékony
reagensekkel, amelyek növelhetik a veszélyes repedés vagy robbanás
valószínűségét.

1. táblázat Általános biztonsági figyelmeztetések, folytatás
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Biztonsági és szabályozási megfelelőség

Biztonsági megfelelőség
A CFX Opus Dx rendszer a tesztek alapján eleget tesz az alábbi biztonsági és elektromágneses
szabványok valamennyi követelményének:

n IEC 61010-1:2010 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei – 1. rész: Általános követelmények

n IEC 61010-2-010:2019 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei – 2-010. rész Részletes követelmények
anyagok hevítésére szolgáló laboratóriumi berendezésekhez

n IEC 61010-2-081:2019 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei – 2-081. rész: Részletes követelmények elemző
és egyéb célú automatikus és félautomatikus laboratóriumi berendezésekhez

n IEC 61010-2-101:2018 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei – 2-101. rész: Részletes követelmények in vitro
diagnosztikai (IVD) orvosi berendezésekhez

n CAN/CSA-C22.2 NO. 61010-1-12:2018 Méréstechnikai, irányítástechnikai és laboratóriumi
felhasználásra szolgáló elektromos berendezések biztonsági követelményei, 1. rész: Általános
követelmények

n CAN/CSA-C22.2 NO. 61010-2-010:19 Méréstechnikai, irányítástechnikai és laboratóriumi
felhasználásra szolgáló elektromos berendezések biztonsági követelményei, 2-010. rész: Részletes
követelmények anyagok hevítésére szolgáló laboratóriumi berendezésekhez

n CAN/CSA-C22.2 NO. 61010-2-081:19 Méréstechnikai, irányítástechnikai és laboratóriumi
felhasználásra szolgáló elektromos berendezések biztonsági követelményei, 2-081. rész: Részletes
követelmények elemző és egyéb célú automatikus és félautomatikus laboratóriumi
berendezésekhez

n CSA-C22.2 NO. 61010-2-101:19 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra
szolgáló elektromos berendezések biztonsági követelményei – 2-101. rész: Részletes
követelmények in vitro diagnosztikai (IVD) orvosi berendezésekhez

n EN 61010-1:2010 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei, 1. rész: Általános követelmények
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n EN 61010-2-010:2014 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei – 2-010. rész: Részletes követelmények
anyagok hevítésére szolgáló laboratóriumi berendezésekhez

n EN 61010-2-081:2015 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei – 2-081. rész: Részletes követelmények elemző
és egyéb célú automatikus és félautomatikus laboratóriumi berendezésekhez

n EN 61010-2-101:2017 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei – 2-101. rész: Részletes követelmények in vitro
diagnosztikai (IVD) orvosi berendezésekhez

n EN 61010-1:2012 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei – 1. rész: Általános követelmények

n EN 61010-2-010:2019 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei – 2-010. rész: Részletes követelmények
anyagok hevítésére szolgáló laboratóriumi berendezésekhez

n EN 61010-2-081:2019 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei – 2-081. rész: Részletes követelmények elemző
és egyéb célú automatikus és félautomatikus laboratóriumi berendezésekhez

n EN 61010-2-101:19 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések biztonsági követelményei – 2-101. rész: Részletes követelmények in vitro
diagnosztikai (IVD) orvosi berendezésekhez

Elektromágneses összeférhetőség (EMC)
A CFX Opus Dx rendszer a tesztek alapján eleget tesz az alábbi elektromágneses kompatibilitásra
vonatkozó szabványok valamennyi követelményének:

n IEC 61326-1:2012 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések – EMC követelmények – 1. rész: Általános követelmények. „A” osztályú
eszközként tesztelve

n IEC 61326-2-6:2012 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések – EMC követelmények – 2–6. rész: Részletes követelmények in vitro
diagnosztikai (IVD) orvosi berendezésekhez.
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n IEC 61326-1:2013 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések – EMC követelmények – 1. rész: Általános követelmények. „A” osztályú
eszközként tesztelve

n EN 61326-2:-6:2013 Méréstechnikai, irányítástechnikai és laboratóriumi felhasználásra szolgáló
elektromos berendezések – EMC követelmények – 2–6. rész: Részletes követelmények in vitro
diagnosztikai (IVD) orvosi berendezésekhez.

n FCC 15. rész, B szakasz, 15.107 és 15.109 pont. „A” osztályú digitális eszközként tesztelve

n CAN ICES-003v6: 2019 Zavarokat okozó berendezések szabványa, informatikai berendezések
(beleértve a digitális készülékeket is) – Határértékek és mérési módszerek. Az „A” osztály
határértékei szerint tesztelve

EMC figyelmeztetések és megjegyzések
n Figyelmeztetés: Ha a jelen egységet a Bio-Rad által kifejezetten jóvá nem hagyott módon

átalakítják, a felhasználónak a jelen egység üzemeltetésére vonatkozó jogosultsága érvénytelenné
válhat.

n Megjegyzés: A készülék tesztelése során megállapították, hogy megfelel az „A” osztályú digitális
eszközökre vonatkozó határértékeknek az FCC-szabályzat 15. része szerint. Ezeket a
határértékeket úgy állapították meg, hogy megfelelő védelmet nyújtsanak a káros interferenciák
ellen, amikor a berendezést kereskedelmi környezetben üzemeltetik. Ez a berendezés
rádiófrekvenciás energiát hoz létre, használ és sugározhat, és ha nem a használati kézikönyvben
foglaltaknak megfelelően helyezik üzembe és használják, káros interferenciát okozhat a rádiós
kommunikációban. Lakókörnyezetben történő használat esetén a jelen berendezés valószínűleg
káros interferenciát fog okozni. Ilyen esetben az interferencia elhárításáról a felhasználónak a saját
költségén gondoskodnia kell.

n Az FCC-megfelelőségre vonatkozó megjegyzés: Habár a jelen készüléket tesztelték, és
megállapították, hogy megfelel az FCC-szabályzat B szakasza 15. részében az „A” osztályú digitális
eszközökre meghatározott előírásoknak, megjegyezzük, hogy ez a megfelelőség önkéntes, hiszen a
jelen műszer a gyártás időpontjában hatályos, hivatkozott FCC-előírások tekintetében a 47 CFR
15.103(c) pontja értelmében „mentességet élvező eszköznek” minősül.

n Megjegyzés a kábelekhez: A készülék EMC-megfelelőségét a készülékhez mellékelt, speciálisan
kialakított USB-kábelekkel tesztelték. A műszerrel az EMC-kibocsátási határértékek folyamatos
betartásához ezeket a kábeleket, illetve a Bio-Rad által engedélyezett egyéb kábeleket kell
használni.
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A környezetre vonatkozó követelmények
A CFX Opus Dx rendszer t biztonságos üzemeltetésre terveztük a következő táblázatban felsorolt
környezeti feltételek mellett.

Paraméter Specifikáció

Környezet Kizárólag beltéri használat

Működési magasság Legfeljebb 2000 méterrel a tengerszint felett

Környezeti szobahőmérséklet 15–31°C*

Szállítási és tárolási hőmérséklet –20° és 60°C között**
–4 és 140°F között

Relatív páratartalom 20–80% (nem lecsapódó)***

Működési teljesítmény 100–240 VAC ± 10%, 50/60–850 Hz, max. 850
W

Hálózati feszültség ingadozása ±10%

Maximális áramfogyasztás < 850 watt

Biztosítékok 10 A, 250 V, 5 x 20 mm, gyors típusú
(mennyiség: 2)

Túlfeszültségi kategória II

Szennyezési fok 2

*A műszer ezen hőmérséklet-tartományon kívüli üzemeltetése nem felel meg a teljesítményre
vonatkozó előírásoknak. Az 5-40 °C közötti szobahőmérséklet biztonságosnak tekinthető.

**A készülék tárolását és szállítását a szállítási tartályban végezze, hogy megfeleljen a hőmérsékleti
feltételeknek.

***A műszer ilyen körülmények között 4⁰C-on legfeljebb 18 órán át működtethető. 4⁰C-on akár 72 órán
keresztül is tárolható, ha a páratartalom kevesebb, mint 60% (nem lecsapódó).

2. táblázat A CFX Opus Dx valós idejű PCR-rendszer környezetre vonatkozó
követelményei
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Veszélyek
A CFX Opus Dx rendszer úgy tervezték, hogy a gyártó által előírt módon használva biztonságosan
működjön. Ha a rendszert vagy annak bármely alkatrészét nem a gyártó által meghatározott módon
használják, a műszerbe beépített védelem károsodhat. A Bio-Rad nem vállal felelősséget semmilyen
sérülésért vagy kárért, amelyet a berendezés bármilyen, nemmeghatározott módon történő használata
vagy a műszer olyan átalakítása okoz, amelyet nem engedélyezett a Bio-Rad vagy hivatalos képviselője.
A CFX Opus Dx rendszer szervizelését csak a Bio-Rad képzett szakemberei végezhetik.

Biológiai veszélyek
A CFX Opus Dx rendszer laboratóriumi termék. Biológiailag veszélyes minták jelenlétében azonban
kövesse az alábbi irányelveket, és tartsa be a saját laboratóriumára és tartózkodási helyére vonatkozó
helyi irányelveket.

Megjegyzés: Ez az eszköz normál működés során nem bocsát ki biológiailag veszélyes anyagokat.

Általános óvintézkedések

n Minden esetben viseljen laboratóriumi köpenyt, laboratóriumi kesztyűt, védőszemüveget vagy
oldalvédelemmel ellátott biztonsági szemüveget.

n Ne nyúljon a szájához, orrához és a szeméhez.

n Teljes mértékben fedje le az összes vágást vagy horzsolást a potenciálisan fertőző anyagokkal való
munkavégzés előtt.

n Ha bármilyen potenciálisan fertőző anyaggal dolgozott, mossa meg a kezét alaposan szappannal és
vízzel, mielőtt elhagyná a laboratóriumot.

n Amunkaasztalnál való munkavégzés előtt vegye le óráját és ékszereit.

n Tároljon minden fertőző vagy potenciálisan fertőző anyagot törés- és szivárgásbiztos edényben.

n Mielőtt kimegy a laboratóriumból, vegye le a védőruhát.

n Kesztyűs kézzel ne írjon, ne vegye fel a telefont, ne kapcsolja fel a villanyt, illetve ne nyúljon
semmihez, amihez mások kesztyű nélkül hozzányúlhatnak.

n Cseréljen gyakran kesztyűt. A láthatóan szennyeződött kesztyűt azonnal vegye le.

n Nem szabad potenciálisan fertőző anyagok hatásának kitenni olyan anyagokat, melyeket nem lehet
megfelelően fertőtleníteni.

n Biológiailag veszélyes anyagokkal végzett művelet befejezésekor fertőtlenítse a munkaterületet
megfelelő fertőtlenítőszerrel (például 1:10 arányban hígított háztartási fehérítőszerrel).
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Felületi fertőtlenítés

FIGYELMEZTETÉS! Az áramütés elkerülése érdekében a fertőtlenítési művelet
végrehajtása előtt mindig kapcsolja ki a műszert, és a csatlakozódugóját húzza ki a
hálózati dugaszolóaljzatból.

Az alábbi területek bármilyen kórházi minőségű baktériumölő, vírusölő vagy gombaölő fertőtlenítőszerrel
tisztíthatók:

n Külső fedél és ház

n A belső mintablokk felülete és mintablokk cellái

n Vezérlőpanel és kijelző

A fertőtlenítőszer elkészítéséhez és alkalmazásához kövesse a termék gyártójának utasításait.
Fertőtlenítőszer alkalmazása után mindig többször öblítse ki vízzel a mintablokkot és a mintablokk celláit.
A vizes öblítés után alaposan szárítsa meg a mintablokkot és a mintablokk celláit.

Fontos: Ne használjon dörzsölő vagy maró hatású tisztítószereket vagy erős lúgos oldatokat. Ezek
a szerek megkarcolhatják a felületeket és megrongálhatják a mintablokkot, ami miatt megszűnhet a
pontos hőmérséklet-szabályozás.

Biológiai veszélyt jelentő anyagok ártalmatlanítása

A következő potenciálisan szennyezett anyagokat a laboratóriumra vonatkozó helyi, regionális és
nemzeti jogszabályokkal összhangban ártalmatlanítsa:

n Klinikai minták

n Reagensek

n Használt reakciós edények, valamint egyéb olyan fogyóeszközök, amelyek szennyezettek lehetnek

Kémiai veszélyek
A CFX Opus Dx rendszer nem tartalmaz potenciálisan veszélyes vegyi anyagokat.

Robbanékonysággal vagy gyúlékonysággal kapcsolatos veszélyek
A CFX Opus Dx rendszer nem jelent(enek) gyúlékonysággal vagy robbanással kapcsolatos rendkívüli
veszélyt, ha a Bio-Rad Laboratories által előírt módon használják.
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Elektromos veszélyek
A CFX Opus Dx rendszer nem jelent(enek) rendkívüli elektromos veszélyt a kezelők számára, ha
megfelelő módon helyezték üzembe és fizikai átalakítás nélkül használják, valamint megfelelő
specifikációjú elektromos táphálózathoz csatlakoztatják.

Szállítás
A CFX Opus Dx rendszer mozgatása vagy szállítása előtt fertőtlenítési eljárásokat kell végrehajtani. A
rendszert mindig külön konténerben, a Bio-Rad által biztosított csomagolóanyagban mozgassa vagy
szállítsa, amely megvédi a rendszert a sérülésektől.

A rendszer szállításával és a megfelelő csomagolóanyag igénylésével kapcsolatban forduljon a Bio-Rad
helyi irodájához.

Akkumulátor
A CFX Opus Dx rendszer egy 3 V-os lítium-fém gombelemet használ az időbeállítások és a futtatási
adatok megőrzéséhez a hálózati tápfeszültség kimaradása esetén. Ha az idő nemmarad beállítva a
készülék kikapcsolása után, ez azt jelezheti, hogy az elem és az akkumulátor kezd gyengülni.

FIGYELMEZTETÉS! Ne kísérelje meg kicserélni az elemet, illetve az akkumulátort.
Szervizelését nem végezheti a felhasználó. Ehelyett kérjen segítséget a Bio-Rad
műszaki ügyfélszolgálattól.

Kizárólag az Amerikai Egyesült Államok Kalifornia állama esetén

n Perklorát – a lítiumakkumulátorok perklorátot tartalmaznak, ezért speciális kezelésre lehet szükség.
Lásd: www.dtsc.ca.gov/hazardouswaste/perchlorate.

Ártalmatlanítás
A CFX Opus Dx rendszer elektromos anyagokat tartalmaznak; ezeket nem szabad válogatatlan
hulladékként elhelyezni, valamint elkülönítve kell összegyűjteni, az Európai Uniónak az elektromos és
elektronikus berendezésekből származó hulladékokról szóló 2012/19/EU számú direktívája szerint –
WEEE Direktíva. Ártalmatlanítás előtt kérdezze meg a Bio-Rad helyi képviselőjét az adott országra
vonatkozó utasításokról.
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Jótállás
A CFX Opus Dx rendszer és a kapcsolódó tartozékokra általános Bio-Rad jótállás vonatkozik. A jótállás
részleteiről a Bio-Rad helyi irodájától kérhet információt.
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1. fejezet Bevezetés
A Bio-Rad nagyteljesítményű PCR-sokszorosító rendszerei a legújabb technológiai újításokat
tartalmazzák, nagyobb pontosságot és reprodukálhatóságot biztosítva a nukleinsav-sokszorozásban
genomvizsgálatokhoz.

A Bio-Rad CFX Maestro Dx szoftver, Security Edition valamennyi CFX készülékkel kompatibilis, és
optimalizált futtatás fájlokkal rendelkezik a Bio-Rad PrimePCR primerrel és szondával végzett
vizsgálatokhoz.

n CFX Opus 96 Dx valós idejű PCR-rendszer (ebben az útmutatóban CFX Opus 96 Dx néven)

n CFX Opus 384 Dx valós idejű PCR-rendszer (ebben az útmutatóban CFX Opus 384 Dx néven)

n CFX Opus Deepwell Dx valós idejű PCR-rendszer (ebben az útmutatóban CFX Opus Deepwell Dx
néven)
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1. fejezet Bevezetés

A CFXMaestro Dx szoftver, Security Edition (ebben az útmutatóban CFX Maestro Dx SE) használatával
komplex adatok értelmezését végezheti el, és nagyon hatékony vizsgálatokat állíthat össze genetikai
elemzéshez. Néhány kattintással összeállíthatja a vizsgálatokat, és génexpresszió-vizsgálatát különböző
eszközökkel, például t-tesztekkel, egyirányú ANOVA-val, PrimePCR kontroll analízissel és a
referenciagén-kiválasztó eszközzel értelmezheti. Ezután az eredményeit a CFX Maestro Dx SE kitűnően
testre szabható adatmegjelenítő és jegyzetelőeszközeivel előkészítheti publikációkhoz és poszterekhez.

Megjegyzés: Néhány képernyő megjelenése a CFX Maestro szoftverben eltérően nézhet ki, mint
ebben a felhasználói útmutatóban. A szoftver megjelenése helyes, és a funkciók megegyeznek.

Fontos: A kiberbiztonság a kibertérben lévő eszközök védelme a kibertámadásokkal szemben. A
kiberbiztonság lehetővé teszi a Bio-Rad számára, hogy megvédje munkatársait, információit,
rendszereit és hírnevét a kibertérben. A kibertér mindig aktív, technológiailag összekapcsolódó világ;
emberekből, szervezetekből, információkból és technológiákból áll.

Kiberbiztonsági problémák esetén fontos a gyors reagálás! Ha azt gyanítja, hogy a műszerével
kapcsolatban kiberbiztonsági probléma merülhet fel, vagy hogy a kiberbiztonság megsérült az Ön
telephelyén, azonnal forduljon a Bio-Rad képviselőjéhez műszaki támogatásért.
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A CFXMaestro Dx szoftver, Security Edition főbb jellemzői

A CFX Maestro Dx szoftver, Security Edition főbb jellemzői
A CFX Maestro Dx SE termékkel a következőket végezheti el:

n Kielemezheti az adatokat oszlopdiagramok, klasztergramok és szórásgörbék használatával, így
gyorsan értelmezheti és megértheti az eredményeket.

n Adatainak megjelenítését testre szabhatja és nagyfelbontású grafikonokat exportálhat publikációs
célokra, illetve jelentések készítésére.

n Meghatározhatja az RNS minőségét, és hibakeresést végezhet a kísérletekben PrimePCR-elemző
kontrollokkal.

n Kiválaszthatja a megfelelő referenciagént, és elemezheti stabilitását a referenciagén-kiválasztó
eszközzel.

n Statisztikai elemzést, például egyirányú ANOVA-analízist hajthat végre a génexpressziós
vizsgálatokban.

Ez a felhasználói útmutató ezeket a jellemzőket, valamint használatukat ismerteti.

További információk
A(z) CFX Maestro Dx SE üzembe helyezése és telepítése, majd a vonatkozó Bio-Rad beállítása után ez
az útmutató, valamint a részletes CFX Maestro Dx SE súgótémák bármely nézetben elérhetők a Help
(Súgó) menüből.

Tipp: A Bio-Rad webhelyének megnyitásához kattintson a Bio-Rad logóra a CFX Maestro Dx SE
bármelyik ablakának jobb felső sarkában. Ez a webhely műszaki megjegyzésekre, kézikönyvekre,
videókra, termékinformációkra és műszaki támogatásra mutató hivatkozásokat tartalmaz. A webhely
számos műszaki információforrást is tartalmaz a PCR-ral, valós idejű PCR-ral és génexpresszióval
kapcsolatos legkülönfélébb módszerekről és alkalmazásokról.
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1. fejezet Bevezetés
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2. fejezet A CFX Maestro Dx szoftver, Security
Edition telepítése

A jelen fejezetben bemutatjuk, hogyan kell telepíteni a CFX Maestro Dx szoftver, Security Editiont. A Bio-
Rad támogatott valós idejű PCR-műszereinek beállítására vonatkozó információkat az adott útmutatóban
találja.

A(z) CFX Maestro Dx SE szükséges a CFX Opus 96 Dx, CFX Opus 384 Dx és a CFX Opus Deepwell Dx
valós idejű PCR-rendszerek valós idejű PCR-adatainak elemzéséhez. Ezt a szoftver által vezérelt
üzemmódban e rendszerek vezérléséhez is használhatja.

A CFX Opus Dx rendszer csomagolásában USB-kábel is található tartozékok zsákján belül. Az USB-
kábellel a CFX Maestro Dx SE szoftvert futtató számítógépet csatlakoztathatja a CFX Opus Dx
rendszerhez.

Vegye le a csomagolóanyagokat, és őrizze meg őket, mert később még szüksége lehet rájuk. Ha bármely
elem hiányzik vagy megsérült, vegye fel a kapcsolatot a helyi Bio-Rad irodával.
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2. fejezet A CFX Maestro Dx szoftver, Security Edition telepítése

Rendszerkövetelmények
A(z) 3. táblázat a CFX Maestro Dx SE szoftvert futtató számítógépre vonatkozó minimális és ajánlott
rendszerkövetelményeket ismerteti.

Rendszer Minimális Ajánlott

Operációs
rendszer

Microsoft Windows 10 (csak 64
bites), 1511-ös build vagy
későbbi, a legújabb biztonsági
frissítésekkel.

Microsoft Windows 10 (csak 64 bites), 1511-ös
build vagy későbbi, a legújabb biztonsági
frissítésekkel.

Megjegyzés: A(z) CFX Maestro Dx szoftver, Security Editiont a Windows 11 is támogatja.

Fontos: A biztonságos rendszerindítást le kell tiltani a CFX Maestro Dx SE szoftvert futtató
számítógépeken. A(z) CFX Maestro Dx SE szoftvert futtató számítógépeket úgy kell beállítani, hogy a
rendszer biztonsági frissítés után ne induljon automatikusan újra, ha egy futtatás folyamatban van.
Kérjen segítséget a rendszergazdától.

Portok 2 darab USB 2.0 nagy sebességű
port

2 darab USB 2.0 nagy sebességű port

Szabad hely a
merevlemez-
meghajtón

128 GB 128 GB

Processzor
sebessége

2,4 GHz, kétmagos 2,4 GHz, négymagos

RAM 4 GB RAM 8 GB RAM

Képernyő
felbontása

1024 x 768 képpont, True Color
üzemmóddal

1280 x 1024 képpont, True Color üzemmóddal

PDF-olvasó Adobe PDF Reader vagy valamelyik támogatott
Microsoft Office programcsomagWindows
PDF-olvasója:

n 2016

n 2019

Lokalizáció Támogatott Microsoft Windows
64 bites operációs rendszer
angol, kínai és orosz nyelven

Támogatott Microsoft Windows 64 bites
operációs rendszer angol, kínai és orosz
nyelven

3. táblázat A CFX Maestro Dx SE szoftvert futtató számítógépre vonatkozó követelmények
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Rendszerkövetelmények

Megjegyzés: Ha a CFX Automation Control szoftvert futtató számítógépen a CFX Maestro Dx SE
szoftvert is szeretné futtatni, a képernyő felbontását állítsa 1280 x 1024 képpontra, és engedélyezze
a True Color üzemmódot.
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2. fejezet A CFX Maestro Dx szoftver, Security Edition telepítése

A CFX Maestro Dx SE szoftver telepítése
Fontos: A szoftver telepítése vagy frissítése előtt a CFX Maestro Dx SE szoftvert futtató
számítógépről le kell választani az esetlegesen hozzá csatlakoztatott készülékeket. A szoftver
telepítése során a műszert nem kell kikapcsolnia. Gondoskodjon arról, hogy az összes futtatás el
legyen mentve, valamint hogy egyetlen kísérlet se fusson éppen.

Megjegyzés: A telepítés megkezdése előtt ellenőrizze, hogy a Biztonságos rendszerindítás ki van-e
kapcsolva. Győződjön meg arról, hogy a számítógép úgy van konfigurálva, hogy a rendszer- vagy a
biztonsági frissítés után ne induljon újra automatikusan, ha futtatás van folyamatban. Kérjen
segítséget a rendszergazdától.

A CFX Maestro Dx SE szoftver telepítéséhez

1. Szükség szerint válassza le a számítógépről az esetlegesen hozzá csatlakoztatott készülékeket.

Keresse meg a műszer USB-kábelét a CFX Maestro Dx SE szoftvert futtató számítógépen, és
válassza le ezt a kábelt a számítógépről. A kábel CFX Opus Dx rendszerhez csatlakoztatott vége a
helyén maradhat.

2. Jelentkezzen be a CFX Maestro Dx SE szoftvert futtató számítógépre rendszergazdai
jogosultságokkal.

3. Helyezze a CFX Maestro Dx SE szoftvert tartalmazó USB-meghajtót a számítógép USB-portjába.

4. A Windows Intézőben keresse meg és nyissa meg a CFX Maestro Dx SE szoftver USB-meghajtóját.

Az USB-meghajtó a kiadási megjegyzéseket és a következő mappákat tartalmazza:

n CFX

n Drivers (Illesztőprogramok)

n Firmware

n Quick Start (Gyors üzembe helyezés)

A(z) CFX mappa más fájlok mellett tartalmazza a(z) CFX Maestro Dx SE szoftver telepítőjét
(CFXMaestroDxSetup.exe).

5. Nyissa meg a(z) CFX mappát, és kattintson duplán a(z) CFXMaestroDxSetup.exe fájlra a telepítő
elindításához.

6. Kövesse a képernyőn megjelenő telepítési utasításokat.

A befejezés után a(z) Bio-Rad CFX Maestro Dx szoftver, Security Edition ikon jelenik meg a
számítógépének asztalán.
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A CFX Maestro Dx SE szoftver telepítése

Tipp: A CFXMaestro telepítője automatikusan telepíti a(z) CFX Maestro Dx szoftver, Security
Edition felhasználói útmutatóját. Az útmutatókat úgy keresheti meg, ha a Help (Súgó) menüben
az Open User Guides (Felhasználói útmutatók megnyitása) opciót választja.

7. A telepítés befejeződését követően a szoftvert tartalmazó USB-meghajtó biztonságosan
eltávolítható a számítógépből.
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2. fejezet A CFX Maestro Dx szoftver, Security Edition telepítése

Csatlakoztatott műszerek észlelése
A telepítés során a CFX Maestro Dx SE telepítője automatikusan telepíti az eszközillesztőket a
CFX Maestro Dx SE szoftvert futtató számítógépre. A CFX Maestro Dx SE észleli a csatlakoztatott
eszközöket, amikor elindítja a szoftvert.

Csatlakoztatott műszerek észleléséhez

1. Ha még nem tette meg, dugja be a mellékelt „B” típusú USB kábel négyzet alakú végét a készülék
alapjának hátulján található „B” típusú USB csatlakozóaljzatba.

2. A kábel másik végét dugja be a CFX Maestro Dx SE szoftvert futtató számítógép egyik USB
csatlakozóaljzatába.

3. Ha a készülék még nem fut, nyomja meg a készüléken levő kapcsolót a készülék bekapcsolásához.

4. Indítsa el a CFX Maestro Dx SE szoftvert.

A szoftver automatikusan érzékeli a csatlakoztatott készüléket, és megjeleníti a nevét a Detected
Instruments (Felismert készülékek) panelen a Home (Kezdőlap) ablakban.

Megjegyzés: Ha a műszer nem jelenik meg a Detected Instruments (Felismert készülékek) panelen,
ellenőrizze, hogy megfelelően be van-e dugva az USB kábel. A meghajtóprogramok
újratelepítéséhez a CFX Maestro Dx SE Home (Kezdőlap) ablakában válassza ki a Tools > Reinstall
Instrument Drivers (Eszközök > Készülékmeghajtó programok újratelepítése) parancsot.
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Szoftverfájlok

Szoftverfájlok
A(z) 4. táblázat a CFX Maestro Dx SE fájltípusait ismerteti.

Fájltípus Kiterjesztés Részletek

Protokoll .prcl A PCR-futtatás elvégzéséhez szükséges
protokollbeállítási adatokat tartalmazza.

Lemez .pltd A PCR-futtatás elvégzéséhez szükséges lemezbeállítási
adatokat tartalmazza.

Adat .pcrd Egy kísérleti futtatás és a PCR-elemzés eredményeit
tartalmazza.

PrimePCR futtatás .csv A PrimePCR-lemezekre vonatkozó protokollt és
lemezelrendezést tartalmazza.

Génvizsgálat .mgxd Több PCR-futtatás és génexpresszió-elemzés
eredményeit tartalmazza.

Önálló előadatfájl .zpcr Önálló műveletek során kiolvasott
fluoreszcenciaértékeket tartalmaz, amelyeket a rendszer
egy adatfájlba konvertál.

LIMS .plrn Egy LIMS-kompatibilis futtatás elvégzéséhez szükséges
lemezbeállítási és protokollinformációkat tartalmazza.

JSON .json Csak olvasható fájl, amelyet csak a CFX Opus Dx
rendszerek hoznak létre; ez a fájl tartalmazza azokat a
futtatásifájl-adatokat, amelyek a fájlböngésző részletek
ablaktáblájában jelennek meg, amikor kiválaszt egy
futtatási fájlt. Ez a fájl a futtatás befejezése után jön létre.
A rendszer a .zpcr fájllal együtt exportálja és az
adatfájlokkal együtt elmenti, ha a mentési hely USB-
meghajtó vagy megosztott hálózati mappa.

4. táblázat CFX Maestro Dx SE fájltípusok
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3. fejezet A CFX Maestro Dx szoftver, Security
Edition felhasználói fiókjainak kezelése

A CFXMaestro Dx szoftver, Security Edition termékbe a felhasználók Windows-os felhasználói nevükkel
és jelszavukkal jelentkeznek be. Az a személy, aki a CFX Maestro Dx SE szoftvert telepítette,
automatikusan adminisztrátori szerepet kap, és létrehozhatja és kezelheti a felhasználói fiókokat és
szerepköröket. Minden más felhasználóhoz felhasználói fiókot kell rendelni a szoftverbe való
bejelentkezéshez és a szoftver használatához.

Fontos: Minden felhasználónak rendelkeznie kell Windows-fiókkal és jelszóval a CFX Maestro Dx
SE szoftvert futtató számítógépen, mielőtt felhasználói fiókot és szerepkört rendelhet hozzájuk. A
felhasználók a Windows felhasználók vagy aWindows rendszergazdák csoport tagjai lehetnek. A
Windows felhasználók csoport tagjai csak a saját CFX Maestro Dx SE fájlokhoz és mappákhoz
férhetnek hozzá. A Windows rendszergazdák csoport tagjai a számítógép összes felhasználójának
fájljaihoz és mappáihoz hozzáférnek.

Ez a fejezet azt ismerteti, hogyan kell létrehozni Microsoft Windows felhasználókat ahhoz, hogy ezeket a
felhasználókat létre tudja hozni a CFX Maestro Dx SE szoftverben. Ebből a szakaszból azt is
megismerheti, hogyan vehet fel felhasználókat a CFX Maestro Dx SE szoftverben, és hogyan kezelheti a
felhasználói szerepköröket és engedélyeket.
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3. fejezet A CFX Maestro Dx szoftver, Security Edition felhasználói fiókjainak kezelése

A CFX Maestro Dx szoftver, Security Edition elindítása
Megjegyzés: A felhasználóknak be kell jelentkeznie a Windows felhasználói nevükkel és
jelszavukkal.

A CFX Maestro Dx SE szoftver elindításához

1. A CFX Maestro Dx SE szoftvert futtató számítógépen kattintson duplán a parancsikonra a
CFX Maestro Dx SE elindításához.

2. A Login (Bejelentkezés) párbeszédpanelen írja be aWindows jelszavát, és kattintson az OK gombra.

A CFX Maestro Dx SE megnyitja a Home (Kezdőlap) képernyőt. A címsor mutatja a bejelentkezett
felhasználó Windows felhasználói nevét, a menüsor pedig egy kék matricát jelenít meg, amely azt
jelzi, hogy a szoftver megfelel a 21 CFR 11. részének, például:
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A CFXMaestro Dx szoftver, Security Edition elindítása
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3. fejezet A CFX Maestro Dx szoftver, Security Edition felhasználói fiókjainak kezelése

Microsoft Windows felhasználók hozzáadása a CFX Maestro
Dx szoftver, Security Editiont futtató számítógéphez

A CFX Maestro Dx SE szoftvert futtató számítógépre minden felhasználónak a Windows-
felhasználónévvel és -jelszóval kell bejelentkeznie. A pontos auditkövetés érdekében aWindows
felhasználói fiókokat nem lehet létrehozni a Start> Beállítások> Fiókok párbeszédpanelen keresztül. A
Windows felhasználói fiókokat a számítógép vezérlőpultján keresztül kell létrehozni.

Fontos: Ha a társított CFX Maestro Dx SE felhasználó létrehozása után módosítja a Windows-
felhasználó tulajdonságait (ideértve a felhasználónevet és a teljes nevet is), a CFX Maestro Dx SE
felhasználó érvénytelenné válik. Mielőtt elmentené aWindows-felhasználót és létrehozná a társított
CFX Maestro Dx SE felhasználót, ellenőrizze az adatok helyességét.

Tipp: AWindows-fiókok létrehozása előtt olvassa el a Microsoft felhasználókezelésről szóló
dokumentációját, és további információkért forduljon a Windows-rendszergazdájához.

Windows felhasználói fiókok létrehozása a CFX Maestro Dx SE szoftvert futtató
számítógépen

1. Jelentkezzen be a CFX Maestro Dx SE szoftvert futtató számítógépre a Windows rendszergazdai
csoport tagjaként.

2. Az asztalon kattintson jobb gombbal a Sajátgép elemre, és válassza a Kezelés lehetőséget a
Számítógép-kezelő konzol megnyitásához.

3. A Számítógép-kezelő konzolon bontsa ki a Helyi felhasználók és csoportok elemet.

4. Kattintson jobb gombbal a Felhasználók mappára, és válassza ki az Új felhasználó lehetőséget az Új
felhasználó párbeszédpanel megnyitásához.
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Microsoft Windows felhasználók hozzáadása a CFX Maestro Dx szoftver, Security Editiont futtató számítógéphez

5. Az Új felhasználó párbeszédpanelen a következő mezőket kell kitölteni:

n Felhasználónév

n Teljes név

n Jelszó

n Jelszó megerősítése

6. Kattintson a Create (Létrehozás) elemre.
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A CFX Maestro Dx szoftver, Security Edition felhasználóinak
létrehozása és törlése

Tipp: Csak a CFX Maestro Dx SE rendszergazdai szerepköre hozhatja létre és törölheti a
CFX Maestro Dx SE felhasználói fiókjait. Az a személy, aki a CFX Maestro Dx SE szoftvert
telepítette, automatikusan megkapja a Rendszergazda szerepkört. Ez a személy hozzárendelheti a
rendszergazda szerepkörét más felhasználókhoz.

Megjegyzés: A CFX Maestro Dx SE szoftverben legalább egy felhasználónak rendszergazdai
szerepkört kell kapnia.

A CFX Maestro Dx SE felhasználói fiókjainak létrehozásához

1. Ellenőrizze, hogy minden tervezett felhasználó a Windows felhasználók vagy aWindows
rendszergazdák csoportjának tagja-e, és rendelkezik-e Windows jelszóval a CFX Maestro Dx SE
szoftvert futtató számítógépen.

2. Indítsa el a CFX Maestro Dx SE szoftvert, és jelentkezzen be rendszergazdaként.

3. A Home (Kezdőlap) ablakban válassza ki a User > User Administration (Felhasználó > Felhasználók
kezelése) elemet.
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A CFXMaestro Dx szoftver, Security Edition felhasználóinak létrehozása és törlése

Ekkor megjelenik a User Administration (Felhasználók kezelése) párbeszédablak.

4. A Manage Users (Felhasználók kezelése) szakaszban adja meg minden felhasználóhoz a következő
információkat:

n User name (Felhasználónév) – a CFX Maestro Dx SE szoftverben e felhasználó Windows
felhasználói nevének kell lennie.

n Full name (Teljes név) – a felhasználó teljes neve.

Ez a név az auditnaplóban a Teljes felhasználó mezőben jelenik meg. Ennek a névnek meg kell
egyeznie a Teljes név mezőbe beírt névvel a Windows-felhasználó létrehozásakor.

n Role (Szerepkör) – a felhasználóhoz rendelendő szerepkör.

Megjegyzés: Csak egy szerepet választhat ki a legördülő listából. További információk: A
CFX Maestro Dx szoftver, Security Edition felhasználói szerepköreinek kezelése.

n Domain (Tartomány) – az a Windows-tartomány, ahonnan a felhasználó a szoftvert eléri.

További információkat a Windows-rendszergazdájától kaphat.

5. Kattintson az OK gombra, majd a Yes (Igen) gombra a módosítások mentéséhez és a User
Administration (Felhasználókezelés) párbeszédpanel bezárásához.
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A CFX Maestro Dx SE egy felhasználói fiókjának törléséhez

1. Indítsa el a CFX Maestro Dx SE szoftvert, és jelentkezzen be rendszergazdaként.

2. A kezdőablakban válassza ki a User > User Administration (Felhasználó > Felhasználókezelés)
lehetőséget a User Administration (Felhasználókezelés) párbeszédpanel megnyitásához.

3. A Manage Users (Felhasználók kezelése) táblán válassza ki a Remove (Törlés) lehetőséget
mindegyik törölni kívánt felhasználóhoz.

4. Kattintson az OK gombra, majd a Yes (Igen) gombra a módosítások mentéséhez és a User
Administration (Felhasználókezelés) párbeszédpanel bezárásához.

A CFX Maestro Dx szoftver, Security Edition felhasználói
szerepköreinek kezelése

Fontos: A CFX Maestro Dx SE szoftverben legalább egy felhasználóhoz Rendszergazda szerepkört
kell rendelni. Ezt a szerepet több felhasználóhoz is hozzárendelheti.

A CFX Maestro Dx SE négy felhasználói szerepkörrel rendelkezik. Minden felhasználóhoz hozzá kell
rendelni valamilyen szerepet, hogy hozzáférhessen a szoftverhez. Bár a felhasználókhoz csak egy
szerepkör rendelhető hozzá, a felhasználó szerepkörét bármikor megváltoztathatja.

A Rendszergazda szerep kivételével megváltoztathatja az egyes szerepkörökhöz rendelt engedélyeket.
A szerephez rendelt összes felhasználó csak az adott szerepkör engedélyeit örökli.

Alapértelmezés szerint az egyes szerepkörök jogosultságai a következők:

n Rendszergazda: ennek a szerepnek mindenhez van jogosultsága; ezeket az engedélyeket nem
lehet módosítani.

n Vezető: ennek a szerepkörnek az e-mail beállítását kivéve mindenhez van engedélye.

n Kezelő: ennek a szerepkörnek a ciklusok átugrását és az e-mail beállítását kivéve mindenre van
jogosultsága.

n Vendég: ez a szerepkör csak fájlokat tud olvasni.

A szerepkörök kiosztásakor a CFX Maestro Dx SE szoftverben gondosan határozza meg az egyes
felhasználókra vonatkozó követelményeket. Például mentési engedély nélkül a Vendég szerepkörrel
rendelkező felhasználók nem fognak tudni fájlokat aláírni. E-mail fiók létrehozásának engedélye nélkül a
futtatások befejeztével egyik szerepkör sem kap e-mailt.
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A CFXMaestro Dx szoftver, Security Edition felhasználói szerepköreinek kezelése

Szerepkör engedélyeinek módosítása

1. Indítsa el a CFX Maestro Dx SE szoftvert, és jelentkezzen be rendszergazdaként.

2. A kezdőablakban válassza ki a User > User Administration (Felhasználó > Felhasználókezelés)
lehetőséget a User Administration (Felhasználókezelés) párbeszédpanel megnyitásához.

3. A Manage Rights (Jogok kezelése) szakaszban törölje vagy jelölje be a szükséges engedélyek
jelölőnégyzetét az egyes szerepkörökhöz.

4. Kattintson az OK gombra, majd a Yes (Igen) gombra a módosítások mentéséhez és a User
Administration (Felhasználókezelés) párbeszédpanel bezárásához.

A szerepköre és engedélyei megtekintése
Tipp: A Principal (Vezető), Operator (Kezelő) vagy Guest (Vendég) felhasználói szerepkörrel
rendelkező felhasználók csak a saját felhasználói beállításaikat, jogosultságaikat és szerepköreiket
tekinthetik meg. Az adminisztrátori szerepkörrel rendelkező felhasználók megtekinthetik az összes
felhasználói engedélyt és szerepkört.

Saját aktuális felhasználói szerepkörének és jogosultságainak megtekintéséhez

u A Home (Kezdőlap) ablakban válassza ki a User > User Administration (Felhasználó > Felhasználó
kezelése) elemet.

Ha módosítani szeretné a User Administration (Felhasználó kezelése) ablakban látható felhasználói
beállításokat, jogosultságokat és szerepköröket, vegye fel a kapcsolatot a CFX Maestro Dx SE
rendszergazdájával.
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4. fejezet A CFX Maestro Dx szoftver, Security
Edition használata

Fontos: A CFXMaestro Dx szoftver, Security Edition a Microsoft Windows felhasználóhitelesítését
használja a biztonságos CFX-adatfájlokhoz való hozzáférés ellenőrzéséhez. Vegye fel a kapcsolatot
a Windows rendszergazdájával, hogy hozzon létre olyan környezetet, amely megfelel a 21 CFR 11.
része követelményeinek.

A CFX Maestro Dx SE szoftvert használva a felhasználók megtehetik a következőket:

n Adat- és génvizsgálati fájlok aláírása.

n Adatfájlok védelme jelszóval.

n Auditnaplók megtekintése és kinyomtatása.

Ez a szakasz részletesen ismerteti ezeket a funkciókat.

Biztonságos fájlok
Alapértelmezés szerint a CFX Maestro Dx SE biztonságos fájlokat a bejelentkezett felhasználó
személyes mappájába menti, amely a következő helyen található:

C:\Felhasználók\<felhasználónév>\Dokumentumok\Bio-Rad\CFX_MDX\My qPCR

A .pcrd fájlokat elmentheti abba a mappába, és szerkesztheti is őket. Ez a mappa más mappákra (például
a Sample Files mappára) mutató hivatkozásokat tartalmaz, amelyek írásvédett fájlokat tartalmaznak.
Azonban egy rendszergazda törölheti annak a mappának a tartalmait.

Tipp: Alternatív megoldásként a Windows rendszergazdája létrehozhat egy megosztott mappát, és
a CFX Maestro Dx SE rendszergazdája beprogramozhatja a szoftvert, hogy az összes fájlt ebbe a
mappába mentse.

A CFX Maestro Dx SE szoftver a lemez-, protokoll-, adat- és génvizsgálati fájlokat mentéskor
biztonságosként jelöli. Ezeket a fájlokat a CFX Maestro vagy a CFX Maestro Dx SE szoftverben hozhatja
létre. Miután elmenti őket a CFX Maestro Dx SE szoftverben, ezeket a fájlokat csak a CFX Maestro Dx SE
szoftverben lehet megnyitni.
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A CFX Maestro Dx SE auditnaplót hoz létre az összes biztonságos adat- és génvizsgálati fájlhoz (.pcrd és
.mgxd fájlok). A szoftver az összes auditálható tevékenységet rögzíti a fájl auditnaplójában. További
információ: Auditnaplók a(z) 319. oldalon.

Biztonságos fájlok aláírása

Egy fájl elmentése után a CFX Maestro Dx SE szoftverben a felhasználók elektronikus aláírást adhatnak
hozzá. Fájl aláírásához a felhasználó szerepkörének tartalmaznia kell az engedélyt fájlok mentésére.
Például alapértelmezés szerint a Guest (Vendég) szerepkör nem tartalmazza a fájlmentési engedélyt,
ezért ezzel a szerepkörrel a felhasználók nem írhatnak alá fájlt.

A CFX Maestro Dx SE szoftverben az aláírt fájlok nincsenek csak olvashatóként beállítva. Többször
felülvizsgálhatók, módosíthatók és aláírhatók. A szoftver az auditnaplóban minden változtatást és aláírást
rögzít. A következő fájltípusokat lehet aláírni:

n Adatfájlok (.pcrd)

n Génvizsgálati fájlok (.mgxd)

Megjegyzés: A fájlokat el kell menteni, és csak utána lehet aláírni őket. Ha nemrégiben végzett
futtatást a CFX Maestro Dx SE szoftverben, először mentse el a kapott adatfájlt.

Fájl aláírása

1. Jelentkezzen be a CFX Maestro Dx SE szoftverbe aWindows bejelentkezési adataival.

2. Nyissa meg az aláíráshoz a biztonságos adatfájlt vagy génvizsgálati fájlt.

3. Válassza ki a File > Sign (Fájl > Aláírás) lehetőséget. Megjelenik az Electronic Signature
(Elektronikus aláírás) párbeszédpanel.
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4. Írja be aWindows felhasználónevét és jelszavát, valamint a fájl aláírásának okát.

A felhasználónév és az aláírás oka szerepel az auditnaplóban (további információ: Auditnaplók a(z)
319. oldalon ).

5. Kattintson az OK gombra az aláírás elküldéséhez és a párbeszédpanel bezárásához.

Biztonságos fájlok módosítása

A CFX Maestro Dx SE szoftverben a felhasználók módosíthatják a biztonságos fájlokat, beleértve az
aláírt és aláíratlan adat- és génvizsgálati fájlokat is. Amikor elment egy módosított biztonságos adat- vagy
génvizsgálati fájlt, a szoftver felszólítja, hogy adja meg a változás okát. A változásokat a rendszer rögzíti a
fájl auditnaplójában.

Tipp: Mivel a szoftver nem hoz létre auditnaplókat a lemez- és protokollfájlokhoz, e fájlok
módosításainak mentésekor nem kap felszólítást.

Módosított adat- vagy génvizsgálati fájl mentéséhez

1. Jelentkezzen be a CFX Maestro Dx SE szoftverbe aWindows bejelentkezési adataival.

2. Nyisson meg és módosítson egy biztonságos adatfájlt vagy génvizsgálati fájlt.

Tipp: Az auditálható tevékenységek listáját lásd: Auditálható események a(z) 321. oldalon.
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3. Válassza ki a File > Save (Fájl > Mentés) lehetőséget. Megjelenik az Audit Trail Change Reason (Az
auditnapló változásának oka) párbeszédpanel.

Ez a párbeszédpanel a következő információkat jeleníti meg, amelyeket a rendszer minden egyes
módosítási eseménynél rögzít a fájl naplófejlécében:

n Date (Dátum) – a változás bekövetkezésének dátuma.

n User (Felhasználó) – a bejelentkezett felhasználó Windows-tartománya és felhasználóneve.

n Comment (Megjegyzés) – az utolsó mentett megjegyzés.

n Signature (Aláírás) – a fájl utolsó aláírójának elektronikus aláírása.

n Signature reason (Az aláírás oka) – az aláírás oka.

n Application (Alkalmazás) – CFX Maestro Dx SE (BioRadCFXManager.exe néven jelenik meg,
ami helyes).

n Application version (Alkalmazásverzió) – a CFX Maestro Dx SE aktuális verziója.

n Full user (Teljes felhasználó) – a bejelentkezett felhasználó teljes neve.

Megjegyzés: Ez a név jelenik meg az auditnaplóban.

n Machine (Gép) – az a számítógép, amelyre a szoftver telepítve van.
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Amódosítási táblázat a módosítás eredményeként bekövetkezett auditálható változásokat jeleníti
meg. A változás okának rövid leírása is megjelenhet.

Tipp: A Reason for Change (Változás oka) oszlopban hozzáadhat vagy szerkeszthet egy
leírást.

4. Tekintse át a változtatások listáját. Szükség esetén adjon meg részletes okokat.

5. Tegye az alábbiak egyikét:

n Kattintson a Save Changes (Változtatások mentése) gombra a fájl változásainak, valamint a
táblázatban végrehajtott módosítások mentéséhez és a párbeszédpanel bezárásához.

A fájl változásai és a változások okai megjelennek a fájl auditnaplójában.

n Kattintson a Cancel Changes (Változtatások visszavonása) gombra a fájl korábbi állapotának
visszaállításához és a párbeszédpanel bezárásához.

A változásokat a rendszer nemmenti el a fájlba, és az auditnapló nem frissül.
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A fájlok védelme jelszóval

További biztonsági szintként a CFX Maestro Dx SE lehetővé teszi a felhasználók számára, hogy jelszót
állítsanak be az összes biztonságos fájlhoz. Amikor jelszót állít be egy biztonságos fájlra, vegye
figyelembe a következő feltételeket:

Állapot Teendő

Nem szükséges jelszó. Minden felhasználó megnyithatja, módosíthatja és
elmentheti a biztonságos fájlt, a jogosultságaiktól
függően.

A fájl mentéséhez jelszót kell
megadni.

Minden felhasználó megnyithatja a biztonságos fájlt, és
azok, akik ismerik a mentéshez szükséges jelszót,
módosíthatják és elmenthetik a biztonságos fájlt.

A fájl megnyitásához jelszót kell
megadni.

Csak azok a felhasználók tudják megnyitni, módosítani
és menteni a biztonságos fájlt, akik ismerik a
megnyitáshoz szükséges jelszót.

A fájlhoz meg kell adni a
megnyitáshoz és mentéshez
szükséges jelszót is.

Néhány felhasználó megnyithatja a biztonságos fájlt, és
e felhasználók egy része módosíthatja és mentheti is.

A felhasználó szerepétől függően bármely felhasználó elvégezheti a Save as (Mentés másként)
műveletet, új biztonságos fájlt létrehozva más néven, vagy azonos néven elmentve egy másik helyre,
amennyiben az alábbiak egyike igaz:

n A biztonságos fájl nincs jelszóval védve.

n A felhasználó tudja a jelszót a fájl megnyitásához.

Tipp: Az új fájl mentése jelszóvédelem nélkül történik. Az eredeti fájlhoz továbbra is kell
jelszó/jelszavak.

A szereptől függően a felhasználó módosíthatja és mentheti az eredeti fájlt, amennyiben az alábbiak
egyike igaz:

n A fájl nincs jelszóval védve.

n A felhasználó tudja a fájl megnyitásához és mentéséhez szükséges jelszót.

Megjegyzés: A felhasználó szerepének tartalmaznia kell a fájlok mentésének jogát a jelszavak
beállításához. Például a Guest (Vendég) szerepkörrel rendelkező felhasználók nemmenthetnek
fájlokat, ezért nem állíthatnak be jelszavakat a fájlokra.

Fontos: Csak a CFX Maestro Dx SE adminisztrátorai állíthatják vissza vagy törölhetik a jelszavakat.

54 | CFX Maestro Dx SE szoftver



Fájl védelme jelszóval

1. Jelentkezzen be a CFX Maestro Dx SE szoftverbe aWindows hitelesítő adataival.

2. Nyissa meg a biztonságos fájlt.

3. Válassza a File > File Passwords (Fájl > Fájljelszavak) lehetőséget. Megjelenik a File Passwords
(Fájljelszavak) párbeszédpanel.

4. Írja be a jelszavakat a Save Password (Jelszó mentéshez) és Open Password (Jelszó
megnyitáshoz) mezőbe.

Tipp: Alapértelmezés szerint a jelszavak csillagként jelennek meg gépeléskor. Válassza ki a
Show Password (Jelszó megjelenítése) lehetőséget, hogy a jelszó megjelenjen gépelés közben.

Fontos: A jelszavakban meg vannak különböztetve a kis- és nagybetűk. A CFX Maestro Dx SE
nem korlátozza a jelszavakat. A legjobb gyakorlatokról az intézményben a rendszergazdája tud
felvilágosítást adni.

5. Kattintson a Set Passwords (Jelszavak beállítása) elemre a jelszavak beállításához és a
párbeszédpanel bezárásához.

6. A fájl módosításainak mentéséhez válassza ki a File > Save (Fájl > Mentés) lehetőséget.
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Jelszavak törléséhez

Fontos: A jelszavak törléséhez rendszergazdának kell lennie a CFX Maestro Dx SE szoftverben.

1. A Password Required (Jelszó szükséges) párbeszédpanelen kattintson a Remove Passwords
(Jelszavak törlése) elemre.

Megjelenik a CFX Maestro Dx SE Login (Bejelentkezés) párbeszédpanelje.

2. Adja meg a CFX Maestro Dx SE adminisztrátorának Windows felhasználói nevét és jelszavát, majd
kattintson az OK gombra.

Megjelenik az eredeti adatfájl.

Fontos: A jelszavak törléséhez el kell mentenie a fájlt.

3. A fájl módosításainak mentéséhez válassza ki a File > Save (Fájl > Mentés) lehetőséget.

56 | CFX Maestro Dx SE szoftver



Jelszavak megváltoztatásához

Fontos: Csak a CFX Maestro Dx SE adminisztrátorai változtathatják meg a jelszavakat.

1. Nyissa meg a biztonságos fájlt.

2. Válassza a File > File Passwords (Fájl > Fájljelszavak) lehetőséget. Megjelenik a File Passwords
(Fájljelszavak) párbeszédpanel.

Tipp: A Save Password (Jelszó mentéshez), Open Password (Jelszó megnyitáshoz) és Show
Password (Jelszó megjelenítése) le van tiltva.

3. Kattintson a Reset Passwords (Jelszavak visszaállítása) elemre.

Megjelenik a CFX Maestro Dx SE Login (Bejelentkezés) párbeszédpanelje.
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4. Adja meg a CFX Maestro Dx SE adminisztrátorának Windows felhasználói nevét és jelszavát, majd
kattintson az OK gombra.

Megjelenik a File Passwords (Fájljelszavak) párbeszédpanel.

5. Tegye az alábbiak egyikét:

n A jelszóvédelem visszaállításához írja be az új jelszót a megfelelő jelszómezőbe.

n A jelszóvédelem törléséhez törölje a jelszómezőket.

6. Kattintson a Set Passwords (Jelszavak beállítása) elemre a jelszó módosításainak mentéséhez és a
párbeszédpanelből való kilépéshez.
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5. fejezet A munkaterület
A(z) CFX Maestro Dx szoftver, Security Edition interfészt biztosít a PCR-protokollok kifejlesztéséhez,
futtatásukhoz CFX Opus Dx és Deepwell Dx műszereken és a PCR-futtatások adatainak elemzéséhez.

A CFX Maestro Dx SE szoftver öt elsődleges munkafelületet kínál:

n A Home (Kezdőlap) ablak

n A Startup Wizard (Indítási varázsló)

n A Protocol Editor (Protokollszerkesztő) ablak

n A Plate Editor (Lemezszerkesztő) ablak

n A Data Analysis (Adatelemzés) ablak

Ez a fejezet bemutatja és röviden ismerteti az egyes munkaterületeket.
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A Home (Kezdőlap) ablak
A CFX Maestro Dx SE program elindításakor megnyílik a Home (Kezdőlap) ablak, és megjelenik a
Startup Wizard (Indítási varázsló), amelyben beállíthat egy kísérletet, elvégezhet vagy megismételhet
egy futtatást vagy elemezhet egy meglévő futtatást. Ezenkívül a Home (Kezdőlap) ablakból megtekintheti
az alkalmazásra és a műszerekre vonatkozó naplókat, létrehozhat új felhasználókat, kezelheti a meglévő
felhasználókat, valamint számos hasznos eszközt elérhet. További információk: 6. fejezet, A Home
(Kezdőlap) ablak.
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A Startup Wizard (Indítási varázsló)
A Startup Wizard (Indítási varázsló) segítségével gyorsan beállíthat és futtathat felhasználó által beállított
kísérleteket, valamint gyorsan kiválaszthat és futtathat egy PrimePCR-kísérletet. Ezenkívül ezzel a
varázslóval megismételhet egy futtatást vagy kielemezhet futtatási adatokat.
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A Protocol Editor (Protokollszerkesztő) ablak
A Protocol Editor (Protokollszerkesztő) ablakban létrehozhat, megnyithat, áttekinthet és szerkeszthet egy
protokollt. Módosíthatja a fedélhőmérsékletet is a megnyitott protokollhoz. A Protocol Editor
(Protokollszerkesztő) működését az 7. fejezet, Protokollok létrehozása című szakasza részletezi.
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A Plate Editor (Lemezszerkesztő) ablak
A Plate Editor (Lemezszerkesztő) ablakban létrehozhat, megnyithat, áttekinthet és szerkeszthet egy
lemezt. A Plate Editor (Lemezszerkesztő) működésének részletei a 8. fejezet, Lemezek előkészítése
című részében találhatók.
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A Data Analysis (Adatelemzés) ablak
A Data Analysis (Adatelemzés) ablakban megtekinthet és összehasonlíthat futtatási adatokat, statisztikai
elemzéseket végezhet, adatokat exportálhat, valamint publikációra kész jelentéseket hozhat létre. Az
adatelemzési funkciókat a 10. fejezet, Az adatelemzés áttekintése és 11. fejezet, Az adatelemzéssel
kapcsolatos részletek című szakaszok ismertetik.
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A CFXMaestro Dx szoftver, Security Edition interfészt biztosít a PCR-protokollok kifejlesztéséhez,
futtatásukhoz CFX Dx rendszereken és a PCR-futtatási adatok elemzéséhez.

A jelen fejezet bemutatja a CFX Maestro Dx SE szoftvert, és ismerteti a Home (Kezdőlap) ablakból
elérhető funkciókat.
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A Home (Kezdőlap) ablak
A CFX Maestro Dx SE szoftver elindításakor megnyílik a Home (Kezdőlap) ablak, és megjelenik a Startup
Wizard (Indítási varázsló), amellyel beállíthat egy futtatást, elvégezhet vagy megismételhet egy futtatást
vagy elemezhet egy meglévő futtatást. Ezenkívül a Home (Kezdőlap) ablakból megtekintheti az
alkalmazásra és a műszerekre vonatkozó naplókat, létrehozhat új felhasználókat, kezelheti a meglévő
felhasználókat, valamint számos hasznos eszközt elérhet.

1. A szoftver címsorában a szoftver és a bejelentkezett felhasználó neve látható.

2. A menüsor gyors hozzáférést kínál a File (Fájl), View (Nézet), Users (Felhasználók), Run
(Futtatás), Tools (Eszközök), Window (Ablak) és Help (Súgó) menüpontban található
parancsokhoz.

3. Az eszköztárban található parancsok gyors hozzáférést biztosítanak a menüpontokhoz.

JELMAGYARÁZAT

66 | CFX Maestro Dx SE szoftver



A Home (Kezdőlap) ablak

4. A bal oldali panelen a CFX Maestro Dx SE szoftvert futtató számítógéphez csatlakoztatott
készülékek, valamint olyan gombok láthatók, amelyekkel működtetheti a fedelet és
megtekintheti a műszerek állapotát.

5. A fő panelen a munkaablak látható. A Home (Kezdőlap) képernyőn a Startup Wizard (Indítási
varázsló) az alapértelmezett munkaablak.

6. A státuszsorban a csatlakoztatott készülékek és a bejelentkezett felhasználó neve látható.

A File (Fájl) menü parancsai
New (Új) – megnyit egy párbeszédpanelt, amelyen választhat az új protokoll, lemez vagy génvizsgálat
létrehozása lehetőségek közül.

Open (Megnyitás) – megnyit egy párbeszédpanelt, amelyen egy meglevő protokollra, lemezre, adatfájlra,
génvizsgálatra, LIMS-fájlra, egy önálló műszerről történő futtatási (önálló futtatási) vagy PrimePCR
futtatási fájlra navigálhat, és megnyithatja a kiválasztott elemet.

Recent Data Files (Legutóbbi adatfájlok) – megjeleníti a legutóbb megnyitott PCR-fájlok listáját.

Repeat a Run (Egy futtatás megismétlése) – a Windows fájlkezelőjében megnyitja az elmentett PCR-
fájlok helyét, ahol megkereshet egy megismételni kívánt futtatást.

Exit (Kilépés) – bezárja a CFX Maestro Dx SE szoftvert.

A View (Nézet) menüpont parancsai
Application Log (Alkalmazásnapló) – szoftverhasználati napló megjelenítése, amelyben a kezdeti
telepítéstől az aznapi dátumig láthatók az adatok.

Run Reports (Futtatási jelentések) – a futtatási jelentések megjelenítése egy listában.

Startup Wizard (Indítási varázsló) – a Startup Wizard (Indítási varázsló) megjelenítése a fő panelen.

Run Setup (Futtatás beállításai) – a Run Setup (Futtatás beállításai) ablak megjelenítése a fő panelen.

Instrument Summary (Készülék-összefoglaló) – az Instrument Summary (Készülék-összefoglaló) ablak
megjelenítése a fő panelen.

Detected Instruments (Felismert készülékek) – váltókapcsoló annak a beállításához, hogy a szoftver a
bal oldali panelen megjelenítse a csatlakoztatott műszereket vagy ne. A szoftver alapértelmezés szerint
megjeleníti a csatlakoztatott műszereket a bal oldali panelen.

Toolbar (Eszköztár) – váltókapcsoló annak a beállítására, hogy a szoftver megjelenítse az eszköztárat a
képernyő tetején vagy ne. A szoftver alapértelmezés szerint megjeleníti az eszköztárat.
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Status Bar (Állapotsor) – váltókapcsoló annak a beállítására, hogy a szoftver megjelenítse az állapotsort
a képernyő alján vagy ne. A szoftver alapértelmezés szerint megjeleníti az állapotsort.

Show (Megjelenítés) – párbeszédpanel megnyitása, amellyel Ön a következőket teheti:

n A Status log (Státusznapló) megjelenítése vagy zárolása.

n A CFX Maestro Dx SE adatmappájának megnyitása és megtekintése.

n A felhasználó adatmappájának megnyitása és megtekintése.

n A LIMS-fájl mappájának megnyitása és megtekintése.

n A PrimePCRmappa megnyitása és megtekintése.

n A futtatási előzmények megtekintése.

n Az összes csatlakoztatott készülék tulajdonságainak megtekintése.

A User (Felhasználó) menüpont parancsai
Select User (Felhasználó kiválasztása) – megnyitja a Login (Bejelentkezés) képernyőt, amelyen
kiválaszthat egy felhasználót a User Name (Felhasználónév) legördülő listáról, és bejelentkezhet az
alkalmazásba.

Change Password (Jelszó megváltoztatása) – megnyitja a Change Password (Jelszó megváltoztatása)
párbeszédpanelt, amelyben a felhasználók megváltoztathatják a jelszavukat.

Megjegyzés: Ez az opció le van tiltva a CFX Maestro Dx SE esetében. A felhasználóknak a
Windows jelszavukat kell megváltoztatni a CFX Maestro Dx SE szoftverben használt jelszavuk
megváltoztatásához.

User Preferences (Felhasználói beállítások) – megnyitja a User Preferences (Felhasználói beállítások)
párbeszédpanelt, amelyben a felhasználók módosíthatják az alapértelmezett beállításokat az
alábbiakhoz:

n E-mail-értesítés küldése és fogadása a futtatás befejezésekor

n Adatfájlok elmentése

n Protokollok létrehozása a Protocol Editor (Protokollszerkesztő) vagy a Protocol AutoWriter
(Automatikus protokollíró) használatával

n Lemezek létrehozása

n Adatok elemzése

n Génexpresszió-elemzés végrehajtása

n Az adatok minőségének meghatározása
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n A CFX készülék adatainak exportálása

User Administration (Felhasználók kezelése) – megnyitja a User Administration (Felhasználók
kezelése) párbeszédpanelt, amelyben a rendszergazdák felhasználókat hozhatnak létre, módosíthatják a
szerepkörök engedélyeit, és szerepköröket rendelhetnek a felhasználókhoz.

Bio-Rad Service Login (Szervizbejelentkezés) – kizárólag a Bio-Rad műszaki szervizszemélyzete
használatára. Ezt a parancsot ne válassza ki.

A Run (Futtatás) menüpont parancsai
User-defined Run (Felhasználó által definiált futtatás) —megnyitja a Run Setup (Futtatás beállításai)
ablakot, amelyben beállíthat egy felhasználó által definiált protokollt és lemezt, majd lefuttathat egy PCR-
kísérletet a kiválasztott készüléken.

PrimePCR Run (PrimePCR futtatás) —megnyitja a Start Run (Futtatás indítása) fület a Run Setup
(Futtatás beállításai) ablakban a kiválasztott készülék alapján betöltött alapértelmezett PrimePCR
protokollal és lemezelrendezéssel.

End-Point Only Run (Csak végpont futtatása) —megnyitja a Start Run (Futtatás indítása) fület a Run
Setup (Futtatás beállításai) ablakban a kiválasztott készülék alapján betöltött alapértelmezett
végpontprotokollal és lemezelrendezéssel.

Qualification Run (Kvalifikációs futtatás) —megnyitja a Start Run (Futtatás indítása) fület a Run Setup
(Futtatás beállításai) ablakban a Bio-Rad a kiválasztott készülékhez betöltött alapértelmezett kvalifikációs
protokolljával és lemezelrendezéssel.

A Tools (Eszközök) menü parancsai
Master Mix Calculator (Törzsoldat-kalkulátor) – a Master Mix Calculator (Törzsoldat-kalkulátor)
megnyitása, amellyel létrehozhat egy reakciókeveréket, és kinyomtathatja a számításokat.

Protocol AutoWriter (Automatikus protokollíró) – a Protocol AutoWriter (Automatikus protokollíró)
párbeszédpanel megnyitása, amellyel könnyen létrehozhat egy új protokollt.

Ta Calculator (Ta-kalkulátor) – a Ta Calculator (Ta-kalkulátor) megnyitása, amellyel könnyen
kiszámíthatja a primerek izzítási hőmérsékletét.

Dye Calibration Wizard (Festékkalibráló varázsló) – a Dye Calibration Wizard (Festékkalibráló varázsló)
megnyitása, amellyel bekalibrálhat egy műszert egy új fluorofórhoz.

Reinstall Instrument Drivers (A műszer illesztőprogramjainak újratelepítése) – a Bio-Rad valós idejű
PCR-rendszereivel való kommunikációt vezérlő illesztőprogramok újratelepítése.
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Zip Data and Log Files (Adat- és naplófájlok tömörítése) – egy olyan párbeszédpanel megnyitása,
amellyel kiválaszthatja azokat a fájlokat, amelyeket szeretne tömöríteni és tömörített fájlba elmenteni
tároláshoz vagy e-mail-üzenetben történő elküldéshez.

Batch Analysis (Kötegelt elemzés) – a Batch Analysis (Kötegelt elemzés) párbeszédpanel megnyitása,
amellyel beállíthatja az egynél több adatfájl egyidejű elemzésére vonatkozó paramétereket.

Options (Opciók) – egy párbeszédpanel megnyitása, amelyben a következőket teheti:

n A levelezőszerver beállításainak konfigurálása.

n A LIMS, Seegene és más adatfájlokra vonatkozó exportálási beállítások konfigurálása.

Tipp: Kiválaszthatja azt a lehetőséget is, hogy exportáláskor a Seegene Viewer
automatikusan elinduljon, ha az adatokat Seegene formátumban exportálja.

n Megváltoztathatja a felhasználói kezelőfelület megjelenített nyelvét (angol, kínai, orosz)

Fontos: A kiválasztott nyelv megjelenítéséhez újra kell indítania a(z) CFX Maestro Dx SE
szoftvert.

Fontos: Az operációs rendszere által használt nyelvnek meg kell egyeznie a(z)
CFX Maestro Dx SE kezelőfelületén megjeleníteni kívánt nyelvvel.

A Help (Segítség) menüpont parancsai
Tipp: A CFX Maestro Dx SE Help (Súgó) menüje minden ablakban elérhető a menüsorban.

Contents (Tartalom) – megjeleníti a Contents (Tartalom) fület a CFX Maestro Dx SE súgórendszerében.

Index – megjeleníti a tárgymutató fület a CFX Maestro Dx SE súgórendszerében.

Search (Keresés) – megjeleníti a Search (Keresés) fület a CFX Maestro Dx SE súgórendszerében.

Open User Guide (A Felhasználói útmutató megnyitása) – megnyitja ezt az útmutatót PDF
formátumban.

Additional Documentation (Kiegészítő dokumentáció) – hozzáférést biztosít a CFX Opus Dx valós idejű
PCR-rendszerek üzemeltetési kézikönyvéhez.

Release Notes (Kiadási megjegyzések) – megnyitja a Kiadási megjegyzéseket a CFX Maestro Dx SE
telepített verziójához.

Video Resources (Videoanyagok) – megnyit egy webhelyet, ahol a Bio-Rad videoanyagai, pl.
oktatóvideói találhatók.

qPCR Applications and Technologies (qPCR alkalmazások és technológiák) webhely – megnyitja a
Bio-Rad qPCR Applications & Technologies webhelyét, ahonnan további információkhoz juthat a valós
idejű PCR (qPCR) technológiával kapcsolatban.
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PCR Reagents (PCR-reagensek) webhely – megnyitja a Bio-Rad PCR és qPCR Reagents webhelyét,
ahonnan PCR-reagenseket, szupermixeket, festékeket és készleteket rendelhet.

PCR Plastic Consumables (Műanyag fogyóeszközök PCR-hoz) webhely – megnyitja a Bio-Rad PCR
Plastics and Consumables webhelyét, ahonnan PCR-lemezeket, lemeztömítéseket, kémcsöveket és
kupakokat, valamint egyéb műanyag tartozékokat rendelhet.

Software (Szoftver) webhely – megnyitja a Bio-Rad PCR Analysis Software webhelyét, ahonnan
megrendelheti a Bio-Rad CFX Maestro Dx SE termékének frissített verzióit.

About (Névjegy) – megjeleníti a CFX Maestro Dx SE szerzői jogi és verzióinformációit.

Az eszköztár parancsai

– aWindows Intéző megnyitása, amellyel megkereshet és megnyithat egy adatfájlt vagy egy
génvizsgálati fájlt.

– a Master Mix Calculator (Törzsoldat-kalkulátor) megnyitása.

– a Run Setup (Futtatás beállításai) ablak megnyitása.

– a Run Setup (Futtatás beállításai) ablak megnyitása a kiválasztott műszer alapján betöltött
alapértelmezett PrimePCR-protokollal és lemezelrendezéssel.

– a Startup Wizard (Indítási varázsló) megnyitása.
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A Startup Wizard (Indítási varázsló)
A CFX Maestro Dx SE szoftver elindulásakor a munkatáblán megjelenik a Startup Wizard (Indítási
varázsló). Az Indítási varázslóból a következőket tudja elvégezni:

n Kiválaszthat egy készüléket a felismert készülékek közül, és beállíthat egy felhasználó által definiált
vagy PrimePCR futtatást.

n Megnyithat és megismételhet egy futtatást.

n Megnyithat egy adatfájlt vagy egy génvizsgálati fájlt, és elemezheti egy egyszeri futtatás vagy több
génexpressziós futtatás eredményeit.

Ezeket a feladatokat a későbbi fejezetekben részletesen ismertetjük.

Állapotsor
A szoftver fő ablakának alján található állapotsor bal oldalán az észlelt műszerek aktuális állapota látható.
Az állapotsor jobb oldalán az aktuális felhasználó neve, valamint a dátum és az idő látható.
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Detected Instruments (Felismert készülékek) panel
A Detected Instruments (Felismert készülékek) panel a CFX Maestro Dx SE szoftvert futtató számítógéphez
csatlakoztatott műszereket jeleníti meg. Alapértelmezettként mindegyik műszer egy ikonként jelenik meg,
amelynek a neve a készülék sorozatszáma.

Erről a panelről a következőket teheti:

n A kiválasztott készülék jellemzőinek és kalibrált festékeinek megtekintése

A készülék jellemzőivel kapcsolatos információk: Készülék tulajdonságainak megtekintése a(z) 76.
oldalon.

n Egy csatlakoztatott készülék állapotának megtekintése

n A kiválasztott készülék motoros fedelének felnyitása

n A kiválasztott készülék motoros fedelének lezárása

n Az összes csatlakoztatott készülék állapotának megtekintése

Egy csatlakoztatott készülék állapotának megtekintéséhez

u A Detected Instruments (Észlelt készülékek) panelen válassza ki a célkészüléket, és végezze el az
alábbiak egyikét:

n Kattintson a View Status (Állapot megtekintése) opcióra a Selected Instrument (Kiválasztott
készülék) részben.

n Jobb gombbal kattintson, és a megjelenő menüben válassza ki a View Status (Állapot
megtekintése) lehetőséget.

Megjelenik a Run Details (Futtatás részletei) párbeszédpanel, amelyen látható a Run Status
(Futtatás állapota) fül. A kiválasztott készülék státusza megjelenik a futtatás állapota panel alatt, pl.:
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Egy készülék fedelének felnyitásához vagy lezárásához

u A Detected Instruments (Észlelt készülékek) panelen válassza ki a célkészüléket, és végezze el az
alábbiak egyikét:

n Kattintson az Open Lid (Fedél felnyitása) vagy a Close Lid (Fedél lezárása) lehetőségre a
Selected Instrument (Kiválasztott készülék) részben.

n Jobb gombbal kattintson, és válassza ki a megfelelő műveletet a megjelenő menüben.

n Nyissa meg a Run Details (Futtatás részletei) párbeszédpanelt, válassza ki a Run Status
(Futtatás állapota) fület, és kattintson az Open Lid (Fedél felnyitása) vagy a Close Lid (Fedél
lezárása) lehetőségre.

Az összes csatlakoztatott készülék állapotának megtekintéséhez

u Tegye az alábbiak egyikét:

n Az All Instruments (Összes készülék) részben a Detected Instruments (Észlelt készülékek)
panelen kattintson a View Summary (Összefoglalás megtekintése) parancsra.

n Amenüsorban válassza ki a View > Instrument Summary (Megtekintés > Készülék
összefoglalása) lehetőséget.

Megjelenik az Instrument Summary (Készülék összefoglalása) párbeszédpanel.

Tipp: Ha a rendszer csak egy csatlakoztatott készüléket érzékel, az All Instruments (Összes
készülék) rész nem jelenik meg a Detected Instruments (Észlelt készülékek) panelen. Egyetlen
készülék összefoglalásának megtekintéséhez válassza ki a View > Instrument Summary
(Megtekintés > Készülék összefoglalása) lehetőséget.
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Az Instrument Summary (Készülék összefoglalása) eszköztár vezérlőelemei

Az 5. táblázat az Instrument Summary (Készülék összefoglalása) eszköztárban található
vezérlőelemeket és funkciókat sorolja fel.

Gomb A gomb neve Funkció

Új futtatás létrehozása Létrehoz egy futtatást a kiválasztott
blokkon a Run Setup (Futtatás
beállításai) ablak megnyitásával.

Leállítás Leállítja az aktuális futtatást a kiválasztott
blokkokon.

Szünet Szünetelteti az aktuális futtatást a
kiválasztott blokkokon.

Újraindítás Újraindítja a futtatást a kiválasztott
blokkokon.

Blokkjelző villogtatása Villogtatja a kijelző LED-et a kiválasztott
blokkok fedelén.

Fedél felnyitása Felnyitja a kiválasztott blokk motorizált
fedelét.

Fedél lezárása Lezárja a kiválasztott blokk motorizált
fedelét.

A kiválasztott blokkok
elrejtése

Elrejti a kiválasztott blokkokat az
Instrument Summary (Készülék
összefoglalása) listában

Az összes blokk
megjelenítése

Megjeleníti a kiválasztott blokkokat az
Instrument Summary (Készülék
összefoglalása) listában

5. táblázat Az Instrument Summary (Készülék összefoglalása) eszköztár vezérlőelemei
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Gomb A gomb neve Funkció

Megjelenítés Annak kiválasztása, hogy melyik
blokkokat jelenítse meg a listában.
Válassza ki az egyik opciót az összes
detektált blokk, az összes nem használt
blokk, az aktuális felhasználóval futó
összes blokk vagy az összes futó blokk
megjelenítésére

Készülék tulajdonságainak megtekintése
A Detected Instruments (Felismert készülékek) panelból megtekintheti egy kiválasztott készülék adatait,
például a tulajdonságait a szállítási rögzítőcsavar állapotát (csak a CFX Connect és a CFX Touch
esetén), valamint kalibrált festékei (fluorofórjai) listáját.

A készülék tulajdonságainak megtekintéséhez

u A Detected Instruments (Felismert készülékek) panelben kattintson a jobb gombbal a célkészülékre,
és válassza ki a megjelenő menüből a Properties (Tulajdonságok) lehetőséget.

Properties (Tulajdonságok) fül

A Properties (Tulajdonságok) fül a kiválasztott készülékkel kapcsolatos műszaki adatokat sorol fel,
például a típust, az alkatrészek sorozatszámát, valamint a firmware-verziókat. A készülék alapértelmezett
neve (a sorozatszáma) sok helyen megjelenik, például a Detected Instruments (Felismert készülékek)
panelen, valamint az Instrument Properties (Készüléktulajdonságok) párbeszédpanel fejlécében. A
könnyebb azonosítás érdekében a készüléket átnevezheti.

Megjegyzés: Nem változtathatja meg a CFX Opus műszer nevét, ha CFX Maestro szoftvert használ.

Calibrated Dyes (Kalibrált festékek) fül

A Calibrated Dyes (Kalibrált festékek) fül a kalibrált fluorofórokat és lemezeket jeleníti meg a kiválasztott
műszerhez.
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Egy adott kalibrációval kapcsolatos részletes információk megtekintéséhez kattintson a kalibráció Info
gombjára a Detail (Részlet) oszlopban.
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Előkészületek
Ez a szakasz azokat a feladatokat ismerteti, amelyek elvégzésére szükség lehet a CFX Maestro Dx SE
használata előtt. A következők tartoznak ide:

n Reakció-törzsoldat létrehozása

n Új festékek kalibrálása

Reakció-törzsoldat létrehozása
A CFX Maestro Dx SE Master Mix Calculator (Törzsoldat-kalkulátor) eszközével könnyen kiszámíthatja,
hogy az egyes összetevőkből mennyire van szükség a törzsoldat elkészítéséhez. A törzsoldat-számítási
táblát kinyomtathatja az alapértelmezett nyomtatón, valamint az egyes célokhoz tartozó számításokat
elmentheti későbbi felhasználásra.

Reakció-törzsoldat létrehozása a Master Mix Calculator (Törzskeverék-kalkulátor) eszközzel

1. A Master Mix Calculator (Törzsoldat-kalkulátor) eszközt kétféleképpen is megnyithatja:

n Válassza ki a Tools > Master Mix Calculator (Eszközök > Törzsoldat-kalkulátor) elemet.

n Kattintson a Master Mix Calculator (Törzsoldat-kalkulátor) elemre az eszköztárban.

Megjelenik a Master Mix Calculator (Törzsoldat-kalkulátor).
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2. A Reaction (Reakció) szakaszban válasszon egy detektálási módszert:

n SYBR®Green/EvaGreen®

n Probes (Szondák)

3. Új cél létrehozásához a Target (Cél) szakaszban kattintson a Create New (Új cél létrehozása)
elemre. A célok legördülő listájában megjelenik egy új célnév.

4. (Opcionális) Az alapértelmezett célnév módosítása:

a. Jelölje ki a cél nevét a célok legördülő listájában.

b. Írjon be egy új célnevet a Target (Cél) mezőbe.

c. Nyomja meg az Enter gombot.

5. Állítsa be az induló és befejező koncentrációkat az előrehaladó és fordított primerekhez és az
esetleges szondákhoz.
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6. A Master Mix Setup (Törzsoldat beállítása) szakaszban állítsa be a következő paraméterek értékeit:

n A futtatni kívánt reakciók száma

n Reakciós térfogat cellánként

n Sablontérfogat cellánként

n Supermix-koncentráció cellánként

n Reakciós többlettérfogat cellánként

7. (Opcionális) Végezze el a 2–6. lépéseket annyi célhoz, amennyihez szükséges.

8. A Choose Target to Calculate (A számítani kívánt cél kiválasztása) szakaszban válassza ki a
számítani kívánt célt.

Tipp: Egyidejűleg csak egy, több vagy az összes célt lehet kiszámítani.

Az egyes kiválasztott célhoz szükséges komponensek számított térfogatai megjelennek a
törzsoldattáblában.

9. Ha a Target (Cél) és a Master Mix Setup (Törzsoldat beállítása) szakaszban beírt mennyiségeket
szeretné beállítani új alapértelmezett értékekként, kattintson a Set as Default (Beállítás
alapértelmezettként) elemre.

10. Ha el szeretné menteni a Master Mix Calculator (Törzsoldat-kalkulátor) párbeszédpanel tartalmát,
kattintson az OK gombra.

A törzsoldat-számítási tábla kinyomtatásához

u Ha szeretne kinyomtatni egy törzsoldat-számítási táblát, kattintson a Print (Nyomtatás) elemre.

A rendszer a számítási táblát az Ön alapértelmezett nyomtatójának a segítségével nyomtatja ki.

A törzsoldat-számítási tábla mentése PDF-fájlként

u Módosítsa az alapértelmezett nyomtatót egy PDF-meghajtóra, majd a Master Mix Calculator
(Törzsoldat-kalkulátor) párbeszédpanelen kattintson a Print (Nyomtatás) elemre.

Célok törléséhez

u Válassza ki a célt a célok legördülő listájáról, majd kattintson a Remove (Törlés) elemre.

Fontos: Ha egy célt töröl a célok listájából, a rendszer az adott célt azokból a törzsoldat-
számításokból is törli, amelyekben a cél szerepel. A cél törlésénél legyen óvatos.
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Új festékek kalibrálása
A CFX Opus 96 Dx és CFX Opus Deepwell Dx,rendszerek a fehér cellás és átlátszó cellás lemezekben
általánosan használt fluorofórokhoz gyárilag kalibrálva van. A CFX Opus 384 Dx rendszereket gyárilag
csak fehér cellás lemezekben használt fluorofórokhoz kalibráljuk be. A(z) 6. táblázat azokat a fluorofórokat
és csatornát sorolja fel, amelyekhez az egyes műszerek kalibrálva vannak.

Megjegyzés: A CFX Opus 96 Dx, CFX Opus 384 Dx, CFX Opus Deepwell Dx, rendszerek
tartalmaznak egy olyan csatornát is, amely FRET-vizsgálatokhoz használható. Ez a csatorna nem
igényel kalibrációt az adott festékekhez.

Fontos: Ha felhasználó által meghatározott kalibrálást végez egy gyárilag kalibrált festékhez, a
készülék a felhasználó által megadott kalibrálást használja a gyári kalibrálás helyett.

Fluorofórok Csatorna Gerjesztés, nm Detektálás, nm Műszer

FAM, SYBR®
Green I

1 450–490 515–530 CFX Opus 96
Dx, CFX Opus
384 Dx és CFX
Opus Deepwell
Dx rendszerek

VIC, HEX, CAL
Fluor Gold 540,
Cal Fluor Orange
560

2 515–535 560–580 CFX Opus 96
Dx, CFX Opus
384 Dx és CFX
Opus Deepwell
Dx rendszerek

ROX, Texas Red,
CAL Fluor Red
610, TEX 615

3 560–590 610–650 CFX Opus 96
Dx, CFX Opus
384 Dx és CFX
Opus Deepwell
Dx rendszerek

Cy5, Quasar 670 4 620–650 675–690 CFX Opus 96
Dx, CFX Opus
384 Dx és CFX
Opus Deepwell
Dx rendszerek

6. táblázat Gyárilag kalibrált fluorofórok, csatornák és műszerek
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Fluorofórok Csatorna Gerjesztés, nm Detektálás, nm Műszer

Quasar 705,
Cy5.5

5 672–684 705–730 Csak a CFX
Opus 96 Dx
rendszer

FRET-vizsgálat (nem gyárilag kalibrált)

Nem gyárilag
kalibrált szín

FRET 450–490 560–580 CFX Opus 96
Dx, CFX Opus
384 Dx és CFX
Opus Deepwell
Dx rendszerek

Új festékek CFX rendszerekhez történő kalibrálásához

1. A Home (Kezdőlap) ablakban válasszon ki egy célműszert a Detected Instruments (Felismert
készülékek) táblán.

2. Válassza ki a Tools > Calibration Wizard (Eszközök > Kalibráció varázsló) lehetőséget a Dye
Calibration (Festékkalibráció) varázsló megnyitásához.
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A Calibrated Fluorophores (Kalibrált fluorofórok) című táblázatban a célműszerhez már bekalibrált
fluorofórok láthatók.

3. A Calibrate New or Existing Fluorophores (Új vagy létező fluorofórok kalibrálása) részben válassza ki
a kalibrálni kívánt fluorofórt a legördülő listából.

Ha a fluorofór neve nem szerepel a listán, a nevét a szövegablakba beírva adhatja a listához.

Fontos: Az egyedileg kalibrált fluorofórok elnevezésekor legyen óvatos. Ha egyedi
festékkalibrációt hoz létre egy fluorofórhoz a gyárilag kalibrált fluorofórral azonos néven, a
műszer az egyedi fluorofórt (nem a gyárilag kalibrált fluorofórt) fogja használni a futtatások
során.

4. Válassza ki a lemeztípust a fluorofórhoz.

Ha a lemeztípus nem szerepel a listában, a nevét a szövegablakba írva adhatja hozzá a listához.

5. Válasszon ki egy csatornát a fluorofórhoz.

6. Válasszon ki egy lemezoszlopot a fluorofórhoz.

7. (Opcionális) Írjon be egy színt, melyet a fluorofórhoz szeretne rendelni.

8. Kattintson az Add to Plate (Hozzáadás lemezhez) gombra a fluorofór hozzáadásához.

9. (Opcionális) Ismételje meg a 3–8. lépést a lemezhez kalibrálni tervezett minden egy fluorofór
hozzáadásához.

10. Amikor befejezte a fluorofórok hozzáadását, kattintson a View Plate (Lemez megtekintése) gombra a
Pure Dye Plate Display (Tiszta festékes lemez megjelenítése) ablak megnyitásához.

Használja ezt az ablakot útmutatónak, amikor a festékeket a lemezekbe tölti.

11. Készítsen elő egy 96- vagy 384-cellás vagy mély cellás lemezt a festék kalibráláshoz:

a. A Pure Dye Plate Display (Tiszta festékes lemez megjelenítése) ablakban látható elrendezés
szerint pipettázzon festékoldatot a cellákba.

b. Minden fluorofórhoz töltsön négy cellába 50 µl (96-cellás vagy mély cellás lemez) vagy 30 µl
(384-cellás lemez) 300 nM festékoldatot. Megjegyzés: a lemeznek legalább a fele üres cellákat
tartalmaz.

c. Zárja le a lemezt a kísérleténél használandó tömítési módszerrel.

12. Helyezze a kalibrációs lemezt a blokkba, és zárja le a fedelet.

13. A Dye Calibration (Festékkalibrálás) varázslóban kattintson a Calibrate (Kalibrálás), majd az OK
gombra annak megerősítéséhez, hogy a lemez a blokkban van.
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14. Amikor a CFX Maestro Dx szoftver, Security Edition végrehajtotta a kalibráló futtatást, megjelenik
egy párbeszédpanel. Kattintson a Yes (Igen) gombra a kalibrálás befejezéséhez, és nyissa meg a
Dye Calibration Viewer (Festékkalibrálás megtekintése) ablakot.

15. Kattintson az OK gombra az ablak bezárásához.

Felhasználói beállítások
Tipp: Ezeket a műveleteket nem szükséges elvégezni a CFX Maestro Dx SE használatához.
Nyugodtan kihagyhatja ezt a részt, illetve ezeket a műveleteket bármikor elvégezheti.

A CFX Maestro Dx SE szoftverben minden felhasználó testre szabhatja munkakörnyezetét. Például a
Users > User Preferences (Felhasználók > Felhasználói beállítások) menüben a következőket végezheti
el:

n E-mail-értesítések beállítása a futtatás befejezéséről.

Megjegyzés: Ez a funkció csak azoknak a felhasználóknak érhető el, akiknek a szerepköre
tartalmazza ezt a jogot. További információkért lásd: A CFX Maestro Dx szoftver, Security
Edition felhasználói szerepköreinek kezelése a(z) 46. oldalon.

n Alapértelmezett beállítások módosítása:

o A fájlok mentésének helye

o A futtatásbeállítási fájlok

o A fájlok nevének előtagja

n Alapértelmezett paraméterek beállítása egy új protokoll és lemez létrehozásakor.

n Az alapértelmezett adatelemzési és génexpressziós paraméterek beállítása.

n Az alapértelmezett minőség-ellenőrzési paraméterek testreszabása.

n Az exportálási paraméterek tesztre szabása.

A Tools (Eszközök) menüben a következőket végezheti el:

n Törzsoldat létrehozása.

n Festékek kalibrálása egy adott berendezéshez.

Megjegyzés: A törzsoldat és a festékkalibrálás bárki számára elérhető, aki bejelentkezik a
szoftverbe.

Ez a rész ezeknek a műveleteknek az elvégzését ismerteti.
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E-mail-értesítés beállítása

A CFX Maestro Dx SE szoftvert kimenő levelezőszerveréhez csatlakoztathatja, és így e-mail üzenetben
értesítheti a meghatározott felhasználókat a futtatás befejeződéséről. Ezenkívül adatfájlt és elemzési
jelentést is csatolhat a meghatározott felhasználóknak. A CFX Maestro Dx SE és az Ön SMTP-
kiszolgálója közötti kapcsolat beállításához lásd: A Security Edition csatlakoztatása egy SMTP-
kiszolgálóhoz a(z) 86. oldalon.

Megjegyzés: Az, hogy egy felhasználó hozzáférhet-e az e-mail-beállítási funkciókhoz, attól függ,
hogy a rendszergazda milyen felhasználói csoportot és jogosultságokat állított be az adott
felhasználóhoz. A felhasználók és a szerepköreik kezelésére vonatkozó részletekért lásd: A CFX
Maestro Dx szoftver, Security Edition felhasználói szerepköreinek kezelése a(z) 46. oldalon.

E-mail-értesítések beállítása

1. Válassza ki a User > User Preferences (Felhasználó > Felhasználói beállítások) elemet a User
Preferences (Felhasználói beállítások) párbeszédpanel megnyitásához.

Megjelenik a User Preferences (Felhasználói beállítások) párbeszédpanel és rajta az Email (E-mail)
fül.

Megjegyzés: Ha a rendszer úgy érzékeli, hogy Ön még nem állított be érvényes SMTP-
kiszolgálót a CFX Maestro Dx SE szoftverhez, erről értesíti Önt. Az Options (Beállítások)
párbeszédpanel megnyitásához és az SMTP-szerver beállításához kattintson a Configure
Outgoing Email (Kimenő e-mail beállítása) lehetőségre. További információkért lásd: A Security
Edition csatlakoztatása egy SMTP-kiszolgálóhoz a(z) 86. oldalon.

2. A To (Címzett) szövegbeviteli mezőbe írja be minden egyes személy e-mail címét, akit tájékoztatni
szeretne a futtatás befejeződéséről. A futtatás befejeződése után az összes címzett e-mailt kap.

Megjegyzés: Az egyes e-mail-címeket külön sorba kell írni. Az egyes címek beírása után
nyomja meg az Enter billentyűt.
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3. (Opcionális) A cc (Másolat) szövegbeviteli mezőbe adott esetben írja be azoknak a címzetteknek az
e-mail-címét, akiknek másolatot szeretne küldeni az egyes e-mail-értesítésekből.

4. (Opcionális) A rendszer alapértelmezés szerint az összes címzettnek elküldi csatolmányként az
adatfájl másolatát. Ha nem szeretné csatolni az adatfájl másolatát, törölje ebből a jelölőnégyzetből a
jelölést.

5. (Opcionális) Ha az e-mail-üzenethez szeretné csatolni az elemzési jelentést PDF formátumban,
jelölje be az Attach Analysis Report (Elemzési jelentés csatolása) elemet.

6. A módosítások mentéséhez és a User Preferences (Felhasználói beállítások) párbeszédpanel
bezárásához kattintson az OK gombra.

Megjegyzés: A szolgáltatótól függően be tudja állítani, hogy a rendszer e-mail értesítést küldjön a
mobiltelefonjára. A mobiltelefonja e-mail címére vonatkozó konkrét információkért forduljon a
mobiltelefon-szolgáltatójához. Írja be a telefon e-mail címét (például 5552221234@your_service_
provider_EmailDomain.net) a User Preferences (Felhasználói beállítások) képernyő
szövegmezőjébe.

Címzett e-mail-címének a szerkesztéséhez

u Szükség szerint módosítsa az e-mail címet, majd kattintson az OK gombra.

E-mail címzettjének törlése

1. Válassza ki az e-mail-címzettet, majd nyomja le a Delete (Törlés) billentyűt.

2. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói beállítások) párbeszédpanelen a Restore Defaults
(Visszaállítás az alapértelmezett beállításokra) elemre kattint, a rendszer az összes fülön
visszaállítja az összes beállítást az eredeti, gyári beállításokra. Legyen körültekintő, ha erre a
gombra kattint.

A Security Edition csatlakoztatása egy SMTP-kiszolgálóhoz

Fontos: Néhány kereskedelmi webmail-szolgáltató fokozott e-mailes biztonsági beállításokat
használ. Ha Ön ilyen fiókot használ, engedélyeznie kell az Allow less secure apps (Kevésbé
biztonságos appok engedélyezés) beállítást ahhoz, hogy a CFX Maestro Dx SE e-mailt tudjon
küldeni. További információt webmail-szolgáltatója biztonsági információiban találhat.

Ha Ön a Google Gmail vagy Microsoft Office 365 SMTP-kiszolgálóját használja e-mailek küldésére, akkor
be kell kapcsolnia a 2 lépcsős azonosítást és létre kell hoznia egy „alkalmazásjelszót” a Gmail- vagy
Office365-fiókjának beállításaiban. A Maestro e-mail-beállítások párbeszédpanelen történő
hitelesítéshez másolja és illessze be az „alkalmazásjelszót” a jelszómezőbe a normál e-mail-jelszava
helyett.
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A szoftver csak akkor tud e-mail-értesítéseket küldeni, ha Ön beállítja a kapcsolatot a CFX Maestro Dx
SE és az Ön e-mail-szervere között.

A CFX Maestro Dx SE csatlakoztatásához egy levelezőszerverhez

1. Tegye az alábbiak egyikét:

n Válassza ki a User > User Preferences (Felhasználó > Felhasználói beállítások) opciót, és
kattintson a Configure Outgoing Email (Kimenő e-mail konfigurálása) gombra az Email (E-mail)
fülön.

n Válassza ki a Tools > Options (Eszközök > Opciók) menüpontot.

Megjelenik az Options (Opciók) párbeszédpanel és rajta az Email (E-mail) fül.

2. Adja meg a következő információkat a vállalatához:

n SMTP Server Name (az SMTP-szerver neve) – a kimenő e-mail-szerver neve a cégénél.

n Port – az SMTP-szervere portszáma. Ez általában 25.

n Use SSL (SSL használata) — Secure Sockets Layer (SSL; biztonságos csatlakozási réteg)
opció. Egyes SMTP-szerverek megkövetelik ezt a beállítást. Ha ez nem szükséges az Ön
cégénél, szüntesse meg a jelölőnégyzet bejelölését.

n Use Default “From” Address (Használja az alapértelmezett „Feladó” címet) – a
levelezőszerver neve az Ön cégénél. Egyes SMTP-szerverek megkövetelik, hogy minden
elküldött e-mail tartalmazzon egy bizonyos tartományból származó „feladó” címet, pl.
név@AzÖnCége.com. Ha ez az eset áll fenn, szüntesse meg a jelölőnégyzet bejelölését, és
adjon meg egy érvényes e-mail-címet.
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n Authentication Required (Hitelesítés szükséges) — ha az adott intézményben megkövetelik a
fiók hitelesítését, ellenőrizze, hogy ez a jelölőnégyzet be van-e jelölve.

n User Name (Felhasználónév) — a hitelesített fiók neve. Ez csak akkor szükséges, ha az
Authentication Required (Hitelesítés szükséges) beállítás ki van választva.
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n Password (Jelszó) — a hitelesített fiók jelszava. Ez csak akkor szükséges, ha az Authentication
Required (Hitelesítés szükséges) beállítás ki van választva.

Fontos: Ha Ön a Google Gmail vagy Microsoft Office 365 SMTP-kiszolgálóját használja e-
mailek küldésére, akkor be kell kapcsolnia a 2 lépcsős azonosítást, majd létre kell hoznia egy
„alkalmazásjelszót” a Gmail- vagy Office365-fiókjának beállításaiban. Maestro e-mail-
beállítások párbeszédpanelen történő hitelesítéshez másolja és illessze be az
„alkalmazásjelszót” a CFX Maestro Dx SE jelszómezejébe a normál e-mail-jelszava helyett.

Az SMTP-beállítások helyességének ellenőrzéséhez írjon be egy érvényes e-mail címet a Test Email
Address (Ellenőrző e-mail-cím) szövegmezőbe, és kattintson a Test Email (E-mail tesztelése)
gombra.

Megjegyzés: egyes SMTP-szerverek nem engedélyezik a mellékleteket, mások pedig csak egy
bizonyos méretig engedélyezik őket. Ha Ön adatfájlok, illetve jelentések e-mail mellékletként
való elküldését tervezi a CFX Maestro Dx SE berendezéssel, válassza ki a Test Attachment
(Tesztmelléklet) opciót, és állítsa be az Attachment Size in MB (Melléklet mérete MB-ban)
értéket legalább 5 megabájtra (MB).

3. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Az alapértelmezett fájlbeállítások módosítása

A User Preference (Felhasználói beállítások) párbeszédpanel Files (Fájlok) fülén módosíthatja a
következőket:

n A CFX Maestro Dx SE fájljainak elmentésére használt alapértelmezett hely

n A futtatás beállításának alapértelmezett fájljai

n Az alapértelmezett fájlelnevezési paraméterek

Az alapértelmezett fájlbeállítások módosításához

1. Válassza ki a User > User Preferences (Felhasználó > Felhasználói beállítások) elemet a User
Preferences (Felhasználói beállítások) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói beállítások) párbeszédpanelen válassza ki a Files (Fájlok) fület.
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3. A Default Folder for File Creation (Alapértelmezett mappa fájl létrehozásához) részben válasszon ki
egy alapértelmezett mappát, ahová el akarja menteni az új fájlokat. Az egyes fájltípusokhoz más és
más helyet választhat:

n Protokoll

n Lemez

n Adatfájl

n Génvizsgálat

4. A File Selection for Run Setup (Fájl kiválasztása futtatás beállításához) részben lépjen a célprotokoll-
és lemezfájlokhoz, és válassza ki őket az Experiment Setup (Kísérlet beállítása) ablakban való
megjelenítéshez.

5. A Data File (Adatfájl) részben határozza meg az adatfájlok elő-, illetve utótagját. Bármelyik részhez
válasszon ki egy új értéket saját legördülő listájából. Egyéni előtagot és utótagot is megadhat a Prefix
(Előtag) és Suffix (Utótag) szövegmezőkben.

A CFX Maestro Dx SE megjeleníti az új fájlnév előnézetét a kiválasztó ablakok alatt.

6. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói beállítások) párbeszédpanelen a Restore Defaults
(Visszaállítás az alapértelmezett beállításokra) elemre kattint, a rendszer az összes fülön
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visszaállítja az összes beállítást az eredeti, gyári beállításokra. Legyen körültekintő, ha erre a
gombra kattint.

A protokollra vonatkozó alapértelmezett paraméterek beállítása

Az alapértelmezett protokollparaméterek beállításához a Protocol Editor
(Protokollszerkesztő) és a Protocol AutoWriter (Automatikus protokollíró) eszközökhöz

1. Válassza ki a User > User Preferences (Felhasználó > Felhasználói beállítások) elemet a User
Preferences (Felhasználói beállítások) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói beállítások) párbeszédpanelen válassza ki a Protocol (Protokoll)
fület.

3. A Protocol Editor (Protokollszerkesztő) szakaszban határozza meg a Protocol Editor
(Protokollszerkesztő) ablakban megjelenő következő beállítások értékeit:

n Sample volume (Mintatérfogat) – a cellákban található egyes minták térfogata (µl
mértékegységben kifejezve).

n Lid Shutoff temperature (Kikapcsolási fedélhőmérséklet) – az a hőmérséklet (ºC
mértékegységben kifejezve), amelyen a fedélfűtő futtatás közben kikapcsol.

4. A Protocol AutoWriter (Automatikus protokollíró) szakaszban határozza meg a Protocol AutoWriter
(Automatikus protokollíró) ablakban megjelenő következő beállítások értékeit:

n Annealing temperature (Izzítási hőmérséklet) – a ºC mértékegységben kifejezett hőmérséklet
az iProof DNS-polimerázt, iTaq DNS-polimerázt vagy egyéb polimerázokat használó
kísérletekhez.
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n Amplicon length (Amplikonhosszúság) – az amplikon hosszúsága bázispárokban (bp)
kifejezve.

5. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói beállítások) párbeszédpanelen a Restore Defaults
(Visszaállítás az alapértelmezett beállításokra) elemre kattint, a rendszer az összes fülön
visszaállítja az összes beállítást az eredeti, gyári beállításokra. Legyen körültekintő, ha erre a
gombra kattint.

A lemezre vonatkozó alapértelmezett paraméterek beállítása

A Plate (Lemez) fülön Ön által végrehajtott módosításokat a szoftver összes felhasználója tudja
használni. A lemezbeállítás során Ön által végrehajtott módosítások azt követően állnak a felhasználók
rendelkezésére, hogy Ön elmentette és bezárta a lemezfájlt.

A User Preferences (Felhasználói beállítások) párbeszédpanelen a következőket végezheti el:

n Alapértelmezett lemezparaméterek beállítása.

n Cél, minta és biológiai csoport nevének hozzáadása az adott könyvtárhoz.

n Cél, minta és biológiai csoport nevének törlése az adott könyvtárból.

Az alapértelmezett lemezparaméterek beállításához

1. Válassza ki a User > User Preferences (Felhasználó > Felhasználói beállítások) elemet a User
Preferences (Felhasználói beállítások) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói beállítások) párbeszédpanelen válassza ki a Plate (Lemez) fület.
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3. Határozza meg a következő beállítások értékeit egy új lemezfájlhoz. Ezek az értékek jelennek meg a
Plate Editor (Lemezszerkesztő) ablakban:

n Plate Type (Lemeztípus)

n Plate size (Lemezméret)

n Units (Egységek) – A standardot tartalmazó cellák indítási sablonjának koncentrációja.

A CFX Maestro Dx SE ezeket az egységeket egy standard görbe létrehozására használja a
Data Analysis Quantification (Adatelemzés kvantifikálása) fülön.

n Scientific notation (Tudományos jelölés) – ha ez a beállítás van kiválasztva, a CFX Maestro Dx
SE a koncentrációegységeket tudományos jelöléssel jeleníti meg.

n Scan mode (Leolvasási üzemmód) – a leolvasandó csatornák száma és típusa futtatás közben.

n Fluorophores (Fluorofórok) – a Plate Editor (Lemezszerkesztő) cellabetöltő vezérlőiben
megjelenő alapértelmezett fluorofórok.
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n Libraries (Könyvtárak) – az Ön által a kísérleteiben jellemzően használt cél, minta és biológiai
csoport neve:

o Target names (Célnevek) – a célgének és -szekvenciák neve.

o Sample names (Mintanevek) – a kísérleti minták neve vagy azonosító jellemző a
mintákhoz (pl. Egér1, Egér2, Egér3).

o Biological group names (Biológiaicsoport-nevek) – olyan minták csoportjainak neve,
melyeknél megegyezik a kezelési státusz vagy a kezelési körülmények (pl. 0. óra, 1. óra, 2.
óra).

4. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Cél, minta vagy biológiai csoport új nevének hozzáadásához

u Amegfelelő könyvtármezőbe írja be a nevet a célhoz, mintához vagy biológiai csoporthoz, és
kattintson az OK gombra.

Cél, minta vagy biológiai csoport nevének törléséhez

u Amegfelelő könyvtármezőben válassza ki a nevet, nyomja meg a Delete (Törlés) gombot, majd
kattintson az OK gombra.

Fontos: A könyvtárból törölt neveket a szoftver véglegesen törli, és többé nem állnak a felhasználók
rendelkezésére. A CFX Maestro Dx SE alapértelmezett neveinek visszaállításához kattintson a
Restore Defaults (Alapértelmezett beállítások visszaállítása) gombra. Ha a User Preferences
(Felhasználói beállítások) párbeszédpanelen a Restore Defaults (Visszaállítás az alapértelmezett
beállításokra) elemre kattint, a rendszer az összes fülön visszaállítja az összes beállítást az eredeti,
gyári beállításokra. Járjon el körültekintően a CFX Maestro Dx SE alapértelmezett neveinek
törlésénél és ennek a gombnak a megnyomásánál.

94 | CFX Maestro Dx SE szoftver



Előkészületek

Az adatelemzésre vonatkozó alapértelmezett paraméterek beállítása

Az alapértelmezett adatelemzési paraméterek beállításához

1. Válassza ki a User > User Preferences (Felhasználó > Felhasználói beállítások) elemet a User
Preferences (Felhasználói beállítások) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói beállítások) párbeszédpanelen válassza ki a Data Analysis
(Adatelemzés) fület.

3. Az Analysis Mode (Analízis-üzemmód) részben válassza ki azt az üzemmódot, amellyel elemezni
kívánja az adatokat (Fluorophore /Fluorofór/ vagy Target /Cél/).

4. A PCR Quantitation (Mennyiségi PCR) részben állítsa be az alapértelmezett paramétereket a
következő opciókhoz:

n Baseline Setting (Kiindulási érték beállítása) – a kiindulási érték módszere az elemzési
üzemmódhoz.

n Cq Determination Mode (A Cq-meghatározás üzemmódja) – az az üzemmód, amelyben a
rendszer kiszámítja a Cq értékeket az egyes fluoreszcencia-jelvonalakhoz (regresszió vagy
egyetlen küszöbérték).
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n Threshold Calc. Mode (Küszöbérték-számítási üzemmód) – a végpont célmennyisége.

Az alapértelmezett üzemmód az Auto (Automatikus), azaz a szoftver automatikusan kiszámítja
a végpont célt. Egy adott küszöbérték beállításához szüntesse meg az Auto (Automatikus)
jelölőnégyzet kijelölését, és írja be saját végpontmennyiségét relatív
fluoreszcenciaegységekben (RFE) számítva. A maximális érték 65 000,00 RFE. Az adatfájlok a
további futtatásokban ezt a küszöbérték-beállítást fogják használni.

n Baseline Calc. Mode (Alapérték-számítási üzemmód) — az alapérték az összes jelvonalhoz.

Az alapértelmezett üzemmód az Auto (Automatikus), azaz a szoftver automatikusan kiszámítja
az alapvonalat az összes jelvonalhoz. Egy adott alapérték beállításához szüntesse meg az Auto
(Automatikus) jelölőnégyzet kijelölését, és írja be a minimális és maximális értékeket a
ciklustartományhoz (1-től 9999-ig). Az adatfájlok a további futtatásokban ezt a ciklustartományt
fogják használni.

n Log View (Napló nézet) — azt határozza meg, hogy a szoftver hogyan ábrázolja a
sokszorosítási adatokat:

o On (Be) – a sokszorosítási adatokat a szoftver egy féllogaritmikus grafikonon ábrázolja.

o Off (Ki) – (alapértelmezett) a sokszorosítási adatokat a szoftver egy lineáris grafikonon
ábrázolja.

5. Az End Point (Végpont) részben válassza ki az átlagolandó végciklusok számát a
végpontszámításoknál:

n PCR—az átlagolandó végciklusok száma a mennyiségi adatokhoz (az alapértelmezett 5).

n End Point Only run (Csak végpontok futtatása) — a végpontok száma az átlagoláshoz a
végpontadatokhoz (az alapértelmezett 2).

6. A Melt Curve (Olvadási görbe) részben válassza ki a detektálandó csúcstípust (pozitív vagy negatív).

7. A Well Selector (Cellaválasztó) részben válassza ki, hogyan legyenek megjelenítve a cellacímkék
(mintatípus, célnév vagy mintanév szerint).

8. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói beállítások) párbeszédpanelen a Restore Defaults
(Visszaállítás az alapértelmezett beállításokra) elemre kattint, a rendszer az összes fülön
visszaállítja az összes beállítást az eredeti, gyári beállításokra. Legyen körültekintő, ha erre a
gombra kattint.
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A génexpresszió-adatfájlra vonatkozó alapértelmezett paraméterek beállítása

Az alapértelmezett paraméterek beállítása egy új génexpressziós adatfájlhoz

1. Válassza ki a User > User Preferences (Felhasználó > Felhasználói beállítások) elemet a User
Preferences (Felhasználói beállítások) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói beállítások) párbeszédpanelen válassza ki a Gene Expression
(Génexpresszió) fület.

3. Határozza meg a következő beállítások értékeit:

n Relative to (Viszonyítási alap) – a génexpressziós adatok grafikus ábrázolása egy 1-es
origójú kontrollhoz vagy a nullához viszonyítva:

o Zero (Nulla) – a szoftver figyelmen kívül hagyja a kontrollt. Ez az alapértelmezett beállítás
olyankor, amikor az Experiment Settings (Kísérlet beállításai) ablakban nincs megadva
kontrollminta.

o Control (Kontroll) – a szoftver az Experiment Setup (Kísérlet beállításai) ablakban
megadott kontrollmintához viszonyítva számítja ki az adatokat.

n X-axis (X tengely) – a minta vagy a cél grafikus ábrázolása az X tengelyen.

n Y-axis (Y tengely) – lineáris, log2 vagy log10 skála grafikus ábrázolása az Y tengelyen.

n Scaling (Skálázás) – a grafikonhoz kapcsolódó skálázási opció (az alapértelmezett opció:
Unscaled /Nem skálázott/):

o Highest (Legmagasabb) – a szoftver a legmagasabb adatponthoz skálázza a grafikont.

o Lowest (Legalacsonyabb) – a szoftver a legalacsonyabb adatponthoz skálázza a
grafikont.

o Unscaled (Nem skálázott) – a szoftver skálázás nélkül ábrázolja az adatokat a grafikonon.

n Mode (Üzemmód) – az elemzés üzemmódja: relatív mennyiség (∆Cq) vagy normalizált
expresszió (∆∆Cq).

n Error Bar (Hibasáv) – az adatok variabilitása szórásként (Std. Dev.) vagy a középérték standard
hibájaként (Std. Error Mean) ábrázolva.

n Error Bar Multiplier (Hibasávszorzó) – a szórás szorzója, amelyet a rendszer a hibasávok
grafikus ábrázolásához használ (az alapértelmezett érték: 1).

A szorzót 2 vagy 3 értékre növelheti.

n Sample Types to Exclude (Kizárni kívánt mintatípusok) – az elemzésből kizárni kívánt
mintatípusok.
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Egy vagy több mintát is választhat, amelye(ke)t ki szeretne zárni az elemzésből. Ha az összes
mintatípust ki szeretné zárni, törölje a kijelölt mintatípusok jelölőnégyzeteiből a jelölést.

4. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói beállítások) párbeszédpanelen a Restore Defaults
(Visszaállítás az alapértelmezett beállításokra) elemre kattint, a rendszer az összes fülön
visszaállítja az összes beállítást az eredeti, gyári beállításokra. Legyen körültekintő, ha erre a
gombra kattint.

A minőség-ellenőrzési szabályok testreszabása

A CFX Maestro Dx SE szoftverben minőségellenőrzési szabályokat állíthat be, amelyeket a rendszer a
Data Analysis (Adatelemzés) ablakban levő adatokra alkalmaz. A szoftver az Ön által beállított szabályok
szerint ellenőrzi az adatokat.

Megjegyzés: alapértelmezés szerint az összes minőség-ellenőrzési szabály engedélyezve van.

Tipp: a Data Analysis (Adatelemzés) ablak QC-moduljában egyszerűen kizárhatja azokat a cellákat
az elemzésből, amelyek nem felelnek meg egy QC-paraméternek.

A minőség-ellenőrzési szabályok testreszabásához

1. Válassza ki a User > User Preferences (Felhasználó > Felhasználói beállítások) elemet a User
Preferences (Felhasználói beállítások) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói beállítások) párbeszédpanelben válassza ki a QC (Minőség-
ellenőrzés) fület.
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Ahol:

n NTC – sablon nélküli kontroll

n NRT – reverz transzkriptáz nélküli kontroll

n Efficiency (Hatásfok) – a reakció hatásfoka

n Std Curve R^2 – a standard görbe R négyzet értéke

n Replicate group Cq Std Dev (Replikátum csoport) Cq szórása – az egyes
replikátumcsoportokhoz kiszámított szórás

3. Mindegyik QC (minőség-ellenőrzési) szabályhoz végezze el az alábbiak egyikét:

n Az alapértelmezett érték használatához ne tegyen semmit.

n Az érték módosításához kattintson a Value (Érték) szövegmezőbe, írjon be egy új értéket, és
nyomja meg az Enter gombot.

n A szabály letiltásához szüntesse meg a Use (Használat) jelölőnégyzet kijelölését.

4. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói beállítások) párbeszédpanelen a Restore Defaults
(Visszaállítás az alapértelmezett beállításokra) elemre kattint, a rendszer az összes fülön
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visszaállítja az összes beállítást az eredeti, gyári beállításokra. Legyen körültekintő, ha erre a
gombra kattint.

Az adatexportálás paramétereinek testreszabása

A CFX Maestro Dx SE adatait a következő formátumokban exportálhatja:

n Szöveg (.txt)

n CSV (.csv)

n Excel (.xls, .xlsx)

n XML (.xml)

n HTML (.html)

Fontos: A számítógépre telepítenie kell a Microsoft Excel programot, ha Microsoft Excel táblázatba
szeretné exportálni az adatokat.

Megadhatja az exportálandó adatok típusát, és testre szabhatja az exportált adatok kimenetét.

Az exportálási paraméterek testreszabásához

1. Válassza ki a User > User Preferences (Felhasználó > Felhasználói beállítások) elemet a User
Preferences (Felhasználói beállítások) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói beállítások) párbeszédpanelen válassza ki a Custom Export
(Egyedi exportálás) fület.
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3. Az Export Format (Exportálás formátuma) legördülő listán válassza ki, milyen formátumban szeretné
exportálni az adatokat.

4. A Data to Export (Exportálandó adatok) részben jelölje be az exportálandó adatok típusainak a
jelölőnégyzeteit, vagy szüntesse meg a kijelölésüket. A kiválasztott elemek megjelennek az Exported
Columns (Exportált oszlopok) listamezőben.

Megjegyzés: Alapértelmezés szerint a futtatási információk szerepelnek a fejlécben. Ha nem
akarja szerepeltetni a futtatási információkat, törölje a jelölőnégyzetet.

5. Módosíthatja a kiválasztott elemek kimeneti megjelenítésének sorrendjét

Az Exported Columns (Exportált oszlopok) listamezőben jelölje ki az elemet, majd kattintson a listától
balra levő nyíl gombokra a felfelé vagy lefelé mozgatásához.

6. Opcionálisan módosíthatja a kiválasztott elemek kimeneti oszlopainak nevét:

a. Kattintson a Customize Column Names (Oszlopnevek testreszabása) lehetőségre.

Megjelenik a Column Name Customizer (Oszlop nevének testreszabása) párbeszédpanel.

b. Minden módosítani kívánt alapértelmezett oszlopnévhez írja be az új nevet a Custom Name
(Egyedi név) mezőbe.
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c. Tegye az alábbiak egyikét:

n Kattintson az OK gombra a módosítások elmentéséhez és a Custom Export (Testreszabott
export) fülre való visszatéréshez. Az új név zárójelben jelenik meg az alapértelmezett
oszlopnév mellett az Exported Columns (Exportált oszlopok) listamezőben.

n Amódosítások törléséhez és a Custom Export (Testreszabott export) fülre való
visszatéréshez kattintson a Cancel (Mégse) gombra.

7. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói beállítások) párbeszédpanelen a Restore Defaults
(Visszaállítás az alapértelmezett beállításokra) elemre kattint, a rendszer az összes fülön
visszaállítja az összes beállítást az eredeti, gyári beállításokra. Legyen körültekintő, ha erre a
gombra kattint.
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Egy protokoll egy meghatározott sorrendben végrehajtott lépések összessége. A CFX Maestro Dx
szoftver, Security Edition termékben az összes lépés a berendezés opcióihoz kapcsolódik. A lépések
például a műszert a blokk- és fedélhőmérséklet szabályozására, a blokkban hőmérséklet-különbség
létrehozására, lemez leolvasására vagy olvadási görbe elemzésének végrehajtására utasítják. Minden
opció különböző lemez- és futtatástípusokhoz van megadva.

A CFX Maestro Dx SE két lehetőséget kínál a protokollok létrehozására: a Protokollszerkesztő és az
Automatikus protokollíró.

A Protocol Editor (Protokollszerkesztő) jellemzői a következők:

n Standard protokollvezérlő elemek a protokollok gyors létrehozásához

n Gradiens gyors kiszámítása a kiválasztott sorokhoz

n Futtatási idő gyors kiszámítása a kiválasztott lemeztípushoz

n Protokoll-lépések szerkesztése

n Protokollok elmentése ismételt felhasználáshoz

n A protokoll kinyomtatása az alapértelmezett nyomtatón

A Protocol AutoWriter (Automatikus protokollíró) az Ön által megadott paraméterek felhasználásával
automatikusan létrehoz egy testreszabott PCR-protokollt a következő lépésekkel: forróindítás, kezdeti
denaturálás, hevítés, valamint kiterjesztés. Ezután megtekintheti a javasolt protokoll grafikus ábrázolását,
valamint szerkesztheti, futtathatja vagy elmentheti a protokollt.
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Paraméterek és tartományok a protokoll lépéseihez
A(z) 7. táblázat információi segítségével módosíthatja a protokoll lépéseinek alapértelmezett beállításait.

Hőmérsékleti lépések

A célhőmérséklet 4,0 és 100,0 °C közötti érték, tizedfokban beállítva. A rendszer felmelegszik erre a
hőmérsékletre, és ezt az értéket egy meghatározott ideig (tartási idő) tartja.

Gradienslépések

A gradienstartomány az alsó és felső hőmérséklet közötti különbség egy gradienslépésben. A
megengedett legnagyobb tartomány 24 °C. Az alsó hőmérséklet 30,0 és 99,0 °C közötti érték,
tizedfokban beállítva. A maximális felső hőmérséklet 100 °C. A PCR készülék a célhőmérséklet-
gradiensig melegszik a blokkon keresztül, és egy meghatározott tartási ideig tartja ezt a hőmérsékletet.

Fontos: Aműszer kiszámítja a gradiens értékét. Amikor beír egy értéket a gradienskalkulátor felső
és alsó mezőjébe, a szoftver automatikusan kiszámítja és hozzárendeli a hőmérsékletet a többi
mezőhöz. Ha a felső és az alsó mező közötti bármelyik mezőben hőmérsékletet ad meg, a készülék
automatikusan kiszámítja a fennmaradó mezőket. Nem lehet minden mezőben manuálisan megadni
a hőmérsékleti értéket.
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Paraméter Tartomány Leírás

Felfutási
sebesség

n CFX Opus 96 Dx rendszerek
esetében:
0,1–5 °C másodpercenként

n CFX Opus 384 Dx rendszerek
esetében:
0,1–2,5 °C másodpercenként

n CFX Opus Deepwell Dx
rendszerek esetében:
0,1–2,5 °C másodpercenként

Utasítja a PCR készüléket, hogy az adott
lépésben a megadott sebességgel
melegedjen a célhőmérsékletre.

Csak hőmérsékleti lépések esetében
érhető el.

Növekmény –10,0 és 10,0 °C közötti szám
ciklusonként, tizedfokokban

Utasítja a PCR készüléket, hogy minden
ciklusnál változtassa meg egy lépés
célhőmérsékletét, ahol pozitív szám növeli
a hőmérsékletet, negatív szám pedig
csökkenti azt.

Csak hőmérsékleti lépések esetében
érhető el.

Hosszabbítás Ciklusonként –60 és 60 másodperc
közötti idő

Utasítja a PCR készüléket, hogy
hosszabbítsa meg a tartási időt az egyes
ciklusokkal. A pozitív szám növeli a tartási
időt, a negatív szám pedig csökkenti azt.

Hőmérsékleti és gradienslépésekben
egyaránt elérhető.

Hangjelzés (Nincs paraméter) Utasítja a PCR készüléket, hogy
hangjelzést adjon, ha elérte az adott lépés
célhőmérsékletét.

Csak hőmérsékleti lépések esetében
érhető el.

Lemezolvasás (Nincs paraméter) Utasítja a PCR készüléket, hogy adjon
hozzá egy lemezolvasást a kiválasztott
lépéshez.

Hőmérsékleti és gradienslépésekben
egyaránt elérhető.

7. táblázat Paraméterek és tartományok a protokoll lépéseihez
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A Protocol Editor (Protokollszerkesztő) ablak
A Protocol Editor (Protokollszerkesztő) ablakot protokollok létrehozására, megnyitására, áttekintésére és
szerkesztésére használhatja. A Protocol Editor (Protokollszerkesztő) alapértelmezés szerint egy
általános, valós idejű, 2 lépéses, 96 cellás lemezhez használható protokoll megjelenítésével nyílik meg.

1. A menüsor gyors hozzáférést biztosít a File (Fájl), Settings (Beállítások) és Tools (Eszközök)
menü parancsaihoz.

2. Az eszközsor gyors hozzáférést biztosít a protokoll elmentéséhez és kinyomtatásához, annak
meghatározásához, hogy hová illesszen be egy lépést, a mintatérfogat beállításához, valamint
a becsült protokollfuttatási idő megtekintéséhez.

3. A fő panel a protokoll grafikus ábrázolását mutatja.

4. Az alsó panel a protokoll áttekintő nézetét mutatja.

5. A bal oldali panel a protokoll vezérlőelemeit mutatja, amelyeket hozzáadhat a protokoll
testreszabásához.

JELMAGYARÁZAT
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A File (Fájl) menü parancsai
Save (Mentés) – az aktuális protokoll mentése.

Save As (Mentés másként) – az aktuális protokoll mentése új névvel vagy egy új helyre.

File Passwords (Fájljelszavak) – lehetővé teszi a felhasználók számára a fájl mentéséhez és
megnyitásához szükséges jelszavak beállítását.

Tipp: További információ: A fájlok védelme jelszóval a(z) 54. oldalon.

Close (Bezárás) – a Protocol Editor (Protokollszerkesztő) ablak bezárása.

A Settings (Beállítások) menüpont parancsa
Lid Settings (Fedélbeállítások) – a Lid Setting (Fedélbeállítás) párbeszédpanel megnyitása, amelyen
beállíthatja vagy módosíthatja a fedél hőmérsékletét.

A Tools (Eszközök) menü parancsai
Gradient Calculator (Gradienskalkulátor) – egy párbeszédpanel megnyitása, amelyen kiválaszthatja a
blokktípust egy gradienslépéshez. Az alapértelmezett beállítás: 96 cella.

Run time Calculator (Futtatásiidő-kalkulátor) – egy párbeszédpanel megnyitása, amelyen kiválaszthatja
a lemeztípust és a leolvasási üzemmódot, hogy a rendszer a Run Setup (Futtatás beállításai) ablakban
kiszámíthassa a becsült futtatási időt. Az alapértelmezett beállítás: 96 cella, összes csatorna.

Az eszköztár parancsai

– az aktuális protokollfájl mentése.

– a kiválasztott ablak nyomtatása.

– ezzel a paranccsal kiválaszthatja, hogy a rendszer az aktuálisan kiválasztott
lépéshez viszonyítva hová illesszen be lépéseket.

– ezzel a paranccsal megadhat egy mintatérfogatot µl mértékegységben. A
mintatérfogatok a blokktípustól függően eltérők:

n 96 cellás blokk esetében a tartomány: 0–50 µl.

Felhasználói útmutató | 107



7. fejezet Protokollok létrehozása

n 384 cellás blokk esetében a tartomány: 0–30 µl.

n 96 mély cellás blokk esetében a tartomány: 0–125 µl.

– a protokoll-lépések, a felfutási sebesség, valamint a kiválasztott blokktípus
alapján a becsült futtatási idő megjelenítése.

– a protokollokra vonatkozó súgóinformációk megjelenítése.

Protokollszerkesztési vezérlőelemek
A Protocol Editor (Protokollszerkesztő) ablak bal oldali panelén olyan vezérlőelemek találhatók,
amelyekkel protokollokat hozhat létre.

Az egyes vezérlőelemek olyan paraméterekből tevődnek össze, amelyek a protokoll egy-egy lépését
alkotják. Protokollját testre szabhatja az egyes paraméterek módosításával, valamint hozzáadásukkal
vagy eltávolításukkal. A jelen szakaszban az egyes vezérlőelemekben található opciókat mutatjuk be.

n Insert Step (Lépés beillesztése) – egy lépés beillesztése a kiválasztott
lépés elé vagy mögé. A hőmérsékletre és a várakozási időre vonatkozó
értékeket a protokoll grafikus kijelzőjén és a protokoll áttekintő
nézetében is szerkesztheti.

n Insert Gradient (Gradiens beillesztése) – egy gradienslépés
beillesztése a gradienskalkulátorban kiválasztott cellablokk típusa
alapján. A gradienstartományt a Gradient (Gradiens) panelen
szerkesztheti; ez a panel egy gradienslépés beillesztésekor jelenik meg.

n Insert GOTO (GOTO lépés beillesztése) – egy ciklikus (hurok-) lépés
beillesztése, amely arra utasítja a szoftvert, hogy meghatározott számú
cikluson keresztül ismételje egy szekvencia meghatározott lépéseit. Az

ismétlések akkor kezdődnek, amikor az első ciklus befejeződik. Például utasíthatja a szoftvert, hogy
39 alkalommal ismételje meg a 2–4. lépéseket. Az utolsó ismétlés végére a szoftver összesen 40
alkalommal végzi el a 2–4. lépéseket. A visszatérési (GOTO) lépést és a ciklusok számát a protokoll
grafikus kijelzőjén és a protokoll áttekintő nézetében is szerkesztheti.

n Insert Melt Curve (Olvadási görbe beillesztése) – egy olvadásigörbe-leolvasási lépés beillesztése.
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n Insert Plate Read to Step (Lemezleolvasás beillesztése a lépéshez) – egy lemezleolvasási parancs
hozzáadása a kiválasztott lépéshez. A lemezleolvasás funkció célja a fluoreszcencia
mennyiségének mérése egy ciklus végén. A lemezleolvasási lépés általában az utolsó lépés egy
GOTO hurokban.

Tipp: ha egy lépéshez hozzáad egy lemezleolvasási parancsot, akkor az adott lépés
kiválasztásakor a gomb a Remove Plate Read (Lemezleolvasás eltávolítása) gombra vált.

n Remove Plate Read (Lemezleolvasás eltávolítása) – egy lemezleolvasási parancs eltávolítása a
kiválasztott lépésből.

Tipp: ha egy lépésből eltávolít egy lemezleolvasási parancsot, az adott lépés kiválasztásakor a
gomb a következőre változik: Add Plate Read to Step (Lemezleolvasás hozzáadása a
lépéshez).

n Step Options (Lépésbeállítások) – a Step Options (Lépésbeállítások) párbeszédpanel megnyitása
és a kiválasztott lépéshez elérhető opciók megjelenítése. A lépésbeállításokra vonatkozó részletes
információk: Step Options (Lépésbeállítások) a(z) 110. oldalon.

Tipp: A Step Options (Lépésbeállítások) párbeszédpanel úgy is elérhető, ha a grafikus kijelzőn
a jobb egérgombbal rákattint a lépésre.

n Delete Step (Lépés törlése) – a kiválasztott lépés törlése a protokollból.
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Step Options (Lépésbeállítások)

Nyissa meg a Step Options (Lépésbeállítások) párbeszédpanelt azoknak az opcióknak a
megtekintéséhez, amelyeket hozzáadhat, módosíthat vagy eltávolíthat egy lépésből.

n Plate Read (Lemez leolvasása) – kiválasztásakor hozzáad egy lemezleolvasást a lépéshez.

n Temperature (Hőmérséklet) – beállítja a célhőmérsékletet a kiválasztott lépéshez.

n Gradient (Gradiens) – beállítja a gradienstartományt a lépéshez; a tartomány 1–24 °C.

Megjegyzés: egy gradiens a blokk elején levő legalacsonyabb hőmérséklettel (a képen a „H”
sor) és a blokk végén levő legmagasabb hőmérséklettel (a képen az „A” sor) fut.

n Increment (Növekedés) – a kiválasztott lépés hőmérsékletének növelésének (vagy
csökkentésének) mértéke; ezt a mennyiséget adja hozzá a berendezés a célhőmérséklethez
mindegyik ciklusban. A tartomány ±0,1–10 °C.

Megjegyzés: A hőmérséklet csökkentéséhez írjon egy mínusz jelet (-) a számérték elé (például:
-5°C).

n Ramp Rate (Felfutási sebesség) – a felfutási sebesség a kiválasztott lépéshez; a tartomány a blokk
méretétől függ.

n Time (Idő) – a várakozási idő a kiválasztott lépéshez.
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n Extend (Meghosszabbítás) – az időmennyiség (mp-ben) a kiválasztott lépés meghosszabbításához
vagy csökkentéséhez; a berendezést ezt az értéket hozzáadja a várakozási időhöz minden
ciklusban; a tartomány 1–60 mp.

n Beep (Sípolás) – ha be van jelölve, a lépés közben a berendezés sípol.

Tipp: Ha egy olyan számot ír be, amely kívül esik az opció tartományán, a szoftver a számot a
tartományon belüli legközelebbi értékre módosítja.
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Protokoll létrehozása a Protocol Editor (Protokollszerkesztő)
eszközzel

A Protocol Editor (Protokollszerkesztő) eszközzel egyedi protokollfájlokat hozhat létre. Továbbá
lehetősége van a korábban mentett protokollfájlokat, illetve a CFX Maestro Dx SE szoftverhez mellékelt
mintaprotokollfájlokat szerkeszteni és elmenteni.

Új protokollfájl létrehozásához tegye a következőket:

n Nyisson meg egy protokollfájlt a Protocol Editor (Protokollszerkesztő) ablakban.

Tipp: a Protocol Editor (Protokollszerkesztő) ablakban egy új vagy egy meglévő protokollt is
megnyithat.

n Állítsa be az új protokollt.

n Adjon lépéseket a protokollhoz a protokollvezérlő elemeket tartalmazó panelről.

n Szerkessze a lépések tulajdonságait.

n Mentse el a protokollt.

Tipp: ha egy korábban mentett vagy egy mintaprotokollfájlból szeretne létrehozni egy új protokollt,
lásd: Meglévő protokoll megnyitása a Protocol Editor (Protokollszerkesztő) eszközzel a(z) 114.
oldalon.

Új protokollfájl megnyitása a Protocol Editor (Protokollszerkesztő)
eszközzel
A CFX Maestro Dx SE több lehetőséget kínál egy új protokollfájl megnyitására:

n A Home (Kezdőlap) ablak File (Fájl) menüjéből

n A Futtatás beállítása párbeszédpanelen a Home (Kezdőlap) ablakban

n A Startup Wizard (Indítási varázsló) párbeszédpanelen a Home (Kezdőlap) ablakban

Új protokollfájl megnyitásához a Home (Kezdőlap) ablakból

u A Home (Kezdőlap) ablakban válassza ki a File > Open > Protocol (Fájl > Megnyitás > Protokoll)
lehetőséget.

Megnyílik a Protocol Editor (Protokollszerkesztő) ablak, és megjeleníti az alapértelmezett
protokollfájlt.

Tipp: az alapértelmezett protokoll beállítására vonatkozó információk: Az alapértelmezett
fájlbeállítások módosítása a(z) 89. oldalon.
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Új protokoll megnyitásához a Run Setup (Futtatás beállításai) párbeszédpanelről

1. A Home (Kezdőlap) ablakban tegye a következők egyikét a Run Setup (Futtatás beállításai)
párbeszédpanel megnyitásához:

n Válassza ki a Run > User-defined Run (Futtatás > Felhasználó által meghatározott futtatás)
elemet.

n Kattintson a User-defined Run Setup (Felhasználó által meghatározott futtatás beállítása)
elemre az eszköztárban.

Megnyílik a Run Setup (Futtatás beállításai) párbeszédpanel a Protocol (Protokoll) füllel, amelyen az
Ön alapértelmezett protokollfájlja látható.

2. Kattintson a Create New (Új protokoll létrehozása) elemre.

Megnyílik a Protocol Editor (Protokollszerkesztő) ablak, és megjelenik benne az alapértelmezett
valós idejű protokoll.

Új protokollfájl megnyitásához a Startup Wizard (Indítási varázsló) párbeszédpanelről

1. A Home (Kezdőlap) ablakban tegye a következők egyikét a Startup Wizard (Indítási varázsló)
megnyitásához, ha jelenleg nem látható:

n Válassza ki a View > Startup Wizard (Nézet > Indítási varázsló) elemet.

n Kattintson a Startup Wizard (Indítási varázsló) elemre az eszköztárban.

2. Szükség esetén válassza ki a műszer típusát a legördülő listából.

3. Kattintson a futtatás típusaként a User-defined (Felhasználó által beállított) elemre.

Megnyílik a Run Setup (Futtatás beállításai) párbeszédpanel és rajta a Protocol (Protokoll) fül,
amelyen az alapértelmezett protokollfájl látható.

4. Kattintson a Create New (Új protokoll létrehozása) elemre.

Megnyílik a Protocol Editor (Protokollszerkesztő) ablak, és megjelenik benne az alapértelmezett
valós idejű protokoll.

Új protokoll megnyitásához a Run (Futtatás) menüből

1. A Home (Kezdőlap) ablakban tegye a következők egyikét a Run Setup (Futtatás beállításai)
párbeszédpanel megnyitásához:

n Válassza ki a Run > User-defined Run (Futtatás > Felhasználó által meghatározott futtatás)
elemet.

n Kattintson a User-defined Run Setup (Felhasználó által meghatározott futtatás beállítása)
elemre az eszköztárban.
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Megnyílik a Run Setup (Futtatás beállításai) párbeszédpanel a Protocol (Protokoll) füllel, amelyen az
Ön alapértelmezett protokollfájlja látható.

2. Kattintson a Create New (Új protokoll létrehozása) elemre.

Megnyílik a Protocol Editor (Protokollszerkesztő) ablak, és megjelenik benne az alapértelmezett
valós idejű protokoll.

Meglévő protokoll megnyitása a Protocol Editor
(Protokollszerkesztő) eszközzel
A CFX Maestro Dx SE mintaprotokollfájlokat biztosít, amelyeket szerkeszthet és új testreszabott
protokollként elmenthet. Egy létező testreszabott protokollból is létrehozhat új protokollt.

Példa protokollfájl megnyitásához

1. A HomeWindow (Kezdőlap) ablakban válassza ki a File > Open > Protocol (Fájl > Megnyitás >
Protokoll) opciót.

Alapértelmezés szerint a Windows fájlkezelője a CFX Maestro Dx SE mintafájljainak mappáját nyitja
meg.

2. Nyissa meg a Sample files (Mintafájlok) mappát. A következő mappákat láthatja:

n ConventionalProtocols – (Konvencionális protokollok) hagyományos PCR-analízis
mintaprotokollfájljait tartalmazza.

n DataFiles (Adatfájlok) – mintaadatfájlokat tartalmaz, amelyeket a CFX Maestro Dx SE
jellemzőinek felfedezéséhez használhat.

n MeltCalibration (Olvadáskalibráció) – a Bio-Rad Precision Melt Analysis (Precíziós
olvadásvizsgálat) szoftverével használandó mintaprotokollfájlokat tartalmaz.

n Plates (Lemezek) – mintalemezfájlokat tartalmaz.

n RealTimeProtocols (Valós idejű protokollok) – valósidejű PCR-elemzéshez használható
mintaprotokollfájlokat tartalmaz.

3. Nyissa meg a protokollmappát a végrehajtani kívánt futtatási típushoz, azaz vagy a
ConventionalProtocols (Konvencionális protokollok), vagy a RealTimeProtocols (Valós idejű
protokollok) mappát.

4. Válassza ki a protokollt, és kattintson az Open (Megnyitás) gombra.

A mintaprotokoll megnyílik a Protocol Editor (Protokollszerkesztő) ablakban.

5. Válassza ki a File > Save As (Fájl > Mentés másként) opciót, és mentse el a protokollt egy új névvel
vagy egy új mappába.
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Létező protokoll megnyitásához

1. A Home (Kezdőlap) ablakban tegye a következők egyikét:

n Válassza ki a File > Open > Protocol (Fájl > Megnyitás > Protokoll) opciót, keresse meg és
válassza ki a célprotokollt, majd kattintson az Open (Megnyitás) gombra.

n Nyissa meg a Startup Wizard (Indítási varázsló) párbeszédpanelt, és tegye a következők
egyikét:

o Amegjelenített protokoll szerkesztéséhez kattintson az Edit Selected (Kiválasztott protokoll
szerkesztése) gombra.

o Egy másik létező protokoll szerkesztéséhez kattintson a Select Existing (Meglévő protokoll
kiválasztása) opcióra, majd lépjen a célfájlhoz.

A protokoll megnyílik a Protocol Editor (Protokollszerkesztő) ablakban.

2. Válassza ki a File > Save As (Fájl > Mentés másként) opciót, és mentse el a protokollt egy új névvel
vagy egy új mappába.

Új protokoll beállítása
Tipp: Ha a protokollfájl tartalmazza a szükséges paramétereket (pl. ha egy létező lemezfájlt
szerkeszt), átugorhatja ezt a részt. Ugorjon a Lépések hozzáadása egy protokollhoz a(z) 117.
oldalon.

Az új protokollfájlokhoz a következő paraméterek szükségesek:

n Blokk típusa

n A leolvasási üzemmód a kiválasztott blokktípushoz

n A fedél hőmérséklete

n Aminta térfogata
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A blokktípus beállítása

A CFX Maestro Dx SE a blokktípus alapján automatikusan kiszámítja a hőmérséklet-növekményeket a
gradienslépésekhez.

Megjegyzés: a Protocol Editor (Protokollszerkesztő) ablakban beállított lemeztípusnak meg kell
egyeznie a reakciómodulban található lemez típusával.

A blokktípus beállításához

u A Protocol Editor (Protokollszerkesztő) ablakban válassza ki a Tools > Gradient Calculator
(Eszközök > Gradienskalkulátor) elemet, majd a megjelenő legördülő listában válassza ki a
megfelelő lemeztípust.

A leolvasási üzemmód kiválasztása a kiválasztott blokktípushoz

A protokoll lefutási idejének meghatározásához válassza ki a célblokk típusát és a leolvasás üzemmódját.

A blokktípus és a leolvasási üzemmód kiválasztásához

u A Protocol Editor (Protokollszerkesztő) ablakban válassza ki a Tools > Run time Calculator
(Eszközök > Futtatásiidő-kalkulátor) elemet, majd válassza ki a megfelelő lemeztípust és leolvasási
üzemmódot a megjelenő legördülő listából.

A fedélhőmérséklet módosítása

A CFX Maestro Dx SE a következők szerint állítja be az alapértelmezett fedélhőmérsékleteket:

n 96 cellás és mély cellás műszerek – 105,0 °C

n 384 cellás műszerek – 95,0°C

A protokoll szükségleteinek megfelelően az alapértelmezett beállítások módosíthatók, illetve a fedélfűtés
kikapcsolható.

A fedélhőmérséklet módosításához

1. A Plate Editor (Lemezszerkesztő) ablakban válassza ki a Settings > Lid Settings (Beállítások >
Fedélbeállítások) lehetőséget.

Ekkor megjelenik a Lid Settings (Fedélbeállítások) párbeszédablak.

2. Tegye az alábbiak egyikét:

n Válassza ki a User Defined (Felhasználó által meghatározott) lehetőséget, és írjon be egy
hőmérsékleti értéket a szövegmezőbe.

n Válassza ki a Turn Off Lid Heater (Fedélfűtés kikapcsolása) lehetőséget.

3. Kattintson az OK gombra a módosítások elfogadásához és a párbeszédablak bezárásához.
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A mintatérfogat beállítása

A CFX Maestro Dx SE alapértelmezés szerint 25 µl értékre állítja az egyes cellák mintatérfogatát. A
mintatérfogatok a blokktípustól függően eltérők, például:

n 96 cellás blokk esetében 0–50 µl

n 384 cellás blokk esetében 0–30 µl

A műszer a kétféle hőmérséklet-szabályozási üzemmód egyikének a segítségével határozza meg, hogy a
minta mikor éri el a célhőmérsékletet egy protokollban:

n Calculated mode (Kiszámított üzemmód) – ha a mintatérfogat a blokknak megfelelő, nem nulla
értékre van beállítva, a műszer a mintatérfogat alapján számítja ki a minta hőmérsékletét. Ez a
standard üzemmód.

n Block mode (Blokk üzemmód) – amikor a mintatérfogat nulla (0) µl értékre van beállítva, a műszer a
minta hőmérsékletét a blokk mért hőmérsékletével azonos értékként rögzíti.

A mintatérfogat beállítása egy meghatározott blokkhoz

u A Plate Editor (Lemezszerkesztő) ablakban írja be a helyes értéket az eszköztárban található
Sample Volume (Mintatérfogat) szövegbeviteli mezőbe.

Tipp: Az alapértelmezett mintatérfogatot módosíthatja a User Preferences (Felhasználói beállítások)
párbeszédpanelen. Lásd: Az alapértelmezett fájlbeállítások módosítása a(z) 89. oldalon.

Lépések hozzáadása egy protokollhoz
Lépés hozzáadásához egy protokollhoz

1. Nyissa meg a protokollt a Protocol Editor (Protokollszerkesztő) ablakban.

2. Döntse el, hogy hová szeretné beilleszteni az új lépést. Az eszköztárban válassza ki a Before (Elé)
vagy After (Mögé) lehetőséget a Step (Lépés) legördülő listában.

3. Az ábrán válassza ki azt a lépést, amely elé vagy után be kívánja illeszteni az új lépést.

4. A bal oldali panelen kattintson az Insert Step (Lépés beszúrása) gombra.

5. A hőmérséklet vagy a várakozási idő módosításához kattintson az alapértelmezett értékre az ábrán
vagy a protokoll áttekintésén, és írjon be egy új értéket.

6. (Opcionális) A bal oldali panelen kattintson a Step Options (Lépésbeállítások) gombra a Step
Options (Lépésbeállítások) párbeszédablak megjelenítéséhez, és módosítsa a kiválasztott lépéshez
rendelkezésre álló opciókat.
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Tipp: a Step Options (Lépésbeállítások) párbeszédablakot a grafikon panelen vagy a protokoll
áttekintő panelén a jobb egérgombbal előhívható menüből érheti el.

7. A protokoll módosításainak elmentéséhez kattintson az OK gombra, majd a Yes (Igen) gombra.

Megjelenik a Save As (Mentés másként) párbeszédpanel.

8. A Save As (Mentés másként) párbeszédablakban írjon be egy nevet az új protokollfájlhoz, és
kattintson a Save (Mentés) gombra.

Gradienslépés beillesztése
Gradienslépés beillesztéséhez

1. Győződjön meg arról, hogy a gradiensre vonatkozó lemezméret ugyanaz, mint a műszer blokktípusa,
vagyis 96 cellás, 384 cellás vagy mély cellás.

2. Ha eddig még nem tette meg, válassza ki a lemezméretet a gradienshez:

Válassza ki a Tools > Gradient Calculator (Eszközök > Gradienskalkulátor) elemet, majd a legördülő
listáról válassza ki a megfelelő cellatípust.

3. Az eszköztárban válassza ki a Before (Elé) vagy az After (Utána) elemet az Insert Step (Lépés
beillesztése) legördülő listából.

4. A grafikonon vagy az áttekintő panelen válassza ki azt a lépést, amely elé vagy mögé be szeretné
illeszteni a gradienslépést.

5. A bal oldali panelen kattintson az Insert Gradient (Gradiens beillesztése) elemre. A rendszer az új
gradienslépést kiemeli a grafikonon és az áttekintő panelen. Például:
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A gradiensben található egyes sorok hőmérséklete megjelenik a jobb oldali panelen található
Gradient (Gradiens) táblázatban.

6. A gradiens hőmérséklet-tartományának szerkesztéséhez tegye a következők egyikét:

n Kattintson az alapértelmezett hőmérsékletre a grafikonon vagy az áttekintő panelen, és írjon be
egy új hőmérsékletet.

n Kattintson a Step Options (Lépésbeállítások) elemre, majd írja be a gradienstartományát a Step
Options (Lépésbeállítások) ablakban.

n Módosítsa a Range (Tartomány) értéket a Gradient (Gradiens) táblázatban.

7. A várakozási idő szerkesztéséhez kattintson az alapértelmezett időre a grafikus vagy a szöveges
nézeten, majd írjon be egy új időt.

8. A módosítások mentéséhez kattintson az OK gombra, majd a Yes (Igen) gombra.

GOTO (LÉPJ) lépés beillesztése
Megjegyzés: Egy GOTO (LÉPJ) készletbe nem lehet GOTO (LÉPJ) lépést beilleszteni; nem
lehetséges egymásba ágyazott GOTO ciklusokat létrehozni.
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GOTO (LÉPJ) lépés beillesztéséhez

1. Az eszköztárban válassza ki a Before (Elé) vagy After (Mögé) lehetőséget az Insert Step (Lépés
beillesztése) legördülő listában.

2. A grafikonon válassza ki a beilleszteni kívánt GOTO lépés előtti vagy az utáni lépést.

3. A bal oldali táblában kattintson az Insert GOTO (GOTO utasítás beillesztése) gombra.

4. A GOTO lépés számának vagy az ismétlések számának a szerkesztéséhez válassza ki az
alapértelmezett számot a grafikonban vagy az áttekintő táblában, és írjon be egy új értéket.

5. A módosítások mentéséhez kattintson az OK gombra, majd a Yes (Igen) gombra.

Olvadási görbe lépés beillesztése
Tipp: olvadási görbe lépés nem illeszthető be GOTO (LÉPJ) ciklusba.

Megjegyzés: az olvadási görbe lépés 30 másodperces várakozást tartalmaz a lépés elején, amely
nem látható a protokollban.

Olvadási görbe lépés beillesztéséhez

1. Az eszköztárban válassza ki a Before (Elé) vagy After (Mögé) lehetőséget az Insert Step (Lépés
beillesztése) legördülő listában.

2. A grafikonon válassza ki azt a lépést, amely elé vagy után szeretné beilleszteni az olvadási görbét.
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3. A bal oldali panelen kattintson az Insert Melt Curve (Olvadási görbe beillesztése) parancsra. Az új
olvadási görbe lépés ki van emelve a grafikonban és az áttekintő panelen, pl.:

4. Az olvadási görbe tartományának vagy növekedési lépésidejének szerkesztéséhez válassza ki az
alapértelmezett számot a grafikonban vagy az áttekintő panelen, és írjon be egy új értéket.

5. A módosítások mentéséhez kattintson az OK gombra, majd a Yes (Igen) gombra.
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Lemezleolvasási lépés hozzáadása vagy eltávolítása
Tipp: ha egy lépéshez hozzáad egy lemezleolvasási parancsot, akkor az adott lépés kiválasztásakor
a gomb a Remove Plate Read (Lemezleolvasás eltávolítása) gombra vált.

Lemezleolvasás hozzáadásához egy lépéshez

1. Az eszköztárban válassza ki a Before (Elé) vagy After (Mögé) lehetőséget az Insert Step (Lépés
beillesztése) legördülő listában.

2. A grafikonon válassza ki azt a lépést, amely elé vagy mögé be szeretné illeszteni a lemezleolvasás
lépést.

3. A bal oldali panelen kattintson az Add Plate Read to Step (Lemezleolvasás hozzáadása a lépéshez)
elemre egy lemezleolvasás hozzáadásához a kiválasztott lépéshez.

4. A módosítások mentéséhez kattintson az OK gombra, majd a Yes (Igen) gombra.

Lemezleolvasás eltávolításához egy lépésből

u A grafikonon válassza ki a lemezleolvasást tartalmazó lépést, majd a bal oldali panelen kattintson a
Remove Plate Read (Lemezleolvasás eltávolítása) elemre.

A lépésbeállítások módosítása
A lépésbeállítások módosításához egy kiválasztott lépésnél

1. Válassza ki a céllépést a diagramon vagy az áttekintő panelen.

2. A bal oldali panelen kattintson a Step Options (Lépésbeállítások) gombra a Step Options
(Lépésbeállítások) párbeszédpanel megnyitásához.

Másik megoldásként a jobb egérgombbal kattintson valamelyik panelen a céllépésre, és válassza ki
a Step Options (Lépésbeállítások) lehetőséget a megjelenő menüben.

3. Opciók hozzáadásához, módosításához vagy eltávolításához:

n Írjon be egy értéket a megfelelő szövegmezőbe.

n Módosítson egy értéket az adott szövegmezőben.

n Jelöljön be egy jelölőnégyzetet, vagy szüntesse meg a bejelölését.

4. Kattintson az OK gombra a módosítások elmentéséhez és a Step Options (Lépésbeállítások)
párbeszédpanel bezárásához.

5. Kattintson az OK gombra, majd a Yes (Igen) gombra a protokoll elmentéséhez.
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Lépés törlése
Fontos: Ez a funkció nem vonható vissza. Óvatosan járjon el a lépések törlésénél.

A protokoll egy lépésének törléséhez

1. Válassza ki a lépést a diagramban vagy az áttekintő panelen.

2. A bal oldali panelen kattintson a Delete Step (Lépés törlése) opcióra a kiválasztott lépés törléséhez.

3. Kattintson az OK gombra, majd a Yes (Igen) gombra a protokoll elmentéséhez.

Protokoll másolása, exportálása vagy nyomtatása
Protokoll másolásához

u Kattintson a jobb gombbal a protokoll áttekintésére, és válassza ki a Copy Protocol (Protokoll
másolása) parancsot.

Az áttekintést beillesztheti egy .txt, .xls, .doc vagy .ppt fájlba.

Protokoll exportálásához

1. Kattintson a jobb gombbal a protokoll áttekintésére, és válassza ki az Export Protocol (Protokoll
exportálása) parancsot.

Megjelenik a Save As (Mentés másként) párbeszédpanel.

2. (Opcionális) A Windows fájlkezelőjével lépjen egy mappába, amelybe el akarja menteni a
protokollfájlt.

3. A File name (Fájlnév) mezőbe írjon be egy nevet az exportált protokollfájlhoz.

4. Kattintson a Save (Mentés) gombra.

Protokoll kinyomtatásához

u Kattintson a jobb gombbal a protokoll áttekintő nézetére, és válassza ki a Print (Nyomtatás)
parancsot.

A protokoll áttekintését kinyomtathatja az alapértelmezett nyomtatóján.
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Protokoll létrehozása a Protocol AutoWriter (Automatikus
protokollíró) eszközzel

Fontos: A Bio-Rad nem garantálja, hogy a Protocol AutoWriter (Automatikus protokollíró) eszközzel
létrehozott protokoll futtatása minden esetben PCR-terméket eredményez.

A CFX Maestro Dx SE Protocol AutoWriter (Automatikus protokollíró) eszköze a következő bemeneti
paraméterek alapján automatikusan hoz létre PCR-protokollokat:

n Amplicon length (Amplikonhosszúság) – a PCR-termék elvárt hosszúsága

n Annealing temperature (Izzítási hőmérséklet) – az aktuálisan használt primerek Ta reakció-
hőmérséklet értéke

Ha a Ta ismeretlen, a Ta-kalkulátorral a primerszekvenciái alapján automatikusan kiszámíthatja.

Megjegyzés: a Ta értéke a primer olvadási hőmérsékletére (Tm) vonatkozó, a kiválasztott
enzimen és a protokoll sebességén alapuló információk helyesbítésével számítható ki.

n Enzyme type (Enzimtípus) – a DNS-polimeráz enzim (iTaq, iProof DNA polymerase /iTaq, iProof
DNS-polimeráz/ vagy Other /Egyéb/)

Ha az iTaq vagy az iProof DNS-polimeráztól eltérő enzimet használ, további információkat írhat be,
például a gradienstartományt, a forróindítási aktiválási időt (másodpercben), valamint a végső
kiterjesztési időt (másodpercben).

n Run speed (Futtatási sebesség) – a reakció sebessége (standard, fast /gyors/ vagy ultrafast
/ultragyors/)

A Protocol AutoWriter (Automatikus protokollíró) a kiválasztott sebességbeállításnak megfelelően
optimalizálja a protokollt. A teljes futtatási időt a következő tényezők határozzák meg: a lépések és a
ciklusok száma, az egyes lépések inkubációs időtartama, valamint a célhőmérsékleten az
uniformitás eléréséhez szükséges időtartam.

A Protocol AutoWriter (Automatikus protokollíró) az Ön által beírt paraméterek, valamint a standard PCR-
irányelvek alapján automatikusan létrehoz egy testreszabott PCR-protokollt a következő lépésekkel:
forróindítás, kezdeti denaturálás, izzítás, valamint kiterjesztés. Ezután megtekintheti a javasolt protokoll
grafikus ábrázolását, valamint szerkesztheti, futtathatja vagy elmentheti a protokollt.
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Új protokoll létrehozása a CFX Maestro Dx SE Protocol AutoWriter (Automatikus
protokollíró) eszközével

1. A Home (Kezdőlap) ablakban válassza ki a Tools > Protocol AutoWriter (Eszközök > Automatikus
protokollíró) elemet.

Megjelenik a Protocol AutoWriter (Automatikus protokollíró) párbeszédpanel.

2. Az Enter Target Values/Enzyme (Célértékek/enzim beírása) szakaszban tegye a következőket:

n Ha ismeri a primerek izzítási hőmérsékletét (Ta), írja be ezt az értéket.

Tipp: további információk: A Ta kalkulátor használata a(z) 126. oldalon.

Megjegyzés: bővebb információk a Ta kalkulátorban alkalmazott számításokról: Breslauer
et al. 1986.

n Írja be az amplikonhosszúságot bázispárokban (bp).

n Válasszon ki egy enzimtípust az opciókat tartalmazó listából (iTaq DNA polymerase /iTaq DNS-
polimeráz/, iProof DNA polymerase /iProof DNS-polimeráz/ vagy Other /Egyéb/).

Tipp: ha az enzimtípusnál az Other (Egyéb) értéket választja, az Additional Parameters
(Optional) (További paraméterek /opcionális/) szakaszban található paraméterek aktívvá
válnak.
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3. Ha az enzimtípusnál az Other (Egyéb) értéket választotta, a protokollhoz hozzáadhatja a következő
paraméterek bármelyikét vagy mindegyikét:

n Gradienstartomány

n Forróindítási aktiválási hőmérséklet

n Végső kiterjesztési idő

4. A Type (Típus) szakaszban a csúszka mozgatásával válassza ki a protokoll sebességét (Standard,
Fast /Gyors/ vagy Ultrafast /Ultragyors/). A CFX Maestro Dx SE kiigazítja a teljes futtatási időt.

5. Válassza ki az elvégezni kívánt PCR-vizsgálat típusát (az alapértelmezett érték a Real-time PCR
/Valós idejű PCR/).

A valós idejű PCR-vizsgálatnál a CFX Maestro Dx SE hozzáad egy lemezleolvasási lépést a
fluoreszcenciaadatok rögzítésére.

6. A Preview (Előnézet) szakaszban tekintse át a protokollt. Szükség szerint módosításokat végezhet.

7. Tegye az alábbiak egyikét:

n Az új protokoll mentéséhez kattintson az OK gombra. A protokoll az elmentését követően
megnyílik a Startup Wizard (Indítási varázsló) ablakban. Ha módosítást szeretne végezni a
protokollon, akkor kattintson az Edit Selected (Kijelölt elemek szerkesztése) gombra. Így például
lehetséges, hogy módosítania kell a fedélhőmérsékletet és a mintatérfogatot.

n Ha a protokoll mentése nélkül szeretné bezárni az ablakot, kattintson a Cancel (Mégse) gombra.

A Ta kalkulátor használata
Ha a primer izzítási hőmérséklete ismeretlen, az érték kiszámításához használhatja a Ta Calculator (Ta
kalkulátor) eszközt. Az értéket használhatja a Protocol AutoWriter (Automatikus protokollíró) vagy a
Protocol Editor (Protokollszerkesztő) eszközben a protokoll létrehozásához.

Tudnivalók a Ta kalkulátorról
A Ta kalkulátor kiszámítja az egyes primerekhez tartozó Tm értékeket, valamint a protokollhoz standard
sebességnél tartozó Ta értéket.

A protokollhoz tartozó Ta a következő szabályok figyelembevételével az átlagos primer Tm értékeken
alapszik:

n Ha a primer Tm értékei közötti különbség több mint 4 °C, akkor a Ta = (a primer két Tm értéke közül
az alacsonyabb + 2) – 4 °C

n Ha a Tm értékek közötti különbség ≤4 °C, akkor a Ta = (a primer Tm értékeinek átlaga) – 4 °C
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Bázispárszámlálási módszer

A Ta Calculator (Ta kalkulátor) mindegyik primer esetében a 14 vagy annál kevesebb bázispárból (bp)
álló szekvenciához használható bázispárszámlálási módszert alkalmazza.

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4),

ahol w, x, y és z az A, T, G és C bázisok száma a szekvenciában.

„Legközelebbi szomszéd” módszer

A 14 bázispárnál hosszabb szekvenciákhoz a rendszer a legközelebbi szomszéd módszert alkalmazza. A
legközelebbi szomszéd módszerben az olvadási hőmérséklet számítása az entrópia (az oligonukleotid
véletlenszerűségének sorrendje, illetve mértéke), az entalpia (az oligonukleotid által kibocsátott vagy
elnyelt hő), a szabad energia és a hőmérséklet közötti termodinamikai összefüggésen alapul.

∆H = ∆G + T* ∆S

ahol:

n ∆H = az entalpia értéke, cal/mol*K

n T = hőmérséklet, Kelvin

n ∆S = az entrópia értéke, cal/mol*K

n ∆G = Gibbs-féle szabad energia cal/mol*K egységben

Az entrópia és az entalpia változásait a 8. táblázat látható nukleotidpár-értékek összegzésével
közvetlenül lehet számítani (Breslauer és mtsai. 1986).

A szabad energia és a reagensek, valamint termékek egyensúlyi koncentrációi közötti kapcsolatot a

∆G = R*T*ln ((DNS * primer)/(DNS + primer))

egyenlet adja, ahol R a gázállandó (1,986 cal/mol*K).

A két egyenletben a G behelyettesítése és a T-re történő megoldás a

T = ∆H/(∆S + R*Ln((DNS * primer)/(DNS + primer)))

eredményt adja, feltételezve, hogy a DNS és a DNS-primer komplex koncentrációja megegyezik.

Empirikusan meghatározták, hogy 5 kcal (3,4 kcal) szabad energia (Sugimoto és mtsai. 1996) változás
történik az egyszálúról a B-formájú DNS-be való átalakulás során. Ez feltételezhetően a spirál kezdési
energiája. Végül pedig, egy só miatti módosítás hozzáadása azt az egyenletet adja, amelyet a Ta -
kalkulátor használ:

T = (∆H – 5(KCal/K*mol))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (SóMolaritás)
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A sókoncentrációhoz nincs szükség módosító állandóra, mivel a különböző paraméterek meghatározása
1 M NaCl értéknél történt, és 1 log10 értéke nulla.

A termodinamikai számítások azt feltételezik, hogy az izzítás 7,0 pH-értéken történik. A Tm számításai azt
feltételezik, hogy a szekvenciák nem szimmetrikusak, és legalább egy G vagy C nukleinsavat
tartalmaznak.

Az oligonukleotid-szekvenciának legalább 14 bázis hosszúságúnak kell lennie ahhoz, hogy elfogadható
Tm értékeket adjon. A 14-nél kevesebb bázis esetében a bázispárszámlálási módszert kell használni
(lásd az alábbi 8. táblázat).

Interakció ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

8. táblázat Breslauer interakciós állandók
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A Ta kalkulátor használata

A Ta Calculator (Ta kalkulátor) használatához

1. A Ta Calculator (Ta kalkulátor) megnyitásához végezze el az alábbiak egyikét:

n Ha a Protocol AutoWriter (Automatikus protokollíró) ablakban van, kattintson a Ta Calculator (Ta
kalkulátor) opcióra.

n A Home (Kezdőlap) ablakban válassza ki a Tools > Ta Calculator (Eszközök > Ta kalkulátor)
opciót.

Megjelenik a Ta Calculator (Ta kalkulátor) párbeszédpanel.

2. A Forward Primer (Egyenes primer) szövegmezőbe írja be vagy illessze be az egyenes primer
szekvenciáját.

Tipp: használhatja a párbeszédpanel bal oldalán levő A, T, G, C gombokat is a szekvencia
beírásához.

3. Írja be vagy illessze be a fordított primer szekvenciáját a Reverse Primer (Fordított primer)
szövegmezőbe.

4. Kattintson a Calculate (Számítás) gombra.
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A Ta Calculator (Ta kalkulátor) kiszámítja és megjeleníti az egyes primerek Tm értékét és az átlagos
Tm és Ta értékeket, például:

Ha a primer Tm értékei több mint 4 °C távolságra vannak egymástól, a Protocol AutoWrite
(Automatikus protokollíró) az alacsonyabb primer Tm értéke + 2 °C-ot használ alapként a Ta érték
kiszámításához, amelyet Ön tovább módosíthat az enzim és a reakciósebesség megváltoztatásával.

A Ta Calculator (Ta kalkulátor) izzítási hőmérsékletet generál a standard sebességhez iTaq DNS-
polimerázzal. Más enzim használata esetén a sebességbeállítások automatikusan módosítják a Ta
értéket.

5. Tegye az alábbiak egyikét:

n Ha a Ta Calculator (Ta kalkulátor) ablakot a Protocol AutoWriter (Automatikus protokollíró)
ablakból nyitotta meg, kattintson az OK gombra. Ekkor visszatér a Protocol AutoWriter
(Automatikus protokollíró) ablakba. Az izzítási hőmérséklet a program automatikusan módosítja.

n Ha a Ta Calculator (Ta kalkulátor) opciót a Tools (Eszközök) menüből nyitotta meg, jegyezze fel
a számításokat, és kattintson a Cancel (Mégse) gombra a kalkulátor bezárásához.
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A lemezfájl a futtatás paramétereire vonatkozó információkat tartalmaz, például a leolvasási üzemmódot,
a fluorofórokat és a cellák tartalmát. A futtatás után a CFX Maestro Dx szoftver, Security Edition a cellák
tartalmát összekapcsolja a protokoll során rögzített fluoreszcenciaadatokkal, valamint elvégzi a megfelelő
elemzést a Data Analysis (Adatelemzés) ablakban. Így például a rendszer a standard típusú mintát
tartalmazó cellák segítségével egy standard görbét hoz létre.

A CFX Maestro Dx SE két lehetőséget kínál a lemezek létrehozására: a Plate Editor (Lemezszerkesztő) a
valós idejű PCR-futtatáshoz és a Setup Wizard (Beállítási varázsló) a normalizált génexpressziós
elemzéshez.

A Plate Editor (Lemezszerkesztő) eszköz a következő funkciókat tartalmazza:

n A lemez celláihoz hozzárendelhető standard fluorofórok és mintatípusok.

n A referenciacél és kontroll minta beállítása a génexpresszió-elemzéshez.

n A lemezbeállítás szerkesztése egy futtatás előtt, közben vagy után.

n A lemezfájlok elmentése későbbi ismételt felhasználásra.

n A lemezfájl kinyomtatása az alapértelmezett nyomtatóval.

A Setup Wizard (Beállítási varázsló) végigvezeti Önt azokon a lépéseken, amelyekkel lemezelrendezést
hozhat létre a normalizált génexpresszió elemzéséhez. A Setup Wizard (Beállítási varázsló) eszközt
futtatás előtt, közben és után is használhatja.
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A Plate Editor (Lemezszerkesztő) ablak
A Plate Editor (Lemezszerkesztő) ablakban egyedi lemezeket hozhat létre, illetve módosíthatja a
meglévő lemezeket.

1. A menüsor gyors hozzáférést kínál a File (Fájl) és Settings (Beállítások) menüpontban található
parancsokhoz, valamint a lemezszerkesztési eszközök által kínált lehetőségekhez.

2. Az eszköztár gyors hozzáférést kínál a fontos lemezbetöltési funkciókhoz.

3. A fő panelen a lemez áttekintő nézete és az Ön által alkalmazott lemezopciók láthatók.

4. A jobb oldali panelen olyan opciók láthatók, amelyekkel testre szabhatja a lemezt.

5. Az alsó panel a lemez típusát mutatja, valamint gyors hozzáférést kínál a megtekintési
lehetőségekhez.

JELMAGYARÁZAT

A File (Fájl) menü parancsai
Save (Mentés) – a lemezadatfájl mentése a User Preferences (Felhasználói beállítások) párbeszédpanel
File (Fájl) fülén meghatározott helyre. További információk: Az alapértelmezett fájlbeállítások módosítása
a(z) 89. oldalon. Ez a menüpont csak új lemezfájl létrehozásakor érhető el.
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Save As (Mentés másként) – a megnyitott lemezadatfájl mentése egy Ön által megadott új névvel. Ez a
menüpont csak új lemezfájl létrehozásakor érhető el.

File Passwords (Fájljelszavak) – lehetővé teszi a felhasználók számára a fájl mentéséhez és
megnyitásához szükséges jelszavak beállítását.

Extract Plate (Lemez kinyerése) – egy párbeszédpanel megnyitása, amelyen kinyerheti/elmentheti a
(.pltd kiterjesztésű) lemezfájlt. Ez a menüpont csak meglévő lemezfájl megtekintésekor vagy
szerkesztésekor érhető el.

Print (Nyomtatás) – a megnyitott lemezadatfájl kinyomtatása.

Close (Bezárás) – a Plate Editor (Lemezszerkesztő) ablak bezárása.

Az Edit (Szerkesztés) menü parancsai
Undo (Visszavonás) – visszavon egy lemezfájlon végzett módosítást a lemezfájl elmentéséig.

Redo (Mégis) – visszafordítja a legutóbbi Undo (Visszavonás) műveletet, hacsak el nemmentette a
lemezt.

A Settings (Beállítások) menü parancsai
Plate Size (Lemezméret) – egy párbeszédpanel megnyitása, amelyen kiválaszthat egy lemezméretet a
futtatáshoz.

Megjegyzés: A lemezméretnek azonosnak kell lennie annak a blokknak a méretével, amely a
futtatás elvégzéséhez használni kívánt műszeren található.

Válassza a 96 cellást, ha:

n CFX Opus 96 Dx

n CFX Opus Deepwell Dx

Válassza a 384 cellást, ha:

n CFX Opus 384Dx

Plate Type (Lemeztípus) – lehetővé teszi a mintáit tartalmazó lemezben található cellák típusának
kiválasztását, mely BRWhite (BR fehér) vagy BR Clear (BR átlátszó) lehet. Az adatok pontos
elemzéséhez a kiválasztott lemeztípusnak azonosnak kell lennie a futtatás során használt lemeztípussal.

Megjegyzés: Az új lemeztípusokat be kell kalibrálni. Bővebb információk: Új festékek
kalibrálása a(z) 81. oldalon.
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Number Convention (Számok megjelenítése) – kiválaszthatja, hogy a rendszer az egységeket
tudományos jelöléssel jelenítse-e meg. A rendszer alapértelmezés szerint az egységeket tudományos
jelöléssel jeleníti meg.

Units (Egységek) – lehetővé teszi, hogy kiválassza azokat az egységeket, amelyek akkor jelennek a
táblázatokban, ha ismeretlen mintákat szeretne kvantifikálni standard görbével összehasonlítva.

Az Editing Tools (Szerkesztőeszközök) menü parancsai
Setup Wizard (Beállítási varázsló) – megnyitja a Setup Wizard (Beállítási varázsló) opciót, amelyben
megadhatja az elrendezési és elemzési paramétereket az aktuális lemezhez. A Setup Wizard (Beállítási
varázsló) funkciót egy futtatás előtt, közben és befejeződése után is használhatja.

Spreadsheet View/Importer (Táblázatos nézet /importálás) – megnyitja a View (Megtekintés)
párbeszédpanelt, amely sablonként, táblázatos formában mutatja a lemezelrendezést. Ezen a
párbeszédpanelen a lemezsablon adatait .csv formátumban exportálhatja vagy importálhatja.

Flip Plate (Lemez átfordítása) – a lemez tartalmát 180o-kal átfordítja.

Az eszköztár parancsai

Visszaállítja a lemezen végzett változtatást. A CFX Maestro Dx SE
legfeljebb tíz visszavonási műveletet támogat.

Érvényteleníti a legutóbbi Visszavonás műveletet. A CFX Maestro Dx SE
legfeljebb tíz érvénytelenítési műveletet támogat.

Az aktuális lemezfájl mentése.

Legördülő lista megjelenítése, amellyel növelheti vagy csökkentheti a
lemeznézet nagyítását.

Legördülő lista megjelenítése, amellyel kiválaszthat egy leolvasási
üzemmódot, amely meghatározza, hogy a műszer egy futtatás során
mely csatornákból gyűjtsön fluoreszcenciaadatokat.

A Well Groups Manager (Cellacsoport-kezelő) megnyitása, amelyben
cellacsoportokat hozhat létre az aktuális lemezhez.

Párbeszédpanel megjelenítése, amelyen kiválaszthatja a sokszorosítási
jelek színeit és szimbólumait.
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A Plate Editor (Lemezszerkesztő) ablak

A View (Nézet) párbeszédpanel megnyitása, amely sablonként,
táblázatos formátumban megjeleníti a lemezelrendezést. Ezen a
párbeszédpanelen a lemezsablon adatait .csv formátumban
exportálhatja vagy importálhatja.

A Setup Wizard (Beállítási varázsló) megnyitása, amellyel
meghatározhatja az elrendezési és elemzési paramétereket az aktuális
lemezhez. A Setup Wizard (Beállítási varázsló) eszközt futtatás előtt,
közben és után is használhatja.

A User Preferences (Felhasználói beállítások) párbeszédpanelen a Plate
(Lemez) fül megnyitása, amelyen meghatározhatja a lemezelrendezési
paramétereket, valamint létrehozhat és törölhet cél-, minta- és
biológiaicsoport-neveket. A Plate (Lemez) fülön Ön által végzett
módosítások elérhetők lesznek, amikor legközelebb megnyitja a Plate
Editor (Lemezszerkesztő) ablakot.

A lemez beállításához és a cellák betöltéséhez szükséges lépések
megjelenítése.
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Lemezfájl létrehozása a Plate Editor (Lemezszerkesztő)
eszközzel

A Plate Editor (Lemezszerkesztő) eszközzel egyedi lemezfájlokat hozhat létre. Lehetősége van a
korábban mentett lemezfájlok, illetve a CFX Opus Dx rendszerhez mellékelt mintalemezfájlok
szerkesztésére és mentésére is.

Új lemezfájl létrehozásához tegye a következőket:

n Nyisson meg egy lemezfájlt a Plate Editor (Lemezszerkesztő) ablakban.

n Válassza ki a lemez típusát.

Megjegyzés: a lemezfájlhoz megadott lemeztípusnak meg kell egyeznie a reakciómodulban
található lemez típusával.

n Válassza ki a protokollban használni kívánt leolvasási üzemmódot.

n Válassza ki a lemezben használni kívánt fluorofórokat.

n Válassza ki a minta típusát, a célokat és mintákat.

n Adott esetben válassza ki a technikai replikátumokat.

n Mentse el a lemezelrendezést.

Tipp: ha egy korábban elmentett vagy egy mintalemezfájlból szeretne létrehozni egy új lemezt, lásd:
Meglévő lemezfájl megnyitása a Plate Editor (Lemezszerkesztő) eszközben a(z) 138. oldalon.

Új lemezfájl megnyitása a Plate Editor (Lemezszerkesztő) ablakban
A CFX Maestro Dx SE több lehetőséget is kínál egy új lemezfájl megnyitására:

n A Home (Kezdőlap) ablakból

n A Startup Wizard (Indítási varázsló) párbeszédpanelről

n A Run Setup (Futtatás beállításai) párbeszédpanelről

Új lemezfájl megnyitása a Home (Kezdőlap) ablakból

u Válassza ki a File > New Plate (Fájl > Új lemez) elemet.

Megnyílik a Plate Editor (Lemezszerkesztő) ablak és rajta a kiválasztott műszerhez tartozó
alapértelmezett lemezfájl.

Tipp: az alapértelmezett lemezfájl beállítására vonatkozó információk: Az alapértelmezett
fájlbeállítások módosítása a(z) 89. oldalon.
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Új lemezfájl megnyitása a Startup Wizard (Indítási varázsló) párbeszédpanelről

1. A Home (Kezdőlap) ablakban tegye a következők egyikét a Startup Wizard (Indítási varázsló)
megnyitásához, ha jelenleg nem látható:

n Válassza ki a View > Startup Wizard (Nézet > Indítási varázsló) elemet.

n Kattintson a Startup Wizard (Indítási varázsló) elemre az eszköztárban.

2. Szükség esetén válassza ki a műszer típusát a legördülő listából.

3. Új lemez létrehozásához kattintson a User-defined (Felhasználó által meghatározott) elemre a
futtatás típusaként.

Megnyílik a Run Setup (Futtatás beállításai) párbeszédpanel és rajta a Protocol (Protokoll) fül.

4. Kattintson a Plate (Lemez) fülre, majd a Create New (Új lemez létrehozása) elemre.

Megnyílik a Plate Editor (Lemezszerkesztő) ablak és rajta a kiválasztott műszerhez tartozó
alapértelmezett lemezelrendezés.

Új lemezfájl megnyitásához a Run Setup (Futtatás beállításai) párbeszédpanelről

1. A Home (Kezdőlap) ablakban tegye a következők egyikét a Run Setup (Futtatás beállításai)
párbeszédpanel megnyitásához:

n Válassza ki a Run > User-defined Run (Futtatás > Felhasználó által meghatározott futtatás)
elemet.

n Kattintson a User-defined Run Setup (Felhasználó által meghatározott futtatás beállítása)
elemre az eszköztárban.

Megnyílik a Run Setup (Futtatás beállításai) párbeszédpanel és rajta a Protocol (Protokoll) fül.

2. Új lemez létrehozásához kattintson a Plate (Lemez) fülre, majd kattintson a Create New (Új lemez
létrehozása) elemre.

Megnyílik a Plate Editor (Lemezszerkesztő) ablak és rajta a kiválasztott műszerhez tartozó
alapértelmezett lemezelrendezés.
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Meglévő lemezfájl megnyitása a Plate Editor (Lemezszerkesztő)
eszközben
A CFX Maestro Dx SE mintalemezfájlokat kínál, amelyeket Ön szerkeszthet és elmenthet új lemezként.
Egy korábban mentett lemezfájlból is létrehozhat egy új lemezfájlt.

Mintalemezfájl megnyitásához

1. A Home (Kezdőlap) ablakban válassza ki a File > Open > Plate (Fájl > Megnyitás > Lemez) elemet.

A Windows fájlkezelője megnyitja a CFX Opus Dx rendszer Sample files (Mintafájlok) mappáját.

2. Nyissa meg a Sample files (Mintafájlok) mappát, majd nyissa meg a Plates (Lemezek) mappát.

3. Válasszon ki egy lemezfájlt, majd kattintson a Megnyitás gombra.

A mintalemezfájl megnyílik a Plate Editor (Lemezszerkesztő) ablakban.

4. Válassza ki a File > Save As (Fájl > Mentés másként) elemet, majd mentse el a lemezfájlt új névvel
vagy egy új mappába.

Egy korábban mentett lemezfájl megnyitásához

1. A Home (Kezdőlap) ablakban tegye a következők egyikét:

n Válassza ki a File > Open > Plate (Fájl > Megnyitás > Lemez) elemet, keresse meg és válassza
ki a kívánt lemezt, majd kattintson az Open (Megnyitás) elemre.

n Nyissa meg a Startup Wizard (Indítási varázsló) párbeszédpanelt, és tegye a következők
egyikét:

o Meglévő lemezfájl szerkesztéséhez kattintson a Select Existing (Meglévő fájl kiválasztása)
elemre, majd lépjen a kívánt fájlhoz.

o Amegjelenített lemezfájl szerkesztéséhez kattintson az Edit Selected (Kijelölt fájl
szerkesztése) gombra.

A kívánt lemez megnyílik a Plate Editor (Lemezszerkesztő) ablakban.

2. Válassza ki a File > Save As (Fájl > Mentés másként) elemet, majd mentse el a lemezfájlt új névvel
vagy egy új mappába.
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Új lemezfájl beállítása
Tipp: Ha a lemezfájl tartalmazza a szükséges paramétereket (pl. ha egy mintát vagy egy meglevő
lemezfájlt szerkeszt), kihagyhatja ezt a részt. Ugorjon ide: Opcionális paraméterek hozzárendelése a
lemezfájlhoz a(z) 147. oldalon.

Az új lemezfájlokhoz a következő paraméterek szükségesek:

n Plate size (Lemezméret)

n Plate Type (Lemeztípus)

n Leolvasási üzemmód

n Egy fluorofór (festék)

n Egy mintatípus

A lemez méretének és típusának kiválasztása

Fontos: A lemezbeállítás során ki kell választania egy lemezméretet. Futtatás közben vagy azt
követően nemmódosíthatja a lemezméretet.

A szoftver a lemezméretet és -típust a futtatás közben az összes cellára alkalmazza. Ügyeljen arra, hogy
a kiválasztott lemezméret megegyezzen a futtatásban használni tervezett lemez méretével.

A(z) Bio-Rad CFX Opus Dx rendszerei gyárilag kalibráltak számos fluoreszkáló festékre és
lemezkombinációra való tekintettel. A kalibráció a készülékre, festékre és lemeztípusra specifikus eljárás.
Ügyeljen arra, hogy a használni tervezett fluorofór kalibrálva legyen a kiválasztott lemeztípushoz.

Tipp: Egy új festék és lemeztípus kombinációnak kalibrációjához egy adott készüléken válassza ki a
Tools > Calibration Wizard (Eszközök > Kalibrációs varázsló) lehetőséget. A festékek és
lemeztípusok kalibrálásával kapcsolatos információk: Új festékek kalibrálása a(z) 81. oldalon.

A leolvasási üzemmód kiválasztása

A CFX Opus 96 Dx és a CFX Opus Deepwell Dx rendszerek öt csatornán (plusz FRET) gerjesztik és
érzékelik a fluorofórokat. A CFX Opus 384 Dx rendszer a fluorofórokat négy csatornában (plusz FRET)
gerjeszti és detektálja. Valamennyi rendszer többszörös adatrögzítő leolvasási üzemmódot alkalmaz
futtatás közben a fluoreszcenciaadatok rögzítésére.

A CFX Maestro Dx SE három leolvasási üzemmódot biztosít:

n Minden csatorna

o Az 1–5. csatornát olvassa le a CFX Opus 96 Dx és a CFX Opus Deepwell Dx rendszereken

o Az 1–4. csatornát olvassa le a CFX Opus 384 Dx rendszereken
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n SYBR®/FAM

o Csak az 1. csatornát olvassa le

o Gyors leolvasást biztosít

n FRET

o Csak a FRET-csatornát olvassa le

o Gyors leolvasást biztosít

Fluorofórok kiválasztása

Fontos: A futás elkezdése előtt a CFX rendszerek ellenőrzik, hogy az Ön által a lemezben megadott
fluorofórok kalibrálva vannak-e az adott készüléken. Olyan lemezt nem futtathat, mely az adott
készüléken nem kalibrált fluorofórokat tartalmaz.

A futtatás előtt legalább egy fluorofórt be kell töltenie a lemezelrendezésbe. Ekkor annyi fluorofórt adhat
hozzá, amennyi csak szükséges, de a lemeznek tartalmaznia kell legalább egy fluorofórt. A kiválasztott
fluorofórok opcióként jelennek meg a célokhoz a Target Names (Célnevek) ablakban.

A Select Fluorophores (Fluorofórok kiválasztása) párbeszédpanelt a fluorfórok (vagy lemezfestékek)
betöltéséhez használhatja a Plate Editor (Lemezszerkesztő) cellabetöltő vezérlőelemeibe. A Select
Fluorophores (Fluorofórok kiválasztása) párbeszédpanelben megjelenő fluorofórok az Ön által
kiválasztott leolvasási üzemmódtól függenek:

n Minden csatorna

Az összes rendelkezésre álló fluorofór megjelenik.

Tipp: annyi fluorofórt hozzáadhat, amennyi szükséges, de mindegyik cellába csatornánként
csak egyetlen fluorofórt tölthet be.

n SYBR®/FAM

Csak az 1. csatorna fluorofórjai jelennek meg.

n FRET

Csak a 6. csatorna fluorofórja jelenik meg.

Tipp: A 6. (FRET) csatorna fluorofórja csak akkor jelenik meg, ha a kiválasztott leolvasási
üzemmód FRET. Ez nem áll rendelkezésre az All Channels (Minden csatorna) leolvasási
üzemmódhoz.

Megjegyzés: Közvetlenül nem adhat fluorofórokat, illetve nem távolíthatja el őket a Select
Fluorophore (Fluorofór kiválasztása) párbeszédpanelben. Az új fluorofórokat kalibrálnia kell egy
műszeren a Calibration Wizard (Kalibrációs varázsló) használatával. A kalibrálás után az új fluorofór
automatikusan megjelenik a listán. További információk: Új festékek kalibrálása a(z) 81. oldalon.
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Mintatípusok kiválasztása

Fontos: A futás előtt legalább egy, a lemezcellákhoz hozzárendelni kívánt mintatípust ki kell
választania.

A CFX Maestro Dx SE öt mintatípust kínál:

n Unknown (Ismeretlen)

n Standard

n NTC (no template control, sablon nélküli kontroll)

n Positive Control (Pozitív kontroll)

n Negative Control (Negatív kontroll)

n NRT (no reverse transcriptase, reverz transzkriptáz nélkül)

A lemezcellákhoz Ön rendeli hozzá a mintatípusokat.

Új lemez beállítása

Új lemez beállításához

1. Nyisson meg egy új lemezt a Plate Editor (Lemezszerkesztő) ablakban.

2. A lemez méretének beállításához válassza ki a Settings > Plate Size (Beállítások > Lemezméret)
opciót, és válassza ki a megfelelő lemezméretet a legördülő menüből.

3. A lemeztípus beállításához válassza ki a Settings > Plate Type (Beállítások > Lemeztípus) opciót, és
válassza ki a BRWhite (BR fehér) vagy BR Clear (BR átlátszó) lehetőséget a legördülő menüből.

4. Opcionálisan a Settings (Beállítások) menüből módosíthatja a számformátumot és a megjelenítési
egységeket:

n A számformátummódosításához válassza ki a Settings > Number Convention (Beállítások >
Számformátum) opciót, és válassza ki a Scientific Notation (Tudományos jelölés) lehetőséget.

Tipp: Alapértelmezett beállításként a Scientific Notation (Tudományos jelölés) van
kiválasztva. Ebben az esetben a Scientific Notation (Tudományos jelölés) kiválasztása törli
az alapértelmezett választást, és a számformátumot standard formátumra állítja be.

n Amegjelenítési egységek módosításához válassza ki a Settings > Units (Beállítások >
Egységek) lehetőséget, és válasszon ki egy új egységet.

5. A leolvasási üzemmód beállításához válassza ki a megfelelő leolvasási üzemmódot a Scan Mode
(Leolvasási üzemmód) legördülő listából a Plate Editor (Lemezszerkesztő) ablak eszközsorában.
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6. Válassza ki a szükséges fluorfórokat a lemezhez:

a. A jobb oldali panelen kattintson a Select Fluorophores (Fluorofórok kiválasztása) opcióra.

Megjelenik a Select Fluorophores (Fluorofórok kiválasztása) párbeszédpanel. Láthatja az 5.
lépés kiválasztott leolvasási üzemmódjához rendelkezésre álló fluorofórokat, például:

b. Egy fluorofór kiválasztásához kattintson a Selected (Kiválasztva) jelölőnégyzetébe.

Tipp: Egy fluorofór törléséhez a listából szüntesse meg a Selected (Kiválasztva)
jelölőnégyzetének kijelölését.

c. A fluorofór megjelenítési színének módosításához kattintson a Color (Szín) mezőjébe.

Megjegyzés: az Ön által kiválasztott szín mind a Plate Editor (Lemezszerkesztő) ablakban,
mind a Data Analysis (Adatelemzés) diagramokon jelöli a fluorofórt.

d. A Color (Szín) párbeszédpanelen válassza ki a kívánt színt, vagy kattintson a Define Custom
Colors (Egyedi színek definiálása) opcióra egy új szín létrehozásához a fluorofór jelölésére.

e. Kattintson az OK gombra a módosítások elmentéséhez és a Select Fluorophores (Fluorofórok
kiválasztása) párbeszédpanelből történő kilépéshez.
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7. Legalább egy cellát ki kell választania egy mintatípus betöltéséhez. Alapértelmezés szerint az A1
cella van kiválasztva.

A Plate (Lemez) panelen végezze el az alábbiak egyikét:

n Több egymással szomszédos cella hozzáadásához kattintson egy cellába, és húzza a
célcellához.

n Több, egymással nem szomszédos cella betöltéséhez tartsa nyomva a Control billentyűt, majd
kattintson az egyes cellákra.

n Egy ugyanazt a mintatípust tartalmazó egész sor kiválasztásához kattintson az oszlop számára.

n Egy egész sor betöltéséhez kattintson a sor számára.

n Az egész lemez betöltéséhez kattintson a lemez bal felső sarkába.

Például:
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8. Rendeljen hozzá egy mintatípust a kiválasztott cellához vagy cellákhoz a Sample Type (Mintatípus)
legördülő menüből.

9. Rendeljen hozzá legalább egy fluorofórt egy mintatípust tartalmazó összes cellához. Egy cellához
vagy cellacsoporthoz egynél több fluorofórt is hozzárendelhet.

Megjegyzés: Csatornánként csak egyetlen fluorofórt lehet megadni. Ugyanabból a csatornából
ugyanahhoz a cellához nem rendelhet hozzá egynél több fluorofórt.

Tipp: a fluorofórral társíthat egy célt, vagy megteheti, hogy most csak hozzárendeli a fluorofórt a
cellához, és a kísérlet lefuttatása után társít egy célt a fluorofórhoz.

n Ha csak egy fluorofórt szeretne társítani a kiválasztott cellákhoz, a Target Names (Célnevek)
rész jobb oldali paneljében válassza ki a Load (Betöltés) jelölőnégyzetet az adott fluorofórhoz.

n Egy cél társításához egy fluorofórral a Target Names (Célnevek) részben válasszon ki egy
célnevet a legördülő listából az adott fluorofórhoz. A szoftver automatikusan bejelöli a Load
(Betöltés) jelölőnégyzetet.

10. A Standard mintatípust tartalmazó cellákhoz be kell töltenie egy koncentrációt. Mindegyik cellához
különböző koncentrációértéket adhat meg. Alapértelmezés szerint a CFX Maestro Dx SE 1,00E+06
koncentrációt tölt be az összes cellába Standard mintatípussal. Az értéket szükség szerint
módosíthatja.

a. A Plate (Lemez) panelen válasszon ki egy Standard cellát vagy cellacsoportot.

b. A Concentration (Koncentráció) részben kattintson a Load (Betöltés) gombra az érték
betöltéséhez a kiválasztott cellába vagy cellacsoportba.

c. (Opcionális) Egy másik koncentráció betöltéséhez írja be az új értéket a Concentration
(Koncentráció) szövegmezőbe, és nyomja meg az Enter gombot.

d. Végezze el ezt a lépést az összes Standard mintatípust tartalmazó cellához.
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Tipp: Ha ugyanazt a koncentrációt szeretné az összes Standard cellába betölteni,
ügyeljen, hogy az <All> <Összes> felirat jelenjen meg a legördülő listában a Concentration
(Koncentráció) érték alatt. Ha ugyanazt a koncentrációértéket szeretné egy adott fluorofórt
tartalmazó összes cellába betölteni, kattintson a legördülő listára, és válassza ki a fluorofórt.

11. Az új lemez elmentéséhez kattintson az OK gombra.
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A Plate Editor (Lemezszerkesztő) eszközben a jobb egérgombbal kattintással
elérhető menüpontok

A(z) 9. táblázat azokat a menüpontokat ismerteti, amelyek a Plate Editor (Lemezszerkesztő) eszközben
elérhetők, ha az eszközben bármely cellára rákattint a jobb egérgombbal. Ez a menü megjelenik a
Spreadsheet View/Importer (Táblázatos nézet/Importálás) eszközben is.

Tétel Funkció

Copy (Másolás) A teljes táblázat másolása.

Copy as Image
(Másolás képként)

A táblázat másolása képfájlként.

Print (Nyomtatás) A táblázat nyomtatása.

Print Selection (A
kiválasztott rész
nyomtatása)

Csak a kiválasztott cellák nyomtatása.

Export to Excel
(Exportálás Excel-
fájlba)

A fájl exportálása egy Excel-táblázatba.

Export to CSV
(Exportálás .csv
kiterjesztésű fájlba)

A fájl exportálása .csv kiterjesztésű fájlként.

Export to Xml
(Exportálás .xml
kiterjesztésű fájlba)

A fájl exportálása .xml kiterjesztésű fájlként.

Export to Html
(Exportálás .html
kiterjesztésű fájlba)

A fájl exportálása .html kiterjesztésű fájlként.

Find (Keresés) Meghatározott szöveg keresése.

Sort (Rendezés) A táblázat rendezése a Sort (Rendezés) ablakban legfeljebb
három adatoszlop kiválasztásával.

9. táblázat A lemezek Spreadsheet View/Importer (Táblázatos nézet / importálás)
eszközében a jobb egérgombbal kattintva elérhető menüpontok
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Opcionális paraméterek hozzárendelése a lemezfájlhoz
A lemezfájl az összes olyan cella tartalmára vonatkozó információkat tartalmaz, amelyekben egy
futtatáshoz minta található. A futtatás után a CFX Maestro Dx SE a cellatartalmakat összekapcsolja a
protokoll során rögzített fluoreszcenciaadatokkal, valamint alkalmazza a megfelelő elemzést a Data
Analysis (Adatelemzés) ablakban.

A CFX Maestro Dx SE programban Ön paramétereket rendelhet a lemezben található egyes cellákhoz a
kísérletek futtatása előtt, közben vagy akár után. A paramétereket egy meglévő lemezfájlhoz vagy egy új
lemezfájlhoz is hozzárendelheti. Ezek a paraméterek a következők:

n Target names (Célnevek) – az egyes betöltött cellákban található vizsgált cél vagy célok (gének
vagy szekvenciák).

n Sample names (Mintanevek) – az egyes betöltött cellákban található mintának megfelelő azonosító
vagy állapot, például „mouse1” (1. egér), „mouse2” (2. egér) vagy „mouse3” (3. egér).

n Biological groups (Biológiai csoportok) – egy cellacsoportnak megfelelő azonosító vagy állapot,
például 0Hr (0 óra), 1Hr (1 óra) vagy 2Hr (2 óra).

Tipp: A célneveknek és a mintaneveknek és biológiai csoportoknak azonosnak kell lenniük a
cellákban ahhoz, hogy az adatokat össze lehessen hasonlítani a Data Analysis (Adatelemzés)
ablak Gene Expression (Génexpresszió) fülén. Minden névnél egyeznie kell a kis- és nagybetűs
írásmódnak, írásjeleknek és szóközöknek is. Például az „Aktin” nem ugyanaz, mint az „aktin”, a
„2óra” nem ugyanaz, mint a „2 óra”, az „Egér 1” pedig nem ugyanaz, mint az „egér1”. Az
egységes elnevezések biztosításához írja be a neveket a Kezdőlapon elérhető User > User
Preferences > Plate (Felhasználó > Felhasználói beállítások > Lemez) menüpont Libraries
(Könyvtárak) szakaszába.

n Technical replicates (Technikai replikátumok) – minden egyes cella, amelyet a minta és cél(ok)
ugyanazon kombinációja (vagyis az ismétlődő qPCR-reakciók) elemzésére használ.

n Dilution series (Hígítási sor) – ennyivel kell változnia a Standard mintatípus koncentrációjának egy
replikátumcsoporton belül ahhoz, hogy a rendszer létrehozza az elemezni kívánt standardgörbe-
adatokat.

Cél hozzárendelése cellákhoz
Tipp: Ugyanazt a célnevet egy vagy több cellához is hozzárendelheti. Ezenkívül több célt is
hozzárendelhet ugyanahhoz a cellához.

Fontos: Ha a cél hozzárendelése után az OK (Rendben) gombra kattint, a rendszer elmenti a
módosításokat, és a Plate Editor (Lemezszerkesztő) eszköztárban letiltja az Undo (Visszavonás)
elemet. Legyen körültekintő, amikor az OK gombra kattint.
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Cél hozzárendeléséhez egy cellához vagy cellacsoporthoz

1. A Plate Editor (Lemezszerkesztő) ablakban győződjön meg arról, hogy a cellához vagy a
cellacsoporthoz hozzárendelt egy mintatípust.

Bővebb információk a mintatípusok cellákhoz történő hozzárendeléséről: Mintatípusok kiválasztása
a(z) 141. oldalon.

2. A Plate (Lemez) panelen válassza ki a cellát vagy cellacsoportot:

n Ha csak egyetlen cellát szeretne kiválasztani, kattintson az adott cellára.

n Több, egymással szomszédos cella kiválasztásához kattintson egy cellára, majd húzza az
egérmutatót a célcellára.

n Több, egymással nem szomszédos cella kiválasztásához tartsa nyomva a Control billentyűt,
majd kattintson az egyes cellákra.

n Ha egy teljes oszlopot szeretne kiválasztani ugyanazzal a mintatípussal, kattintson az oszlop
számára.

n Ha egy egész sort szeretne kiválasztani, kattintson az adott sor számára.

3. A jobb oldali panelen válasszon ki egy nevet a Target Name (Cél neve) legördülő listáról minden
kiválasztott fluorofórhoz.

4. Ismételje meg a 3. lépést minden olyan cellánál vagy cellacsoportnál, amelyhez célt kell rendelnie.

Tipp: Az egyes kiválasztott fluorofórokhoz azonos vagy eltérő célneveket is hozzárendelhet.

5. A módosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.

Megjegyzés: ha a lemezt tévedésből módosította, kattintson az Undo (Visszavonás) elemre a
Plate Editor (Lemezszerkesztő) eszköztárban, mielőtt a módosítások elfogadásához az OK
gombra kattint.

Egy célnév eltávolításához

u Ha szeretne eltávolítani egy célnevet a kiválasztott cellából vagy cellacsoportból, törölje a jelölést az
adott cél Load (Betöltés) jelölőnégyzetéből.
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Fontos: Ha egy célnevet eltávolít egy cellából, a rendszer a célnévhez kapcsolódó fluorofórt is
eltávolítja. Legyen körültekintő, amikor egy célnevet eltávolít egy cellából.

Célnév hozzáadásához a listához

u Ha a legördülő listához szeretne hozzáadni egy célnevet, tegye a következők egyikét:

n Írjon be egy nevet a Target Name (Célnév) legördülő listába, majd nyomja le az Enter billentyűt.

Tipp: ha egy listához hozzáad egy célnevet, az a célnév az összes többi céllistában is
megjelenik.

n Kattintson a legördülő listától jobbra található zöld + szimbólumra, írjon be egy nevet a célhoz,
majd nyomja le az Enter billentyűt.

n Kattintson a User Preferences (Felhasználói beállítások) gombra az eszközsoron, és adja hozzá
a nevet a Target Names (Célnevek) könyvtárhoz a Plate (Lemez) fülön.

Fontos: A legördülő listában hozzáadott célnevek csak az aktuális lemezhez állnak
rendelkezésre, és csak akkor, ha a nevet egy cellához hozzárendeli, és a lemezkiosztást
elmenti. Ha a nevet nem rendeli hozzá egy cellához, és a lemez elrendezését nemmenti el, a
szoftver nemmenti el a nevet, így nem tudja majd használni. Ha egy célnevet állandó jelleggel
szeretne hozzáadni, a Target Names (Célnevek) könyvtárhoz is adja hozzá a User Preferences
(Felhasználói beállítások) párbeszédpanelen. A könyvtárhoz hozzáadott nevek akkor is
elérhetők lesznek, amikor később újból megnyitja a Plate Editor (Lemezszerkesztő) ablakot.
További információk: A lemezre vonatkozó alapértelmezett paraméterek beállítása a(z) 92.
oldalon.

Célnév törléséhez a listából

1. Az eszköztáron kattintson a User Preferences (Felhasználói beállítások) elemre.

Megjelenik a User Preferences (Felhasználói beállítások) párbeszédpanel és rajta a Plate (Lemez)
fül.

2. A Plate (Lemez) fülön található Target Names (Célnevek) könyvtárban válassza ki a törölni kívánt
nevet, majd nyomja meg a Delete (Törlés) billentyűt.

3. A módosítások mentéséhez és a User Preferences (Felhasználói beállítások) párbeszédpanelről
történő kilépéshez kattintson az OK gombra.

Fontos: Olyan célneveket nem lehet törölni, amelyeket korábban elmentett egy lemezfájllal. A
rendszer automatikusan eltávolítja a listából azokat az egyedi neveket, amelyeket Ön ugyan
hozzáad a Target Names (Célnevek) legördülő listához, de nem használja és nemmenti el őket
a lemezzel. Ha egy nevet töröl a Target Names (Célnevek) könyvtárból, a szoftver az adott nevet
véglegesen törli, így az a felhasználók számára nem lesz elérhető. Legyen körültekintő a
célnevek törlésénél.
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Mintanév hozzárendelése cellákhoz
Megjegyzés: Egy mintanév hozzárendeléséhez a kiválasztott cellákhoz legalább egy fluorofórt
hozzá kell rendelnie. Ha a kiválasztott cellák nincsenek hozzárendelve egy fluorofórhoz, a Sample
Names (Mintanevek) legördülő lista le van tiltva. A fluorofórok hozzárendelésével kapcsolatos
információk: Cél hozzárendelése cellákhoz a(z) 147. oldalon.

Tipp: minden cellához vagy cellacsoporthoz csak egy mintanevet rendelhet hozzá.

Egy mintanév hozzárendeléséhez egy cellához vagy egy cellacsoporthoz

1. A Plate Editor (Lemezszerkesztő) eszközben ellenőrizze, hogy a cellához vagy cellacsoporthoz
hozzá van-e rendelve egy fluorofór.

2. A Plate (Lemez) panelen válassza ki a cellát vagy a cellacsoportot.

3. A jobb oldali panelen válasszon ki egy nevet a Sample Names (Mintanevek) legördülő listából.

A szoftver automatikusan bejelöli a Load (Betöltés) jelölőnégyzetet.

4. Ismételje meg a 3. lépést mindegyik cellához vagy cellacsoporthoz, amelyhez hozzá kell rendelnie
egy mintanevet.

5. A módosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.

Megjegyzés: ha a lemezt tévedésből módosította, kattintson az Undo (Visszavonás) elemre a
Plate Editor (Lemezszerkesztő) eszköztárban, mielőtt a módosítások elfogadásához az OK
gombra kattint.

Mintanév eltávolításához

u Egy kiválasztott cellához vagy cellacsoporthoz tartozó mintanév eltávolításához szüntesse meg a
Load (Betöltés) jelölőnégyzet bejelölését.

Mintanév hozzáadásához a listához

u Mintanév hozzáadásához a legördülő listához végezze el az alábbiak egyikét:

n Írjon be egy nevet a Sample Names (Mintanevek) legördülő listába, és nyomja meg az Enter
gombot.
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n Kattintson a legördülő listától jobbra levő zöld + jelre, és írjon be egy nevet a mintához.

n Kattintson a User Preferences (Felhasználói beállítások) gombra az eszközsoron, és adja hozzá
a nevet a Sample Names (Mintanevek) könyvtárhoz a Plate (Lemez) fülön.

Fontos: A legördülő listában hozzáadott mintanevek csak az aktuális lemezhez állnak
rendelkezésre, és csak akkor, ha a nevet egy cellához hozzárendeli, és a lemezkiosztást
elmenti. Ha a nevet nem rendeli hozzá egy cellához, és a lemez elrendezését nemmenti el, a
szoftver nemmenti el a nevet, így nem tudja majd használni. Egy mintanév végleges
hozzáadásához adja hozzá a Sample Names (Mintanevek) könyvtárhoz is a User Preferences
(Felhasználói beállítások) párbeszédablakban. A könyvtárhoz hozzáadott nevek akkor is
elérhetők lesznek, amikor később újból megnyitja a Plate Editor (Lemezszerkesztő) ablakot.
További információk: A lemezre vonatkozó alapértelmezett paraméterek beállítása a(z) 92.
oldalon.

Egy mintanév törléséhez a listáról

1. Az eszköztáron kattintson a User Preferences (Felhasználói beállítások) elemre.

Megjelenik a User Preferences (Felhasználói beállítások) párbeszédpanel és rajta a Plate (Lemez)
fül.

2. A Sample Names (Mintanevek) könyvtárban a Plate (Lemez) fülön válassza ki a törölni kívánt nevet,
és nyomja meg a Delete (Törlés) gombot.

3. A módosítások mentéséhez és a User Preferences (Felhasználói beállítások) párbeszédpanelről
történő kilépéshez kattintson az OK gombra.

Fontos: Egy lemezfájllal elmentett mintanevek nem törölhetők. A Sample Names (Mintanevek)
listához hozzáadott és a lemezzel nem használt, illetve nem elmentett egyéni neveket a szoftver
automatikusan törli a legördülő listából. A Sample Names (Mintanevek) könyvtárból törölt
neveket a szoftver véglegesen törli, és többé nem állnak a felhasználók rendelkezésére. A
mintanevek törlésénél körültekintően kell eljárni.

Biológiai csoportok cellához rendelése
Megjegyzés: Biológiai csoport kijelöléséhez a kiválasztott cellákat legalább egy fluorofórhoz hozzá
kell rendelni. A fluorofór hozzárendelése bekapcsolja a Biológiai csoportok legördülő listát. A
fluorofórok hozzárendelésével kapcsolatos információk: Cél hozzárendelése cellákhoz a(z) 147.
oldalon.

Tipp: minden cellához vagy cellacsoporthoz egy biológiai csoportot rendelhet hozzá.
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Biológiai csoport hozzárendeléséhez egy cellához vagy cellacsoporthoz

1. A Plate Editor (Lemezszerkesztő) eszközben ellenőrizze, hogy a cellához vagy cellacsoporthoz
hozzá van-e rendelve egy fluorofór.

2. A Plate (Lemez) panelen válassza ki a cellát vagy a cellacsoportot.

3. A jobb oldali panelen válasszon a Biological Group (Biológiai csoport) legördülő listáról.

A CFX Maestro Dx SE automatikusan bejelöli a csoport Load (Betöltés) jelölőnégyzetét.

4. Ismételje meg a 3. lépést mindegyik cellához vagy cellacsoporthoz, amelyhez hozzá kell rendelni egy
biológiai csoportot.

5. A módosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.

Megjegyzés: ha a lemezt tévedésből módosította, kattintson az Undo (Visszavonás) elemre a
Plate Editor (Lemezszerkesztő) eszköztárban, mielőtt a módosítások elfogadásához az OK
gombra kattint.

Biológiai csoport eltávolítása

u Egy biológiai csoport eltávolításához a kiválasztott cellából vagy cellacsoportból szüntesse meg a
Load (Betöltés) jelölőnégyzete bejelölését.

Biológiai csoport felvétele a listára

u Biológiai csoport felvételéhez a legördülő listába tegye a következők egyikét:

n Írjon be egy nevet a Biological Group (Biológiai csoport) legördülő listába, és nyomja meg az
Enter gombot.

n Kattintson a legördülő listától jobbra levő zöld + jelre, és írjon be egy nevet a biológiai
csoporthoz.

n Kattintson a User Preferences (Felhasználói beállítások) gombra az eszközsoron, és adja hozzá
a nevet a Biological Names (Biológiai nevek) könyvtárhoz a Plate (Lemez) fülön.

Fontos: A biológiai csoportok a legördülő listához hozzáadott neve csak az aktuális lemezhez
érhető el, és kizárólag akkor, ha az adott nevet hozzárendeli egy cellához, és elmenti a lemez
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elrendezését. Ha a nevet nem rendeli hozzá egy cellához, és a lemez elrendezését nemmenti
el, a szoftver nemmenti el a nevet, így nem tudja majd használni. Egy biológiai csoport nevének
végleges hozzáadásához adja hozzá a Biological Names (Biológiai nevek) könyvtárhoz is a
User Preferences (Felhasználói beállítások) párbeszédablakban. A könyvtárhoz hozzáadott
nevek akkor is elérhetők lesznek, amikor később újból megnyitja a Plate Editor
(Lemezszerkesztő) ablakot. További információk: A lemezre vonatkozó alapértelmezett
paraméterek beállítása a(z) 92. oldalon.

Egy biológiai csoport nevének törlése a listából

1. Az eszköztáron kattintson a User Preferences (Felhasználói beállítások) elemre.

Megjelenik a User Preferences (Felhasználói beállítások) párbeszédpanel és rajta a Plate (Lemez)
fül.

2. A Biological Names (Biológiai nevek) könyvtárban a Plate (Lemez) fülön válassza ki a törölni kívánt
nevet, és nyomja meg a Delete (Törlés) gombot.

3. A módosítások mentéséhez és a User Preferences (Felhasználói beállítások) párbeszédpanelről
történő kilépéshez kattintson az OK gombra.

Fontos: A biológiai csoportok lemezfájllal elmentett neve nem törölhető. A szoftver
automatikusan törli a listából azokat a neveket, melyeket hozzáadott a Biological Group Names
(Biológiaicsoport-nevek) legördülő listához, és nem használta a lemezzel, valamint nem
mentette el a lemezhez. A Biological Group Names (Biológiaicsoport-nevek) könyvtárból törölt
neveket a szoftver véglegesen törli, és ezután nem állnak a felhasználók rendelkezésére. A
biológiai nevek törlésénél körültekintően kell eljárni.

Az összes biológiai csoport megtekintéséhez a lemezen

u Kattintson a Show Biological Groups (Biológiai csoportok megjelenítése) lehetőségre a lemezen levő
összes biológiai csoport megtekintéséhez.

Mindegyik csoportot egy adott szín jelöl; a Show Biological Groups (Biológiai csoportok
megjelenítése) gomb Hide Biological Groups (Biológiai csoportok elrejtése) gombbá változik.

Kattintson a Hide Biological Groups (Biológiai csoportok elrejtése) gombra a cellák színének az
eltüntetéséhez. Másik lehetőségként a lemezben levő bármelyik cellára rákattinthat a biológiai
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csoportok elrejtéséhez.

Technikai replikátumok számainak cellákhoz rendelése
Fontos: A technikai replikátumok számainak hozzárendeléséhez a kiválasztott celláknak azonos
cellatartalommal kell rendelkezniük. Ez azt jelenti, hogy a kiválasztott cellákban azonos
mintatípusnak és fluorofórnak kell lennie. Adott esetben további feltétel, hogy azonos cél- és
mintaneveknek, valamint azonos biológiai csoportnak kell tartoznia hozzájuk. Ha nem azonosak, a
CFX Maestro Dx SE nem engedélyezi ezt az opciót.

Technikai replikátumok számainak cellacsoporthoz rendeléséhez

1. A Plate Editor (Lemezszerkesztő) ablakban győződjön meg arról, hogy a cellacsoportban levő cellák
tartalma azonos.

2. A Plate (Lemez) panelen válassza ki a cél cellacsoportot.

3. Ha ugyanazt a replikátumszámot szeretné hozzárendelni az összes kiválasztott cellához, a jobb
oldali panelen található Replicate # (Replikátumszám) szakaszban írja be a replikátumszámot a
mezőbe, majd jelölje be a Load (Betöltés) elemet.

4. (Opcionális) Replikátumsorozat alkalmazása kiválasztott cellákhoz:

a. Kattintson a Technical Replicates (Műszaki replikációk) elemre. A Replicate # (Replikátumszám)
szakasz megváltozik, és a következő opciókat jeleníti meg:

n Replicate size (Replikátumméret) – a replikátumok egyes csoportjaiban található cellák
száma
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n Starting replicate # (Kezdő replikátumszám) – a replikátumsorozatban található első szám
a kiválasztott replikátumcsoporthoz

Megjegyzés: A CFX Maestro Dx SE alapértelmezés szerint a lemezben hozzárendelt
legutolsó technikai replikátum számánál eggyel nagyobb számot jeleníti meg a kezdő
replikátumszámként. Ha például a lemezben az utolsó technikai replikátum száma az ötös,
a soron következő kezdő szám a hatos lesz. A kezdő számot bármilyen számra
módosíthatja, amelyet még nem osztott ki.

n Betöltési irány (Horizontal /Vízszintes/ vagy Vertical /Függőleges/)

b. A paraméterek alkalmazásához a sorozathoz és a Replicate # (Replikátumszám) kijelzőhöz
történő visszatéréshez kattintson az Apply (Alkalmazás) elemre.

5. A módosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.

Megjegyzés: ha a lemezt tévedésből módosította, kattintson az Undo (Visszavonás) elemre a
Plate Editor (Lemezszerkesztő) eszköztárban, mielőtt a módosítások elfogadásához az OK
gombra kattint.

Egy cella eltávolításához egy replikátumsorozatból

u Válassza ki az eltávolítani kívánt cellát vagy cellacsoportot, majd törölje a Replicate # Load
(Replikátumszám betöltése) jelölőnégyzetből a jelölést.

Másik lehetőségként a Clear Replicate # (Replikátumszám törlése) elemre is kattinthat, ha szeretné
törölni a replikátumszámot a kiválasztott cellából vagy cellacsoportból.

Az összes technikai replikátum megtekintéséhez a lemezen

u Ha szeretné megtekinteni az összes technikai replikátumot a lemezen, kattintson a Show Technical
Replicates (Technikai replikátumok megjelenítése) elemre.

A rendszer az egyes csoportokat meghatározott színekkel jelzi, és a Show Technical Replicates
(Technikai replikátumok megjelenítése) gomb helyett a Hide Technical Replicates (Technikai
replikátumok elrejtése) gomb jelenik meg.

Ha szeretné törölni a cellákban található színt, kattintson a Hide Technical Replicates (Technikai
replikátumok elrejtése) elemre. Másik lehetőségként a lemezben található bármelyik cellára
kattinthat, ha el szeretné rejteni a technikai replikátumokat.

Hígítási sor hozzárendelése standard mintatípusokhoz
A korábban említetteknek megfelelően valamennyi Standard mintatípusú cellához hozzá kell rendelni egy
koncentrációértéket. Egy hígítási sor több Standard mintatípusú cellához is hozzárendelhető.
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Megjegyzés: Hígítási sor hozzárendeléséhez egy cellacsoporthoz a celláknak egy technikai
replikátumsorozatban kell lenniük. Információk a cellák replikátumsorozathoz való hozzáadásáról:
Technikai replikátumok számainak cellákhoz rendelése a(z) 154. oldalon.

Hígítási sor hozzárendelése Standard mintatípusú cellacsoporthoz

1. A Plate Editor (Lemezszerkesztő) eszközben ellenőrizze, hogy teljesülnek-e az alábbi
követelmények:

n A cellacsoport mintatípusa Standard.

n A csoportban levő összes cellához legalább egy fluorofór hozzá van rendelve, és mind ugyanazt
a fluorofórt tartalmazza.

n A csoportban levő összes cella ugyanabban a technikai replikátumsorozatban van.

Megjegyzés: a CFX Maestro Dx SE csak akkor engedélyezi a Dilution Series (Hígítási sor)
opciót, ha az összes kiválasztott cella eleget tesz ezeknek a követelményeknek.

2. A Plate (Lemez) panelen válassza ki a cél cellacsoportot.

3. A jobb oldali panelen levő Concentration (Koncentráció) részben kattintson a Dilution Series (Hígítási
sorok) gombra. A Concentration (Koncentráció) rész átvált az alábbi opciók megjelenítésére:

n Starting concentration (Kiindulási koncentráció) – az a koncentrációérték, amelytől a sorozat
kezdődik

n Replicates from and to (Replikátumok ettől eddig) – a sorozatban levő azon replikátumok,
amelyekre a hígítási faktort alkalmazni fogja

n Dilution factor (Hígítási faktor) – a koncentráció változtatásának mértéke az egyes
replikátumcsoportokban

4. Állítsa be az értékeket az opciókhoz, vagy fogadja el az alapértelmezett értékeket.

5. Alapértelmezés szerint a hígítási sorozat a hígítási faktorral csökken. A hígítási sorozat növeléséhez
válassza ki az Increasing (Növelés) lehetőséget.
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6. (Opcionális) A hígítási faktor alapértelmezés szerint a replikátumsorozatban levő összes fluorofórra
érvényes. Ha az Ön sorozata egynél több fluorofórt tartalmaz, és a hígítást egyetlen fluorofórra
akarja alkalmazni, válassza ki a legördülő listáról.

7. Kattintson az Apply (Alkalmaz) gombra a hígítási faktor alkalmazásához a cellacsoportra és a
Concentration (Koncentráció) nézetre történő visszalépéshez.

8. A módosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.

Cellatartalmak másolása egy másik cellába
Egy cella tartalmát kimásolhatja és beillesztheti egyetlen cellába vagy több cellába. Azonban csak
egyetlen cella tartalmát tudja kimásolni. Nem lehet több cellát kiválasztani és kimásolni a tartalmukat.

A cellák tartalmának bemásolásához egy másik cellába

1. A Plate (Lemez) panelen válassza ki a másolandó cellát.

2. A jobb gombbal kattintson a cellára, és válassza ki a Copy Well (Cella másolása) opciót.

3. Válassza ki azt a cellát vagy cellákat, ahová be kívánja illeszteni a tartalmat:

n Ha csak egyetlen cellát szeretne kiválasztani, kattintson az adott cellára.

n Több, egymással szomszédos cella kiválasztásához kattintson egy cellára, majd húzza az
egérmutatót a célcellára.

n Több, egymással nem szomszédos cella kiválasztásához tartsa nyomva a Control billentyűt,
majd kattintson az egyes cellákra.

4. Miközben a célcellák ki vannak választva, kattintson a jobb gombbal, és válassza ki a Paste Well
(Cella beillesztése) parancsot.

A CFX Maestro Dx SE beilleszti az első cella tartalmát a kiválasztott cellákba.

Megjegyzés hozzáadása egy cellához
Lehetősége van leíró megjegyzést hozzáadni az egyes cellákhoz. A cellákhoz tartozó megjegyzéseket a
Data Analysis (Adatelemzés) ablakban található Quantification (Kvantifikáció) fülön tekintheti meg.

Megjegyzés hozzáadásához egy cellához

1. A lemezpanelen válassza ki az(oka)t a cellá(ka)t, amely(ek)hez szeretne megjegyzést fűzni.

2. Az alsó panelen található View (Megtekintés) szakaszban válassza ki a Well Note (Megjegyzés a
cellához) elemet.

A Well Note (Megjegyzés a cellához) terület megjelenik a jobb oldali panelen.
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3. Írja be a megjegyzés tartalmát a szövegbeviteli mezőbe, majd nyomja le az Enter billentyűt.

A szöveg a kiválasztott cellák aljánál jelenik meg.

Tipp: ha korábban már létrehozott megjegyzést valamelyik cellához, kiválaszthatja a legördülő
listából, és alkalmazhatja a kiválasztott cellákra.

Összes tartalom törlése cellákból
Lehetősége van egyetlen cellából, több cellából vagy a teljes lemezből törölni az összes tartalmat. A
cellák kiürítésekor a lemezleolvasás során rögzített fluoreszcenciaadatokat nem törli a rendszer.

Fontos: Egy cella kiürítésekor a rendszer véglegesen törli a tartalmat a cellából. Ha egy cella ürítése
után rákattint az OK gombra és elmenti a lemezt, az ürítést nem lehet visszavonni. Legyen
körültekintő a cellák tartalmának törlésekor.

Összes beállítás törléséhez a cellákból

1. A Plate (Lemez) panel Plate Editor (Lemezszerkesztő) eszközén válassza ki a cellát vagy
cellacsoportot:

n Ha csak egyetlen cellát szeretne kiválasztani, kattintson az adott cellára.

n Több, egymással szomszédos cella kiválasztásához kattintson egy cellára, majd húzza az
egérmutatót a célcellára.

n Több, egymással nem szomszédos cella kiválasztásához tartsa nyomva a Control billentyűt,
majd kattintson az egyes cellákra.

n Ha egy teljes oszlopot szeretne kiválasztani ugyanazzal a mintatípussal, kattintson az oszlop
számára.

n Ha egy egész sort szeretne kiválasztani, kattintson az adott sor számára.

2. A jobb oldali panelen kattintson a Clear Wells (Cellák ürítése) elemre.

A CFX Maestro Dx SE az összes beállítást törli a kiválasztott cellákból.

3. Tegye az alábbiak egyikét:

n Ha a cellákat tévedésből ürítette, kattintson az Undo (Visszavonás) elemre a Plate Editor
(Lemezszerkesztő) eszköztárban, mielőtt a módosítások elfogadásához az OK gombra kattint.
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Fontos: Ha az Undo (Visszavonás) gombra kattintás előtt az OK gombra kattint, a rendszer
elmenti a módosításokat, és a Plate Editor (Lemezszerkesztő) eszköztárban letiltja az Undo
(Visszavonás) elemet.

n Amódosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.
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Kísérleti beállítások módosítása
Az Experiment Settings (Kísérlet beállításai) párbeszédpanelen megtekintheti vagy módosíthatja a célok,
minták és biológiai csoportok listáját, vagy ha a lemezben található cellákhoz biológiai csoportokat
rendelt, beállíthatja az elemezni kívánt génexpresszió-elemzési mintacsoportot.

Az Experiment Settings (Kísérleti beállítások) párbeszédpanel Targets (Célok) fülén az egyes PCR-
reakciókhoz kapcsolódó célnevek listája látható, ideértve például a célgént vagy a vizsgálandó
génszekvenciákat.

A Samples and Biological Groups (Minták és biológiai csoportok) fülön azoknak a mintáknak és biológiai
csoportoknak a nevei láthatók, amelyek a cél forrását jelzik (például egy 1 óra után /1 óra/ vagy egy
meghatározott alanytól /1. egér/ vett mintát).

Lemezbeállítások módosítása az Experiment Settings (Kísérleti beállítások)
párbeszédpanelen

1. Az Experiment Settings (Kísérleti beállítások) párbeszédpanel megnyitásához tegye a következők
egyikét:

n A Plate Editor (Lemezszerkesztő) ablak jobb oldali panelén kattintson az Experiment Settings
(Kísérleti beállítások) elemre.

n A Data Analysis (Adatelemzés) ablak Gene Expression (Génexpresszió) fülén kattintson az
Experiment Settings (Kísérleti beállítások) elemre.

Megjelenik az Experiment Settings (Kísérleti beállítások) párbeszédpanel és rajta a Targets (Célok)
fül tartalma.

160 | CFX Maestro Dx SE szoftver



Kísérleti beállítások módosítása

2. Ha új célt, mintát vagy biológiai csoportot szeretne hozzáadni, írja be a nevét a megfelelő fülön a
New (Új) szövegbeviteli mezőbe, majd kattintson az Add (Hozzáadás) elemre.

3. Ha szeretne egy vagy több célt, mintát vagy biológiai csoportot eltávolítani a listáról, a megfelelő
fülön jelölje be az adott elem jelölőnégyzetét a Select to Remove (Kijelölés eltávolításhoz)
oszlopban, majd kattintson a Remove checked item(s) (Bejelölt elem/ek/ eltávolítása)
lehetőségre.

4. A CFX Maestro Dx SE az NTC (sablon nélküli kontroll) mintatípust kizárja a génexpresszió-
elemzésből.

Ha az NTCmintatípusokat szeretné belefoglalni az elemzésbe, törölje a jelölőnégyzetéből a jelölést
az Exclude the following sample types (A következő mintatípusok kizárása) szakaszban. A megfelelő
jelölőnégyzet bejelölésével a következő mintatípusokat zárhatja ki:

n NRT (no reverse transcriptase, reverz transzkriptáz nélkül)

n Negative Control (Negatív kontroll)

n Positive Control (Pozitív kontroll)

n Standard

5. A Targets (Célok) fülön:

a. Ha szeretne kiválasztani egy célt a génexpresszióadat-elemzés referenciájaként, a Reference
(Referencia) oszlopban választhatja ki.

b. Ha az Analysis Settings (Elemzési beállítások) ablak Gene Expression (Génexpresszió) fülén
szeretné elrejteni azokat az elemzési beállításokat, amelyeket a rendszer alkalmazni fog, törölje
a Show Analysis Settings (Elemzési beállítások megjelenítése) jelölőnégyzetből a jelölést.

A szoftver elrejti a következő oszlopokat:

n Color (Szín)

n Show Chart (Diagrammutatása)

n Auto Efficiency (Automatikus hatásfok)

n Efficiency (%) (Százalékos hatásfok)

c. Ha szeretné megváltoztatni a cél megjelenítési színét a Gene Expression (Génexpresszió)
diagramon, kattintson a cél cellájára a Color (Szín) oszlopban, válasszon egy új színt a
megjelenő Color (Szín) párbeszédpanelen, majd kattintson az OK elemre.

d. A cél megjelenítéséhez a Gene Expression (Génexpresszió) diagramon a kiválasztott színnel
jelölje be a cél jelölőnégyzetét a Show Chart (Diagrammegjelenítése) oszlopban.
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e. A CFX Maestro Dx SE alapértelmezés szerint automatikusan kiszámítja egy cél relatív
hatásfokát, ha az adott cél adatai standard görbét tartalmaznak.

Ha egy korábban meghatározott hatásfokértéket szeretne használni, írja be az értéket a
cellájába az Efficiency (%) (Százalékos hatásfok) oszlopba, majd nyomja le az Enter billentyűt.
A CFX Maestro Dx SE törli az Auto Efficiency (Automatikus hatásfok) jelölőnégyzetet.

6. A Samples and Biological Groups (Minták és biológiai csoportok) fülön:

a. Ha szeretne kiválasztani egy mintát vagy egy biológiai csoportot a génexpressziós adatelemzés
kontroll mintájaként, jelölje be a jelölőnégyzetét a Control (Kontroll) oszlopban.

b. Ha a kontrollfeltételt szeretné hozzárendelni egy mintához vagy biológiai csoporthoz egy
futtatásnál, jelölje be a jelölőnégyzetét a Control (Kontroll) oszlopban.

c. Ha a Show Analysis Settings (Elemzési beállítások megjelenítése) jelölőnégyzet még nincs
bejelölve, a bejelölésével a Gene Expression (Génexpresszió) fülön megtekintheti vagy
módosíthatja azokat az elemzési paramétereket, amelyeket a rendszer alkalmazni fog. A
szoftver elrejti a Color (Szín) és a Show Chart (Diagrammegjelenítése) oszlopokat.

7. Az Experiment Settings (Kísérleti beállítások) párbeszédpanelen található paraméterek mentéséhez
és a Plate Editor (Lemezszerkesztő) ablakhoz történő visszatéréshez kattintson az OK gombra.
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Cellacsoportok létrehozása
A cellacsoportok cellák részhalmazaira osztanak egy lemezt, amelyek függetlenül elemezhetők a Data
Analysis (Adatelemzés) ablakban. A cellacsoportok beállítása után válasszon ki egyet a Data Analysis
(Adatelemzés) ablakban az adatok elemzéséhez független csoportként. Például állítson be
cellacsoportokat egy lemezben futtatott többszörös kísérletek elemzéséhez vagy mindegyik cellacsoport
elemzéséhez különböző standard görbékkel.

Megjegyzés: az alapértelmezett cellacsoport az All Wells (Összes cella).

Cellacsoportok létrehozásához

1. A Well Groups Manager (Cellacsoport-kezelő) megnyitásához végezze el az alábbiak egyikét:

n A Plate Editor (Lemezszerkesztő) eszköztárban kattintson aWell Groups (Cellacsoportok)
lehetőségre.

n A Data Analysis (Adatelemzés) ablakban kattintson a ManageWell Groups (Cellacsoportok
kezelése) lehetőségre.

Ekkor megjelenik a Well Groups Manager (Cellacsoport-kezelő) párbeszédpanel.

2. Új csoport létrehozásához kattintson az Add (Hozzáadás) parancsra. A legördülő menüben a csoport
neveként Group 1 (1. csoport) jelenik meg az első csoporthoz.
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3. Válassza ki a cellákat a cellacsoporthoz a Plate (Lemez) nézetben az egérrel a cellacsoportba
kattintva és a mutatót a cellacsoporton áthúzva. A kiválasztott cellák kék színnel jelennek meg a
Manager (Kezelő) ablakban.

4. (Opcionális) A csoport nevének módosításához válassza ki a nevét a legördülő menüből, és írjon be
egy új nevet.

5. (Opcionális) Cellacsoport törléséhez válassza ki a nevét a legördülő listából, és kattintson a Delete
(Törlés) parancsra.

6. Kattintson az OK gombra a befejezéshez és az ablak bezárásához, vagy kattintson a Cancel
(Mégse) gombra az ablak bezárásához a módosítások elmentése nélkül.

A Well Groups Manager (Cellacsoport-kezelő) eszközhöz a jobb egérgombbal
kattintással elérhető menüpontok

A 10. táblázat azokat a menüpontokat ismerteti, amelyek bármely cellára a jobb egérgombbal kattintva
elérhetők a Well Groups Manager (Cellacsoport-kezelő) párbeszédpanelen.

Tétel Funkció

Copy (Másolás) A cellák tartalmának másolása, amelyek azután
beilleszthetők egy másik cellába vagy cellákba.

Copy as Image (Másolás
képként)

A cellaválasztó nézet másolása képként.

Print (Nyomtatás) A cellaválasztó nézet nyomtatása.

Print Selection (A kiválasztott
rész nyomtatása)

Csak a kiválasztott cellák nyomtatása.

Export to Excel (Exportálás
Excel-fájlba)

Az adatok exportálása Excel-táblázatba.

Export to CSV (Exportálás .csv
kiterjesztésű fájlba)

Az adatok exportálása vesszővel tagolt dokumentumként.

Export to Xml (Exportálás .xml
kiterjesztésű fájlba)

Az adatok exportálása .xml kiterjesztésű
dokumentumként.

Export to Html (Exportálás .html
kiterjesztésű fájlba)

Az adatok exportálása .html kiterjesztésű
dokumentumként.

10. táblázat A Plate Editor (Lemezszerkesztő) Well Groups Manager (Cellacsoport-
kezelő) párbeszédpanelén a jobb gombbal kattintva elérhető menüpontok
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Jelstílusok módosítása
A lemezbeállítás során, valamint amikor egy futtatás folyamatban van, módosíthatja a sokszorozási jelek
színét és stílusát. Így azután könnyen megtekintheti a jeleket a valós idejű állapotot mutató ablakban,
miközben a rendszer rögzíti az adatokat.

A jelstílusok módosításához

1. Kattintson a Trace Styles (Jelstílusok) elemre a Plate Editor (Lemezszerkesztő) eszköztárban.

Megjelenik a Trace Styles (Jelstílusok) párbeszédpanel az aktuálisan megnyitott lemezhez. Például:

2. Ha egy adott fluorofór szerint szeretné megjeleníteni a jelstílusokat, válassza ki az adott fluorofórt a
Fluorophores (Fluorofórok) legördülő listából.

3. A jel megjelenítési formájának a módosításához:

a. Válassza ki a jel típusát a Wells (Cellák) legördülő listából.

b. Kattintson a színére a Color (Szín) oszlopban.

c. A megjelenő Color (Szín) párbeszédpanelen válasszon ki egy másik színt a jelhez, majd
kattintson az OK gombra.

A CFX Maestro Dx SE megjeleníti a cellatípus színváltozását a rácsban.

d. (Opcionális) Válasszon ki egy szimbólumot a jelhez a Symbols (Szimbólumok) legördülő
listából.
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4. A színkészlet gyors módosításához kattintson a kívánt elemre a Color Quick Set (Szín gyors
beállítása) szakaszban.

5. Ha a cellacímkéket szeretné megtekinteni a rácsban, válassza ki a címketípust a Well Labels
(Cellacímkék) szakaszban.

6. A módosítások mentéséhez kattintson az OK gombra, vagy a módosítások elvetéséhez kattintson a
Cancel (Mégse) gombra.
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Lemez megtekintése, exportálása és importálása táblázatos
formátumban

A Spreadsheet View/Importer (Táblázatos nézet / Importálás) eszköz táblázatos formátumban jeleníti
meg egy lemez tartalmát. A megjelenítőben az alábbiak szerint tekintheti meg, importálhatja és
exportálhatja a cellaadatokat.

A Spreadsheet Viewer (Táblázatmegjelenítő) használata a Plate Data
(Lemezadatok) exportálásához és importálásához

A táblázatmegjelenítőből exportálhatja: Target Names (Célnevek), Sample Name (Mintanév), Biological
Group Name (Biológiai csoportnév) és Well Notes (Megjegyzések a cellához). Az exportált sablon
tabulátorral tagolt formátumú, így a Microsoft Excel és a hasonló alkalmazások tudják kezelni. Ugyancsak
importálhat adatokat tabulátorral tagolt alkalmazásból egy előre meghatározott lemezbe egy kísérleti
információs fájlból.

A Spreadsheet View/Importer (Táblázatos nézet / Importálás) eszköz használatához

1. Hozzon létre és mentsen el lemezfájlokat (lásd Lemezfájl létrehozása a Plate Editor
(Lemezszerkesztő) eszközzel).

2. A Plate Editor (Lemezszerkesztő) eszköztárban kattintson a Spreadsheet View/Importer (Táblázatos
nézet / Importálás) fülre a Plate Spreadsheet View (Lemez táblázatos nézete) párbeszédpanel
megnyitásához.
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3. (Opcionális) Kattintson a Show Biological Set Name (Biológiai sor nevének mutatása) és a Show
Well Note (Mutassa a megjegyzést a cellához) mezőkre, hogy megjelenjenek azok az oszlopok a
Spreadsheet View (Táblázatos nézet) fülön és az exportált fájlban.

4. Kattintson az Export Template (Sablonexportálás) gombra, ha létre akar hozni egy üres sablont
Excel (.csv) formátumban. Az exportált fájl ugyanazt az elrendezést mutatja majd, mint a lemeze.

Tipp: Használja a lemezfájl nevét, amikor lemezfájlokat ment el, hogy a fájl könnyen
azonosítható legyen.

5. Töltesse ki az Excel fájljának mezőit a celláinak tartalmával.

Megjegyzés: Csak olyan oszlopban található cellák tartalmát szerkesztheti, amelynek a neve
mellett egy csillag (*) látható (például *Target Name /*Célnév, *Sample Name (Mintanév),
*Biological Group Name (biológiai csoportnév), *Well Note (Megjegyzés a cellához)).

Megjegyzés: Nem adhat hozzá értékeket a Standard Curve (standard görbe) és a Quantity
(mennyiség) oszlopokhoz az exportált Excel fájlban. Ha ezeket az adatokat akarja módosítani,
vissza kell lépnie a Plate editorba (Lemezszerkesztőbe) és a Settings (Beállítások) > Units
(Mértékegységek) menübe kell belépnie. A lemez futtatásának befejeződését követően az
ezekből a standardokból származó adatok az Ön által kiválasztott egységekkel megjelennek a
Data Analysis (Adatelemzés) ablak Quantification (Kvantifikáció) fülén látható Standard Curve
(Standard görbe) diagramon.

6. Importálja a kitöltött Excel fájlt vissza a Plate Editorba (Lemezszerkesztőbe) az Import gombra
kattintással. Az importált lemezadatok megjelennek a Plate Spreadsheet View (Lemezek táblázatos
nézete) ablakban.

Fontos: Ha több fluorofórja is van, akkor a 3–5. lépéseket minden egyes fluorofórra
vonatkozóan el kell végeznie a Flours List (Fluorlista) legördülő menüben a Plate Spreadsheet
View (Lemezek táblázatos nézete) ablakban.

7. Kattintson az OK gombra. Az új lemezadatok meg fognak jelenni a Plate Editor (Lemezszerkesztő)
ablakban.

Tipp: Megtekintheti azokat a menüpontokat, amelyek a Spreadsheet View/Importer (Táblázatos
nézet / importálás) eszközben elérhetők, ha az eszközben bármely cellára vagy bármely
táblázatcímre a Plate Spreadsheet (Lemeztáblázat) nézetben rákattint a jobb egérgombbal.
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Lemezelrendezés létrehozása a Plate Setup Wizard
(Lemezbeállítási varázsló) eszközzel

A Setup Wizard (Beállítási varázsló) eszközzel megadhatja a normalizált génexpresszió elemzéséhez
szükséges lemezelrendezési információkat, beleértve a következőket:

n Célnevek

n Mintanevek

n A célok és a minta helye a lemezen

n Referenciagén(ek)

n Kontroll minta

A Setup Wizard (Beállítási varázsló) eszközt futtatás előtt, közben és után is használhatja.

A Plate Setup Wizard (Lemezbeállítási varázsló) használata
Ez a rész ismerteti a lemezelrendezés létrehozását a lemez Setup Wizard (Beállítási varázsló)
eszközével. A lemezben levő egyes cellák tartalmának egyszerűbb megtekintéséhez kattintson a Zoom
plate (Lemezre közelítés) opcióra a Setup Wizard (Beállítási varázsló) felső részén.

Fontos: Ha visszatér az Auto layout (Automatikus elrendezés) fülre, miközben a Setup Wizard
(Beállítási varázsló) bármelyik fülén van, ez visszaállítja a lemez elrendezését. Legyen körültekintő,
amikor ezt a fület választja ki.

Tipp: az elrendezést a Tools > Clear Plate (Eszközök > Lemez kiürítése) parancs kiválasztásával
hozhatja alaphelyzetbe a Setup Wizard (Beállítási varázsló) ablakban.

A lemez Setup Wizard (Beállítási varázsló) eszközének használatához

1. Nyissa meg a Plate Editor (Lemezszerkesztő) ablakot.

2. A Setup Wizard (Beállítási varázsló) megnyitásához tegye a következők egyikét:

n Válassza ki az Editing Tools > Setup Wizard (Szerkesztőeszközök > Beállítási varázsló) ablakot.

n Kattintson a Setup Wizard (Beállítási varázsló) lehetőségre a Plate Editor (Lemezszerkesztő)
eszköztárban.

Megjelenik a Setup Wizard (Beállítási varázsló), az Auto layout (Automatikus elrendezés) fület
megjelenítve.
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3. Az Auto layout (Automatikus elrendezés) fülön végezze el az alábbiak egyikét:

a. Kattintson egy cellára a rácson, és az egeret húzza keresztbe és lefelé a lemezen annak a
területnek a meghatározására, ahová minta betöltését tervezi.

b. Írja be a betöltendő célok és minták számát.

Tipp: A célok és minták számának meg kell egyeznie a kiválasztott cellák számával. Ha a
beírt szám nem fér el a kiválasztott területre, módosítsa vagy a számokat, vagy a lemezen
kiválasztott területet. Megadható az elemek lemezen belül orientációja és csoportosítása.

c. (Opcionális) Módosítsa a lemez orientációját. Például beállíthatja a célokat oszlopokba, a
mintákat pedig sorokba, vagy csoportosíthat minták szerint.

d. Kattintson a Next (Tovább) gombra a Target names (Célnevek) fülre lépéshez.

Megjegyzés: Ha az Ön lemezelrendezése nem rendelkezik szabályos mintával, céljainak
manuális pozicionálásához használja a Target names (Célnevek) fület, vagy a minták lemezen
történő manuális pozicionálásához a Sample names (Mintanevek) fület. Több cella
kiválasztásához végezzen kattintást és húzást.

4. A Target names (Célnevek) fülön adja meg a célneveket a célcsoportokhoz:

a. Tegye az alábbiak egyikét:

n A célok átnevezéséhez csoport szerint állítsa be a Select by (Kijelölési szempont) opciót a
Target (Cél) értékre.
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n A célok átnevezéséhez cella szerint állítsa a Select by (Kijelölési szempont) opciót a Well
(Cella) értékre.

b. Válasszon ki egy célcsoportot vagy egy cellát a rácsban, és írjon be egy nevet a Target name
(Célnév) legördülő listába.

Tipp: Nyomja meg a Tab gombot a jobbra levő következő csoport vagy cella
kiválasztásához vagy az Enter gombot a lent levő következő csoport vagy cella
kiválasztásához. Másik lehetőségként több, nem egymás mellett levő cella kiválasztásához
a Target name (Célnév) és Sample name (Mintanév) füleken tartsa lenyomva a Control
gombot, és kattintson rá az egyes cellákra.

c. Kattintson a Next (Tovább) gombra a Sample names (Mintanevek) fülre történő továbblépéshez.

5. A Sample names (Mintanevek) fülön adjon meg mintaneveket a mintacsoportokhoz.

6. Kattintson a Next (Tovább) gombra a Reference Targets (Referenciacélok) fülre történő
továbblépéshez.

7. A Reference targets (Referenciacélok) fülön válasszon ki egy vagy több célt referenciának a
normalizált génexpresszióhoz, és kattintson a Next (Tovább) gombra a Control sample (Kontroll
minta) fülre való továbblépéshez.

8. A Control sample (Kontroll minta) fülön válasszon ki egy mintát kontrollnak a relatív génexpresszió-
számításokhoz.

9. Kattintson az OK gombra a lemezelrendezés elmentéséhez és Plate Editor (Lemezszerkesztő)
ablakba való visszatéréshez, ahol folytathatja a lemezparaméterek megadását. További információk:
Opcionális paraméterek hozzárendelése a lemezfájlhoz a(z) 147. oldalon.

Másik megoldásként kattintson a Previous (Előző) gombra egy korábbi fülre való visszatéréshez
bármilyen módosítás végrehajtásához.

Megjegyzés: Az Auto layout (Automatikus elrendezés) fülre való visszatérés automatikusan
alaphelyzetbe állítja a lemezt. Óvatosan járjon el a Previous (Előző) gomb megnyomásakor.
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9. fejezet Kísérletek futtatása
Ez a fejezet az egyedi (felhasználó által definiált) vagy PrimePCR-vizsgálatok futtatását ismerteti a CFX
Maestro Dx szoftver, Security Edition termékkel.

A futtatási adatfájlok protokoll- és lemezinformációkat tartalmaznak a futtatáshoz. A fájl azoknak az
elemzéseknek az adatait is tartalmazza, amelyeket a CFX Maestro Dx SE a futtatás befejezése után
végez el.

A CFX Maestro Dx SE szoftver megkönnyíti a felhasználó által definiált vagy PrimePCR-kísérletek
beállítását és futtatását. A Run Setup (Futtatás beállításai) ablak végigvezeti Önt egy kísérlet
beállításának a szokásos lépésein, és a Start Run (Futtatás indítása) párbeszédpanelre irányítja,
ahonnan elindíthatja a futtatást.
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A Run Setup (Futtatás beállításai) ablak
A Run Setup (Futtatás beállításai) ablak gyors hozzáférést biztosít egy kísérlet beállításához és
futtatásához szükséges fájlokhoz és opciókhoz. Ha Ön egy felhasználó által beállított kísérletet szeretne
futtatni, megnyílik a Run Setup (Futtatás beállításai) ablak és rajta a Protocol (Protokoll) fül. Ha
PrimePCR-kísérletet kíván futtatni, megnyílik a Run Setup (Futtatás beállításai) ablak és rajta a Start Run
(Futtatás indítása) fül.

Tipp: a PrimePCR-kísérletekkel kapcsolatban lásd: PrimePCR-kísérletek végzése a(z) 192. oldalon,
A Start Run (Futtatás indítása) fül a(z) 182. oldalon.
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1. A fülek végigvezetik Önt a kísérletek beállításának és futtatásának lépésein:

n Protocol (Protokoll) fül – egy meglévő protokoll kiválasztása futtatásra vagy
szerkesztésre, vagy egy új protokoll létrehozása a Protocol Editor
(Protokollszerkesztő) ablakban.

n Plate (Lemez) fül – egy meglévő lemez kiválasztása futtatásra vagy
szerkesztésre, vagy egy új lemez létrehozása a Plate Editor (Lemezszerkesztő)
ablakban.

n Start Run (Futtatás indítása) fül – a kísérlet beállításainak megtekintése, egy
vagy több műszerblokk kiválasztása, valamint a futtatás elkezdése.

2. A fő ablakban megjelennek az egyes fülekre vonatkozó opciók, amikor Ön
alkalmazza őket.

3. A navigálási gombok a Start Run (Futtatás indítása) fülre viszik Önt.

JELMAGYARÁZAT

A Run Setup (Futtatás beállításai) ablak megnyitása
A Run Setup (Futtatás beállításai) ablak megnyitásához

u Tegye az alábbiak egyikét:

n A Startup Wizard (Indítási varázsló) Run Setup (Futtatás beállításai) fülén kattintson a User-
defined (Felhasználó által meghatározott) vagy a PrimePCR elemre.

n A Home (Kezdőlap) ablakban található eszköztárban kattintson a User-defined Run Setup
(Felhasználó által meghatározott futtatás beállítása) vagy a PrimePCR Run Setup (PrimePCR-
futtatás beállítása) elemre.

n A Home (Kezdőlap) ablakban válassza ki a Run > User-defined Run (Futtatás > Felhasználó
által meghatározott futtatás) vagy a Run > PrimePCR Run (Futtatás > PrimePCR-futtatás)
elemet.
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A Protocol (Protokoll) fül
A Protocol (Protokoll) fülön az Ön által futtatni tervezett protokollfájl előnézeti képe látható. A protokollfájl
a műszer által hőmérsékleti lépésekre alkalmazandó instrukciókat, valamint a növekedési/csökkenési
sebességet, a mintatérfogatot és a fedélhőmérsékletet szabályozó műszerbeállításokat tartalmazza.

A szoftver alapértelmezés szerint a File Selection for Run Setup (Fájl kiválasztása a futtatás
beállításához) szakaszban meghatározott protokollt jeleníti meg a User > User Preferences (Felhasználó
> Felhasználói beállítások) párbeszédpanel Files (Fájlok) fülén. Az alapértelmezett protokollt
módosíthatja a User Preferences (Felhasználói beállítások) párbeszédpanelen. További információk: Az
alapértelmezett fájlbeállítások módosítása a(z) 89. oldalon.

A Protocol (Protokoll) fülön a következőket teheti:

n Új protokoll létrehozása és futtatása

n Meglévő protokoll kiválasztása és futtatása vagy szerkesztése

Bővebb információk a protokollok létrehozásáról és módosításáról: 7. fejezet, Protokollok létrehozása.

Új protokoll létrehozásához

1. A Protocol (Protokoll) fülön kattintson a Create New (Új protokoll létrehozása) elemre.

Megjelenik a Protocol Editor (Protokollszerkesztő).
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2. Új protokoll létrehozásához használja a Protocol Editor (Protokollszerkesztő) ablakot.

3. A protokoll mentéséhez, valamint a Run Setup (Futtatás beállításai) ablakban található Protocol
(Protokoll) fülre történő visszatéréshez kattintson az OK gombra.

4. Tekintse meg a protokoll adatait, majd tegye a következők egyikét:

n Ha az adatok helyesek, kattintson a Next (Tovább) elemre a Plate (Lemez) fülre történő
továbblépéshez.

n Ha az adatok helytelenek, kattintson az Edit Selected (Kijelölt protokoll szerkesztése) gombra a
Protocol Editor (Protokollszerkesztő) ablakhoz történő visszatéréshez. Módosítsa a protokollt,
mentse a módosításokat, majd a Protocol (Protokoll) fülön kattintson a Next (Tovább) elemre a
Plate (Lemez) fülre történő továbblépéshez.

Meglévő protokoll kiválasztása

1. A Protocol (Protokoll) fülön tegye a következők egyikét:

n Kattintson a Select Existing (Meglévő protokoll kiválasztása) elemre, majd lépjen egy meglévő
protokollhoz.

n Kattintson az Express Load (Expressz betöltés) elemre, és válasszon ki egy protokollt a
protokollok legördülő listájából.

Tipp: Lehetősége van protokollokat hozzáadni az Express Load (Expressz betöltés)
legördülő listához vagy eltávolítani onnan őket. További információk: Express Load
(Expressz betöltés) protokollok hozzáadása és eltávolítása.

2. Tekintse meg a protokoll adatait, majd tegye a következők egyikét:

n Ha az adatok helyesek, kattintson a Next (Tovább) elemre a Plate (Lemez) fülre történő
továbblépéshez.

n Ha az adatok helytelenek, kattintson az Edit Selected (Kijelölt protokoll szerkesztése) gombra a
Protocol Editor (Protokollszerkesztő) ablak megnyitásához. Módosítsa a protokollt, mentse a
módosításokat, majd a Protocol (Protokoll) fülön kattintson a Next (Tovább) elemre a Plate
(Lemez) fülre történő továbblépéshez.

Express Load (Expressz betöltés) protokollok hozzáadása és eltávolítása

Módosíthatja az Express Load (Expressz betöltés) legördülő lista tartalmát, amely a Protocol Editor
(Protokollszerkesztő) ablakban jelenik meg. Az ebben a listában szereplő protokollok a következő
mappában vannak elmentve:

c:\Felhasználók\Nyilvános\Nyilvános dokumentumok\Bio-Rad\CFX_
MDx\Felhasználók\<felhasználónév>\ExpressLoad\
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Az Express Load (Expressz betöltés) protokoll-lista módosításához

1. Keresse meg és nyissa meg az ExpressLoad mappát.

2. Tekintse át a protokollfájlokat (.pcrl) a mappában.

3. Végezze el az alábbiak valamelyikét:

n A legördülő listából történő eltávolításhoz törölje a protokollokat a mappából.

n A legördülő listához történő hozzáadáshoz másolja a protokollokat a mappába.
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A Plate (Lemez) fül
Megjegyzés: Ha a Protocol (Protokoll) fülön kiválasztott protokoll nem tartalmaz valós idejű PCR-
elemzésre vonatkozó lemezleolvasási lépést, a rendszer a Plate (Lemez) fület elrejti. A Plate
(Lemez) fül megtekintéséhez vegyen fel legalább egy lemezleolvasást a protokollba.

A Plate (Lemez) fülön megjelenik az Ön által betölteni tervezett lemezfájl előnézeti képe. Valós idejű
PCR-futtatás során a lemezfájl tartalmazza az egyes cellák tartalmának leírását, így a fluorofórokat, a
letapogatási módszert és a lemez típusát. A CFX Maestro Dx SE ezeket a leírásokat használja az
adatgyűjtéshez és elemzéshez.

A szoftver alapértelmezés szerint a File Selection for Run Setup (Fájl kiválasztása a futtatás
beállításához) szakaszban meghatározott lemezt jeleníti meg a User > User Preferences (Felhasználó >
Felhasználói beállítások) párbeszédpanel Files (Fájlok) fülén. Az alapértelmezett lemezt módosíthatja a
User Preferences (Felhasználói beállítások) párbeszédpanelen. További információk: Az alapértelmezett
fájlbeállítások módosítása a(z) 89. oldalon.

A Plate (Lemez) fülön a következőket teheti:

n Új lemez létrehozása és betöltése.

n Meglévő lemez kiválasztása és betöltése vagy szerkesztése.

Bővebb információk a lemezek létrehozásáról és módosításáról: 8. fejezet, Lemezek előkészítése.
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Új lemez létrehozásához

1. A Plate (Lemez) fülön kattintson a Create New (Új lemez létrehozása) elemre.

Megjelenik a Plate Editor (Lemezszerkesztő).

2. Új lemez létrehozásához használja a Plate Editor (Lemezszerkesztő) ablakot.

3. A lemez mentéséhez, valamint a Run Setup (Futtatás beállításai) ablak Plate (Lemez) fülére történő
visszatéréshez kattintson az OK gombra.

4. Tekintse meg a lemez adatait, majd tegye a következők egyikét:

n Ha az adatok helyesek, kattintson a Next (Tovább) elemre a Start Run (Futtatás indítása) fülre
történő továbblépéshez.

n Ha az adatok helytelenek, kattintson az Edit Selected (Kijelölt elemek szerkesztése) gombra a
Plate Editor (Lemezszerkesztő) ablakhoz történő visszatéréshez. Módosítsa a lemezfájlt,
mentse a módosításokat, majd a Plate (Lemez) fülön kattintson a Next (Tovább) elemre a Start
Run (Futtatás indítása) fülre történő továbblépéshez.

Meglévő lemezfájl kiválasztása

1. A Plate (Lemez) fülön tegye a következők egyikét:

n Kattintson a Select Existing (Meglévő lemez kiválasztása) elemre, majd tallózzon be egy
meglévő lemezfájlt.

n Kattintson az Express Load (Expressz betöltés) elemre, és válasszon ki egy lemezfájlt a
legördülő listából.

Tipp: Lehetősége van lemezeket hozzáadni az Express Load (Expressz betöltés) legördülő
listához vagy eltávolítani őket onnan. További információ: Express Load (Expressz betöltés)
lemezfájlok hozzáadása és eltávolítása.

2. Tekintse meg a lemez adatait, majd tegye a következők egyikét:

n Ha az adatok helyesek, kattintson a Next (Tovább) elemre a Start Run (Futtatás indítása) fülre
történő továbblépéshez.

n Ha az adatok helytelenek, kattintson az Edit Selected (Kijelölt elemek szerkesztése) gombra a
Plate Editor (Lemezszerkesztő) ablak megnyitásához. Módosítsa a lemezfájlt, mentse a
módosításokat, majd kattintson a Next (Tovább) elemre a Start Run (Futtatás indítása) fülre történő
továbblépéshez.

Express Load (Expressz betöltés) lemezfájlok hozzáadása és eltávolítása

A Plate Editor (Lemezszerkesztő) ablakban megjelenő Express Load (Expressz betöltés) legördülő lista
tartalmát módosítani lehet. A listában megjelenő lemezek a következő mappában vannak elmentve:

c:\Felhasználók\Nyilvános\Dokumentumok\Bio-Rad\CFX_MDx\Users\<felhasználónév>\ExpressLoad\
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A lemezfájlok Express Load (Expressz betöltés) listájának módosításához

1. Keresse meg és nyissa meg az ExpressLoad mappát.

2. Tekintse át a mappában található (.pltd kiterjesztésű) lemezfájlokat.

3. Tegye az alábbiak egyikét:

n A legördülő listából történő eltávolításhoz törölje a lemezfájlokat a mappából.

n A legördülő listához történő hozzáadáshoz másolja a lemezfájlokat a mappába.
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A Start Run (Futtatás indítása) fül
A Start Run (Futtatás indítása) fülön a futtatni kívánt kísérletre vonatkozó információk láthatók. Ezenkívül
megjeleníti az(oka)t a csatlakoztatott műszerblokko(ka)t, amely(ek)en Ön lefuttathatja a kísérletet.

A Start Run (Futtatás indítása) fülön a következőket teheti:

n A futtatásra vonatkozó részletes információk megtekintése, beleértve a kiválasztott protokollfájlt,
lemezfájlt és leolvasási üzemmódot.

n A futtatásra vonatkozó megjegyzések hozzáadása.

n Az összes csatlakoztatott műszer adatainak megtekintése, beleértve a futtatási állapotukat (futás
vagy üresjárat), a mintatérfogat µl mértékegységben kifejezett értékét, a fedél hőmérsékletét, az
emulációs üzemmódot, valamint az azonosítót vagy a vonalkódot (ha van).

Megjegyzés: Módosítani lehet, hogy mely oszlopok jelenjenek meg a Start Run on Selected
Blocks (Futtatás indítása a kiválasztott blokkokon) táblában. Bővebb információk: Adatok
módosítása a Selected Blocks (Kiválasztott tömbök) táblázatban a(z) 183. oldalon.

n Azon blokk(ok) kiválasztása, amelye(ke)n szeretné a futtatást elvégezni.

n A kiválasztott műszerek fedelének kinyitása vagy lezárása távolról.
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n A futtatás elindítása.

Adatok módosítása a Selected Blocks (Kiválasztott tömbök) táblázatban

Módosíthatja a Start Run on Selected Blocks (Futtatás indítása a kiválasztott blokkokon) táblában
megjelenő oszlopokat. Az alapértelmezett mintatérfogat és fedél hőmérsékletének értékeket szintén
módosíthatja a táblában. A beállítások módosításait a rendszer alkalmazza a végrehajtani kívánt
futtatásra.

Oszlopok hozzáadásához a Start Run on Selected Blocks (Futtatás indítása a kiválasztott
blokkokon) táblához

u A jobb egérgombbal kattintson a táblára, és válasszon ki egy lehetőséget a megjelenő menüben.

Oszlopok törléséhez a Start Run on Selected Blocks (Futtatás indítása a kiválasztott
blokkokon) táblából

u A jobb egérgombbal kattintson a táblára, és törölje az opciót a megjelenő menüben.

A mintatérfogat vagy a fedélhőmérséklet szerkesztéséhez egy blokknál

u Válassza ki a mintatérfogat vagy a fedélhőmérséklet mezőjét a célblokkhoz, és írjon be egy új értéket
a mezőbe.

Futtatásazonosító vagy vonalkód hozzáadásához a blokkhoz

u Válassza ki az ID/Bar Code (Azonosító/Vonalkód) mezőt a célblokkhoz, és írjon be egy azonosítót,
vagy szkennelje le a blokkot egy vonalkódolvasóval.

Kísérlet futtatása
Fontos: Egy kísérlet lefuttatása előtt ügyeljen arra, hogy a számítógépe vírusölő programja ne
kezdjen el ellenőrizni a futtatás közben. További információk: A CFX Maestro Dx SE szoftver
telepítése a(z) 34. oldalon, illetve forduljon a rendszergazdához.

Kísérlet futtatásához

1. A Start Run (Futtatás indítása) fülön ellenőrizze a lemez és protokoll adatait a Run Information
(Futtatási információk) részben.

2. (Opcionális) A futtatással vagy a kísérlettel kapcsolatos megjegyzéseket írja be a Notes
(Megjegyzések) szövegpanelbe.

3. Válassza ki egy vagy több blokk jelölőnégyzetét, amelyeken végre akarja hajtani a futtatást.

Tipp: ha az összes blokkon szeretné futtatni a kísérletet, válassza ki a Select All Blocks (Az
összes blokk kiválasztása) lehetőséget a Selected Blocks (Kiválasztott blokkok) táblázat alatt.
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4. (Opcionális) Kattintson a Flash Block Indicator (Blokkjelző villogtatása) opcióra a jelző LED villogtatásához
a kiválasztott műszerblokkoknál.

5. Tegye be a kísérleti lemezeket a blokkba:

a. Kattintson az Open Lid (Fedél felnyitása) gombra. A kiválasztott blokkok motoros fedele felnyílik.

b. Tegyen egy kísérleti lemezt minden kiválasztott blokkba.

c. Kattintson a Close Lid (Fedél lezárása) gombra.

Tipp: a CFX Opus Dx rendszereken érintse meg a Kezdőképernyőn a Fedél felnyitása vagy
Fedél lezárása lehetőséget.

6. Kattintson az Open Lid (Fedél felnyitása) és a Close Lid (Fedél lezárása) gombra az egyes
kiválasztott műszerblokkok motoros fedelének felnyitásához vagy lezárásához.

7. Tekintse meg a futtatás adatait, majd végezze el a következők egyikét:

n Ha az adatok helyesek, kattintson a Start Run (Futtatás indítása) opcióra.

n Ha az adatok nem helyesek:

o Helyesbítse az adatokat a Selected Blocks (Kiválasztott blokkok) táblázatban, majd
kattintson a Start Run (Futtatás indítása) gombra.

o Térjen vissza a megfelelő fülre, és hajtsa végre a szükséges módosításokat, mentse el
őket, kattintson a Next (Tovább) gombra a Start Run (Futtatás indítása) fülre való
visszatéréshez, és indítsa el a futtatást.

Új futtatás elindításához egy korábbi futtatásból

u Tegye az alábbiak egyikét:

n Válassza ki a File > Repeat a Run (Fájl > Futtatás megismétlése) lehetőséget a szoftver fő
menüsorából; lépjen a megismételni kívánt futtatási fájlra, és kattintson rá duplán.

n Válassza ki a Repeat Run (Futtatás megismétlése) fület a Startup Wizard (Indítási varázsló)
ablakban, és kattintson duplán a megismételni kívánt futtatás futtatási adatfájljára.

Opcionálisan a Repeat Run (Futtatás megismétlése) fülön rákattinthat a Browse (Böngészés)
gombra, és a megismételni kívánt adatfájlra lépve duplán rákattinthat.
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A Run Details (Futtatás részletei) párbeszédpanel
Amikor a Start Run (Futtatás indítása) parancsra kattint, a CFX Maestro Dx SE szoftver felszólítja az
adatfájl (.pcrd) elmentésére, elindítja a futtatást, és megnyitja a Run Details (Futtatás részletei)
párbeszédpanelt. A Run Details (Futtatás részletei) párbeszédpanel három állapotjelző fülből áll:

n Run Status (Futtatás állapota) – ezt a fület a protokoll aktuális állapotának megtekintésére, a fedél
felnyitására vagy lezárására, a futtatás szüneteltetésére, ismétlések hozzáadására, lépések
kihagyására vagy a futtatás megállítására használhatja.

n Real-time Status (Valós idejű státusz) – ezt a fület a valós idejű PCR fluoreszcenciaadatainak
rögzítésével egyidejűleg történő megtekintésére használhatja.

n Time Status (Időstátusz) – ezt a fület a protokoll teljes képernyős visszaszámlálójának
megtekintésére használhatja.

Ezeket a füleket a későbbi szakaszokban részletesen ismertetjük.

A Run Status (Futás állapota) fül
A Run Status (Futtatás állapota) fülön egy folyamatban lévő futtatás aktuális állapota látható. Ezenkívül
ezen a nézeten vezérelheti a fedelet és módosíthatja a folyamatban lévő futtatást.
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1. Run Status (Futtatás állapota) panel – a protokoll aktuális előrehaladási állapotát
jeleníti meg.

2. Run Status (Futtatás állapota) vezérlőelemek – lehetővé teszik a műszer
működtetését vagy az aktuális protokoll félbeszakítását.

3. Run Information (Futtatási információk) panel – a futtatás részleteit jeleníti meg.

JELMAGYARÁZAT

A Run Status (Futtatás állapota) fülön található parancsok

A Run Status (Futtatás állapota) fülön található parancsokat a készülék a szoftverről történő
működtetéséhez vagy a folyamatban levő futtatás módosításához használhatja.

Megjegyzés: A protokoll módosítása egy futtatás közben (pl. ismétlések hozzáadása) nem
változtatja meg a futtatáshoz rendelt protokollfájlt. Ezeket a műveleteket a Run Log (Futtatási napló)
rögzíti.

– felnyitja a motoros fedelet a kiválasztott műszereken.

Fontos: A fedél felnyitása futtatás közben szünetelteti a futtatást az aktuális lépésben, és
megváltoztathatja az adatokat. A Run Status (Futtatás állapota) fülön található parancsok a(z) 186.
oldalon.

– lezárja a motoros fedelet a kiválasztott műszereken.

– több ismétlést ad hozzá az aktuális GOTO (LÉPJ) lépéshez a protokollban. Ez az opció csak
akkor elérhető, ha fut egy GOTO (LÉPJ) lépés.

Megjegyzés: Amikor a protokoll folyamatban van, további ismétléseket is felvehet egy GOTO
ciklus végrehajtása közben. Azonban A CFX Maestro Dx SE az ismétlések számának legújabb
változását ismeri fel. Például ha 10 további ismétlést vesz fel egy GOTO ciklus közben, a
szoftver a teljes számot n + 10-re változtatja. Ha ezután további öt (5) ismétlést vesz fel
ugyanebben a ciklusban, a CFX Maestro az ismétlések teljes számát n + 5-re változtatja. Az
első változtatást (10 ismétlés) figyelmen kívül hagyja. Annak biztosításához, hogy a szoftver
elvégezze a célzott ismétlések számát, írja be a teljes számot (ebben az esetben 15 ismétlés).

– kihagyja az aktuális lépést a protokollban.
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Megjegyzés: Ha egy GOTO lépés során ugrást kezdeményez, a rendszer a következő
ismétlésre ugrik a GOTO ciklusban. Ha a GOTO lépés utolsó ciklusa volt folyamatban az ugrás
idején, a rendszer a következő lépésre ugrik.

– a kiválasztott műszeren villogtatja a LED-et, azonosítva a kiválasztott blokkokat.

– szünetelteti a protokollt.

Megjegyzés: ezt a műveletet a Run Log (Futtatási napló) rögzíti.

– folytat egy szüneteltetett protokollt.

– megállítja a futtatást a protokoll vége előtt.

Megjegyzés: ha egy futtatást a protokoll vége előtt megállít, megváltoztathatnak a kapott
adatok.

A műszer fedelének felnyitása a PCR futtatása alatt

Ha bármely műszer fedelét felnyitják, miközben fut egy PCR, a(z) CFX Maestro Dx SE a következő
párbeszédpanelt jeleníti meg:

A párbeszédpanel megjelenésekor a műszer továbbra is futtatja a protokollt. Az OK gomb szünetelteti a
működést, a műszer fedelének zárszerkezete kiold és a fedél kinyílik. A Cancel (Mégse) gomb bezárja a
párbeszédpanelt, és a működés folytatódik.
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A Real-time Status (Valós idejű státusz) fül
A Real-time Status (Valós idejű státusz) fül az egyes ciklusoknál a futtatás közben az első két lemez
leolvasása után rögzített valós idejű PCR-adatokat jeleníti meg.

1. Sokszorosítási jelvonal panel – valós idejű sokszorosítási adatokat jelenít meg a
futtatás közben.

2. Cellacsoport-azonosító – ha cellacsoportokat hozott létre a lemez beállítása során,
a felhasználók kiválaszthatnak egy specifikus cellacsoportot a jelvonalak, cellák és
táblázatos információk megtekintéséhez.

Lépésszám-azonosító – ha a protokoll egynél több lépésnél rögzít adatokat (pl. a
sokszorosítás és olvadási görbe során), a felhasználók kiválaszthatnak egy
specifikus lépést, és megtekinthetik az annál a lépésnél rögzített jelvonalakat.

3. Cellaválasztó panel – megjeleníti a lemezben levő aktív, inaktív és üres cellákat.

4. Lemezbeállítás panel – a lemezbeállításokat mutatja táblázatos formában.

JELMAGYARÁZAT
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5. Futtatás részletei panel – a futtatás valós idejű státuszát jeleníti meg, amely a
következőkből áll:

n Aktuális lépés

n Aktuális ismétlés

n Aktuális hőmérséklet

n Hátralevő idő

n Aminta hőmérséklete

n A fedél hőmérséklete

6. Lemezbeállítás – megnyitja a Lemezbeállítás párbeszédpanelt, amelyben a
felhasználók futtatás közben módosíthatják az aktuális lemezbeállításokat.

A Real-time Status (Valós idejű státusz) fülön a következőket végezheti el:

n Megjeleníthet vagy elrejthet valós idejű jelvonalakat a lemezszerkesztő táblán vagy a lemezbeállító
táblán kiválasztva őket.

n Megtekinthet egyes jelvonalakat vagy jelvonalcsoportokat a cellacsoport legördülő listában való
kiválasztásukkal.

n Szerkesztheti a lemezt vagy kicserélheti a lemezfájlt.

n Egy PrimePCR-fájlt alkalmazhat a futtatáshoz.

Valós idejű jelek megjelenítése vagy elrejtése

Alapértelmezés szerint minden betöltött cella aktív, és megjelenik a lemezbeállítás táblázatában. Az aktív
cellák kék színnel jelennek meg a cellaválasztó panelen. Az elrejtett cellák világosszürke színnel, a nem
használt cellák pedig sötétszürke színnel jelennek meg a cellaválasztó panelen.

A futtatás során elrejtheti az aktív cellákhoz tartozó jelvonalakat. A CFX Maestro Dx SE továbbra is rögzíti
minden cella adatait; ha elrejti a cellákat, az adataik nem jelennek meg a lemezbeállítási táblában.

Valós idejű jelvonalak elrejtéséhez

u A cellaválasztó panelen kattintson az elrejteni kívánt aktív (kék színű) cellákra.

Valós idejű jelvonalak megjelenítéséhez

u A cellaválasztó panelen kattintson a megjeleníteni kívánt elrejtett (világosszürke színű) cellákra.

A cellaválasztóval kapcsolatos további információk: Cellaválasztó a(z) 211. oldalon.
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Lemezbeállítás szerkesztése

Lemezbeállítás szerkesztéséhez

u Kattintson a Plate Setup (Lemezbeállítás) elemre, majd válassza ki a View/Edit Plate (Lemez
megtekintése/szerkesztése) elemet.

Megjelenik a Plate Editor (Lemezszerkesztő) ablak, amelyben szerkesztheti a lemezt, miközben a
futtatás folyamatban van. Bővebb információk a lemezek szerkesztéséről: 8. fejezet, Lemezek
előkészítése.

Megjegyzés: A Plate Editor (Lemezszerkesztő) ablakból a jelstílusokat is szerkesztheti. A
változások megjelennek a sokszorosítási jel grafikonján a Real-time Status (Valós idejű státusz)
fülön.

Lemezfájl cseréje

Tipp: egy lemezfájl cseréje különösen akkor lehet hasznos, ha úgy indít el egy futtatást, hogy az
ExpressLoad (Expressz betöltés) mappában egy Quick Plate (Gyors lemez) fájl található.

Lemezfájl cseréjéhez

u Kattintson a Plate Setup (Lemezbeállítás) elemre, majd válassza ki a következő lehetőségek egyikét:

n Lemezfájl cseréje – válassza ki az új lemezfájlt a tallózóablakban látható listából.

n Egy PrimePCR-fájl alkalmazása – a Smart search (Intelligens keresés) funkcióval keressen egy
olyan futtatási fájlt, amelyből a szoftver a lemezelrendezést lekérdezi, vagy a Browse (Tallózás)
elemre kattintva keressen egy olyan fájlt, amelyet Ön a Bio-Rad webhelyéről letöltött, és nem a
PrimePCRmappában található.

Megjegyzés: A CFX Maestro Dx SE ellenőrzi a lemezfájlra vonatkozó leolvasási üzemmódot és
a lemezméretet. Ezeknek azonosnak kell lenniük azokkal a futtatási beállításokkal, amelyekkel a
futtatást elindította.
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A Time Status (Időstátusz) fül
A Time Status (Időstátusz) fülön az aktuális futtatás befejeződéséig hátralévő idő látható.
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PrimePCR-kísérletek végzése
A PrimePCR-kísérletek a Bio-Rad által laboratóriumi kísérletekben validált és optimalizált útvonal- vagy
betegségspecifikus vizsgálatokat használnak, amelyek a következő formátumokban állnak
rendelkezésre:

n Lemezekkel előre ellátott panelek – egy biológiai útvonalra vagy betegségre vonatkozó, specifikus
vizsgálatokat tartalmazó lemezek; ilyenek például a PrimePCR-kontrollok és a referenciagének.

n Egyedileg konfigurált lemezek – olyan lemezek, amelyeket a felhasználó által definiált elrendezéssel
lehet beállítani, és lehetőséget biztosítanak arra, hogy kiválassza a vizsgálatot a vizsgált célokhoz,
kontrollokhoz és referenciákhoz.

n Egyéni vizsgálatok – egyéni primerkészleteket tartalmazó, valós idejű reakciókban használható
kémcsövek.

A teljes futási idő csökkentéséhez eltávolíthatja az olvadási lépést a protokollból. A Bio-Rad határozottan
ajánlja, hogy semmilyen egyéb módosítást ne végezzen a PrimePCR-futtatási protokollban. Az
alapértelmezett protokoll az, amelyet a vizsgálat validálására használtak. Bármiféle ettől való eltérés
befolyásolhatja az eredményeket. A protokollmódosítások a kapott adatfájl Run Information (Futtatási
információk) fülén, valamint minden létrehozott jelentésben be vannak jegyezve.

Egy PrimePCR-futtatás elindításához

u Egy PrimePCR-futtatás elindításához végezze el az alábbiak bármelyikét:

n A Startup Wizard (Indítási varázsló) ablakban válassza ki a PrimePCR opciót a Run Setup
(Futtatás beállításai) fülön, majd válassza ki a megfelelő kémiát) (SYBER® vagy szonda).

n Válasszon ki egy PrimePCR-futtatást a Repeat Run (Futtatás megismétlése) fülön levő Recent
Runs (Legutóbbi futtatások) listából a Startup Wizard (Indítási varázsló) ablakban.

n Válassza ki a File > Open > PrimePCR Run File (Fájl > Megnyitás > PrimePCR-futtatási fájl)
lehetőséget a Home (Kezdőlap) ablakban.

n Húzzon egy PrimePCR-futtatási fájlt a Home (Kezdőlap) ablakba, majd engedje el.

Miután kiválasztott egy PrimePCR-futtatást, megnyílik a Run Setup (Futtatás beállításai) ablak a Start
Run (Futtatás indítása) fülön, a kiválasztott készüléknek megfelelő alapértelmezett PrimePCR-
lemezelrendezést betöltve.

Az olvadási lépés eltávolításához a protokollból

u A Protocol (Protokoll) fülön törölje az Include Melt Step (Olvadási lépés belefoglalása) opció melletti
jelölőnégyzetet.
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PrimePCR-kísérletek végzése

Célinformációk importálásához PrimePCR-lemezekhez egy lemezelrendezésbe

1. Tegye az alábbiak egyikét:

n A Real-time Status (Valós idejű státusz) fülön a Run Details (Futtatás részletei)
párbeszédablakban válassza ki a Plate Setup > Apply PrimePCR File (Lemezbeállítás >
PrimePCR-fájl alkalmazása) lehetőséget.

n A Data Analysis (Adatelemzés) ablakban válassza ki a Plate Setup > Apply PrimePCR File
(Lemezbeállítás > PrimePCR-fájl alkalmazása) lehetőséget.

2. A PrimePCR run file (PrimePCR-futtatási fájl) párbeszédpanelen kattintson a Browse (Böngészés)
gombra, és lépjen a megfelelő PrimePCR-fájlhoz (.csv).

3. Válassza ki a cél PrimePCR-fájlját, és kattintson az Open (Megnyitás) gombra.

A CFX Opus Dx rendszer a célinformációkat importálja a lemezelrendezésbe.
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Önálló adatok továbbítása elemzésre
Fontos: Ha adatfájlokat továbbít CFX Opus Dx rendszer műszerből a CFX Maestro Dx SE
szoftverbe, a rendszerre mentett összes fájl átkerül. Az adatok biztonságos továbbításához
győződjön meg arról, hogy elegendő lemezterület áll rendelkezésre a művelethez.

Amikor a futtatás befejeződik, a CFX Maestro Dx SE elemzi a fluoreszcenciaadatokat. Ha a futtatást
önálló üzemmódban végzi el, és a futtatás adatait magára a CFX Opus Dx rendszerre menti el, az
elemzés elvégzéséhez az adatokat továbbítani kell CFX Maestro Dx SE szoftvert futtató számítógépre.

A CFX Opus Dx rendszer összesen 100 valós idejű PCR-futtatást képes tárolni. Miután a futtatás
befejeződik, az önálló adatfájlokat e-mail-üzenetben, USB-meghajtón keresztül vagy magán a szoftveren
keresztül továbbíthatja a CFX Maestro Dx SE szoftvert futtató számítógépre.

A jelen szakaszban azt ismertetjük, hogy az önálló adatokat hogyan lehet továbbítani a CFX Maestro Dx
SE szoftvert futtató számítógépnek.

Adatok továbbítása e-mailben
Adatfájl elküldéséhez e-mailben a futtatás végén

1. Állítsa be az e-mail-értesítéseket a műszerhez.

Lásd: E-mail-értesítés beállítása a(z) 85. oldalon vagy a CFX Opus Dx valós idejű PCR-rendszer
kezelési kézikönyve.

2. Az e-mail-értesítések beállításakor ügyeljen arra, hogy az Attach Data File (Adatfájl csatolása) opció
be legyen jelölve.

A rendszer a futtatási adatokat .pcrd fájlként küldi el e-mailben.

Adatok átvitele a CFX Opus Dx valós idejű PCR-rendszerről
A CFX Opus Dx rendszer File Browser (Fájlböngésző) funkciójával adatfájlokat vihet ét egy csatolt USB-
meghajtóra vagy egy megosztott hálózati mappába. A CFX Maestro Dx SE protokollfájljait is átviheti egy
USB meghajtóról vagy megosztott hálózati meghajtóról a mappájába vagy a CFX Opus Dx rendszer
nyilvános mappájába, és futtathatja őket a CFX Opus Dx rendszeren.

Tipp: Ez a szakasz az adatok továbbítását ismerteti. Az Ethernet-kapcsolat beállításáról a CFX
Opus Dx valós idejű PCR-rendszer felhasználói kézikönyvében talál információkat, amely elérhető a
CFX Maestro Dx SE Súgó menüjében.
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Önálló adatok továbbítása elemzésre

1. A File Browser (Fájlböngésző) képernyő megjelenítéséhez a CFX Opus Dx rendszer
kezdőképernyőjén érintse meg a Files (Fájlok) elemet.

2. A File Browser (Fájlböngésző) képernyőn keresse meg a másolni kívánt fájlt, majd érintse meg a fájlt
a fájlrészletek ablaktáblájának megtekintéséhez.

3. A fájlrészletek ablaktábláján koppintson az Options (Opciók) elemre, majd a Copy (Másolás) elemre.

Megjelenik a Select Location (Hely kiválasztása) párbeszédpanel.

4. A Select Location (Hely kiválasztása) párbeszédpanelen tegye a következők egyikét:

n Navigáljon egy meglévő mappához.

n Navigáljon oda, ahol a fájl elmentéséhez létre szeretne hozni egy mappát, majd érintse meg a
Create Folder (Mappa létrehozása)

(  ) elemet új mappa létrehozásához ezen a helyen.

5. Koppintson a Select (Kiválasztás) gombra a fájl másolásához a kiválasztott helyre, vagy a Cancel
(Mégse) gombra koppintva térjen vissza a File Browser (Fájlböngésző) képernyőre.

Megjegyzés: Ha a kiválasztott helyen létezik azonos nevű fájl, megjelenik egy párbeszédpanel.
Érintse meg a Yes (Igen) gombot a meglévő fájl felülírásához vagy a No (Nem) gombot a File
Browser (Fájlböngésző) képernyőhöz való visszatéréshez.

A CFX Opus Dx rendszer megerősítő üzenetet jelenít meg, amikor a fájlt sikeresen átmásolta.

Felhasználói útmutató | 195



9. fejezet Kísérletek futtatása

Adatátvitel a CFX Maestro Dx szoftver, Security Editiontermékkel
Adatátvitelhez CFX Maestro Dx SE szoftveren keresztül

1. A Home (Kezdőlap) ablak Detected Instruments (Felismert készülékek) panelén kattintson a jobb
egérgombbal a kívánt műszerre, majd válassza ki a Retrieve Data Files (Adatfájlok lekérése) elemet.

A CFX Maestro Dx SE megjeleníti a Browse For Folder (Mappa tallózása) párbeszédpanelt.

2. A Browse For Folder (Mappa tallózása) párbeszédpanelen lépjen arra a helyre, ahova szeretné
elmenteni az adatfájlokat, majd kattintson az OK gombra.

A rendszer a továbbítási folyamat során a kiválasztott helyen létrehoz egy Real-Time Data (Valós
idejű adatok) nevű mappát. A rendszer a futtatási adatokat különálló (.zpcr kiterjesztésű) fájlokként
menti el a Real-Time Data (Valós idejű adatok) mappába.

Adatok továbbítása USB-meghajtó segítségével
Ha a műszeren található USB-portba egy USB-meghajtót helyez, a rendszer a futtatás befejeződésekor
automatikusan elmenti az adatfájlt az USB-meghajtó gyökérkönyvtárába. Ezenkívül megkereshet
korábban elmentett adatfájlokat is, és elmentheti őket a csatlakoztatott USB-meghajtóra.

Adatfájlok továbbításához USB-meghajtóra CFX Opus Dx rendszereken

u A Select Location (Hely kiválasztása) párbeszédpanelen érintse meg az USB elemet, és keresse
meg a célmappát, ahová át szeretné másolni a fájlt, vagy a Cancel (Mégse) gombra kattintva térjen
vissza a Fájlböngésző képernyőre.

Megjegyzés: Ha a kiválasztott helyen létezik azonos nevű fájl, megjelenik egy párbeszédpanel.
Érintse meg a Yes (Igen) gombot a meglévő fájl felülírásához vagy a No (Nem) gombot a File
Browser (Fájlböngésző) képernyőhöz való visszatéréshez.

A CFX Opus Dx rendszer megerősítő üzenetet jelenít meg, amikor a fájlt sikeresen átmásolta.
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Adatátvitel megosztott hálózati meghajtóval CFX Opus Dx valós
idejű PCR-rendszer termékeket használva
Tipp: megosztott hálózati meghajtóra/meghajtóról csak CFX Opus Dx rendszer műszerekkel lehet
adatokat átvinni.

A CFX Opus Dx rendszer műszerek lehetővé teszik, hogy Ethernet használatával csatlakozzon egy
megosztott hálózati meghajtóhoz. Sikeres kapcsolat esetén adatfájlokat vihet át a megosztott hálózati
meghajtón lévő mappába/mappából.

Adatok átviteléhez megosztott hálózati meghajtóra/meghajtóról

u A Select Location (Hely kiválasztása) párbeszédpanelen érintse meg a Network (Hálózat) elemet, és
keresse meg a célmappát, ahová át szeretné másolni a fájlt, vagy a Cancel (Mégse) gombra kattintva
térjen vissza a File Browser (Fájlböngésző) képernyőre.

Megjegyzés: Ha a kiválasztott helyen létezik azonos nevű fájl, megjelenik egy párbeszédpanel.
Érintse meg a Yes (Igen) gombot a meglévő fájl felülírásához vagy a No (Nem) gombot a File
Browser (Fájlböngésző) képernyőhöz való visszatéréshez.

A CFX Opus Dx rendszer megerősítő üzenetet jelenít meg, amikor a fájlt sikeresen átmásolta.

Adatfájl létrehozása
Aműszerről a CFX Maestro Dx SE szoftvert futtató számítógépre átvitt tömörített adatfájlt (.zpcr fájl)
adatfájlokká (.pcrd fájl) kell konvertálni. A CFX Maestro Dx SE a .zpcr fájlt .pcrd fájlokká konvertálja, majd
kiválaszt egy lemezfájlt, amelynél megegyezik a szkennelési üzemmód és a lemezméret, és alkalmazza
a .pcrd fájlra.

Adatfájl létrehozásához egy önálló adatfájlból

1. A CFX Maestro Dx SE szoftverben végezze el az alábbiak egyikét:

n Keresse meg a cél .zpcr fájlt, és húzza a CFX Maestro Dx SE HomeWindow (Kezdőlap)
ablakára.

n Válassza ki a File > Open > Stand-alone Run (Fájl > Megnyitás > Önálló futtatás) opciót, és
keresse meg és válassza ki a cél fájlt.

A CFX Maestro Dx SE megjeleníti a Save As (Mentés másként) párbeszédpanelt.

2. Lépjen abba a mappába, amelyikbe el szeretné menteni a .pcrd fájlt, és kattintson a Save (Mentés)
gombra.

A .pcrd fájl elmentése után a CFX Maestro Dx SE megnyitja a Data Analysis (Adatelemzés) ablakot,
és megjeleníti a kapott adatokat.
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10. fejezet Az adatelemzés áttekintése
A CFXMaestro Dx szoftver, Security Edition a valós idejű PCR-adatokat automatikusan feldolgozza az
egyes futtatások végén, és megnyitja a Data Analysis (Adatelemzés) ablakot az adatok (a .pcrd fájl)
megjelenítéséhez.

n Húzzon egy adatfájlt (.pcrd kiterjesztéssel) a Home (Kezdőlap) ablakba, és eressze el.

n Válassza ki a File > Open > Data File (Fájl > Megnyitás > Adatfájl) lehetőséget a Home (Kezdőlap)
ablakban, és menjen a cél .pcrd fájlhoz.

n Válassza ki a File > Recent Data Files (Fájl > Legutóbbi adatfájlok) lehetőséget a Home (Kezdőlap)
ablakban; itt a tíz legutóbb megnyitott adatfájl listájából választhat.

n Válassza ki az Analyze (Elemzés) fület a Startup Wizard (Indítási varázsló) ablakban, és válasszon a
Recent Files (Legutóbbi fájlok) listájából, vagy kattintson a Browse (Böngészés) gombra az adatfájl
megkereséséhez.

Data Analysis (Adatelemzés) ablak
A Data Analysis (Adatelemzés) ablakban több fül látható; az egyes füleken egy-egy meghatározott
elemzési módszerrel elemzett adatok, illetve a futtatásra vonatkozó információk láthatók. A fülek csak
akkor jelennek meg, ha a futtatás során rögzített adatok elérhetők az adott típusú elemzéshez.

Tipp: Amegjeleníteni kívánt füleket a Data Analysis (Adatelemzés) ablakban látható View
(Megtekintés) legördülő menüből választhatja ki. A fülek eredeti elrendezéséhez a Settings >
Restore Default Windows Layout (Beállítások > Alapértelmezett ablakelrendezés visszaállítása)
elem kiválasztásával térhet vissza.
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A Data Analysis (Adatelemzés) eszköztár
A Data Analysis (Adatelemzés) ablakban levő eszköztár gyors hozzáférést biztosít a fontos adatelemzési
funkciókhoz.

A 11. táblázat az eszköztárban levő gombok funkcióit sorolja fel.

Gomb Név Funkció

Plate Setup
(Lemezbeállítás)

View/Edit plate (Lemez
megtekintése/szerkesztése) – megnyitja a
Plate Editor (Lemezszerkesztő) eszközt a
cellák tartalmának megtekintéséhez és
szerkesztéséhez.

Replace Plate file (Lemezfájl kicserélése) –
kiválaszt egy lemezfájlt a lemezelrendezés
kicserélésére.

Apply PrimePCR file (PrimePCR-fájl
alkalmazása) – kiválaszt egy futtatási fájlt a
lemezelrendezés kicserélésére egy
PrimePCR-futtatáshoz.

ManageWell
Groups
(Cellacsoportok
kezelése)

Megnyitja a Well Groups Manager
(Cellacsoport-kezelő) ablakot cellacsoportok
létrehozásához, szerkesztéséhez és
törléséhez.

Well Group
(Cellacsoport)

Kiválaszt egy létező cellacsoportnevet a
legördülő menüből. Az alapértelmezett
választás az All Wells (Összes cella). Ez a
gomb csak akkor jelenik meg, ha létrehozott
cellacsoportokat.

Analysis Mode
(Analízis-üzemmód)

Az adatokat Fluorophore (Fluorofór) vagy
Target (Cél) üzemmódban elemzi.

Help (Súgó) Megnyitja a szoftver súgóját, ahol megtalálja
az online súgót és a kézikönyv digitális
példányát Acrobat PDF formátumban.

11. táblázat Eszköztár a Data Analysis (Adatelemzés) ablakban
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Data Analysis (Adatelemzés) ablak

Data Analysis (Adatelemzés) menüsor
A 12. táblázat a Data Analysis (Adatelemzés) ablakban lévő menüsor menüpontjait sorolja fel.

Menüpont Parancs Funkció

File (Fájl) Save (Mentés) Elmenti a fájlt.

Save As (Mentés másként) Elmenti a fájlt egy új néven.

Fájljelszavak Lehetővé teszi a felhasználók számára a fájlok
mentéséhez és megnyitásához szükséges
jelszavak beállítását.

Aláírás Lehetővé teszi a felhasználók számára az
adatfájl aláírását.

Futtatás megismétlése Az aktuális futtatásból kivonja a protokoll- és
lemezfájlt az újrafuttatáshoz.

Close (Bezárás) Bezárja a Data Analysis (Adatelemzés)
ablakot.

View
(Megtekintés)

Run Log (Futtatási napló) Megnyit egy Run Log (Futtatási napló) ablakot
az aktuális adatfájl futtatási naplójának
megtekintéséhez.

Auditnapló Megnyitja a fájl auditnaplóját.

Quantification, Melt Curve, Gene
Expression, End Point, Custom
Data View, QC, Run Information
(Kvantifikáció, Olvadási görbe,
Génexpresszió, Végpont,
Testreszabott adat nézet,
Minőség-ellenőrzés, Futtatási
információk)

Megjeleníti a vizsgált adatokat a kiválasztott
fülekben a Data Analysis (Adatelemzés)
ablakban. Legalább egy fület ki kell választani.

12. táblázat A Data Analysis (Adatelemzés) ablak menüsorának menüpontjai
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Menüpont Parancs Funkció

Beállítások Cq Determination Mode (Cq-
meghatározás üzemmód)

Kiválaszthatja a Regression (Regresszió)
vagy Single Threshold (Egyetlen küszöbérték)
üzemmódot, meghatározva, hogy a Cq-
értékeket a szoftver hogyan számítsa az
egyes görbékhez.

12. táblázat A Data Analysis (Adatelemzés) ablak menüsorának menüpontjai, folytatás
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Data Analysis (Adatelemzés) ablak

Menüpont Parancs Funkció

Baseline Setting (Kiindulási érték
beállítása)

Lehetővé teszi a Baseline Subtraction
(Alapérték kivonása) módszer kiválasztását a
megjelölt cellacsoportokhoz.

Analysis Mode (Analízis-
üzemmód)

Az adatok elemzését Fluorophore (Fluorofór)
vagy Target (Cél) szerint teszi lehetővé.

Vizsgálandó ciklusok Lehetővé teszi az elemezni kívánt ciklusok
kiválasztását.

Baseline Threshold (Kiindulási
küszöbérték)

Megnyitja a Baseline Thresholds (Kiindulási
küszöbértékek) ablakot a kiindulási érték vagy
a küszöbérték módosításához.

Trace Styles (Jelstílusok) Megnyitja a Trace Styles (Jelstílusok) ablakot.

Plate Setup (Lemezbeállítás) Megnyitja a Plate Editor (Lemezszerkesztő)
eszközt a lemez megtekintéséhez és
szerkesztéséhez; kicserélheti az aktuális
lemezt egy felhasználó által definiált
lemezfájlra vagy egy PrimePCR-futtatási
fájlra.

Include All Excluded Wells (Az
összes kizárt cella belefoglalása)

Az összes kizárt cellát belefoglalja az
elemzésbe.

Mouse Highlighting (Kiemelés
egérrel)

Be- vagy kikapcsolja az adatok egyidejű
kiemelését az egérmutatóval.

Tipp: ha a Mouse Highlighting (Kiemelés
egérrel) funkció ki van kapcsolva, nyomja
meg a Control gombot a kiemelés
ideiglenes bekapcsolásához.

Restore Default Window Layout
(Alapértelmezett ablakelrendezés
visszaállítása)

Az ablakok elrendezését visszaállítja az
alapértelmezett beállításra.

12. táblázat A Data Analysis (Adatelemzés) ablak menüsorának menüpontjai, folytatás
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Menüpont Parancs Funkció

Exportálás Az összes adatlap exportálása Lehetővé teszi annak kiválasztását, hogy a
program az összes táblázatnézetet exportálja
minden fülről egy .csv, .txt, Excel vagy .xml
fájlba.

Export RDML File (RDML-fájl
exportálása)

Lehetővé teszi az RDML 1.1 vagy 1.0
verziójának kiválasztását, amelybe a fájlt
exportálni kívánja.

Custom Export (Testreszabott
export)

Megnyitja a Custom Export (Testreszabott
export) ablakot, amelyben megadhatja az
exportálandó mezőket és a fájlformátumot.

Export to LIMS Folder (Exportálás
LIMS-mappába)

Megnyit egy ablakot az adatok elmentéséhez
az előre meghatározott formátumban a LIMS-
mappába.

Kézi exportálás Megnyit egy ablakot, ahol megadhatja, hová
szeretné elmenteni az összes táblázatnézet
adatait olyan Excel-fájlokba, amelyek
kimondottan a Seegene, Inc. és a Bio-Rad
Laboratories által használhatók.

Tipp: Exportáláskor automatikusan el is
indíthatja a Seegene Viewer programot.
További információk: A Tools (Eszközök)
menü parancsai a(z) 69. oldalon.

Tools (Eszközök) Reports (Jelentések) Megnyitja a jelentést az adott adatfájlhoz.

Well Group Reports (Cellacsoport-
jelentések)

Megnyitja a Well Group Report (Cellacsoport-
jelentés) ablakot, ahol meghatározott
cellacsoportokhoz lehet jelentéseket
létrehozni.

Import Fluorophore Calibration
(Fluorofórkalibrálás importálása)

Az aktuális adatfájlra alkalmazandó
kalibrációs fájl kiválasztása.

qbase+ A qbase+ v2.5 elindítása közvetlenül az
aktuális .pcrd fájlból, ha telepítve van.

LIMS PLRN fájl előállítása Az adatfájlt LIMS formátumú .plrn fájlként
menti.

12. táblázat A Data Analysis (Adatelemzés) ablak menüsorának menüpontjai, folytatás
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Data Analysis (Adatelemzés) ablak

A fülek
A Data Analysis (Adatelemzés) ablakban található összes fül diagramokon és táblázatokban jeleníti meg
az adatokat egy adott elemzési módszerhez, és tartalmaz egy cellaválasztót a megjeleníteni kívánt
adatok kiválasztásához. Kinyitásakor a Data Analysis (Adatelemzés) ablak alapértelmezettként a
Quantification (Kvantifikáció) fület jeleníti meg. Az Amplification (Sokszorosítás) diagramadatokat a
Quantification (Kvantifikáció) fülön a futtatáshoz megfelelő elemzési beállítások meghatározására
használhatja.

Megjegyzés: A szoftver a táblákban levő adatokat az egyes Data Analysis (Adatelemzés) fülekhez
kapcsolja. Például ha az egérmutatót a cellaválasztóban egy cella fölé helyezi, a szoftver az összes
többi táblában kiemeli az adatokat.

Step Number Selector (Lépésszámválasztó)
A CFX Opus Dx rendszer több protokoll-lépésben gyűjthet fluoreszcenciaadatokat; a szoftver az egyes
lépésekben rögzített adatokat önállóan tárolja. A(z) CFX Maestro Dx SE a lépésszámválasztót a
Kvantifikáció fülön a Standard görbe diagram alatt jeleníti meg. Ha egy protokoll tartalmaz legalább egy
adatgyűjtési lépést, a CFX Maestro Dx SE az első adatgyűjtési lépés adatait jeleníti meg.

Ha a protokoll egynél több adatgyűjtési lépést tartalmaz, a lépést kiválaszthatja egy legördülő listából.
Például:
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Ha kiválaszt egy lépést, a szoftver a választást a Data Analysis (Adatelemzés) ablakban megjelenített
összes adatra alkalmazza.

Cellacsoportok megtekintése a Data Analysis (Adatelemzés)
ablakban
A lemezben levő cellákat cellacsoportokkal részhalmazokba csoportosíthatja önálló elemzéshez. Ha
cellacsoportokat hoz létre, a csoportnevek megjelennek a Data Analysis (Adatelemzés) ablak Well
Groups (Cellacsoportok) legördülő listájában az eszköztáron.

Ha cellacsoportokat hozott létre, a szoftver az All Wells (Összes cella) alapértelmezett cellacsoportot
jeleníti meg a Data Analysis (Adatelemzés) ablak megnyitásakor, az összes olyan cellában levő adatokat
megjelenítve, amelyekben a diagramokban és táblázatokban szereplő tartalom található. A
cellaválasztóban csak a cellacsoportban levő olyan cellák jelennek meg, amelyekben van tartalom, és az
adatelemzések számításaiban csak az ezekből a cellákból származó adatok szerepelnek.

Tipp: a cellacsoportok létrehozásához, szerkesztéséhez és törléséhez kattintson a ManageWell
Groups (Cellacsoportok kezelése) gombra az eszközsorban.

Megjegyzés: ha nem hozott létre cellacsoportokat, a Well Groups (Cellacsoportok) legördülő lista
nem jelenik meg az eszköztárban.

Cellatartalmak módosítása futtatás után
Ha az adatelemzés során módosítja az adatok megjelenítését úgy, hogy megváltoztatja a cellák tartalmát
a Plate Editor (Lemezszerkesztő) ablakban, ez soha nemmódosítja a futtatás során az egyes cellákból
begyűjtött fluoreszcenciaadatokat. Miután a modul begyűjti a fluoreszcenciaadatokat, Ön ezeket az
adatokat nem tudja törölni, de a nézetből és az elemzésből eltávolíthatja az adatokat.

A cellák tartalmának a módosításához egy futtatás után

u A Data Analysis (Adatelemzés) ablakban kattintson a Plate Setup (Lemezbeállítás) lehetőségre, és
válasszon ki egyet az alábbi opciók közül:

n Edit/View Plate (Lemez szerkesztése/megtekintése) – megnyitja a Plate Editor
(Lemezszerkesztő) ablakot, amelyben kézzel módosíthatja az elrendezést.

n Replace Plate File (Lemezfájl cseréje) – a Select Plate (Lemez kiválasztása) böngésző
megnyitása, ahol megkereshet egy korábban elmentett lemezfájlt, amelyre a jelenlegi
lemezelrendezést szeretné lecserélni.

n Apply PrimePCR file (PrimePCR-fájl alkalmazása) – megnyitja a Select PrimePCR
(PrimePCR-fájl kiválasztása) fájlkiválasztó párbeszédpanelt, amelyben egy PrimePCR futtatási
fájlra léphet, és a fájlt alkalmazhatja a lemezelrendezésre.
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Data Analysis (Adatelemzés) ablak

Tipp: A cella tartalmára vonatkozó információkat vehet fel vagy szerkeszthet futtatás előtt, futtatás
közben vagy egy PCR-futtatás befejezése után is. A futtatás előtt hozzá kell rendelnie a szkennelési
üzemmódot és a lemezméretet. Ezek a paraméterek nem változhatnak a futtatás után.
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Adatelemzési beállítások
A Quantification (Kvantifikáció) fülön lévő Amplification (Sokszorosítás) diagram adatai a relatív
fluoreszcenciát (RFE) mutatják az egyes cellákhoz, minden ciklusban. A diagramon látható egyes jelek
egyetlen cellában található egyetlen fluorofór adatait jelzik. Ezek az adatok az egyes cellák Cq-értékeinek
a meghatározására használhatók fluorofóronként. A szoftver két üzemmódot tud használni Cq-értékek
meghatározására:

n Regression (Regresszió) – többváltozós, nem lineáris regressziós modellt alkalmaz az egyes cellák
jelére, majd a modell alapján kiszámítja az optimális Cq-értéket.

n Single Threshold (Egyetlen küszöbérték) – egyetlen küszöbértéket használ a Cq-érték
kiszámítására, az egyes fluoreszcenciagörbék küszöbérték-keresztezési pontja alapján.

Válassza ki a Settings > Cq Determination Mode (Beállítások > A Cq-meghatározás módja) a Cq-
meghatározás módjának kiválasztásához.

A küszöbérték módosítása
Single Threshold (Egyetlen küszöbérték) üzemmódban úgy módosíthat egy fluorofórra vonatkozó
küszöbértéket, hogy a küszöbérték vonalára kattint az Amplification (Sokszorosítás) diagramon, és
függőlegesen mozgatja az egér mutatóját. Másik megoldásként meghatározhat egy pontos keresztezési
küszöbértéket a kiválasztott fluorofórhoz.

Kiindulási értékbeállítások
A szoftver automatikusan, egyénileg beállítja a kiindulási értéket az egyes cellákhoz. A kiindulási érték
beállítása határozza meg azt, hogy a rendszer milyen kiindulási értékkivonási módszert alkalmaz az
összes fluoreszcenciajelhez. A szoftver három lehetőséget kínál a kiindulási értékek kivonásához:

n No Baseline Subtraction (Nincs kiindulási értékkivonás) – az adatok megjelenítése relatív
fluoreszcenciajelekként. Ebben az elemzési üzemmódban bizonyos elemzések nem végezhetők el,
ezért a szoftver a Gene Expression (Génexpresszió), End Point (Végpont) és Allelic Discrimination
(Alléldiszkrimináció) füleket nem jeleníti meg.

n Baseline Subtracted (Kiindulási érték kivonva) – az adatok megjelenítése a kiindulási érték
kivonását követő jelekként a cellákban található egyes fluorofórokhoz. A szoftvernek el kell végezni a
kiindulási érték kivonását az adatokon a kvantifikációs ciklusok meghatározásához, a standard
görbék felépítéséhez, valamint az ismeretlen minták koncentrációjának meghatározásához. A
szoftver olyan jel létrehozásához, ahol kivonta a kiindulási értékeket, a kiindulási ciklusok során
hozzáilleszti a legjobb egyenes vonalat az egyes cellákhoz rögzített fluoreszcenciaértékhez, majd a
legjobban illeszkedő adatokat kivonja a háttérben az egyes ciklusok során kivont adatokból.
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Adatelemzési beállítások

n Baseline Subtracted Curve Fit (A kiindulási értékek kivonásával kapott görbe illesztése) – az
adatok megjelenítése a kiindulási értékek kivonásával kapott jelekként; a szoftver egy
középpontosított középérték-szűrővel kisimítja a kapott görbét. A rendszer ezt a folyamatot azért
végzi el, hogy az egyes Cq értékek változatlanok maradjanak.

Ezeken a lehetőségeken kívül az Apply Fluorescent Drift Correction (Fluoreszcenciacsúszási korrekció
alkalmazása) funkciót is választhatja. Az olyan cellákhoz, ahol egy futtatás első pár ciklusa során
rendellenesen elcsúsznak az RFE-értékek, a szoftver egy becsült kiindulási értéket számít azokból a
szomszédos cellákból, amelyekhez sikerült vízszintes kiindulási értéket létrehozni.

A kiindulási értékkivonási beállítás módosításához

u Válassza ki a Settings > Baseline Setting (Beállítások > Kiindulási érték beállítása) elemet.

Analysis Mode (Analízis-üzemmód)
Az adatok fluorofór vagy célnév szerint csoportosíthatók és elemezhetők. Fluorofór szerinti csoportosítás
esetében a rendszer az adatjeleket fluorofórok szerint jeleníti meg, ahogy az az adott futtatásra vonatkozó
lemezbeállításban szerepel. Ha a sokszorosítási diagram alatt található megfelelő fluorofórválasztó
jelölőnégyzetek be vannak jelölve, az egyes fluorofórok adatai megjelennek a sokszorosítási és
standardgörbe-diagramon (ha elérhető).

Cél szerinti csoportosítás esetében a rendszer az adatjeleket az adott futtatásra vonatkozó
lemezbeállításban beírt célnév szerint jeleníti meg.

Adatelemzési mód kiválasztásához

u Tegye az alábbiak egyikét:

n Válassza ki a Settings > Analysis Mode (Beállítások > Analízis-üzemmód) elemet.
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n Válasszon ki egy üzemmódot az eszköztárban található Analysis Mode (Analízis-üzemmód)
legördülő listából.

Vizsgálandó ciklusok
Az elemezni kívánt ciklusok számát korlátozni lehet. Ezen kívül arra is lehetősége van, hogy
meghatározott ciklusokból származó adatokat elemezzen. Az elemezhető ciklusok maximális száma 50.

Megjegyzés: ha egy futtatás elejéről ciklusokat távolít el, ez jelentős hatással lehet a kiindulási érték
meghatározására.

Az adatelemzés korlátozásához meghatározott ciklustartományra

1. Válassza ki a Settings > Cycles to Analyze (Beállítások > Vizsgálandó ciklusok) elemet.

Megjelenik a Cycles to Analyze (Vizsgálandó ciklusok) párbeszédpanel.

2. Írja be a kezdési és a befejezési ciklusértékeket, majd kattintson az OK gombra.

Ha szeretne visszatérni az elemzéshez eredetileg használt ciklusokhoz, a Cycles to Analyze
(Vizsgálandó ciklusok) párbeszédpanelen kattintson a Restore Defaults (Alapértelmezett értékek
visszaállítása) elemre.
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Cellaválasztó

Cellaválasztó
AWell Selector (Cellaválasztó) ablakban megjelenítheti vagy elrejtheti a cellaadatokat a Data Analysis
(Adatelemzés) ablakban megjelenő diagramokon, illetve táblázatokban. A cellaválasztóban kizárólag
olyan cellák választhatók ki, amelyekbe van minta betöltve. A szoftver a következőképpen színezi a
cellákat a Well Selector (Cellaválasztó) párbeszédpanelen:

n Kék – a kiválasztott cellák jelzése. A kiválasztott cellák adatai megjelennek a Data Analysis
(Adatelemzés) ablakban.

n Világosszürke – a ki nem választott cellák jelzése. A ki nem választott cellák adatai nem jelennek
meg a Data Analysis (Adatelemzés) ablakban.

n Sötétszürke – az üres cellák jelzése.

A cellaadatok megjelenítése vagy elrejtése

u A cellaválasztóban a következőket teheti:

n Egyetlen cella elrejtéséhez kattintson az adott cellára. A cella megjelenítéséhez kattintson újból
az adott cellára.

n Több cella elrejtéséhez kattintson és húzza át az egérmutatót a kiválasztani kívánt cellákon.
Ezeknek a celláknak a megjelenítéséhez húzza át újból az egérmutatót a cellákon.

n Az összes cella elrejtéséhez kattintson a lemez bal felső sarkára. Az összes cella
megjelenítéséhez kattintson újból a bal felső sarokra.
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n Kattintson egy oszlop vagy egy sor elejére, ha szeretné az adott oszlopban, illetve sorban
található cellákat elrejteni. A cellák megjelenítéséhez kattintson újból az adott oszlopra, illetve az
adott sorra.

A cellaválasztó jobb egérgombbal kattintással elérhető
menüpontjai
A 13. táblázat a cellaválasztó nézetben a jobb egérgombbal kattintva elérhető lehetőségeket ismerteti.

Tétel Funkció

Well XX (XX cella) Kizárólag az adott cella megjelenítése, az adott cella eltávolítása a
nézetből, a szín beállítása a cellához vagy a cella kizárása az
elemzésből.

Selected Wells (Kiválasztott
cellák) (kattintás a jobb
egérgombbal és húzás)

Kizárólag az adott cellák megjelenítése, az adott cellák eltávolítása a
nézetből, a szín beállítása a cellákhoz vagy a cellák kizárása az
elemzésből.

Copy (Másolás) A cella tartalmának másolása a vágólapra; a program a Sample Type
(Mintatípus) és az opcionális Replicate # (Replikátumszám)
paramétert is a vágólapra másolja.

Copy as Image (Másolás
képként)

A cellaválasztó nézet másolása képként.

Print (Nyomtatás) A cellaválasztó nézet nyomtatása.

Print Selection (A kiválasztott
rész nyomtatása)

Az aktuálisan kiválasztott rész nyomtatása.

Export to Excel (Exportálás
Excel-fájlba)

Az adatok exportálása Excel-táblázatba.

Export to CSV (Exportálás .csv
kiterjesztésű fájlba)

Az adatok exportálása .csv kiterjesztésű dokumentumként.

Export to Xml (Exportálás .xml
kiterjesztésű fájlba)

Az adatok exportálása .xml kiterjesztésű dokumentumként.

Well Labels (Cellacímkék) A cellacímkék módosítása a következő értékek egyikére: Sample Type
(Mintatípus), Target Name (Célnév) vagy Sample Name (Mintanév).

13. táblázat A cellaválasztó nézetben a jobb egérgombbal kattintva elérhető menüpontok
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Cellák ideiglenes kizárása az elemzésből
Cellák ideiglenes kizárásához az elemzésből

1. Jobb gombbal kattintson a cellára a cellaválasztóban, egy fluoreszcencia-jelvonalra vagy egy pontra
a standard görbén. Több cella kizárásához kattintson a jobb egérgombbal, majd húzza el a kurzort
több cella, jelvonal vagy pont kiemeléséhez.

2. A jobb gombbal elérhető menüről válassza ki a megfelelő lehetőséget:

n Well > Exclude Well (Cella > Cella kizárása)

n Selected Wells > Exclude from Analysis (Kiválasztott cellák > Kizárás az elemzésből)

n Selected Traces > Exclude these wells from Analysis (Kiválasztott jelvonalak > A cellák kizárása
az elemzésből)

Másik lehetőségként a cellák végleges eltávolításához az elemzésből ürítse ki a cellák tartalmát a
Plate Editor (Lemezszerkesztő) ablakban a Clear Wells (Cellák kiürítése) gombra kattintva.

Fontos: Minden kiürített cellatartalmat újra be kell írnia.

Kizárt cella befoglalásához

u Kattintson a cellaválasztóban jobb gombbal a megfelelő cellára, és válassza ki a Well > Include Well
in Analysis (Cella > Cella belefoglalása az elemzésbe) lehetőséget.
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Diagramok
A Data Analysis (Adatelemzés) ablakban levő valamennyi diagram különböző grafikonon jeleníti meg az
adatokat, és lehetőséget nyújt az adatok vagy a diagramok módosításához és exportálásához.

Diagrameszközök
A 14. táblázat a diagramok többségén a jobb egérgombbal kattintva elérhető lehetőségeket ismerteti.

Tétel Funkció

Copy (Másolás) A diagram vágólapra másolása.

Save Image As... (Kép mentése
másként)

A diagrammentése képfájlként. Állítsa be a kép felbontását és
méreteit, majd válassza ki a fájltípust (PNG, GIF, JPG, TIF vagy BMP).

Page Setup... (Oldalbeállítás) A nyomtatásra vonatkozó oldalbeállítás kiválasztása.

Print... (Nyomtatás) A diagram kinyomtatása.

Set Scale to Default (Skála
alapértelmezett értékre állítása)

Az összes adat megjelenítése az oszlopdiagramon. Ha annyi
adatpont/minta található, amennyit nem lehet egyszerre megjeleníteni
a diagram keretében, görgetősávok jelennek meg.

Diagrambeállítások A Chart Settings (Diagrambeállítások) párbeszédpanel megnyitása,
amelyen módosíthatja a diagrammegjelenítési lehetőségeit, például:

n A diagram címe és a tengelyek elnevezése

n A diagram és a tengelyek betűtípusa és betűmérete

n Tengelyskála

n A jelmagyarázat helyzete

14. táblázat A diagramok többségén a jobb egérgombbal kattintva elérhető közös menüpontok

A diagrameszközök a Data Analysis (Adatelemzés) ablakban található minden egyes diagramon is
megjelennek. Minden diagramon megjelennek a következő eszközök:

Copy to Clipboard (Másolás vágólapra) – a diagramnézet tartalmának a másolása a vágólapra.

Chart Settings (Diagrambeállítások) – a Chart Settings (Diagrambeállítások) párbeszédpanel
megnyitása, amelyen módosíthatja a diagrammegjelenítési lehetőségeit, például:

Export (Exportálás) – az Export Options (Exportálási beállítások) párbeszédpanel megnyitása, amelyen
módosíthatja a grafikon felbontását és méretét, és elmentheti a grafikont egy meghatározott helyre a
következő fájltípusokban:

n .bmp
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n .jpg

n .png

Oszlopdiagram-eszközök

Az oszlopdiagramok a diagrameszközökön kívül a következő eszközöket is megjelenítik:

Sort (Rendezés) – a célok és a minták rendezése ábécésorrendben vagy fordított ábécésorrendben.

Color Settings (Színbeállítások) – a Color Settings (Színbeállítások) párbeszédpanel megnyitása,
amelyben módosíthatja a célok és a minták színét.

Bővebb tájékoztatás ezekről az eszközökről: A diagramnézet módosítása és jegyzettel való ellátása a(z)
277. oldalon.

A sokszorosítási diagram eszközei

A sokszorosítási diagramok a fent felsoroltakon kívül a következő eszközöket is megjelenítik:

Trace Styles (Jelstílusok) – a Trace Styles (Jelstílusok) párbeszédpanel megnyitása, amelyben
módosíthatja a jelek megjelenési formáját a sokszorosítási diagramon.

Baseline Threshold (Kiindulási küszöbérték) – a Baseline Threshold (Kiindulási küszöbérték)
párbeszédpanel megnyitása, amelyben módosíthatja a kiválasztott cellák alapértelmezett alapvonalát,
vagy módosíthatja az egyes fluoreszcenciagörbék küszöbértékét a sokszorosítási diagramon.

Diagramadatok másolása a vágólapra

A diagramnézet tartalmát kimásolhatja, majd beillesztheti bármilyen alkalmazásba, amely képes kezelni a
bitkép típusú fájlokat.

Diagramadatok másolásához a vágólapra

1. A diagrameszközökben válassza ki a Copy to Clipboard (Másolás a vágólapra) ikont.

2. Nyisson meg egy olyan alkalmazást, amely képes kezelni a bitképeket (például a Microsoft Word
programot).

3. Kattintson a jobb egérgombbal, majd a Paste (Beillesztés) elemet kiválasztva illessze be a vágólapra
másolt bitképet.

A diagramok megjelenítési beállításainak módosítása

A Chart Settings (Diagrambeállítások) párbeszédpanelen módosíthatja a címeket, betűtípusokat és
betűméreteket, a tengely skáláját, valamint a jelmagyarázat elhelyezkedését a megjelenített diagramhoz.
Az Ön által végzett módosításokat a rendszer kizárólag az aktuálisan megjelenített diagramhoz
alkalmazza, és elmenti őket az adott diagrammal együtt.
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A diagramok megjelenítési beállításainak módosításához

1. A diagrameszközök közül kattintson a Chart Settings (Diagrambeállítások) elemre.

Megjelenik a Chart Settings (Diagrambeállítások) párbeszédpanel.

2. A Chart And Axes (Diagram és tengelyek) fül kiválasztásával a következőket teheti:

n Cím beírása a diagramhoz.

n Új cím beírása az X tengelyhez, valamint a címkék megdöntése.

n Új cím beírása az Y tengelyhez.

3. A Fonts (Betűtípusok) fül kiválasztásával módosíthatja a diagram betűtípusát és betűméretét.

Tipp: A rendszer alapértelmezés szerint automatikusan változtatja a betűméretet, amikor a
diagrammérete megváltozik. Válassza ki a Change Font Size (Betűméret módosítása) elemet,
ha szeretne állandó betűméretet beállítani az egyes címketípusokhoz.

4. Az Axes Scale (Tengelyek skálája) fül kiválasztásával a következőket teheti:

n Az X és Y tengely automatikus skálázásának a kikapcsolása és a minimális és a maximális
skálázási értékek meghatározása.

n Annak beállítása, hogy a grafikonon láthatók legyenek-e rácsvonalak, illetve másodlagos
osztásjelek.

5. A Legend (Jelmagyarázat) fül kiválasztásával a következőket teheti:

n A diagram jelmagyarázatának elrejtése.
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n A diagram jelmagyarázata alapértelmezett helyzetének módosítása.

Megjegyzés: ha a jelmagyarázat a diagramtól balra vagy jobbra helyezkedik el, csak az első tíz
fluorofórt jeleníti meg a diagramon.

6. Ha a módosítások mentése nélkül szeretné megtekinteni, hogy a diagrambeállítási módosítások
hogyan változtatnak a diagrammegjelenésén, bármikor rákattinthat az Apply (Alkalmaz) elemre.

7. A módosítások mentéséhez és a diagramhoz történő visszatéréshez kattintson az OK gombra.

A diagram exportálása

Ezt a párbeszédpanelt a diagram szélességének, magasságának és felbontásának módosítására
használhatja exportáláshoz az alábbi formátumok egyikében:

n .bmp

n .jpg

n .png

Ezt követően az exportált diagramot felhasználhatja az eredmények bemutatására poszteren, Microsoft
PowerPoint bemutatókban és szakmai folyóiratokban.

Megjegyzés: A beállítások módosításakor tartsa szem előtt a következőket:

n Maximális és minimális szélesség és magasság

o 72 dpi felbontásnál: 0,1 – 83 hüvelyk

o 96 dpi felbontásnál: 0,1 – 62 hüvelyk

o 150 dpi felbontásnál: 0,1 – 40 hüvelyk

o 300 dpi felbontásnál: 0,1 – 20 hüvelyk

o 600 dpi felbontásnál: 0,1 – 10 hüvelyk

o Minden felbontáson: 2–6000 képpont

n Az oldalarány a szélességen alapszik.

A diagram exportálásához

1. A diagrameszközökből válassza ki az Export (Exportálás) eszközt.

Megjelenik az Export Preview (Előnézet az exportáláshoz) párbeszédpanel.

Felhasználói útmutató | 217



10. fejezet Az adatelemzés áttekintése

2. Módosítsa szükség szerint a kijelzési beállításokat.

3. Kattintson az Export gombra.

4. Az Export párbeszédpanelben végezze el a következőt:

a. (Opcionális) Lépjen abba a mappába, amelybe el kívánja menteni a diagramfájlt.

b. Írjon be egy fájlnevet, és válasszon ki egy fájltípust a legördülő listából.

5. Kattintson a Save (Mentés) gombra a diagramfájl elmentéséhez.

A kiindulási küszöbértékre vonatkozó beállítások módosítása

Single Threshold (Egyetlen küszöbérték) üzemmódban úgy módosíthat egy fluorofórra vonatkozó
küszöbértéket, hogy a küszöbérték vonalára kattint az Amplification (Sokszorosítás) diagramon, és
függőlegesen mozgatja az egér mutatóját. Másik megoldásként meghatározhat egy pontos keresztezési
küszöbértéket a kiválasztott fluorofórhoz.

Tipp: egy ciklustartomány megadásával az összes adatfájlhoz meghatározhatja a kiindulási értéket
a User > User Preferences (Felhasználó > Felhasználói beállítások) menüpontban található Data
Analysis (Adatelemzés) fülön.
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A kiindulási és a befejező ciklus módosítása az egyes cellákhoz

1. A Quantification (Kvantifikáció) fülön látható Amplification (Sokszorosítás) diagram alatt válasszon ki
egyetlen fluorofórt.

2. A diagrameszközökből válassza ki a Baseline Threshold (Kiindulási küszöbérték) lehetőséget.

Megjelenik a Baseline Threshold (Kiindulási küszöbérték) párbeszédpanel.

3. A Baseline Cycles (Kiindulási ciklusok) szakaszban tegye a következők egyikét:

n Ha egyetlen cellát szeretne kiválasztani, kattintson az adott cella sorának a számára.

n Ha több, egymással szomszédos cellát szeretne kiválasztani, kattintson az első cella sorának a
számára, tartsa nyomva az egérgombot, majd húzza le az egérmutatót az oszlopon az utolsó
celláig.

n Ha több, egymással nem szomszédos cellát szeretne kiválasztani, nyomja a Control billentyűt,
majd kattintson az egyes kívánt cellák sorainak számára.

n Az összes cella kiválasztásához kattintson a táblázatban a bal felső sarokra.

4. Módosítsa a kezdő és befejező kiindulási ciklust (Baseline Begin cycle és Baseline End cycle) az
összes kiválasztott cellához, vagy módosítsa a kezdő és befejező ciklus számát a táblázat alján.

Tipp: a beállításokat visszaállíthatja az utoljára mentett értékekre, ha a Reset All User Defined
Values (Az összes, a felhasználó által meghatározott érték visszaállítása) elemre kattint.

5. A módosítások mentéséhez és a diagramhoz történő visszatéréshez kattintson az OK gombra.

Ciklustartomány beállítása az összes adatfájlhoz

u A Home (Kezdőlap) vagy a Plate Editor (Lemezszerkesztő) ablakban válassza ki a User > User
Preferences (Felhasználó > Felhasználói beállítások) menüpontot, majd válassza ki a Data Analysis
(Adatelemzés) fület.

A célokra, mintákra és biológiai csoportokra vonatkozó adatok rendezése

Megjegyzés: ez az opció csak a génexpressziós diagramokon érhető el.

A célok, minták és biológiai csoportok listája alapértelmezés szerint ábécé-sorrendben jelenik meg. A
Sort (Rendezés) párbeszédpanelen a megjelenítést megváltoztathatja csökkenő ábécé-sorrendre, vagy
egy expressziót áthelyezhet a lista egy másik pontjára.

A célokra, mintákra és biológiai csoportokra vonatkozó adatok rendezéséhez

1. A diagrameszközökből válassza ki a Sort (Rendezés) eszközt.

Megjelenik a Gene Expression Chart Sorting (Génexpressziós diagram rendezése) párbeszédpanel.
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2. Ha a listát fordított ábécé-sorrendben szeretné megjeleníteni, a párbeszédpanelen kattintson a Z-A
elemre.

3. Egy expresszió áthelyezéséhez válassza ki az adott expressziót, majd a diagramok között kattintson
a megfelelő gombra:

n A kiválasztott expresszió áthelyezéséhez egyetlen pozícióval kattintson a felfelé, illetve lefelé
mutató nyílra.

n A kiválasztott expressziót a lista tetejére, illetve aljára helyezheti, ha a felfelé, illetve lefelé
mutató vonalas nyílra kattint.

4. Kattintson az OK gombra a módosítások elmentéséhez és a Gene Expression (Génexpresszió) fülre
való visszatéréshez.
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A cél és minta színbeállításának módosítása

Megjegyzés: ez az opció csak a génexpressziós diagramokon érhető el.

A Color Settings (Színbeállítások) párbeszédpanelt egy cél vagy minta színének a módosításához vagy
az adott tételnek a diagramról való eltávolításához használhatja.

A színbeállítások módosításához

1. A diagrameszközökből válassza ki a Color Settings (Színbeállítások) eszközt.

Ekkor megjelenik a Color Settings (Színbeállítások) párbeszédpanel.

2. Egy cél vagy minta megjelenítési színének módosításához kattintson a színére a Color (Szín)
oszlopban.

3. A megjelenő Color (Szín) párbeszédpanelben válasszon ki egy új színt, majd kattintson az OK
gombra.

4. A szóban forgó elem eltávolításához a génexpressziós diagramról szüntesse meg a jelölőnégyzet
bejelölését a Show Chart (Diagrammegjelenítése) oszlopban.

Tipp: ha az összes elemet szeretné eltávolítani a génexpressziós diagramról, szüntesse meg a
Show Chart (Diagrammegjelenítése) jelölőnégyzet bejelölését az oszlop fejlécében.

5. (Opcionális) Az oszlopdiagram színe alapértelmezés szerint színátmenetként jelenik meg. Ha
homogén formában szeretné megjeleníteni, válassza ki a Use Solid Colors (Homogén színek
alkalmazása) lehetőséget.

6. Kattintson az OK gombra a módosítások elmentéséhez és a Gene Expression (Génexpresszió) fülre
való visszatéréshez.
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Egy terület felnagyítása a diagramon
Egy terület felnagyításához a diagramon

u Kattintson az egérrel és húzza át a diagramon, majd kattintson a Zoom (Ráközelítés) parancsra. A
szoftver átméretezi és a kiválasztott területre középpontosítja a diagramot.

Megjegyzés: Az oszlopdiagramhoz nem szükséges a Zoom (Ráközelítés) parancsra kattintani.

A diagram teljes nézetének visszaállításához

u A jobb egérgombbal kattintson a diagramba, és válassza ki a Set Scale to Default (Skála beállítása
alapértelmezettre) parancsot.

Diagramok másolása Microsoft-fájlba
Az adatdiagramokat át lehet másolni Microsoft Word, Excel, illetve PowerPoint dokumentumokba. A kép
felbontása megegyezik annak a képernyőnek a felbontásával, amelyről a képet rögzítette.

Diagramok másolásához Microsoft-fájlba

1. A Data Analysis (Adatelemzés) ablakban kattintson a Copy To Clipboard (Másolás vágólapra)
elemre a diagram ablaktáblájának jobb felső sarkában.

2. Nyisson meg egy üres Microsoft-fájlt, majd illessze be a vágólap tartalmát.

A diagramoknál a jobb egérgombbal kattintva elérhető közös
menüpontok
A 15. táblázat azokat a menüpontokat ismerteti, amelyek a diagramokon a jobb egérgombbal kattintva
érhetők el. A menüpontok némelyike az összes diagramnál használható, beleértve azokat a
menüpontokat, amelyekkel módosítható az adatok megjelenítési módja, illetve könnyen exportálhatók az
adatok egy diagramból.

Tétel Funkció

Copy (Másolás) A diagrammásolása a vágólapra.

Save Image As (Kép
mentése másként)

A képet mentése a megadott méretben, felbontással és fájltípusba (például
PNG /alapértelmezett/, JPG és BMP).

Page Setup
(Oldalbeállítás)

A nyomtatás beállítási lehetőségeit jeleníti meg.

15. táblázat A diagramoknál a jobb egérgombbal kattintva elérhető menüpontok
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Tétel Funkció

Print (Nyomtatás) A diagram kinyomtatása.

Set Scale to Default
(Skála alapértelmezett
értékre állítása)

A diagram nagyítása után a diagram visszaállítása az alapértelmezett
nézetére.

Chart Options
(Diagramopciók)

A Chart Options (Diagramopciók) ablak megnyitása, amelyben módosíthatja
a diagramot, például annak címét, kiválaszthatja az X és az Y tengelyre
vonatkozó határértékeket és megjelenítheti a rácsvonalakat, valamint a
másodlagos osztásjeleket a tengelyeken.

Megjegyzés: a meghatározott diagramokra vonatkozó menüpontok leírása: 11. fejezet, Az
adatelemzéssel kapcsolatos részletek.
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Táblázatok
A Data Analysis (Adatelemzés) ablakban megjelenített táblázatok az adatok rendezéséhez és
továbbításához különféle lehetőségeket tartalmaznak. Az oszlopokat az alábbi módszerek egyikével
rendezheti:

n Kattintson egy oszlopra, és húzza egy új helyre a kiválasztott táblázatban.

n Kattintson az oszlop fejlécére az adatok rendezéséhez növekvő vagy csökkenő sorrendben.

Maximum három adatoszlop rendezéséhez a Sort (Rendezés) ablakban

1. Kattintson a jobb gombbal a táblázatba, és válassza ki a Sort (Rendezés) lehetőséget.

2. A Sort (Rendezés) párbeszédpanelben válassza ki a rendezni kívánt első oszlop címét. Rendezze az
adatokat növekvő vagy csökkenő sorrendben.

3. Válasszon ki egy második vagy harmadik oszlopot, és válassza ki az Ascending (Növekvő) vagy
Descending (Csökkenő) lehetőséget.

4. Kattintson az OK gombra az adatok rendezéséhez, vagy kattintson a Cancel (Mégse) gombra a
rendezés leállításához.

Tipp: Az egérmutatót egy mező fölé tartva kiemelheti az adatokat a kapcsolódó diagramokon és a
cellaválasztóban. Egy mezőbe kattintva kimásolhatja és egy másik programba beillesztheti a
tartalmát.

A táblázatoknál jobb egérgombbal kattintva elérhető közös
menüpontok
A 16. táblázat azokat a menüpontokat ismerteti, amelyek bármely táblázatos nézeten elérhetők a jobb
egérgombbal kattintva.

Tétel Funkció

Copy (Másolás) A kiválasztott cellák tartalmának a másolása a vágólapra, ahonnan
beilleszthető egy táblázatba (például Excelben).

Copy as Image (Másolás
képként)

A táblázatos nézet másolása képfájlként, amely azután beilleszthető
egy olyan fájlba, amely képes képfájlokat kezelni (például szöveg-
vagy képszerkesztő vagy táblázatkezelő szoftverek fájljaiba).

Print (Nyomtatás) Az aktuális nézet nyomtatása.

16. táblázat A táblázatoknál a jobb egérgombbal kattintva elérhető menüpontok

224 | CFX Maestro Dx SE szoftver



Táblázatok

Tétel Funkció

Print Selection (A kiválasztott
rész nyomtatása)

Az aktuálisan kiválasztott rész nyomtatása.

Export to Excel (Exportálás
Excel-fájlba)

Az adatok exportálása Excel-táblázatba.

Export to Text (Exportálás
szöveges dokumentumba)

Az adatok exportálása egy szövegszerkesztőbe.

Export to CSV (Exportálás .csv
kiterjesztésű fájlba)

Az adatok exportálása .csv fájlba.

Export to Xml (Exportálás .xml
kiterjesztésű fájlba)

Az adatok exportálása .xml fájlba.

Export to Html (Exportálás .html
kiterjesztésű fájlba)

Az adatok exportálása .html fájlba.

Find (Keresés) Szöveg keresése.

Sort (Rendezés) Az adatok rendezése legfeljebb három oszlopban.

Select Columns (Oszlopok
kiválasztása)

A táblázatban megjelenítendő oszlopok kiválasztása.

16. táblázat A táblázatoknál a jobb egérgombbal kattintva elérhető menüpontok, folytatás
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Exportálás
A CFX Maestro Dx SE négy exportálási lehetőséget kínál az Export (Exportálás) legördülő menüből:

n Az összes adatlap exportálása

n Export RDML Files (RDML-fájlok exportálása)

n Custom Export (Testreszabott export)

n Export to LIMS Folder (Exportálás LIMS-mappába)

n Kézi exportálás

Az összes adatlap exportálása
A CFX Maestro Dx SE egyes fülein található összes táblázatnézetet exportálhatja önálló fájlokba.

Az összes adatlap exportálásához

u Válassza ki az Export > Export All Data Sheets (Exportálás > Az összes adatlap exportálása) elemet,
majd válassza ki a kívánt fájltípust:

n CSV (*.csv)

n Text (szöveg) (*.txt)

n Excel munkafüzet (* .xlsx)

Az exportált elemzéseket a szoftver több Excel munkafüzetfájlba menti, fájlonként egy-egy
munkalappal az egyes elemzésekhez. Ha egy elemzés több fluorofórt tartalmaz, az egyes
fluorofórok adatait külön munkalapra exportálja.

n Excel munkafüzet – kombinált (* .xlsx)

Az exportált elemzéseket a szoftver egyetlen Excel munkafüzetfájlba menti, amely minden
egyes elemzett adatkészlethez egy külön munkalapot tartalmaz.

n Excel 97–2003 (*.xls)

Fontos: A számítógépre telepítenie kell a Microsoft Excel programot, ha Microsoft Excel
táblázatba szeretné exportálni az adatokat.

n Xml (*.xml)
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RDML-fájlok exportálása
Az RDML egy strukturált, univerzális adatszabvány kvantitatív PCR (qPCR) adatok cseréjéhez. Az
adatszabvány egy bővíthető jelölőnyelv (Extensible Markup Language, .xml) formátumú szövegfájl. Az
RDML adatcsere-formátummal kapcsolatos további információkat az International RDML Consortium
webhelyén (www.rdml.org) találhat.

Fontos: Az exportált RDML-fájlok elemzési adatokat tartalmaznak, a Data Analysis (Adatelemzés)
ablakban megadott kiindulási értékbeállításoknak megfelelően. A kiindulási értékbeállításokkal
kapcsolatos további információkért lásd Kiindulási értékbeállítások a(z) 208. oldalon.

Megjegyzés: Ha legalább 2.3-as verziószámú qbase+ szoftvert használ, az RDML-fájlt 1.1
verzióban mentse el.

RDML-fájl exportálásához

1. Válassza ki az Export > Export RDML Files (Exportálás > RDML-fájlok exportálása) lehetőséget,
majd a megjelenő listáról az RDML v1.1 vagy RDML v1.0 opciót.

Megjelenik a Save As (Mentés másként) párbeszédpanel.

2. A Save As (Mentés másként) párbeszédpanelben adjon meg egy fájlnevet, valamint azt a helyet,
ahová az RDML-fájlt el akarja menteni.

3. Az exportált fájl elmentéséhez kattintson az OK gombra.
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Egyedi exportfájl létrehozása
Egyedi exportfájl létrehozására

1. Válassza ki az Export > Custom Export (Exportálás > Egyedi exportálás) elemet. Megjelenik a
Custom Export (Egyedi exportálás) párbeszédpanel.

2. A megjelenő legördülő listából válassza ki az exportálási formátumot.

3. Jelölje be az exportálni kívánt elemek jelölőnégyzeteit.

4. (Opcionális) Ha módosítani szeretné egy oszlop nevét, kattintson a Customize Column Name
(Oszlopnév testreszabása) elemre.

5. Kattintson az Export gombra. Megjelenik a Save As (Mentés másként) párbeszédpanel.
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Exportálás

6. A Save As (Mentés másként) párbeszédpanelen határozzon meg egy fájlnevet, valamint azt a helyet,
ahová az exportált fájlt menteni szeretné.

7. Az exportált fájl elmentéséhez kattintson az OK gombra.
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Exportálás egy LIMS-mappába
A szoftver lehetővé teszi az adatok exportálását LIMS-kompatibilis formátumú fájlba. Bővebb információk
a LIMS-fájlok létrehozásáról, kezeléséről és használatáról: C. függelék, LIMS-integráció.

Adatok exportálása LIMS-formátumban

1. Válassza ki az Export > Export to LIMS Folder (Exportálás > Exportálás LIMS-mappába) elemet.

Megjelenik a Save As (Mentés másként) párbeszédpanel.

2. A Save As (Mentés másként) párbeszédpanelen határozzon meg egy fájlnevet, valamint azt a helyet,
ahová az exportált fájlt menteni szeretné.

3. Az exportált fájl elmentéséhez kattintson az OK gombra.

Seegene formátumú adatok exportálása
Az adatokat valamennyi táblázatnézetből exportálni lehet olyan Excel fájlokba, melyek kimondottan a
Seegene, Inc. által használhatók.

Tipp: Az exportálás befejeztével automatikusan elindíthatja a Seegene Viewer programot is.
További információk: A Tools (Eszközök) menü parancsai a(z) 69. oldalon.

Adatok exportálásához Seegene-specifikus formátumban

1. Válassza az Export > Manual Export (Exportálás > Kézi exportálás) elemeket.

Megjelenik a Browse For Folder (Mappa tallózása) párbeszédpanel.

2. A Save As (Mentés másként) párbeszédpanelben adjon meg egy mappahelyet, ahová az exportált
Seegene formátumú Excel (.xlsx) fájlokat el akarja menteni.

Az elemzéseket a szoftver több Excel munkafüzet-fájlba exportálja, fájlonként egy munkalappal az
elemzés adataihoz.

3. Az exportált fájlok elmentéséhez kattintson az OK gombra.
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részletek

A CFXMaestro Dx szoftver, Security Edition Data Analysis (Adatelemzés) ablaka több fület tartalmaz,
ahonnan megtekintheti az adatokat. A jelen fejezetben ezeket a füleket mutatjuk be részletesen.

Tipp: A View (Nézet) menüpontban kiválaszthatja, hogy mely füleket szeretné megtekinteni a Data
Analysis (Adatelemzés) ablakban. A rendszer a testreszabott elrendezést elmenti az adatfájllal
együtt.
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A Quantification (Kvantifikáció) fül
A Quantification (Kvantifikáció) fülön található adatok segítségével beállíthatja az adatelemzési
feltételeket, például az egyes cellákra vonatkozó alapértékek beállítását, valamint a küszöbérték-
beállításokat. A Quantification (Kvantifikáció) fül a következő négy nézeten jeleníti meg az adatokat:

n Amplification (Sokszorosítás) diagram – az egyes ciklusok során az egyes cellákra vonatkozó relatív
fluoreszcencia egységek (RFE) megjelenítése. A diagramon látható egyes jelek egyetlen cellában
található egyetlen fluorofór adatait jelzik.

n Standard curve (Standard görbe) – kizárólag akkor jelenik meg, ha a futtatásban standard (Std)
mintatípusúként megjelölt cellák szerepelnek. A standard görbe a kiindulási mennyiség
logaritmusához viszonyítva ábrázolt küszöbértékciklust mutatja. A jelmagyarázatban megtekinthető
a standard mintatípust tartalmazó cellákban található egyes fluorofórokra vonatkozó
reakcióhatásosság (E).

n Well Selector (Cellaválasztó) – az Ön által megjeleníteni kívánt fluoreszcenciaadatokat tartalmazó
cellák kiválasztása.

n Spreadsheet (Táblázat) – a kiválasztott cellákban összegyűjtött adatok táblázatának a
megjelenítése.
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Fluorofórokra vonatkozó opciók
Ha egy fluorofór adatait szeretné megjeleníteni a Quantification (Kvantifikáció) fülön elérhető
diagramokon és táblázatokban, válassza ki az adott célfluorofór(oka)t az Amplification (Sokszorosítás)
diagram alatt. Ha azt szeretné, hogy a fluorofór adatai ne látszódjanak a Data Analysis (Adatelemzés)
ablakban, törölje a jelölőnégyzetéből a jelölést.

A Trace Styles (Jelstílusok) párbeszédpanel
A Trace Styles (Jelstílusok) párbeszédpanelen módosíthatja a jelek megjelenését a Quantification
(Kvantifikáció) és Melt Curve (Olvadási görbe) fülön látható sokszorosítási, illetve olvadásigörbe-
diagramokon. Ezt követően a változások előnézetét megtekintheti a Trace Styles (Jelstílusok)
párbeszédpanelen megjelenő cellaválasztóban.

A jel stílusának a módosítása

1. Az Amplification (Sokszorosítás) diagram alatt válasszon ki egyetlen fluorofórt.

2. A Trace Styles (Jelstílusok) párbeszédpanel megnyitásához tegye a következők egyikét:

n Kattintson a Trace Styles (Jelstílusok) elemre az Amplification (Sokszorosítás) diagramon.

n Válassza ki a Settings > Trace Styles (Beállítások > Jelstílusok) elemet a Data Analysis
(Adatelemzés) menüsorban.

n Kattintson a jobb egérgombbal egy jelre, majd válassza ki a Trace Styles (Jelstílusok) elemet.

Megjelenik a Trace Styles (Jelstílusok) párbeszédpanel.
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3. A Trace Styles (Jelstílusok) párbeszédpanel alsó panelén található cellaválasztóban válassza ki a
kívánt cellákat. Másik megoldásként válasszon ki a Wells (Cellák) oszlopban található legördülő
menüben olyan cellákat, amelyek egyetlen mintatípust tartalmaznak.

4. Végezze el az alábbiak valamelyikét:

n A kiválasztott cellák színének kiválasztásához kattintson a Color (Szín) oszlopban található
jelölődobozra.

n Ha egy szimbólumot szeretne hozzárendelni a kiválasztott cellákhoz, válasszon ki egy
szimbólumot a Symbol (Szimbólum) legördülő listáról.

n Ha gombcímke alapján szeretné gyorsan beszínezni a cellákat, kattintson a megfelelő gyors
beállításra:

o Random byWell (Véletlenszerűen a cella alapján)

o Random by Replicate (Véletlenszerűen a replikátum alapján)

o Use Fluor Colors (Fluorofórszínek használata)

o Use Target Colors (Célszínek használata)

o Use Sample Colors (Mintaszínek használata)

n Cellacímkék hozzárendeléséhez válasszon a következő értékek közül: Sample Type
(Mintatípus), Target Name (Célnév), Sample Name (Mintanév) vagy Symbol (Szimbólum).
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Log Scale (Logaritmikus skála) opció
Válassza ki a Log Scale (Logaritmikus skála) opciót az Amplification (Sokszorosítás) diagram alatt a
fluoreszcenciagörbék megtekintéséhez fél-logaritmikus skálán:

Tipp: Bármely terület felnagyításához a diagramon kattintson az egérrel, és húzza át a célterületen.
Ha szeretne visszatérni a teljes nézethez, a jobb egérgombbal kattintson a diagramba, és válassza ki
a Set Scale to Default (Skála beállítása alapértelmezettre) parancsot.
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Standard Curve Chart (Standardgörbe-diagram)
A szoftver egy Standard Curve (Standard görbe) diagramot hoz létre a Quantification (Kvantifikáció)
fülön, ha az adatok között a futtatáson belül legalább egy fluorofórhoz standardként (Std) definiált
mintatípusok is tartoznak.

A Standard Curve (Standard görbe) diagram a következő információkat jeleníti meg:

n Az egyes görbék neve (a fluorofór vagy a cél)

n Az egyes fluorofórok vagy célok színe

n A reakció hatásfoka (E). Ezt a statisztikai adatot egy többszörös reakció optimalizálására és az
adatok kiegyenlítésére használhatja egy standard görbéhez.

Megjegyzés: A reakció hatásfoka azt írja le, hogy a cél mekkora része jön létre a protokoll
egyes ciklusaiban. A 100%-os hatásfok azt jelzi, hogy minden ciklusban megduplázódik a cél.

n Coefficient of determination (Determinációs együttható), R2 (R^2 formában írva). Ezt a statisztikai
adatot annak meghatározására használhatja, hogy a vonal mennyire helyesen írja le az adatokat (az
illeszkedés helyessége).

n Slope (Meredekség)

n y-intercept (Y metszéspont)
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Az Amplification (Sokszorosítás) diagramnál elérhető menüpontok
A diagramoknál a jobb egérgombbal kattintva elérhető közös menüpontokon (lásd: A diagramoknál a jobb
egérgombbal kattintva elérhető közös menüpontok a(z) 222. oldalon) kívül vannak olyan menüpontok,
amelyek kizárólag az Amplification (Sokszorosítás) diagramon érhetők el. Ezeket a 17. táblázat mutatja
be.

Menüpont Funkció

Well XX, Fluor Target (XX
cella, fluorofórcél)

Kizárólag az adott cella megjelenítése, az adott cella eltávolítása a
nézetből, a szín beállítása az adott jelhez vagy a cella kizárása az
elemzésből.

Selected Traces
(Kiválasztott jelek)

Kizárólag az adott cellák megjelenítése, az adott cella eltávolítása a
nézetből, a szín beállítása az adott jelekhez vagy a cellák kizárása az
elemzésből.

Show Threshold Values
(Küszöbértékek
megjelenítése)

A küszöbérték megjelenítése a diagramon az egyes sokszorosítási
görbékhez.

Trace Styles (Jelstílusok) A Trace Styles (Jelstílusok) ablak megnyitása, amelyben módosíthatja a
Quantification (Kvantifikáció) és Melt Curve (Olvadási görbe) füleken
látható jelek megjelenésének formáját.

Baseline Thresholds
(Kiindulási küszöbértékek)

A Baseline Thresholds (Kiindulási küszöbértékek) ablak megnyitása,
amelyben módosíthatja az egyes fluorofórokra vonatkozó alapvonalat
vagy küszöbértékeket (a változások a Quantification /Kvantifikáció/ fülön
látható Amplification /Sokszorosítás/ diagramon jelennek meg).

17. táblázat Az Amplification (Sokszorosítás) diagramon a jobb és a bal kattintással elérhető
menüpontok

A Quantification (Kvantifikáció) fülön található táblázat
A 18. táblázat a Kvantifikáció fülön megjelenő táblázatban található adatokat ismerteti.

Információk Leírás

Well (Cella) A cella pozíciója a lemezen

Fluor Detektált fluorofór

18. táblázat A Quantification (Kvantifikáció) fül táblázatának tartalma
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Információk Leírás

Target (Cél) A Plate Editor (Lemezszerkesztő) celláiba betöltött cél neve

Content (Tartalom) A Lemezszerkesztőbe betöltött Sample Type (Mintatípus, kötelező) és
a Replicate # (Replikátumszám, opcionális) kombinációja

Sample (Minta) A Plate Editor (Lemezszerkesztő) celláiba betöltött minta neve

Cq Kvantifikációs ciklus az egyes jelvonalakhoz

Célokra, tartalmakra vagy mintákra vonatkozó adatok módosítása

Módosíthatja a Cél, Tartalom és Minta oszlopokban levő adatokat a lemezfájl szerkesztésével a
lemezszerkesztőben (Plate Editor), akár a kísérlet lefuttatása után is.

A Tartalom, Cél és Minta oszlopokban levő adatok módosításához

u Kattintson a Plate Setup (Lemezbeállítás) opcióra, és válassza ki a View/Edit Plate (Lemez
megtekintése/szerkesztése) lehetőséget a Plate Editor (Lemezszerkesztő) megnyitásához.
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A Quantification Data (Kvantifikációs adatok) fül
A Quantification Data (Kvantifikációs adatok) fül mutatja az egyes cellákban gyűjtött kvantifikációs
adatokat. A CFX Maestro Dx SE az adatokat négy különböző táblázatnézetben jeleníti meg:

n Results (Eredmények) – egy adattáblázatot jelenít meg. Ez az alapértelmezett nézet.

n Standard Curve Results (Standard görbe eredményei) – a standard görbe adatainak táblázatát
jeleníti meg.

n Plate (Lemez) – az egyes cellákban levő adatokat lemeztérképként jeleníti meg.

n RFU (RFE)— az RFE-mennyiségeket jeleníti meg az egyes cellákban az egyes ciklusokhoz.

Válassza ki az adott táblázatot a Quantification Data (Kvantifikációs adatok) fül alatt megjelenő legördülő
listából.

A Results (Eredmények) táblázat
A Results (Eredmények) táblázat a lemezben levő egyes cellákhoz jeleníti meg az adatokat.

Megjegyzés: Valamennyi Std. Dev (szórás) számítás a Plate Editor (Lemezszerkesztő) ablakban
levő cellákhoz kijelölt replikátumcsoportokra vonatkozik. A számítások a Cq értéket átlagolják az
egyes cellákhoz a replikátumcsoportban.

A 19. táblázat a Results (Eredmények) táblázatban megjelenő adatokat adja meg.
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Információk Leírás

Well (Cella) A cella pozíciója a lemezen

Fluor Detektált fluorofór

Target (Cél) Sokszorosítási cél neve (gén)

Content (Tartalom) Mintatípus és replikátumszám

Sample (Minta) A minta leírása

Biological Set Name (Biológiai
sor neve)

A biológiai sor neve

Cq Kvantifikációs ciklus

CqMean (középérték) A kvantifikációs ciklus középértéke a replikátumcsoporthoz

Cq Std. Dev (szórás) A kvantifikációs ciklus szórása a replikátumcsoporthoz

Starting Quantity (indítási
mennyiség, SQ)

A cél becsült indítási mennyisége

Log Starting Quantity (az indítási
mennyiség logaritmusa)

Az indítási mennyiség logaritmusa

SQMean (az indítási mennyiség
középértéke)

Az indítási mennyiség középértéke

SQ Std. Dev (szórás) Az indítási mennyiség szórása a replikátumok között

19. táblázat A Results (Eredmények) táblázat tartalma
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A Standard Curve Results (Standard görbe eredményei) táblázat
A Standard Curve Results (Standard görbe eredményei) táblázat a számított standardgörbe-
paramétereket jeleníti meg.

A 20. táblázat a Standard Curve Results (Standard görbe eredményei) táblázatban megjelenő adatokat
adja meg.

Információk Leírás

Fluor (vagy Target) (fluor vagy
cél)

Detektált fluorofór (vagy cél)

Efficiency % (Hatásfok %) A reakció hatásfoka

Slope (Meredekség) A standard görbe meredeksége

Y-intercept (Y metszéspont) Az a pont, amelynél a görbe metszi az Y tengelyt

R^2 Determinációs együttható

20. táblázat A Standard Curve Results (Standard görbe eredményei) táblázat tartalma
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A Plate (Lemez) táblázat
A Plate (Lemez) táblázatban egyidejűleg egyetlen fluorofórra vonatkozó adatok lemeztérképe látható.

Egy meghatározott fluorofórra vonatkozó adatok megtekintéséhez

u Kattintson a hozzá tartozó fülre a táblázat alján.
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Az RFU (RFE) táblázat
Az RFU (RFE) táblázat a futtatás egyes ciklusai során leolvasott RFE-értékeket mutatja az egyes
cellákhoz. A cellaszám az egyes oszlopok tetején, a ciklusszám pedig az egyes soroktól balra látható.
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A Melt Curve (Olvadási görbe) fül
DNS-megkötő festékeknél és nem hasítható hibridizációs próbáknál a fluoreszcencia akkor a
legfényesebb, amikor a DNS két szála izzani kezd. Ennélfogva ahogy a hőmérséklet közeledik az
olvadási hőmérséklethez (Tm), a fluoreszcencia állandó mértékben csökken (konstans meredekség). Tm
hőmérsékleten a fluoreszcencia drámai mértékben csökken, a meredekség feltűnő megváltozásával.
Ennek a változásnak a sebességét úgy lehet meghatározni, hogy a fluoreszcencia negatív első
regresszióját a hőmérséklettel szemben ábrázoljuk (-d(RFE)/dT). A fluoreszcencia legmagasabb mértékű
változása látható csúcsokat eredményez, és a kettős szálú DNS-komplexek Tm értékét jelzi.

A CFX Maestro Dx SE egy olvadási görbe meghatározása során begyűjtött RFE-adatokat a hőmérséklet
függvényében ábrázolja. Az olvadási csúcsok adatainak elemzéséhez a szoftver mindegyik csúcshoz
kijelöl egy kezdő és egy befejező hőmérsékletet a küszöbérték oszlopának elmozdításával. A
csúcsterület alsó értékét az olvadási küszöb oszlopának helyzete adja meg. Egy érvényes csúcsnak egy
minimummagassággal kell rendelkeznie a küszöbértékoszlop és a legmagasabb csúcs magassága
közötti távolsághoz képest.

A Melt Curve (Olvadási görbe) fül a Tm értéket (olvadási hőmérséklet) mutatja a sokszorosított PCR-
termékekhez, négy nézetben:

n Melt Curve (Olvadási görbe) – az egyes fluorofórok valós idejű adatait RFE/hőmérséklet formában
jeleníti meg az egyes cellákhoz.

n Melt Peak (Olvadási csúcs) – az RFE-adatok hőmérséklettel osztott negatív regresszióját jeleníti
meg az egyes cellákhoz.

n Well selector (Cellaválasztó) – megjeleníti a cellákat az adatok megjelenítéséhez vagy elrejtéséhez.

n Peak spreadsheet (Csúcstáblázat) – a kiválasztott cellában begyűjtött adatokat jeleníti meg.

Megjegyzés: Ez a táblázat mindegyik jelvonalhoz maximum két csúcsot jelenít meg. Több
csúcs megtekintéséhez kattintson a Melt Curve Data (Olvadásigörbe-adatok) fülre.
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AMelt Curve (Olvadási görbe) fül

A 21. táblázat a Melt Curve (Olvadási görbe) táblázatban megjelenő adatokat adja meg.

Információk Leírás

Well (Cella) A cella pozíciója a lemezen

Fluor Detektált fluorofór

Content
(Tartalom)

A Mintatípus és a Replikátumszám kombinációja

Sample (Minta) A lemezszerkesztőbe betöltött minta neve

Melt Temp
(Olvadási
hőmérséklet)

Az olvadási csúcs hőmérséklete az egyes cellákhoz

Megjegyzés: ebben a táblázatban csak a két legmagasabb csúcs jelenik meg.

21. táblázat A Melt Curve (Olvadási görbe) táblázat tartalma
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Olvadásigörbe-adatok módosítása
Az olvadásigörbe-adatok módosításához

u Végezze el az alábbiak valamelyikét:

n A csúcsok befoglalásához az adatelemzésbe, illetve kizárásukhoz kattintson a küszöbérték-
oszlopokra a Melt Peak (Olvadási csúcs) diagramban, és húzza el őket.

n Válassza ki a Positive (Pozitív) opciót a Peaks (Csúcsok) legördülő menüben a Melt Threshold
(Olvadási küszöb) vonal fölötti csúcsok táblázatadatainak megjelenítéséhez, vagy válassza ki a
Negative (Negatív) opciót a vonal alatti csúcsok táblázatadatainak a megjelenítéséhez.

n Nyissa meg a Trace Styles (Jelstílusok) ablakot a jelvonalak színének módosításához a Melt
Curve (Olvadási görbe) és a Melt Peak (Olvadási csúcs) diagramon.

n Válasszon ki egy számot a Step Number (Lépésszám) kiválasztóablakban a Melt Curve
(Olvadási görbe) adatok megtekintéséhez a protokoll egy másik lépésében. A lista egynél több
lépést mutat, ha a protokoll egynél több olvadásigörbe-lépésben tartalmaz lemezolvasást.

n Ha az adatok egy részhalmazát szeretné megvizsgálni, válassza ki a cellákat a
cellaválasztóban.

n Válasszon ki egy cellacsoportot a lemezben levő cellák egy részének megtekintéséhez és
elemzéséhez. Válassza ki az egyes cellacsoportokat név szerint a Well Group (Cellacsoport)
legördülő menüből az eszköztárban.
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AMelt Curve Data (Olvadásigörbe-adatok) fül

A Melt Curve Data (Olvadásigörbe-adatok) fül
Az Olvadásgörbe-adatok fül az adatokat több táblázatban jeleníti meg, amelyek az egyes nyomok összes
olvadási csúcsát tartalmazzák. A CFX Maestro Dx SE négy táblázatkezelési lehetőséget kínál az olvadási
görbe adatainak megtekintésére:

n Melt Peaks (Olvadási csúcsok) – az egyes jelekre vonatkozó összes adat megjelenítése, beleértve
az összes olvadási csúcsot. Ez az alapértelmezett nézet.

n Plate (Lemez) – az adatokat, valamint a lemezben található egyes cellák tartalmát feltüntető nézet
megjelenítése.

n RFU (RFE) – az egyes cellákra és egyes hőmérsékletekre vonatkozó RFE-mennyiségek
megjelenítése.

n -d(RFU)/dT – annak a megjelenítése, hogy a hőmérséklet (T) változásakor mekkora az RFU negatív
változási sebessége. Ez egy első regressziós grafikon a lemezben található egyes cellákhoz.

Válassza ki az egyes táblázatokat a Melt Curve Data (Olvadásigörbe-adatok) fül alatt megjelenő
legördülő listából.

A Melt Peaks (Olvadási csúcsok) táblázat
AMelt Peaks (Olvadási csúcsok) táblázat az összes olvadásigörbe-adatot megjeleníti.

A 22. táblázat a(z) 248. oldalon a Melt Peaks (Olvadási csúcsok) táblázatban megjelenő adatokat adja
meg.
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Információk Leírás

Well (Cella) A cella pozíciója a lemezen

Fluor Detektált fluorofór

Content (Tartalom) A Plate Editor (Lemezszerkesztő) ablakban felsorolt mintatípus

Target (Cél) Sokszorosítási cél (gén)

Sample (Minta) A Plate Editor (Lemezszerkesztő) ablakban felsorolt mintanév

Melt Temperature (Olvadási
hőmérséklet)

Az egyes termékek olvadási hőmérséklete, a táblázatban soronként
egyetlen csúcsként (legmagasabb) felsorolva

Peak Height (Csúcsmagasság) A csúcs magassága

Begin Temperature (Kezdeti
hőmérséklet)

Hőmérséklet a csúcs kezdetén

End Temperature
(Véghőmérséklet)

Hőmérséklet a csúcs végén

22. táblázat A Melt Peaks (Olvadási csúcsok) táblázat tartalma

A Plate (Lemez) táblázat
A Plate (Lemez) táblázat lemezformátumban jeleníti meg az olvadásigörbe-adatokat.

Megjegyzés: a szoftver által hívott csúcsérték módosításához változtassa meg a
küszöbértékvonalat a Melt Curve (Olvadási görbe) fülön látható Melt Peak (Olvadási csúcs)
diagramon.

A 23. táblázat a(z) 249. oldalon a Plate (Lemez) táblázatban megjelenő adatokat adja meg.
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AMelt Curve Data (Olvadásigörbe-adatok) fül

Információk Leírás

Content
(Tartalom)

Egy Sample Type (Mintatípus) (kötelező) és egy Replicate # (Replikátumszám)
(opcionális) paraméter kombinációja

Sample (Minta) A minta leírása

Peak 1 (1. csúcs) Az első olvadási csúcs (legmagasabb)

Peak 2 (2. csúcs) Második olvadási csúcs (alacsonyabb)

23. táblázat A Plate (Lemez) táblázat tartalma

Az RFU (RFE) táblázat
Az RFU (RFE) táblázat az olvadási görbe elkészítésének egyes ciklusai során leolvasott
fluoreszcenciaértékeket mutatja az egyes cellákhoz.

A 24. táblázat az RFU (RFE) táblázatban megjelenő adatokat adja meg.

Információk Leírás

Well number (Cella száma) (A1, A2, A3,
A4, A5)

A lemez betöltött celláinak helyzete

Temperature (Hőmérséklet) A sokszorosított cél olvadási hőmérséklete,
amelyet a rendszer soronként egy cellaként,
valamint az ugyanazon cellában található több
termék esetében több cellaként ábrázol

24. táblázat Az RFU (RFE) táblázat tartalma
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A -d(RFU)/dT (-d(RFE)/dT) táblázat
A -d(RFE)/dT táblázat a változás negatív mértékét mutatja az RFE-értékként a hőmérséklet (T)
változásával.

A 25. táblázat a -d(RFU)/dT táblázatban megjelenő adatokat adja meg.

Információk Leírás

Well number (Cella száma) (A1, A2, A3,
A4, A5)

A lemez betöltött celláinak helyzete

Temperature -d(RFU)/dT (Hőmérséklet -
d(RFE)/dT)

Az RFE változásának negatív mértéke a hőmérséklet (T)
változásával

25. táblázat A -d(RFE)/dT táblázat tartalma
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Az End Point (Végpont) fül
Az End Point (Végpont) fület megnyitva elemezheti a végső relatív fluoreszcencia egységeket( RFE) a
mintával töltött celláknál. A szoftver az ismeretlen mintákat tartalmazó cellák RFE-szintjét összehasonlítja
a negatív kontrollokat tartalmazó cellák RFE-szintjével, és az ismeretlent pozitívnak vagy negatívnak
„hívja”. A pozitív minták RFE-értéke nagyobb, mint a negatív kontrollok átlagos RFE-értéke és a
határérték összege.

A végpontadatok elemzéséhez a lemeznek negatív kontrollokat kell tartalmaznia, máskülönben a szoftver
nem tudja elvégezni a hívást.

n Quantification (Kvantifikáció) protokoll futtatása – egy standard protokoll beállítása. A futtatás
befejeződése után nyissa meg a Data Analysis (Adatelemzés) ablakot, végezze el az adatelemzési
beállításokat a Quantification (Kvantifikáció) fülön, majd kattintson az End Point (Végpont) fülre egy
végpontciklus kiválasztásához.

n End Point Only (Csak végpont) protokoll futtatása – az End Point Only (Csak végpont) protokoll
betöltése a Run Setup (Futtatás beállításai) ablak Plate (Lemez) fülén, egy lemez kiválasztása vagy
létrehozása, majd a futtatás elindítása

Felhasználói útmutató | 251



11. fejezet Az adatelemzéssel kapcsolatos részletek

Az End Point (Végpont) fül megjeleníti az átlagos RFE-értékeket, így meghatározható, hogy a célt
sokszorosította-e az utolsó (befejező) ciklus. Ezekkel az adatokkal meghatározhatja, hogy egy mintában
jelen van-e egy meghatározott célszekvencia (pozitív). A pozitív célok RFE-értékei nagyobbak, mint az
Ön által meghatározott határértékszint.

Tipp: végpont típusú protokoll létrehozásához nyissa meg a Protocol (Protokoll) fület (a Run Setup
/Futtatás beállítása/ ablakban), majd válassza ki a Run > End Point Only Run (Futtatás > Csak
végpont futtatása) parancsot.

Amikor a futtatás befejeződik, az adatfájl megnyílik az End Point (Végpont) fülön, amely a következő
szakaszokból tevődik össze:

n Settings (Beállítások) – az adatelemzési beállítások módosítása.

n Results (Eredmények) – a beállítások módosítása után az eredmények azonnal megjelennek.

n Well Selector (Cellaválasztó) – az Ön által megjeleníteni kívánt végpontadatokat tartalmazó cellák
kiválasztása.

n RFU spreadsheet (RFU-táblázat) – a kiválasztott cellákban összegyűjtött befejező RFE
megjelenítése.

Eredményül kapott adatok
A Results (Eredmények) rész a következő adatokat jeleníti meg:

n Lowest RFU value (Legalacsonyabb RFE-érték) – az adatok közt megtalálható legalacsonyabb RFE-
érték

n Highest RFU value (Legmagasabb RFE-érték) – az adatok közt megtalálható legmagasabb RFE-
érték

n Negative Control Average (A negatív kontroll átlaga) – átlagos RFE a negatív kontrollokat tartalmazó
cellákhoz

n Cut Off Value (Határérték) – a szoftver a tolerancia (RFE vagy a beállításokban megadott százalékos
tartomány) értékének és a negatív kontrollok átlagának összeadásával számítja. Azokat a mintákat,
amelyek RFE-értéke nagyobb a határértéknél, pozitívnak nevezzük. A határérték beállításához
módosítsa az RFE-t vagy a százalékos tartományt

A határérték kiszámításához a szoftver ezt a képletet használja:

határérték = negatív kontroll átlaga + tolerancia

Válasszon ki egy toleranciát az alábbi módszerek egyikével:

n RFUs (RFE-k) (alapértelmezett) – ezzel a módszerrel egy abszolút RFE-értéket használhat a
toleranciához. A minimális RFE-toleranciaérték 2. A maximum a legmagasabb RFE abszolút
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Az End Point (Végpont) fül

értékének és a legalacsonyabb RFE-értékének különbsége. Az alapértelmezett RFE-tolerancia a
teljes RFE-tartomány 10%-a.

n Percent of Range (Százalékos tartomány) – ezt a módszert akkor válassza, ha az RFE-tartomány
egy százalékos értékét szeretné használni a toleranciához. A tartomány minimum százaléka 1%. A
tartomány maximum százaléka 99%. A tartomány százalékának alapértelmezett értéke 10%.
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A végponti adatelemzés módosítása
Az End Point (Végpont) fülön levő adatok módosításához

u Végezze el az alábbiak valamelyikét:

n Válasszon ki egy fluorofórt a legördülő listából.

n Válasszon ki egy End Cycle to Average (Átlagolandó végciklus) értéket azon ciklusok számának
a beállításához, amelyekkel ki akarja számítani az átlagos végponti RFE-értéket.

n Válassza ki az RFE-ket az adatok megtekintéséhez relatív fluoreszcencia egységekben.

n Válassza ki a Percentage of Range (Tartomány százaléka) értéket az adatok megtekintéséhez
az RFE-tartomány százalékaként.

n Ha az adatok egy részhalmazát szeretné megvizsgálni, válassza ki a cellákat a
cellaválasztóban.

n Válasszon ki egy cellacsoportot a lemezben levő cellák egy részének megtekintéséhez és
elemzéséhez. Válassza ki az egyes cellacsoportokat név szerint a Well Group (Cellacsoport)
legördülő menüből az eszköztárban.

RFE-táblázat a végponti elemzéshez
A 26. táblázat az RFE-táblázatban az End Point (Végpont) fülön megjelenő adatokat adja meg.

Információk Leírás

Well (Cella) A cella pozíciója a lemezen

Fluor Detektált fluorofór

Tartalom A Sample type (Mintatípus) és a Replicate # (Replikátumszám) kombinációja

End RFU (Vég RFE) RFE a végponti ciklusnál

Call (Lehívás) Pozitív vagy negatív, ahol a pozitív minták RFE-értéke magasabb a negatív
kontrollok átlagos RFE-értéke és a határérték összegénél.

Sample (Minta) A Lemezszerkesztőbe betöltött mintanév

26. táblázat Az RFE-végponttáblázat tartalma
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Az Allelic Discrimination (Alléldiszkrimináció) fül

Az Allelic Discrimination (Alléldiszkrimináció) fül
Az Allelic Discrimination (Alléldiszkrimináció) fülön genotípusok rendelhetők az ismeretlen mintákat
tartalmazó cellákhoz. Ezen adatok segítségével Ön beazonosíthatja a különböző genotípusokkal
rendelkező mintákat, ideértve az Allele 1 (1. allél), az Allele 2 (2. allél), a Heterozygote (Heterozigóta), a
No Call (Nincs lehívás) (nincs sokszorosítás) és az Undetermined (Meghatározatlan) típusokat.

Megjegyzés: Az alléldiszkriminációra vonatkozó adatoknak többszörös (legalább két-két fluorofórt
tartalmazó) futtatásokból kell származniuk. Az egyes fluorofórok egy-egy allélt azonosítanak az
összes mintában.

Az alléldiszkrimináció-elemzéshez a celláknak legalább a következőket kell tartalmazniuk:

n Két-két fluorofór minden egyes cellában

n NTC (no template control, sablon nélküli kontroll) minták az optimalizált adatelemzéshez

A CFX Maestro Dx SE négy opciót kínál az alléldiszkriminációs adatok megtekintésére:

n Allelic Discrimination (Alléldiszkriminációs) diagram – az adatok megjelenítése az Allele 1 (1. allél) /
Allele 2 (2. allél) paraméterre vonatkozó RFE-grafikonon. A grafikonon látható egyes pontok az egy
cellában található mindkét fluorofór adatait jelzik. A Polar Coordinates (Polárkoordináták)
jelölőnégyzet bejelölésével, illetve bejelölésének megszüntetésével átválthat a Descartes-féle és a
polárkoordináták között. A Descartes-féle koordináták esetében az 1. allélra vonatkozó RFE az X
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tengelyen, a 2. allélra vonatkozó RFE pedig az Y tengelyen jelenik meg. A polárkoordináták
esetében a szög az X tengelyen, az origó és az RFE közötti távolság pedig az Y tengelyen jelenik
meg (az összes NTCmediánja).

n Well spreadsheet (Cellatáblázat) – a lemez egyes celláiból gyűjtött alléldiszkriminációs adatok
megjelenítése.

n Well Selector (Cellaválasztó) – azoknak a celláknak a kiválasztása, amelyek az Ön által
megjeleníteni kívánt alléladatokat tartalmazzák.

n Selected Fluorophores (Kiválasztott fluorofórok) panel – az alléldiszkriminációs diagram X
tengelyéhez és Y tengelyéhez tartozó címke módosítása, az elemezni kívánt ciklus módosítása,
valamint annak a módosítása, hogy a rendszer megjelenítse-e a lehívási térképet.

Az alléldiszkriminációra vonatkozó adatok módosítása
A szoftver automatikusan hozzárendel egy genotípust az ismeretlen mintákat tartalmazó cellákhoz, az
NTC-k pozíciói és az ismeretlen adatpontoknak az NTC-khez viszonyított szöge és távolsága alapján.

Az alléldiszkriminációs adatok módosításához

u Végezze el az alábbiak valamelyikét:

n A polárkoordináták megjelenítéséhez jelölje be az Allelic Discrimination (Alléldiszkrimináció)
diagramban levő jelölőnégyzetet.

n Egy másik fluorofór megtekintéséhez válassza ki az adott fluorofórt a Selected Fluorophores
(Kiválasztott fluorfórok) panel legördülő listájából.

n Lehívás módosításához kattintson az egérrel és húzza át az Allelic Discrimination
(Alléldiszkrimináció) diagram adatpontján/adatpontjain, majd válasszon ki egy opciót a Selected
Wells (Kiválasztott cellák) nevű listából:

o Allele 1 (1. allél)

o Allele 2 (2. allél)

o Heterozygote (Heterozigóta)

o Undetermined (Meghatározatlan)

o No Call (Nincs lehívás)

o Auto Call (Automatikus lehívás)

Tipp: ha szeretne visszatérni az alapértelmezett lehívásra, válassza ki az Auto Call
(Automatikus lehívás) lehetőséget.
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A diagramoknál elérhető menüpontok
A diagramoknál a jobb egérgombbal kattintva elérhető közös menüpontokon (lásd A diagramoknál a jobb
egérgombbal kattintva elérhető közös menüpontok a(z) 222. oldalon) kívül vannak olyan menüpontok is,
amelyek kifejezetten az Allelic Discrimination (Alléldiszkrimináció) diagramon érhetők el. Ezeket a 27.
táblázat mutatja be.

Menüpont Funkció

Zoom (Nagyítás) A diagramnézet fókuszálása a kiválasztott területre (a kurzorral a
diagramon kattintva és elhúzva).

Tipp: ha a nagyítást szeretné úgy visszaállítani, hogy az
összes adatpont látszódjon, kattintson a jobb egérgombbal, és
válassza ki a Set Scale to Default (Skála alapértelmezett
értékre állítása) elemet.

Well (Cella) A kiválasztott cellához elérhető opciók: kizárólag az adott cella
megjelenítése, a cella eltávolítása a nézetből, a szín beállítása az
adott jelhez vagy a cella kizárása az elemzésből.

Selected Wells (Kiválasztott
cellák)

A (kurzorral a diagramon kattintva és elhúzva) kiválasztott cellákhoz
elérhető opciók: csak a kiválasztott cellák megjelenítése, a
kiválasztott cellák eltávolítása a nézetből, a szín beállítása az adott
jelekhez vagy a kiválasztott cellák kizárása az elemzésből.

27. táblázat Az Allelic Discrimination (Alléldiszkrimináció) diagramon a jobb és bal
egérgombbal kattintva elérhető menüpontok

Az Allelic Discrimination (Alléldiszkrimináció) táblázat
A 28. táblázat az Allelic Discrimination (Alléldiszkrimináció) táblázatban megjelenő adatokat határozza
meg.

Információk Leírás

Well (Cella) A cella pozíciója a lemezen

Sample (Minta) A minta megnevezése

Call (Lehívás) Az allél azonosítása, ideértve: automatikus 1. allél, 2. allél,
Heterozigóta, Nincs lehívás vagy Meghatározatlan

28. táblázat Az Allelic Discrimination (Alléldiszkrimináció) táblázat tartalma
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Információk Leírás

Type (Típus) Auto (Automatikus) vagy Manual (Manuális); a lehívás
végrehajtásának módját adja meg. Az Automatikus azt jelzi, hogy a
lehívást a szoftver választotta ki. A Manuális azt jelzi, hogy a lehívást a
felhasználó választotta ki.

RFU1 RFE az 1. allélhoz

RFU2 RFE a 2. allélhoz

28. táblázat Az Allelic Discrimination (Alléldiszkrimináció) táblázat tartalma, folytatás
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A Custom Data View (Egyéni adatnézet) fül

A Custom Data View (Egyéni adatnézet) fül
A Custom Data View (Egyéni adatnézet) fül egyszerre több panelt jelenít meg testre szabható formában.

A Load a Preset View (Előre definiált nézet betöltése) legördülő lista különböző formátumsablonokat kínál
fel a megjelenítéshez. Az alapértelmezett nézet az elemzés alatt álló fájltól függ. Például ha léteznek Melt
Curve (Olvadási görbe) adatok, az Amp + Melt (Sokszorosítás + Olvadás) alapértelmezett nézet jelenik
meg.

Felhasználói útmutató | 259



11. fejezet Az adatelemzéssel kapcsolatos részletek

Egyéni adatnézet létrehozása
Egyéni adatnézet létrehozásához

u Végezze el az alábbiak valamelyikét:

n Válasszon ki egy másik előre beállított nézetet a legördülő listából.

n Válasszon ki egy másik diagramnézetet az egyes egyedi panelek tetejénél levő legördülő
listából.

n Módosítsa a sorok és az oszlopok számát a fülön.

n Módosítsa az egyes panelméreteket. Húzza el az egyes panelek szélénél levő sávokat.

Kattintson a Save as Preset (Elmentés előre definiált beállításként) gombra a testreszabott nézet
elmentéséhez előre beállított sablonként. Kattintson a Manage Presets (Előre definiált beállítások
kezelése) gombra a létező előre beállított nézetek törléséhez, átnevezéséhez vagy visszaállításához.
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A QC (Minőség-ellenőrzés) fül

A QC (Minőség-ellenőrzés) fül
A QC (Minőség-ellenőrzés) fülön a User Preferences (Felhasználói beállítások) ablakban meghatározott
szabályok alapján gyorsan kiértékelheti a futtatási adatok minőségét.

A CFX Maestro Dx SE négy lehetőséget kínál a minőség-ellenőrzési adatok megtekintésére:

n Amplification chart (Sokszorosítási diagram) – az egyes ciklusok során az egyes cellákra
vonatkozó RFE megjelenítése. A diagramon látható egyes jelek egyetlen cellában található egyetlen
fluorofór adatait jelzik.

n QC rules table (Minőség-ellenőrzési szabályok táblázata) – az elérhető minőség-ellenőrzési
szabályok, valamint az egyes szabályokat meghatározó beállítások megjelenítése. A rendszer az
alkalmazott minőség-ellenőrzési szabályokat pipával jelzi.

n Well Selector (Cellaválasztó) – azoknak a celláknak a kiválasztása, amelyek az Ön által
megjeleníteni kívánt fluoreszcenciaadatokat tartalmazzák.

n QC rule summary (Minőség-ellenőrzési szabályok összefoglalása) panel – a kiválasztott minőség-
ellenőrzési szabály megjelenítése, valamint az adott szabálynak meg nem felelő cellák kiemelése.
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A minőség-ellenőrzési kritériumok módosítása
A QC (Minőség-ellenőrzési) kritériumok módosításához

u Jelölje be vagy törölje a Use (Használat) jelölőnégyzetet attól függően, hogy szeretné-e a szabályt a
QC (Minőség-ellenőrzés) során használni.

A minőség-ellenőrzést sikertelen eredménnyel záró cellák kizárása
A CFX Maestro Dx SE a minőség-ellenőrzés kritériumainak meg nem felelő cellákat is megjeleníti a
Results (Eredmények) oszlopban a minőség-ellenőrzési szabályok táblázatában és az összefoglaló
táblában.

A minőség-ellenőrzés kritériumainak meg nem felelő cellák kizárásához

u Válassza ki az Exclude Wells (Cellák kizárása) opciót mindegyik kizárandó cellához.
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A Run Information (Futtatási információk) fül
A Run Information (Futtatási információk) fülön a protokoll, valamint az egyes futtatásokra vonatkozó
egyéb információk láthatók. Ezen a fülön a következőket teheti:

n A protokoll megtekintése.

n A futtatásra vonatkozó megjegyzések beírása vagy szerkesztése.

n A futtatásra vonatkozó ID (azonosító) vagy vonalkód beírása vagy szerkesztése.

n A futtatás során esetlegesen előforduló események megtekintése. Ezeket az üzeneteket a
futtatással kapcsolatos hibák elhárítására használhatja.

Tipp: A protokoll másolásához, exportálásához, illetve nyomtatásához kattintson a jobb
egérgombbal a protokollra. Ha a Notes (Megjegyzések), az ID/Bar Code (Azonosító/vonalkód) vagy
az Other (Egyéb) panelekre kattint a jobb egérgombbal, visszavonhatja, kivághatja, másolhatja,
beillesztheti, törölheti vagy kijelölheti a szöveget.
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Adatelemzési jelentések
A Report (Jelentés) párbeszédpanel információkat közöl az aktuális adatfájlról a Data Analysis
(Adatelemzés) ablakban. Egy jelentés megnyitásához válassza ki a Tools > Reports (Eszközök >
Jelentések) opciót, vagy kattintson a Reports (Jelentések) lehetőségre az eszköztáron.

A Report (Jelentés) párbeszéd az alábbi részekből áll:

n Menü és eszköztár – opciókat biztosít a jelentés vagy sablon formátumához, elmentéséhez és
kinyomtatásához.

n Opciólista (a párbeszédpanel bal felső oldala) – opciókat biztosít a jelentésben való megjelenítéshez.

n Opciók panel (a párbeszédpanel bal alsó oldala) – szövegmezőket jelenít meg, amelyekbe
információkat írhat be egy kiválasztott opcióról.

n Előnézet panel (a párbeszédpanel jobb oldala) – az aktuális jelentés előnézetét jeleníti meg.
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Az adatelemzési jelentések kategóriái
A 29. táblázat a Data Analysis (Adatelemzés) ablakban található adatok típusától függően megjeleníti az
adatelemzési jelentéshez elérhető összes opciót.

Kategória Opció Leírás

Fejléc

A jelentés címe, alcíme és logója

Report Information (A jelentéssel
kapcsolatos információk)

A futtatás dátuma, a felhasználó neve, az
adatfájl neve, az adatfájl útvonala,
valamint a kiválasztott cellacsoport

Audit Information
(Auditinformációk)

Az auditáláshoz szükséges kiegészítő
információk, beleértve az aláírásokat

Notes (Megjegyzések) Az adatjelentésre vonatkozó
megjegyzések

Run Setup (Futtatás beállításai)

Run Information (Futtatási
információk)

A futtatás dátuma, a felhasználó neve, az
adatfájl neve, az adatfájl útvonala,
valamint a kiválasztott cellacsoport

Protocol (Protokoll) A protokoll lépéseinek és opcióinak
szöveges nézete

Plate Display (Lemezkijelző) A lemez egyes celláiban található
információk lemeznézete

Quantification (Kvantifikáció)

Analysis Settings (Elemzési
beállítások)

Adatgyűjtési lépés száma, elemzési
üzemmód, valamint a kiindulási érték
kivonásának módszere

Amplification Chart
(Sokszorosítási diagram)

Sokszorosítási diagram a kvantifikációs
adatokat tartalmazó futtatásokhoz

Standard Curve Chart
(Standardgörbe-diagram)

Standardgörbe-diagram

29. táblázat Adatelemzési jelentések kategóriái az opciók listájában
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Kategória Opció Leírás

Data (Adatok) Az egyes cellákban található adatokat
tartalmazó táblázat

Gene Expression – Bar Chart (Génexpresszió – oszlopdiagram)

Analysis Settings (Elemzési
beállítások)

Elemzési üzemmód, diagramadatok,
skálázási opció, valamint a diagram
hibája

Chart (Diagram) Az oszlopdiagrammásolata

Target Names (Célnevek) A célnevek diagramja

Sample Names (Mintanevek) A mintanevek diagramja

Data (Adatok) Az egyes cellákban található adatokat
tartalmazó táblázat

Target Stability (Célstabilitás) A célok stabilitásának diagramja

Box-and-Whisker Chart
(Dobozdiagram)

Dobozdiagram

Dot Plot Chart (Pontdiagram) Pontdiagram

Gene Expression (Génexpresszió) – klasztergram és szóródási ábra

Analysis Settings (Elemzési
beállítások)

Az egyes diagramtípusok beállításai

Chart (Diagram) A diagrammásolata

Data (Adatok) Az egyes célok adatait tartalmazó
táblázat

Gene Expression (Génexpresszió) – ANOVA Data (ANOVA-adatok)

ANOVA Settings (ANOVA-
beállítások)

Az elemzéshez használt p-érték
küszöbértéke

ANOVA Results (ANOVA-
eredmények)

Az ANOVA és a Tukey-féle HSD post-
hoc elemzésből származó eredmények
táblázata

29. táblázat Adatelemzési jelentések kategóriái az opciók listájában, folytatás
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Kategória Opció Leírás

Melt Curve (Olvadási görbe)

Analysis Settings (Elemzési
beállítások)

Olvadási lépés száma és a
küszöbértékoszlop beállítása

Olvadásigörbe-diagram Olvadásigörbe-diagram

Olvadásicsúcs-diagram Olvadásicsúcs-diagram

Data (Adatok) Az egyes cellákban található adatokat
tartalmazó táblázat

Allelic Discrimination (Alléldiszkrimináció)

Analysis Settings (Elemzési
beállítások)

A fluorofórok, a ciklus, valamint a lehívási
térkép megjelenítése

Allelic Discrimination Chart
(Alléldiszkrimináció diagram)

Az alléldiszkriminációs diagrammásolata

Data (Adatok) Az egyes cellákban található adatokat
tartalmazó táblázat

End Point (Végpont)

Analysis Settings (Elemzési
beállítások)

Fluorofór, az átlagolandó végciklusok,
üzemmód, a legalacsonyabb RFE-érték,
a legmagasabb RFE-érték, valamint a
határérték

Data (Adatok) Az egyes cellákban található adatokat
tartalmazó táblázat

QC Parameters
(Minőség-ellenőrzési
paraméterek)

Data (Adatok) Az egyes QC (Minőség-ellenőrzési)
szabályokhoz tartozó paramétereket
tartalmazó táblázat

29. táblázat Adatelemzési jelentések kategóriái az opciók listájában, folytatás

Felhasználói útmutató | 267



11. fejezet Az adatelemzéssel kapcsolatos részletek

Adatelemzési jelentés létrehozása
A jelentés elrendezését elmentheti sablonként, amelyet hasonló jelentésekhez újra felhasználhat.

Adatelemzési jelentés létrehozásához

1. A jelentés létrehozása előtt végezze el a cellák tartalma, a kiválasztott cellák, diagramok és
táblázatok utolsó módosításait a Data Analysis (Adatelemzés) ablakban.

2. Válassza ki a Tools > Reports (Eszközök > Jelentések) opciót a Data Analysis (Adatelemzés)
menüsorban a Report (Jelentés) párbeszédpanel megnyitásához.

3. Válassza ki azokat az opciókat, amelyeket szerepeltetni kíván a jelentésben. A jelentés
megnyitásakor az alapértelmezett opciók ki vannak választva. Jelölje be vagy törölje a
jelölőnégyzeteket az egész kategóriák vagy egy kategórián belüli egyedi opciók módosításához.

A 29. táblázat a(z) 265. oldalon a megjelenítési opciókat sorolja fel.

Megjegyzés: A jelentésben megjelenő adatok a Data Analysis (Adatelemzés) vagy a Melt Study
(Olvadásvizsgálat) ablak füleiben levő aktuális kiválasztásoktól függenek. Például lehetséges,
hogy egy kvantifikációs futtatás nem tartalmaz egy standard görbét, ennélfogva ezek az adatok
nem jelennek meg a Data Analysis (Adatelemzés) ablakban vagy az adatjelentésben.

4. Módosítsa a kategóriák és elemek jelentésen belüli sorrendjét. Húzza az opciókat a relatív helyzetbe.
Az elemek csak azokon a kategóriákon belül rendezhetők át, amelyekhez tartoznak.

5. (Opcionális) A Report Options (Jelentési opciók) panelen adja meg a kiválasztott opcióra vonatkozó
információkat:

n Válassza ki az információk egy, a jelentésben megjelenítendő részhalmazát.

n Válasszon ki specifikus beállításokat a kijelölt opcióhoz.

n Módosítsa a kiválasztott opcióhoz megjelenítendő szöveget.

6. Kattintson az Update Report (Jelentés frissítése) opcióra a Report Preview (Jelentés előnézete)
frissítéséhez az esetleges módosítások miatt.

7. Nyomtassa ki vagy mentse el a jelentést:

a. Kattintson a Print Report (Jelentés nyomtatása) gombra az eszköztárban az aktuális jelentés
kinyomtatásához.

b. Válassza ki a Select File > Save (Fájl > Mentés) lehetőséget a jelentés mentéséhez PDF (Adobe
Acrobat Reader fájl), MHT (Microsoft dokumentum) vagy MHTML (Microsoft dokumentum)
fájlformátumban.

c. Válassza ki a fájl mentésének helyét.
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Adatelemzési jelentések

d. Válassza ki a File > Save As (Fájl > Mentés másként) opciót a jelentés elmentéséhez új névvel
vagy egy új helyre.

8. (Opcionális) Hozzon létre egy jelentéssablont a kívánt információkkal. A jelentés aktuális
beállításainak elmentéséhez sablonként válassza ki a Template > Save (Sablon > Mentés) vagy
Save As (Mentés másként) opciót. Ezután ha egy új jelentést akar elkészíteni, töltse be a
jelentéssablont.
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Cellacsoport-jelentések létrehozása
Cellacsoport-jelentés létrehozásához

1. Válassza ki a Tools > Well Group Reports (Eszközök > Cellacsoport-jelentések) opciót a Data
Analysis (Adatelemzés) ablakban.

2. A Well Groups Reports (Cellacsoport-jelentések) párbeszédpanelen válassza ki a jelentésbe
belefoglalni kívánt cellacsoportokat, sokszorosítási lépéseket és olvadási lépéseket.

3. Írja be az útvonalat, vagy lépjen abba a mappába, amelybe el kívánja menteni a jelentést.

4. (Opcionális) Válassza ki a Choose a Report Template (Válasszon ki egy jelentéssablont) opciót, és
lépjen a sablonfájl mappájába.

5. (Opcionális) Válassza ki az Open Destination Folder (Célmappa megnyitása) parancsot a mappa
megnyitásához és a jelentések megtekintéséhez létrehozásuk után.

6. Kattintson a Create Reports (Jelentések létrehozása) parancsra.
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12. fejezet Génexpressziós elemzés
A CFXMaestro Dx szoftver, Security Editiont használhatja génexpresszió-futtatás végrehajtására a
reakciókban szigorúan minősített kontrollokat használva, a minták célkoncentrációi között mutatkozó
relatív különbségek normalizálásához. Egy vizsgálandó gén expressziószintjeinek normalizálására
általában egy vagy több referenciagén expressziószintjeit alkalmazzák. A referenciagének figyelembe
veszik az egyes mintákra jellemző betöltési különbségeket és egyéb variációkat, és ezek
expressziószintjeit nem befolyásolhatják a vizsgált biológiai rendszerben.

A két vagy több cellában végbemenő PCR-reakciók közötti relatív különbségek értékeléséhez válassza ki
a Gene Expression (Génexpresszió) fület a Data Analysis (Adatelemzés) ablakban. Például értékelheti
egy PCR-reakción belül a víruseredetű génállományok relatív számát vagy a transzfektált szekvenciák
relatív számát. A génexpresszió-vizsgálat legelterjedtebb alkalmazása a cDNS-koncentráció
összehasonlítása egynél több reakcióban, az állandó állapotú messenger RNS szintjeinek a
felbecsülésére.

A szoftver egy cél relatív expressziószintjét az alábbi esetek egyikével számítja ki:

n Egy célszekvencia (1. cél) relatív expressziószintje egy másik célhoz (2. cél) képest; pl. egy gén
mennyisége egy másik génhez képest ugyanazon mintakezelés alatt.

n Egy célszekvencia relatív expressziós szintje egy mintában ugyanahhoz a célhoz képest eltérő
mintakezelés során; például egy gén önmagához viszonyított relatív mennyisége különböző időbeli,
földrajzi vagy fejlődési körülmények között.

Lemezbeállítás a génexpresszió-elemzéshez
A génexpresszió-elemzés elvégzéséhez a celláknak a következőket kell tartalmazniuk:

n Kettő vagy annál több cél – az a két cél, amelyek különböző sokszorosított géneket vagy
szekvenciákat képviselnek az Ön mintáiban.

n Egy vagy több referenciacél – normalizált expresszió esetében legalább egy célnak referenciacélnak
kell lennie. Jelölje ki az összes referenciacélt az Experiment Settings (Kísérlet beállításai) ablakban,
hogy az adatokat normalizált expresszió üzemmódban elemezhesse (ΔΔCq). A referenciát nem
tartalmazó futtatásokat relatív expresszió üzemmódban kell elemezni (ΔCq).

n Közös minták – az Ön reakcióinak tartalmazniuk kell közös mintákat (legalább kettő szükséges)
ahhoz, hogy a Gene Expression (Génexpresszió) fülön ábrázolt adatokat meg lehessen tekinteni.
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12. fejezet Génexpressziós elemzés

Ezeknek a mintáknak az Ön egyes célszekvenciáira vonatkozó különböző kezeléseket vagy
feltételeket kell képviselniük. Jelöljön ki egy kontroll mintát (ez egy opcionális lépés) az Experiment
Settings (Kísérlet beállításai) ablakban. Ha nincs kiválasztva kontroll, a szoftver a legalacsonyabb Cq
értéket használja kontrollként.

A génexpresszió beállítására vonatkozó követelmények a Plate Editor (Lemezszerkesztő) ablakban attól
függnek, hogy a reakciótartalmak egyszeres PCR típusúak (a reakciókban egyetlen fluorofór szerepel)
vagy többszörös PCR típusúak (a reakciókban egynél több fluorofór szerepel).

Irányított lemezbeállítás
Ha egy adatfájl lemezbeállítása nem tartalmazza az elemzéshez szükséges információkat, és a Gene
Expression (Génexpresszió) fül van kiválasztva, azon a helyen, ahol normál esetben az oszlopdiagram
látható, ezen információk beírására vonatkozó utasítások fognak megjelenni. Normalizált
génexpresszióhoz végezze el a következő lépéseket:

1. Határozza meg a Target (Cél) és a Sample (Minta) nevét a következők bármelyikével:

n Plate Setup (Lemezbeállítás) – a Plate Editor (Lemezszerkesztő) ablak megnyitása.

n Replace Plate File (Lemezfájl cseréje) – a Select Plate (Lemez kiválasztása) böngésző
megnyitása, amelyben megkereshet egy korábban elmentett lemezfájlt, amelyre a jelenlegi
lemezelrendezést szeretné kicserélni.

n Replace PrimePCR File (PrimePCR fájl cseréje) – a Select PrimePCR File (PrimePCR fájl
kiválasztása) párbeszédpanel megnyitása, amelyben megkereshet egy PrimePCR futtatási fájlt,
és azt alkalmazhatja a lemezelrendezésre.

2. Válasszon ki egy vagy több referenciacélt és egy kontroll mintát az Experiment Settings (Kísérlet
beállításai) párbeszédpanellel.

Ha a lemezelrendezés már tartalmaz a célra és a mintára vonatkozó információkat, csak a második
lépés szükséges (ilyen esetben ezt a rendszer narancssárga színnel kiemeli). Ezt a lépést el kell
végezni ahhoz, hogy a rendszer elvégezhesse a normalizált génexpresszió elemzését.

Megjegyzés: a pontszórási diagramok és klasztergramok adatai kizárólag akkor jelennek meg,
ha a génexpressziós vizsgálathoz a Plate Setup (Lemezbeállítás) alatt meghatározott, a
normalizált génexpresszióra vonatkozó összes követelmény teljesül.
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Génexpressziós diagramok
A CFX Maestro Dx SE több nézetben jeleníti meg a génexpresszió-adatokat. A(z) 30. táblázat a
szoftverben elérhető diagrambeállításokat határozza meg.

Gomb Név Funkció

Grafikus ábrázolás A normalizált génexpresszió-adatok
megjelenítése a következő nézetek egyikében:

n Oszlopdiagram (alapértelmezett)

n Dobozdiagram

n Pontdiagram

Klasztergram A normalizált expresszióadatok megjelenítése a
különböző célok és minták expressziójának
hasonlósági fokán alapuló hierarchiában.

Pontszórási diagram Egy kontroll céljai normalizált expressziójának
megjelenítése egy kísérleti mintával
összehasonlítva.

ANOVA A génexpresszió-adatokra vonatkozó egyirányú
ANOVA eredményeinek megjelenítése a
következő R csomagok segítségével,
amelyekkel a rendszer elvégzi az ANOVA
elemzést, és meghatározza a Tukey-féle
eredményeket:

n Kísérőelem az alkalmazott regresszióhoz
(Companion to Applied Regression; röviden:
car)

n Legkisebb négyzetek átlagai (least-square
means; röviden: lsmeans)

Reference Gene Selection
(Referenciagén kiválasztása)
eszköz

(A Gene Study /Génvizsgálat/ ablak Study
Analysis /Vizsgálat analízise/ fülén érhető el.)
Azonosítja a tesztelt referenciagéneket, és a
stabilitásuk szerint az Ideal (Ideális), Acceptable
(Elfogadható) vagy Unstable (Instabil)
kategóriába sorolja őket.

30. táblázat A génexpressziós diagramoknál elérhető beállítások
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Gomb Név Funkció

PrimePCR Controls Analysis
(PrimePCR kontrollok elemzése)

(A Gene Study /Génvizsgálat/ ablak Study
Analysis /Vizsgálat analízise/ fülén érhető el.)
Megjeleníti a tesztelt mintákra vonatkozó
eredményeket.

30. táblázat A génexpressziós diagramoknál elérhető beállítások, folytatás
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Grafikus ábrázolás

A rendszer a célok relatív expresszióját a következő két nézetben jeleníti meg:

n Gene Expression (Génexpressziós) diagram – a valós idejű PCR-adatok megjelenítése a
következők egyikeként:

o ΔΔCq – kontroll minták és referenciacélok használatával kiszámított relatív normalizált expresszió.

o ΔCq – a célgén relatív mennyisége egy mintában egy kontroll mintához viszonyítva.

Bővebb információk az adatok megtekintésével kapcsolatban: A diagramnézet módosítása és
jegyzettel való ellátása a(z) 277. oldalon.

n Spreadsheet (Táblázat) – a génexpressziós adatokat tartalmazó táblázat megjelenítése.

Tipp: Az elérhető lehetőségeket a jobb egérgombbal bármelyik diagramra vagy táblázatra
kattintva láthatja. A Plate Setup (Lemezbeállítás) legördülő menüben a View/Edit Plate (Lemez
megtekintése/szerkesztése) elem kiválasztásával megnyithatja a Plate Editor
(Lemezszerkesztő) ablakot, amelyben módosíthatja a lemez celláinak tartalmát.

Tipp: ha szeretné átrendezni a diagramon a célok és minták nevének sorrendjét, a jobb
egérgombbal kattintással elérhető menüből válassza ki a Sort (Rendezés) elemet.
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Normalizált génexpresszió

Az adatok normalizálásához használja egy vagy több referenciagén mért expressziószintjét
normalizációs faktorként. A referenciagének olyan célok, amelyek nincsenek szabályozva a vizsgált
biológiai rendszerben, pl. aktin,GAPDH vagy tubulin.

Normalizált génexpresszió (ΔΔCq) vizsgálatának beállítása

1. Nyisson meg egy adatfájlt (.pcrd kiterjesztéssel).

2. Tekintse át az adatokat a Data Analysis (Adatelemzés) ablak Quantification (Kvantifikáció) fülén.
Végezze el az adatok beállításait, pl. a küszöbérték és az elemzési üzemmód módosítását.

3. Zárja be a Gene Expression (Génexpresszió) fület.

4. A Gene Expression (Génexpresszió) fülön kattintson az Experiment Settings (Kísérlet beállításai)
lehetőségre.

5. Az Experiment Settings (Kísérlet beállításai) párbeszédpanelen végezze el a következőket:

a. Válassza ki a Samples (Minták) fület, és jelöljön ki egy kontrollt. Kontroll hozzárendelésekor a
CFX Maestro Dx SE az összes génhez tartozó relatív mennyiségeket a kontroll mennyiségére
normalizálja, ami a beállítás szerint 1.

b. Válassza ki a Target (Cél) fület, és jelölje ki a referenciagéneket. A génexpresszió-analízishez
szükség van egy referenciára a mintáiban levő célok közül.

6. Válassza ki a Normalized Expression (ΔΔCq) (Normalizált expresszió) lehetőséget, ha még nincs
kiválasztva, majd tekintse meg az expressziós szinteket a Gene Expression (Génexpresszió) fülön.

Megjegyzés: a Setup Wizard (Beállítási varázsló) szintén használható a lemezelrendezés
beállításához a normalizált génexpresszió-elemzéshez.

Relatív mennyiség

A relatív mennyiségi (ΔCq) adatok definíció szerint nincsenek normalizálva. Ez a módszer olyan minták
kvantifikálására használható, amelyek nem tartalmaznak referenciagéneket (célokat). A kutatók a futtatás
beállításakor általában adottnak veszik a következő szempontok egyikét:

n Minden minta megegyező mennyiségű RNS-t vagy cDNS-t) tartalmaz mindegyik cellában.

n A betöltött biológiai minta mennyiségében mutatkozó esetleges varianciát a futtatás után valamilyen
módszerrel normalizálni fogják a szoftveren kívül végzett adatelemzés során. Például a kutató dönthet
úgy, hogy a relatív mennyiségi értéket elosztja egy normalizáló faktorral, például az egyes mintákhoz
betöltött nukleinsav tömegével vagy azoknak a sejteknek a számával, amelyekből a nukleinsavat
izolálták.
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Relatív mennyiségi (ΔCq) elemzés futtatásához

u A Gene Expression (Génexpresszió) fülön válassza ki a Relative Quantity (Relatív mennyiség, ΔCq)
opciót a Mode (Üzemmód) legördülő listáról a jobb oldali táblán.

Tipp: ha szeretné az eredményeket összevetni a többi génexpresszió-futtatás eredményeivel,
nyisson meg egy új génvizsgálatot, vagy adjon egy adatfájlt egy létező génvizsgálathoz.

A diagramnézet módosítása és jegyzettel való ellátása
A diagram eszköztár menüparancsaival és az adatelemző diagrameszközökkel módosíthatja a
diagramnézetet, jegyzetekkel láthatja el az egyes diagramokat, és módosíthatja a diagram
megjelenítését. A diagram eszköztár a diagram és az adatelemző táblázat között jelenik meg a képernyő
alján.

A Diagram eszköztár eszközei

Tipp: az adatelemzési diagramok jobb oldalán megjelenő diagrameszközökkel kapcsolatos
információk: Diagramok a(z) 214. oldalon.

A diagramok alatt található eszköztár gyors hozzáférést biztosít a jegyzetelést biztosító eszközökhöz.

A 31. táblázat a diagramok eszköztárában levő gombok funkcióit ismerteti.

Gomb Név Funkció

Oszlopdiagram A célok relatív expresszióját jeleníti meg.

Dobozdiagram Az adatokat kvartilis tartományokként jeleníti meg (a
számítással kapcsolatos részletek: Dobozdiagram-
számítások a(z) 317. oldalon).

Megjegyzés: Csak akkor érhető el, ha az Analyze Using
(Elemzés a következő segítségével:) paraméter a
Biological Groups Only (Csak biológiai csoportok) értékre
van állítva.

31. táblázat A diagramok eszköztára
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Gomb Név Funkció

Pontdiagram Az egyes mintaadatpontokat jeleníti meg az egyes
célokhoz.
Megjegyzés: Csak akkor érhető el, ha az Analyze Using
(Elemzés a következő segítségével:) paraméter a
Biological Groups Only (Csak biológiai csoportok) értékre
van állítva.

Nyíl hozzáadása Nyilat rajzol az aktív diagramra.

Kör hozzáadása Kört rajzol az aktív diagramra.

Szöveg hozzáadása Szövegablakot illeszt az aktív diagramba, amelybe
szöveget írhat be a diagramon levő fontos elemek
azonosításához.

Visszavonás Eltávolítja vagy visszavonja az aktív diagramba helyezett
legutóbbi jelölést.

Mégis Érvényteleníti az aktív diagramon végrehajtott legutolsó
Visszavonás műveletet.

Minden jelölés törlése Törli az aktív diagram összes jelölését.

31. táblázat A diagramok eszköztára, folytatás

A célokra, mintákra és biológiai csoportokra vonatkozó adatok rendezése

Megjegyzés: ez az opció csak a génexpressziós diagramokon érhető el.

A célok, minták és biológiai csoportok listája alapértelmezés szerint ábécé-sorrendben jelenik meg. A
Sort (Rendezés) párbeszédpanelen a megjelenítést megváltoztathatja csökkenő ábécé-sorrendre, vagy
egy expressziót áthelyezhet a lista egy másik pontjára.

A célokra, mintákra és biológiai csoportokra vonatkozó adatok rendezéséhez

1. A diagrameszközökből válassza ki a Sort (Rendezés) eszközt.

Megjelenik a Gene Expression Chart Sorting (Génexpressziós diagram rendezése) párbeszédpanel.
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2. Ha a listát fordított ábécé-sorrendben szeretné megjeleníteni, a párbeszédpanelen kattintson a Z-A
elemre.

3. Egy expresszió áthelyezéséhez válassza ki az adott expressziót, majd a diagramok között kattintson
a megfelelő gombra:

n A kiválasztott expresszió áthelyezéséhez egyetlen pozícióval kattintson a felfelé, illetve lefelé
mutató nyílra.

n A kiválasztott expressziót a lista tetejére, illetve aljára helyezheti, ha a felfelé, illetve lefelé
mutató vonalas nyílra kattint.

4. Kattintson az OK gombra a módosítások elmentéséhez és a Gene Expression (Génexpresszió) fülre
való visszatéréshez.

Felhasználói útmutató | 279



12. fejezet Génexpressziós elemzés

A cél, a minta és a biológiai csoport színbeállításainak módosítása

A Color Settings (Színbeállítások) párbeszédpanelen módosíthatja egy cél, minta vagy biológiai csoport
színét, valamint törölheti az elemet a grafikonról.

A cél színbeállításainak a módosítása

1. Ellenőrizze a Gene Expression (Génexpresszió) párbeszédpanel jobb oldali panelén, hogy a Sample
(Minta) elem látható-e az X-Axis (X tengely) legördülő listában.

2. A Chart Tools (Diagrameszközök) szakaszban válassza ki a Color Settings (Színbeállítások) elemet.

Ekkor megjelenik a Color Settings (Színbeállítások) párbeszédpanel.

3. Ha szeretné módosítani egy cél megjelenítési színét, kattintson az adott cél színére a Color (Szín)
oszlopban.

4. A megjelenő Color (Szín) párbeszédpanelben válasszon ki egy új színt, majd kattintson az OK
gombra.

5. Ha szeretne törölni egy célt a génexpressziós grafikonról, vegye ki az adott cél jelölőnégyzetéből a
jelölést a Show Chart (Diagrammegjelenítése) oszlopban.

Tipp: ha az összes célt törölni szeretné, vegye ki a Show Chart (Diagrammutatása)
jelölőnégyzetből a jelölést az oszlop fejlécében.

6. (Opcionális) Az oszlopok alapértelmezés szerint homogén színnel jelennek meg. Ha az oszlopokat
színátmenettel szeretné megjeleníteni, vegye ki a Use Solid Colors (Egyszínű stílus használata)
jelölőnégyzetből a jelölést.

7. Az OK gombra kattintva elmentheti a módosításokat, és visszatérhet a Gene Expression
(Génexpresszió) fülre.

A minta vagy a biológiai csoport színbeállításainak módosításához

1. Ellenőrizze a Gene Expression (Génexpresszió) párbeszédpanel jobb oldali panelén, hogy a Target
(Cél) elem látható az X-Axis (X tengely) legördülő listában.

2. Végezze el a következő szakaszban szereplő lépéseket: A cél színbeállításainak a módosítása a(z)
280. oldalon.

A diagramnézet módosítása

Az aktuális diagramnézet módosításához

u Válassza ki a célnézet menüparancsát az eszköztárból.

Megjegyzés: a Gene Expression (Génexpresszió) fül mindig az alapértelmezett Bar Chart
(Oszlopdiagram) nézet adatait megjelenítve nyílik meg.
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Szélsőséges adatpontok kizárása

A pontdiagramon egyszerűen megtekintheti a szélsőséges adatpontokat, és kizárhatja őket a
vizsgálatból.

A szélsőséges adatpontok kizárásához

u A pontdiagramon kattintson a jobb egérgombbal a cél szélsőséges adatpontjára, és válassza ki az
Exclude Well from Analysis (Cella kizárása a vizsgálatból) lehetőséget.

A szoftver törli az adatpontot a pontdiagramról, és a cella szürke színűre vált a Quantifiation
(Kvantifikáció) fül Well Selector (Cella kiválasztása) menüpontjában.

Kizárt szélsőséges adatpont befoglalása

u A Quantification (Kvantifikáció) fülön kattintson a jobb egérgombbal a cellára a Well Selector (Cella
kiválasztása) ablakban, és válassza ki a Well > Include in Analysis (Cella > Befoglalás az elemzésbe)
lehetőséget.

Az adatpontok részleteinek megtekintése

Adatpontok részleteinek megtekintéséhez

u A dobozdiagramban vagy pontdiagramban vigye a kurzort egy egyedi adatpont fölé.

Megjelenik egy eszközleírás, amely a minta nevét és expresszióját mutatja (relatív mennyiség vagy
normalizált expresszió, a kiválasztott üzemmódtól függően).

Diagramok ellátása jegyzetekkel

Az adatok egyértelmű közlése érdekében mindegyik oszlopdiagram-nézethez hozzáadhat nyilakat,
köröket és szövegeket. A jegyzeteket a szoftver az oszlopdiagrammal együtt elmenti, és megjelennek az
exportált és kinyomtatott fájlban. Egy adott diagramnézethez adott jegyzeteket azonban nem adja hozzá
a többi diagramnézethez.

Egy nyíl vagy egy kör diagramra rajzolásához

1. Az oszlopdiagram eszköztárában kattintson a megfelelő eszközre.

2. Kattintson az oszlopdiagramba, és szükség szerint húzza át a kurzort a diagramon.
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Szöveg hozzáadásához a diagramhoz

1. Az oszlopdiagram eszköztárában kattintson az Add Text (Szöveg hozzáadása) lehetőségre.

2. Kattintson az oszlopdiagramba. Az adott helyen megjelenik egy szövegmező.

3. Írja be a szöveget a szövegmezőbe.

4. A szövegmezőből a diagramon bárhová kattintva léphet ki.

Tipp: az Enter gombot megnyomva több sort is beírhat a szövegmezőbe.

Jegyzet mozgatásához

1. Vigye az egérmutatót a jegyzet fölé. Az ikon átvált egy mutató ujj képére, és a program kiemeli a
jegyzet határvonalát.

2. Kattintson a jegyzetbe, és húzza egy másik helyre.

3. Az új helyére történő rögzítéshez eressze el a jegyzetet.

Jegyzet visszavonásához

u Kattintson az Undo (Visszavonás) gombra.

A szoftver törli a legutolsó alkalommal hozzáadott jegyzetet.

Tipp: a tíz legutóbbi jegyzetet vonhatja vissza egyenként.

Jegyzet visszaállításához

u Kattintson a Redo (Mégis) gombra.

a legutolsóként eltávolított jegyzet újra megjelenik.

Tipp: A tíz legutóbbi jegyzetet hozhatja vissza egyenként.

Jegyzet törléséhez

u Kattintson a jobb egérgombbal a jegyzetre, és válassza ki a Delete (Törlés) opciót.
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Génexpressziós adatok módosítása
Az analízis-üzemmód (normalizált expresszió /∆∆Cq/ vagy relatív mennyiség /∆Cq/) kiválasztása után
állítsa be a megtekintett adatokat a Gene Expression (Génexpresszió) fülön, a diagram jobb oldalán levő
beállítási lehetőségek módosításával.

Tipp: az alapértelmezett génexpressziós adatokat a User Preferences (Felhasználói beállítások)
párbeszédablakban állíthatja be (lásd: A génexpresszió-adatfájlra vonatkozó alapértelmezett
paraméterek beállítása a(z) 97. oldalon).

Grafikonadatok

A grafikonadatok beállításainak engedélyezéséhez állítsa az Y tengely értékét lineáris skálára (Linear
scale). A grafikonadatok beállításai lehetővé teszik az adatok grafikonon való megjelenítését az alábbi
opciók egyike szerint:

n Relative to control (A kontrollhoz képest) – az adatok megjelenítése grafikonon 0-tól 1-ig skálázott
tengellyel. Akkor válassza ki ezt a lehetőséget, ha a futtatásban kontrollt állított be, és a cél csökkent
vagy fokozott expresszióját szeretné gyorsan ábrázolni.

n Relative to zero (A nullához képest) – az adatok megjelenítése grafikonon, az origó a nullponton van.

Analyze Using (Elemzés a következő segítségével:)

A legördülő menüben kiválaszthatja, hogy a rendszer hogyan elemezze és ábrázolja az adatokat. A
következő lehetőségeket használhatja:

n Samples Only (Csak minták) – a rendszer mintánként elemzi és ábrázolja az adatokat.

n Biological Groups Only (Csak biológiai csoportok) – a rendszer a biológiai csoportok alapján elemzi
és ábrázolja az adatokat. A biológiai csoporthoz megjelenített expresszió az adott csoportban
található minták geometriai középértéke.

n Sample Biological Group (Minta, biológiai csoport) – a rendszer mintánként elemzi és ábrázolja az
adatokat, a minta neve után illesztve a biológiai csoportot. A rendszer a megjelenített p-értékeket a
biológiai csoport alapján számítja ki.

n Biological Group Sample (Biológiai csoport, minta) – a rendszer mintánként elemzi és ábrázolja az
adatokat, a minta neve elé illesztve a biológiai csoportot. A rendszer a megjelenített p-értékeket a
biológiai csoport alapján számítja ki.

A legördülő menüvel kiválaszthatja azt a mintát, amelyet a rendszer a relatív mennyiség
normalizálásához fog használni:
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P-értékek és a p-értékre vonatkozó küszöbérték megjelölése a diagramon

Amikor be van jelölve az Annotate P-Values (P-értékek megjelölése) elem, a szoftver egy csillagot (*)
jelenít meg az oszlopdiagramon a cél felett, ha p-értéke a kiválasztott küszöbérték alatt van. A szoftver
automatikusan kiszámítja a p-értéket úgy, hogy egy standard t-próbával összehasonlítja a minta
expressziójának szintjét a kiválasztott kontroll minta expressziójának szintjével. A p-érték
küszöbértékének tartománya: 0,000 – 1,000.

Az X tengelyre vonatkozó beállítások

Az X tengelyre vonatkozó beállítások lehetővé teszik a Gene Expression (Génexpressziós) diagram X
tengelye adatainak kiválasztását:

n Target (Cél) – a célneveket ábrázolja az X tengelyen.

n Sample (Minta) – a mintaneveket ábrázolja az X tengelyen.

Az Y tengelyre vonatkozó beállítások

Az Y tengelyre vonatkozó beállítások lehetővé teszik a Gene Expression (Génexpressziós) diagram
ábrázolását az alábbi három skála egyikével:

n Linear (Lineáris) – ezzel az opcióval lineáris skálán ábrázolhatja az adatokat.

Tipp: az Y tengely Linear (Lineáris) értékre állítása bekapcsolja a Graph Data (Diagramadatok)
legördülő listát, amelyről kiválaszthatja az adatok a kontrollhoz vagy nullához viszonyított
ábrázolását.

n Log 2 – ezzel az opcióval a mintákat nagy dinamikus tartományban értékelheti ki.

n Log 10 – ezzel az opcióval a mintákat nagy dinamikus tartományban értékelheti ki.

Skálázási opciók

Válassza ki a Normalized Gene Expression (ΔΔCq) (Normalizált génexpresszió) lehetőséget, és állítsa be
a opciót None (Nincs) értékre a Gene Expression (Génexpresszió) diagram skálázási opcióinak
engedélyezéséhez. Válasszon ki egyet ezekből a méretezési lehetőségekből az adatok a futtatás
beállításainak legjobban megfelelő kiszámításához és megjelenítéséhez:

n Unscaled (Skálázatlan) – a skálázatlan normalizált génexpressziót jeleníti meg.

n Highest (Legmagasabb) – a normalizált génexpressziót az egyes célokhoz úgy skálázza, hogy az
egyes minták expressziószintjét elosztja a legmagasabb szintű expresszióval az összes mintában.

Ez a skálázási lehetőség a „legmagasabbra méretezett” képletet használja.

n Lowest (Legalacsonyabb) – a normalizált génexpressziót az egyes célokhoz úgy skálázza, hogy az
egyes minták expressziószintjét elosztja a legalacsonyabb szintű expresszióval az összes mintában.
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Ez a skálázási lehetőség a „legalacsonyabbra méretezett” képletet használja.

n Average (Átlag) – a normalizált génexpressziót az egyes célokhoz úgy skálázza, hogy az egyes
minták expressziószintjét elosztja az összes minta mértani középértékével.

Ez a skálázási lehetőség az „átlagra méretezett” képletet használja.

Válassza ki, hogy a rendszer milyen típusú hibaszámításokat (hibasávokat) jelenítsen meg a Gene
Expression (Génexpresszió) diagramon:

A diagramhibasáv szorzója

Válasszon ki egy szorzót a hibaoszlopokhoz a Gene Expression (Génexpresszió) diagramban.
Válasszon egyet a következő egész számokból:

n +/- 1 (alapértelmezett)

n 2

n 3

A szorzó típusa változik, amikor kiválasztja a hibaoszlopot:

n SEMs a középérték standard hibájához

n Std Devs a szórásokhoz

Kísérlet beállításai
Tipp: Ez a párbeszédpanel a Plate Editor (Lemezszerkesztő) eszközben is elérhető. További
információ: Kísérleti beállítások módosítása a(z) 160. oldalon.

Az Experiment Settings (Kísérlet beállításai) párbeszédpanelen megtekintheti vagy módosíthatja a célok,
minták vagy biológiai csoportok listáját, kiválaszthatja a referenciagéneket, kontrollokat, vagy beállíthatja
a vizsgálni kívánt Gene Expression Analysis (Génexpresszió-elemzési) csoportot, ha hozzáadott
biológiai csoportokat a cellákhoz.

Az Experiment Settings (Kísérlet beállításai) párbeszédpanel megnyitásához

u Kattintson a Graphing (Grafikus ábrázolás) fülön az Experiment Settings (Kísérlet beállításai)
gombra a jobb oldali panel alján.

Megjelenik az Experiment Settings (Kísérlet beállításai) párbeszédpanel és rajta a Targets (Célok)
fül.
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A Targets (Célok) beállításainak módosításához

u A Targets (Célok) fülön végezze el az alábbiak valamelyikét:

n Egy cél kiválasztásához génexpresszióadat-elemzés referenciájaként jelölje be a nevét a
Reference (Referencia) oszlopban.

n A cél színének módosításához kattintson a cellájára a Color (Szín) oszlopban, és módosítsa a
színt a megjelenő Color (Szín) párbeszédpanelen.

A szín változása megjelenik a Gene Expression (Génexpresszió) diagramokban.

n Egy korábban meghatározott hatásfokérték használatához szüntesse meg a cél
jelölőnégyzetének bejelölését az Auto Efficiency (Automatikus hatásfok) oszlopban, majd írjon
be egy számot a cél hatásfokának százalékos értékéhez.

Ha egy cél adatai tartalmaznak standard görbét, a szoftver az Auto Efficiency (Automatikus
hatásfok) funkcióval kiszámítja a cél relatív hatásfokát.

A Sample (Minta) beállításainak módosításához

u A Samples (Minták) fülön végezze el az alábbiak valamelyikét:

n Egy minta kiválasztásához génexpresszióadat-elemzés kontrolljaként jelölje be a nevét a
Control (Kontroll) oszlopban.

n Aminta színének módosításához kattintson a cellájába a Color (Szín) oszlopban, és módosítsa
a színt a megjelenő Color (Szín) párbeszédpanelen.

A szín változása megjelenik a Gene Expression (Génexpresszió) diagramokban.

n Aminta megjelenítéséhez a génexpressziós diagramokban válassza ki a Show Chart (Diagram
megjelenítése) oszlopban.

n Aminta törléséhez a génexpressziós diagramokból szüntesse meg a bejelölését a Show Chart
(Diagrammegjelenítése) oszlopban.

Tipp: a mintacsoport adatai megmaradnak a Results (Eredmények) táblázatban.

Minta kizárásához az elemzés számításaiból

u Jelölje be a jelölőnégyzetét az Experiment Settings (Kísérlet beállításai) párbeszédpanel alján.

Megjegyzés: ezzel kizárja a kontrollokat, illetve standardokat a génexpresszió-elemzésből.
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A jobb egérgombbal kattintva elérhető menüpontok
Kattintson a jobb egérgombbal a génexpressziós diagramra a 32. táblázat látható elemek
kiválasztásához.

Tétel Funkció

Copy (Másolás) A diagram vágólapra másolása.

Save Image As (Kép mentése
másként)

A diagrammentése képfájlként. Állítsa be a kép felbontását és
méreteit, majd válassza ki a fájltípust (PNG, JPG, vagy BMP).

Page Setup (Oldalbeállítás) A nyomtatásra vonatkozó oldalbeállítás kiválasztása.

Print (Nyomtatás) A diagram kinyomtatása.

Set Scale to Default (Skála
alapértelmezett értékre állítása)

Show All (Az összes adat megjelenítése) – az összes adat
megjelenítése az oszlopdiagramon. Scroll Bar (Görgetősáv) –
görgetősáv megjelenítése, ha annyi minta található, amennyit nem
lehet egyszerre megjeleníteni a diagram keretében a minimális
oszlopszélesség megtartása mellett.

Diagrambeállítások A Chart Settings (Diagrambeállítások) ablak megnyitása, ahol
módosíthatja a grafikont.

Sort (Rendezés) A diagram X tengelyén megjelenő minták vagy célok sorrendjének
rendezése.

Use Corrected Std Devs
(Korrigált szórások használata)

A hibasávok kiszámítása a korrigált szórás képletével.

Use Solid Bar Colors (Homogén
oszlopok használata)

Homogén oszlopok megjelenítése a diagramon.

X–Axis Labels (Az X tengely
címkéi)

Az X tengely címkéinek megjelenítése vízszintesen vagy döntve.

32. táblázat A jobb egérgombbal kattintással elérhető génexpressziós menüpontok

Felhasználói útmutató | 287



12. fejezet Génexpressziós elemzés

Adattáblázat
A 33. táblázat a Gene Expression (Génexpresszió) adattáblában megjelenő adatokat ismerteti.

Megjegyzés: A rendszer a táblában szereplő értékeket a jobb oldali panelen kiválasztott
grafikontípus és beállítások alapján számítja ki.

Információk Leírás

Target (Cél) Az Experiment Settings (Kísérlet beállításai) ablakban kiválasztott
célnév (sokszorosított gén).

Biological Group (Biológiai
csoport)

Sample Biological Group (Minta,
biológiai csoport)

Biological Group Sample
(Biológiai csoport,) minta

Az Experiment Settings (Kísérlet beállításai) ablakban kiválasztott
minta és/vagy biológiai csoport neve.

Kontroll Az Experiment Settings (Kísérlet beállításai) ablakban kiválasztott
kontroll neve. Ha az Analyze Using (Elemzés a következő
segítségével:) paraméterhez a Samples Only (Csak minták) érték van
beállítva, az Experiment Settings (Kísérlet beállításai) ablakban a
Control (Kontroll) a kiválasztott minta. Ha a Biological Groups Only
(Csak biológiai csoportok), a Sample Biological Group (Minta, biológiai
csoport) vagy a Biological Group Sample (Biológiai csoport, minta)
érték van kiválasztva, a kontroll az Experiment Settings (Kísérlet
beállításai) ablakban kiválasztott biológiai csoport.

Relatív mennyiség vagy
expresszió

A kiválasztott üzemmódtól függően relatív mennyiség (ΔCq) vagy
normalizált génexpresszió (ΔΔCq).

A relatív mennyiség vagy az
expresszió középértékének
standard hibája (vagy szórása)

A kiválasztott opciótól függően a relatív mennyiség, illetve a
normalizált expresszió középértékének standard hibája vagy szórása.
Csak akkor elérhető, ha az Analyze Using (Elemzés a következő
segítségével:) paraméter a Samples Only (Csak biológiai csoportok),
Sample Biological Group (Minta, biológiai csoport) vagy Biological
Group Sample (Biológiai csoport, minta) értékre van állítva.

33. táblázat A Graphing (Grafikus ábrázolás) fül
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Információk Leírás

A relatív mennyiség vagy
expresszió korrigált
középértékének standard hibája
(vagy szórása)

A kiválasztott opciótól függően a relatív mennyiség, illetve a
normalizált expresszió korrigált középértékének standard hibája vagy
szórása. Csak akkor elérhető, ha az Analyze Using (Elemzés a
következő segítségével:) paraméter a Samples Only (Csak biológiai
csoportok), Sample Biological Group (Minta, biológiai csoport) vagy
Biological Group Sample (Biológiai csoport, minta) értékre van állítva.

A Cq középértéke A kvantifikációs ciklus középértéke (nem jelenik meg, ha az Analyze
Using (Elemzés a következő segítségével:) paraméter a Biological
Groups Only (Csak biológiai csoportok) értékre van állítva).

A Cq középértékének standard
hibája (vagy szórása)

A kiválasztott opciótól függően a kvantifikációs ciklus középérték
standard hibája vagy szórása (nem jelenik meg, ha az Analyze Using
(Elemzés a következő segítségével:) paraméter a Biological Groups
Only (Csak biológiai csoportok) értékre van állítva).
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Show Details (Részletek megjelenítése) opció
A 34. táblázat az oszlopdiagram táblázatának jobb gombos menüjéről kiválasztott Show Details
(Részletek megjelenítése) parancs hatására megjelenített adatokat mutatja be.

Információk Leírás

Data Set (Adatkészlet) Fluoreszcenciaadatok egy fluorofórból az adatfájlban

Relative Quantity A minták számított relatív mennyisége

Relative Quantity SD A relatív mennyiség számításának szórása

Corrected Relative Quantity SD A korrigált relatív mennyiség számított szórása

Relative Quantity SEM A relatív mennyiség számítása középértékének standard hibája

Corrected Relative Quantity
SEM

A korrigált relatív mennyiség középértékének számított standard
hibája

Relative Quantity(lg) A statisztikai vizsgálathoz használt relatív mennyiség log2 értéke

SD RQ(lg) A relatív mennyiség szórása (log2)

SEM Expression(lg) Az expresszió középértékének standard hibája (log2)

Unscaled Expression Számított skálázatlan expresszió

Unscaled Expression SD A skálázatlan expresszió számított szórása

Corrected Unscaled Expression
SD

A korrigált skálázatlan expresszió számított szórása

Unscaled Expression SEM A skálázatlan expresszió számított középértékének standard hibája

Corrected Unscaled Expression
SEM

A korrigált skálázatlan expresszió középértékének számított standard
hibája

Unscaled Expression(lg) A skálázatlan expresszió log2 értéke

SD Unscaled Expression(lg) A skálázatlan expresszió szórása (log2)

SEM Unscaled Expression(lg) A skálázatlan expresszió középértékének standard hibája (log2)

Expression Normalizált génexpresszió

34. táblázat Az oszlopdiagram táblázatában látható információk a Show Details (Részletek
megjelenítése) parancs kiválasztása esetén

290 | CFX Maestro Dx SE szoftver



Grafikus ábrázolás

Információk Leírás

Corrected Expression SD A korrigált expresszió számított szórása

Expression SEM Az expresszió középértékének standard hibája

Corrected Expression SEM A korrigált expresszió középértékének számított standard hibája

Expression(lg) A statisztikai analízishez használt expresszió (normalizált expresszió)
log2 értéke

SD Expression(lg) Az expresszió szórása (log2)

SEM Expression(lg) Az expresszió középértékének standard hibája (log2)

Mean Cq A kvantifikációs ciklus középértéke

Cq SD A kvantifikációs ciklus szórása

Cq SEM A kvantifikációs ciklus középértékének standard hibája

34. táblázat Az oszlopdiagram táblázatában látható információk a Show Details (Részletek
megjelenítése) parancs kiválasztása esetén, folytatás

Felhasználói útmutató | 291



12. fejezet Génexpressziós elemzés

Klasztergram
A klasztergram az adatokat a különböző célokhoz és mintákhoz az expresszió hasonlósági fokán alapuló
hierarchiában jeleníti meg.

Megjegyzés: az oszlopdiagramok relatív expresszióján kívüli bármelyik adatdiagram
megjelenítéséhez ki kell választania egy referenciacélt.

A klasztergram a következők szerint ábrázolja egy minta vagy cél relatív expresszióját:

n Fokozott expresszió (piros) – magasabb expresszió

n Csökkent expresszió (zöld vagy kék) — alacsonyabb expresszió

n Nincs változás (fekete)

n Nincs számított érték (fekete, fehér „X”-szel)

Minél halványabb a szín, annál nagyobb az expresszió relatív különbsége. Ha nem számítható ki
normalizált Cq-érték, a négyzet fekete színű lesz egy fehér „X”-szel.

Az adatdiagram külső szélein egy dendrogram található, amely a klaszterhierarchiát jelzi. A hasonló
expressziós mintát mutató célok vagy minták ágai egymáshoz közel lesznek, míg az eltérő mintát
mutatók távolabb lesznek egymástól.

Beállítások
A következő opciókat állíthatja be:

n Cluster By (Csoportosítás a következő szerint:) – válasszon a Targets, Samples, Both, or None
(Célok, Minták, Mindkettő vagy Egyik sem) lehetőségek közül.

n Size (Méret) – beállítja a kép méretét, és módosítja a diagram nagyításának a mértékét.

n Split Out Replicates (Replikátumok különválasztása) – megjeleníti az egyes replikátumok értékeit.

Tipp: módosíthatja a színmintát az alapértelmezett Piros/Zöld színmintáról Piros/Kék színmintára , ha
kiválasztja ezt a lehetőséget diagram jobb gombos menüjéből.

A jobb egérgombbal kattintással elérhető menüpontok
A klasztergramnál ugyanazok a menüpontok érhetők el a jobb egérgombbal kattintással, mint az
oszlopdiagramnál. Az elérhető opciók: 32. táblázat a(z) 287. oldalon. Továbbá a Color Scheme
(Színséma) kiválasztásával módosíthatja a csökkent expressziót a diagramon az alapértelmezett
Red/Green (Piros/zöld) beállításról a Red/Blue (Piros/kék) beállításra.

Adattáblázat
A táblázat a cél, a minta és a normalizált expresszió értékeit mutatja.

292 | CFX Maestro Dx SE szoftver



Pontszórási diagram

Pontszórási diagram
A pontszórási diagram a célok normalizált expresszióját ábrázolja egy kontrollnál egy kísérleti mintával
szemben. A görbében levő vonalak a változási szorzó küszöbértékét jelzik. A vonalak között levő adatpontok azt
jelzik, hogy az adott célhoz (génhez) tartozó expressziókülönbség elhanyagolható a minták között. A vonalakon
kívül levő adatpontok meghaladják a változási szorzó küszöbértékét, és érdemes lehet megvizsgálni őket.

A diagram a következő célexpresszió-változásokat mutatja a változási szorzó küszöbértéke alapján:

n Fokozott expresszió (piros színű kör) – viszonylag magasabb expresszió

n Csökkent expresszió (zöld vagy kék színű kör) – viszonylag alacsonyabb expresszió

n Nincs változás (fekete színű kör)

A változási szorzó küszöbértékének módosításához kattintson valamelyik küszöbértékvonalra, és húzza
el.

Beállítások
A következő opciókat állíthatja be:

n Control Sample (Kontroll minta)

n Experimental Sample (Kísérleti minta)

n Fold Change Threshold (A változási szorzó küszöbértéke). Ha Ön növeli vagy csökkenti a változási
szorzó értékét, a küszöbértéket jelző vonalak ennek megfelelően mozognak a grafikonon.

A jobb egérgombbal kattintással elérhető menüpontok
A pontszórási diagramnál ugyanazok a menüpontok érhetők el a jobb egérgombbal kattintással, mint az
oszlopdiagramnál. Az elérhető opciók: 32. táblázat a(z) 287. oldalon. Továbbá a Symbol (Szimbólum)
kiválasztásával módosíthatja, hogy a rendszer az alapértelmezett kör helyett a következők közül melyik
szimbólumot használja a görbén:

n Triangle (Háromszög)

n Cross (Kereszt)

n Square (Négyzet)

n Diamond (Gyémánt)
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Adattáblázat
A táblázat a kontroll és kísérleti mintákra vonatkozó cél- és normalizált expresszió értékeit mutatja.
Továbbá azt is jelzi, hogy a célok expressziója a célszabályozáshoz viszonyítva fokozott vagy csökkent.
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A Results (Eredmények) táblázat
Az Eredmények táblázat összefoglalja az összes diagram adatait. A 35. táblázat a Results (Eredmények)
táblázatban megjelenő adatokat jeleníti meg.

Információk Leírás

Cél Célnév (sokszorosított gén)

Sample (Minta) Mintanév

A Cq középértéke A kvantifikációs ciklus középértéke

Mean Efficiency Corrected Cq (A
hatásfokkal korrigált Cq
középértéke)

A kvantifikációs ciklus középértéke a reakció hatásosságához történő
helyesbítés után

Normalizált expresszió Egy referenciacélhoz normalizált célexpresszió (ΔΔCq)

Relative Normalized Expression
(Relatív normalizált expresszió)

Egy kontroll mintához viszonyított normalizált expresszió; más néven:
Fold Change (A változás szorzója)

Regulation (Szabályozás) Az expressziónak egy kontroll mintához viszonyított változása

Compared to Regulation
Threshold (A szabályozási
küszöbértékkel
összehasonlítva)

Egy kísérleti minta fokozott vagy csökkentett expressziója a
küszöbérték-beállítás alapján

35. táblázat A Results (Eredmények) fülön látható információk

Megjegyzés: A replikátumokra vonatkozó adatok kizárólag azokon az adatelemzési füleken látható
táblázatokban találhatók meg, amelyeken a Split Out Replicates (Replikátumok szétosztása) ki van
választva (vagyis a Clustergram /klasztergram/ fülön). Ha az oszlopdiagramon kontroll mintaként a
„none” (nincs) opciót választja ki, a génexpresszió-elemzési táblázatokban található
expresszióadatok között eltérések lehetnek.
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Génvizsgálat
Génvizsgálatot hoz létre, hogy egy – a kísérletek között normalizálást végző – futtatások közötti kalibrátor
segítségével összehasonlíthasson egy vagy több valós idejű PCR-kísérletből származó génexpresszió-
adatokat. Génvizsgálat létrehozásához adjon hozzá egy vagy több (.pcrd kiterjesztésű) adatfájlból
adatokat a génvizsgálathoz. A szoftver ezeket egyetlen (.mgxd kiterjesztésű) fájlba csoportosítja.

Megjegyzés: azt, hogy egy génvizsgálat részeként legfeljebb hány darab mintát elemezhet, az
határozza meg, hogy a számítógép mennyi RAM-mal és virtuális memóriával rendelkezik.

Futtatások közötti kalibrálás
A rendszer minden egyes génvizsgálat során automatikusan megkísérli elvégezni a futtatások közötti
kalibrálást az egyes célokhoz, hogy normalizálja a különálló valós idejű PCR-futtatásokban (vagyis a
különböző lemezekből létrehozott különböző .pcrd kiterjesztésű fájlokban) vizsgált célok közötti
eltéréseket.

Ahhoz, hogy a szoftver futtatások közötti kalibrátorként érzékeljen egy mintát, az összehasonlítani kívánt
összes lemezben azonosnak kell lennie a célnévnek, a mintanévnek, valamint – ha használja – a biológiai
sor nevének.

Megjegyzés: Ahhoz, hogy a rendszer futtatás közötti kalibrálást végezzen, legalább egy futtatások
közötti kalibrátor mintának jelen kell lennie a génvizsgálatban. A megfelelő futtatások közötti
kalibrátor mintákat nem tartalmazó célokat a rendszer korrigálás nélkül fogja feldolgozni a
génvizsgálatban (ez nem ajánlott).

A futtatások közötti kalibrátorok kétféleképpen alkalmazhatók:

n Célonként – a különböző PCR-primerek különböző hatásfokkal rendelkezhetnek. A rendszer
alapértelmezés szerint az ugyanazon lemezben található összes olyan cellára alkalmazza a
futtatások közötti kalibrátort, amelyek azonos nevű céllal (például az ugyanazon vizsgálattal generált
Cq-értékkel) rendelkeznek.

n A teljes vizsgálatra – a felhasználó kiválaszt egyetlen futtatások közötti kalibrátort, és a rendszer ezt
alkalmazza a teljes génvizsgálatra.
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A Gene Study (Génvizsgálat) párbeszédpanel

A Gene Study (Génvizsgálat) párbeszédpanel két fület tartalmaz:

n Study Setup (Vizsgálat beállítása) fül – a futtatásokat kezeli a génvizsgálatban.

Fontos: egy génvizsgálatban az adatfájlok hozzáadása vagy eltávolítása nem változtatja meg
az eredeti fájlban levő adatokat.

n Study Analysis (Vizsgálat kiértékelése) fül – megjeleníti a génexpresszió adatokat a kombinált
futtatásokhoz.

A Study Setup (Vizsgálat beállítása) fül
A 36. táblázat a Study Setup (Vizsgálat beállítása) fülön megjelenő adatokat ismerteti.

Oszlop címe Leírás

File Name (Fájl neve) A futtatási adatfájl (.pcrd kiterjesztés) neve

File Folder (Fájlmappa) A génvizsgálatban levő egyes futtatások adatfájljait tároló könyvtár

Date Created (Létrehozás
dátuma)

A futtatási adatok rögzítésének dátuma

36. táblázat A Study Setup (Vizsgálat beállítása) fül a Gene Study (Génvizsgálat)
párbeszédpanelen
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Oszlop címe Leírás

Well Group Name
(Cellacsoport neve)

A fájlnak a génvizsgálathoz történt hozzáadásakor kiválasztott
cellacsoport neve

Tipp: egy cellacsoport elemzéséhez a génvizsgálatban az adott
cellacsoportot az adatfájl génvizsgálatba történő importálása előtt
ki kell választani a Data Analysis (Adatelemzés) ablakban.

Step (Lépés) A protokoll azon lépése, amely tartalmazza a lemezleolvasást a valós
idejű PCR adatok rögzítéséhez

Run Type (Futtatás típusa) A felhasználó által meghatározott vagy PrimePCR-futtatás

Protocol Edited (Protokoll
szerkesztve)

Ha ki van választva, ez azt jelzi, hogy egy PrimePCR-futtatáshoz
használt protokoll szerkesztve volt

View Plate (Lemez
megtekintése)

Megjeleníti a lemez lemeztérképét a génvizsgálatban szereplő összes
futtatás adataival

36. táblázat A Study Setup (Vizsgálat beállítása) fül a Gene Study (Génvizsgálat)
párbeszédpanelen, folytatás

Génvizsgálat előkészítése
Génvizsgálat előkészítéséhez

1. Mielőtt adatokat importálna egy génvizsgálatba, végezze el a következőket a Data Analysis
(Adatelemzés) ablakban:

n Ellenőrizze, hogy az ugyanazt a tartalmat tartalmazó minták neve megegyezik. Egy
génvizsgálatban a szoftver feltételezi, hogy a megegyező cél- vagy mintanevű cellák
ugyanolyan mintákat tartalmaznak.

n Állítsa be a kiindulási értéket és a küszöbértéket (Cq) a Quantification (Kvantifikáció) fülön az
adatok optimalizálására az egyes futtatásokban.

n Válassza ki azt a cellacsoportot, amelyet szeretne bevenni a génvizsgálatba.

Egy cellacsoport adatainak a megjelenítéséhez a génvizsgálatban azt a csoportot ki kell
választani az adatfájl importálása előtt.

A Study Setup (Vizsgálat beállítása) fül a génvizsgálat összes futtatásának listáját mutatja.

2. A Gene Study (Génvizsgálat) párbeszédpanelen válassza ki a Study Setup (Vizsgálat beállítása)
fület.

3. Kattintson az Add Data Files (Adatfájlok hozzáadása) opcióra egy fájl kiválasztásához a fájlkezelő
ablakból.
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Tipp: gyorsan hozzáadhat futtatásokat egy génvizsgálathoz, ha az adatfájlokat (.pcrd
kiterjesztés) ráhúzza a Study Setup (Vizsgálat beállítása) párbeszédpanelre.

4. A CFX Maestro Dx SE az adatfájlok hozzáadásával egyidejűleg automatikusan végrehajtja a
génvizsgálat elemzését. Az eredmények megtekintéséhez válassza ki a Study Analysis (Vizsgálat
elemzése) fület.

Futtatások eltávolításához a génvizsgálatból

u Válasszon ki egy vagy több fájlt a listából, és kattintson a Remove (Eltávolítás) parancsra.

Megjegyzések hozzáadásához a génvizsgálathoz

u A fájlokkal és az analízissel kapcsolatos megjegyzéseket írja be a Notes (Megjegyzések)
szövegpanelbe.

A Study Analysis (Vizsgálati elemzés) fül
A Study Analysis (Vizsgálati elemzés) fülön a génvizsgálat során elvégzett összes futtatásból származó
adatok láthatók. A génexpresszióadat-elemzési opciók ugyanazok, mint egyetlen adatfájl esetében,
kivéve a következőket:

n Az oszlopdiagramok esetében az Inter-run Calibration (Futtatások közötti kalibrálás) elemre kattintva
megjelennek a futtatások közötti kalibrálási értékek (ha a rendszer kiszámította őket).

Megjegyzés: kizárólag a következő mintatípusok használhatók futtatások közötti kalibrátorként:

o Unknown (Ismeretlen)

o Standard

o Positive Control (Pozitív kontroll)

A Negative Control (Negatív kontroll), no template control (sablon nélküli kontroll, NTC) és no reverse
transcriptase control (reverz transzkriptáz nélküli kontroll, NRT) mintatípusok nem használhatók
futtatások közötti kalibrátorként.

n A Reference Gene Selection (Referenciagén kiválasztása) eszköz beazonosítja a tesztelt
referenciagéneket, és a stabilitásuk szerint az Ideal (Ideális), Acceptable (Elfogadható) vagy
Unstable (Instabil) kategóriába sorolja őket:

o Az ideális referenciagének stabilak, és minimális eltérésekkel vannak jelen a tesztelt mintákban.

o Az elfogadható referenciagének nem ideálisan stabilak, és mérsékelt eltérésekkel vannak jelen
a tesztelt mintákban. Akkor használja ezeket a referenciagéneket az elemzéshez, ha nincsenek
ideális referenciagének.
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o Az instabil referenciagének nagymértékű eltérésekkel vannak jelen a tesztelt mintákban.
Ajánlott ezeket a géneket kizárni az elemzésekből.

n A PrimePCR Controls (PrimePCR-vezérlők) eszköz egy táblában megjeleníti a tesztelt mintákra
vonatkozó eredményeket:

o A Summary (Összefoglalás) fülön az összes tesztelt minta összefoglalása látható. Az összes
kontrollvizsgálatot sikeresen teljesítő minták zöld színnel jelennek meg. A kontrollvizsgálatok
közül egyet vagy többet sikertelenül teljesítő minták sárga színnel jelennek meg.

o A PCR fülön a pozitív PCR kontroll típusú vizsgálat eredményei láthatók. Ez a vizsgálat a
génexpressziót befolyásoló gátlás vagy kísérleti problémák detektálására használható.

o Az RT fülön a reverz transzkriptáz kontroll típusú vizsgálat eredményei láthatók. Ez a vizsgálat
az RT teljesítmény kvalitatív kiértékelésére használható, és azonosítja azokat a mintákat, ahol
az RT teljesítmény valószínűleg meghiúsítja a génexpressziót.

o A gDNA (gDNS) fülön a DNS-szennyezési kontroll típusú vizsgálat eredményei láthatók. Ezzel a
vizsgálattal azt határozhatja meg, hogy egy mintában van-e jelen olyan szinten genom DNS
(gDNS), amely befolyásolhatja a qPCR eredményeket.

o Az RQ fülön az RNS-minőség típusú vizsgálatok (RQ1 és RQ2) eredményei láthatók. Ezekkel a
vizsgálatokkal kvalitatívan kiértékelhető, hogy az RNS-integritás kedvezőtlenül befolyásolhatja-
e a génexpressziót.

Génvizsgálat-jelentések kategóriái
A Gene Study Report (Génvizsgálati jelentés) párbeszédpanelt a génvizsgálati adatok jelentésbe
rendezéséhez használhatja. A 37. táblázat a génvizsgálati jelentéshez rendelkezésre álló összes opciót
sorolja fel.

Kategória Opció Leírás

Fejléc

A jelentés címe, alcíme és logója

Report Information (A
jelentéssel kapcsolatos
információk)

Dátum, a felhasználó neve, az adatfájl neve, az
adatfájl útvonala és a kiválasztott cellacsoport

Gene Study File List
(Génvizsgálat-fájllista)

A génvizsgálatban levő összes adatfájl listája

37. táblázat Kategóriák a génvizsgálati jelentésekhez
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Kategória Opció Leírás

Notes (Megjegyzések) Az adatjelentésre vonatkozó megjegyzések

Study Analysis (Vizsgálati elemzés): Oszlopdiagram

Analysis Settings (Elemzési
beállítások)

A kiválasztott elemzési paraméterek listája

Chart (Diagram) Az adatokat ábrázoló génexpressziós
oszlopdiagram

Target Names (Célnevek) A génvizsgálatban levő célok listája

Sample Names
(Mintanevek)

A génvizsgálatban levő minták listája

Data (Adatok) Az adatokat mutató táblázat

Target Stability
(Célstabilitás)

A cél stabilitására vonatkozó adatok

Inter-run Calibration
(Futtatások közötti
kalibrálás)

Futtatások közötti kalibrálási adatok

Box-and-Whisker Chart
(Dobozdiagram)

Génexpressziós dobozdiagram

Dot-Plot Chart
(Pontdiagram)

Génexpressziós pontdiagram

Study Analysis (Vizsgálati elemzés): Klasztergram és pontszórási diagram

Analysis Settings (Elemzési
beállítások)

Az egyes diagramtípusok beállításai

Chart (Diagram) Az adatokat ábrázoló génexpressziós diagram

Data (Adatok) Az egyes célok adatait tartalmazó táblázat

Study Analysis (Vizsgálati elemzés): ANOVA
Data (ANOVA-adatok)

37. táblázat Kategóriák a génvizsgálati jelentésekhez, folytatás
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Kategória Opció Leírás

ANOVA Settings (ANOVA-
beállítások)

Az elemzésben használt p-érték küszöbértéke

ANOVA Results (ANOVA-
eredmények)

Az ANOVA és a Tukey-féle HSD post-hoc
elemzésből származó eredmények táblázata

Shapiro-Wilk Normality
Test (Shapiro-Wilk
normalitási próba)

Biológiai csoport, szám, p-érték és az analízisben
az egyes céloknál előforduló esetleges hibák

ANOVA Errors (ANOVA-
hibák)

Az ANOVA-számítások során azonosított hibák

37. táblázat Kategóriák a génvizsgálati jelentésekhez, folytatás
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Génvizsgálat-jelentés létrehozása
Génvizsgálat-jelentés létrehozásához

1. Egy jelentés létrehozása előtt szükség szerint módosítsa a génvizsgálat-jelentés adatait és
diagramjait.

2. Válassza ki a Tools > Reports (Eszközök > Jelentések) lehetőséget a Gene Study (Génvizsgálat)
menüben a Report (Jelentés) párbeszédpanel megnyitásához.

3. Válassza ki azokat az opciókat, amelyeket szerepeltetni kíván a jelentésben. A jelentés
megnyitásakor az alapértelmezett opciók ki vannak választva. Jelölje be vagy törölje a
jelölőnégyzeteket az egész kategóriák vagy egy kategórián belüli egyedi opciók módosításához.

A Génvizsgálat-jelentések kategóriái a(z) 300. oldalon felsorolja a rendelkezésre álló megjelenítendő
opciókat.

4. Módosítsa a kategóriák és elemek jelentésen belüli sorrendjét. Húzza az opciókat a szükséges
pozícióba. Az elemek csak azokon a kategóriákon belül rendezhetők át, amelyekhez tartoznak.

5. Kattintson az Update Report (Jelentés frissítése) opcióra a Report Preview (Jelentés előnézete)
frissítéséhez az esetleges módosítások miatt.

6. Nyomtassa ki vagy mentse el a jelentést. Kattintson a Print Report (Jelentés nyomtatása) gombra az
eszköztárban az aktuális jelentés kinyomtatásához. Válassza ki a File > Save (Fájl > Mentés) opciót
a jelentés elmentéséhez PDF (Adobe Acrobat Reader fájl) formátumban, és válasszon ki egy helyet,
ahova el akarja menteni a fájlt. Válassza ki a File > Save As (Fájl > Mentés másként) opciót a jelentés
elmentéséhez új névvel vagy egy új helyre.

7. (Opcionális) Hozzon létre egy jelentéssablont a kívánt információkkal. A jelentés aktuális
beállításainak elmentéséhez sablonként válassza ki a Template > Save (Sablon > Mentés) vagy
Save As (Mentés másként) opciót. Ezután ha egy új jelentést akar elkészíteni, töltse be a
jelentéssablont.
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A. függelék Adatelemzési számítások
A CFXMaestro Dx szoftver, Security Edition automatikusan kiszámítja a képleteket, és az eredményeket
megjeleníti a Data Analysis (Adatelemzés) füleken. A jelen mellékletben azt ismertetjük részletesen, hogy
a CFX Maestro Dx SE hogyan számítja ki a képleteket.

A reakció hatásfoka
A bizonyítékok alapján a génexpresszióra vonatkozó adatok elemzésekor a hatásfok pontos mérése
minden primer- és próbakészletnél pontosabb eredményeket ad. A génexpresszió-számításokban
használt alapértelmezett hatásfok értéke 100%. A reakció hatásfokának kiértékeléséhez készítsen egy
standard görbét egy reprezentatív minta sorozatos hígításának felhasználásával egy releváns dinamikus
tartományban, majd jegyezze le az azt követő génexpresszió-elemzés hatásfokát. Amennyiben a futtatás
standard görbét tartalmaz, és az Auto Efficiency (Automatikus hatásfok) be van jelölve a Targets (Célok)
fülön az Experiment Settings (Kísérlet beállításai) ablakban, a szoftver automatikusan kiszámítja a
hatásfokot, és megjeleníti a Standard Curve (Standard görbe) alatt a Quantification (Kvantifikáció) fülön.

A hatásfok képleteiben szereplő hatásfok (E) a Pfaffl (2001) és Vandesompele és mtsai. (2002) által leírt
„hatásosságra” utal. Ezekben a publikációkban a 2-es hatásosság (minden egyes ciklusnál tökéletes
duplázódás) ebben a szoftverben a 100%-os hatásfokkal egyenértékű. A hatásfok számítását a
szoftverben használt hatásfokra konvertálhatja a következő matematikai összefüggések alkalmazásával:

n E = (%-os hatásfok * 0,01) + 1

n %-os hatásfok = (E – 1) * 100

Relative Quantity
A relatív mennyiség (ΔCq) képlete bármely minta (releváns gén) esetében a következő:

Megjegyzés: A rendszer ezt a képletet használja a relatív mennyiség kiszámításához, amikor nincs
meghatározva kontrollminta.

Ahol:
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n E = a primer- és szondakészlet hatásfoka. Ezt a hatékonyságot a következő képlettel lehet
kiszámítani:
(%-os hatékonyság * 0,01) + 1, ahol 100%-os hatékonyság = 2

n C q (min) = annak a mintának az átlagos Cq értéke, amelynél a legalacsonyabb a vizsgálandó génre
vonatkozó átlagos Cq

n C q (minta) = a minta átlagos Cq értéke

n GOI = vizsgálandó gén (gene of interest, egyetlen cél)

Relatív mennyiség egy kontroll kiválasztásakor
Ha ki van jelölve egy kontroll minta- vagy biológiai csoport, a rendszer bármelyik vizsgálandó gént (GOI)
tartalmazó mintához a relatív mennyiséget (RQ) ezzel a képlettel számítja ki:

Ahol:

n E = a primer- és szondakészlet hatásfoka. Ezt a hatékonyságot a következő képlettel lehet
kiszámítani:
(%-os hatékonyság * 0,01) + 1, ahol a 100%-os hatékonyság = 2

n Cq (kontroll) = Átlag Cq a kontroll mintához

n Cq (minta) = átlagos Cq bármely GOI-t tartalmazó mintához

n GOI = vizsgálandó gén (gene of interest, egyetlen cél)

A relatív mennyiség szórása
Fontos: a jelen számítás kizárólag akkor alkalmazható, ha az Analyze Using (Elemzés a következő
segítségével:) paraméter a Samples Only (Csak minták), a Sample Biological Group (Minta, biológiai
csoport) vagy a Biological Group Sample (Biológiai csoport, minta) értékre van állítva.

A relatív mennyiség szórásának képlete:

Ahol:

n SD Relative Quantity = a relatív mennyiség szórása

n SD CqGOIminta = a minta (vizsgálandó gén) Cq értékének a szórása
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Hatásfokkal korrigált Cq (CqE)

n Relative Quantity = a minta relatív mennyisége

n E = a primer- és szondakészlet hatásfoka. Ezt a hatékonyságot a következő képlettel lehet
kiszámítani:
(%-os hatékonyság * 0,01) + 1, ahol a 100%-os hatékonyság = 2

n GOI = vizsgálandó gén (gene of interest, egyetlen cél)

Hatásfokkal korrigált Cq (CqE)
A hatásfokkal korrigált Cq képlete:

Ahol:

n E = hatásfok

A közepes hatásfokkal korrigált Cq (MCqE)
A közepes hatásfokkal korrigált Cq képlete:

Ahol:

n CqE = hatásfokkal korrigált Cq

n n = replikátumok száma
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Normalizált expresszió
A normalizált expresszió (ΔΔCq) az Ön céljának (génjének) az Ön biológiai rendszerében található
referenciacélok (gének vagy szekvenciák) mennyiségéhez normalizált relatív mennyisége. A
referenciacélok kiválasztásához nyissa meg az Experiment Settings (Kísérlet beállításai) ablakot, majd
kattintson minden egyes referenciagénként szolgáló cél referenciaoszlopára.

A normalizált expresszió képlete (amely a kiszámított relatív mennyiségen (RQ) alapuló kiszámítást
használja):

Ahol:

n RQ = egy minta relatív mennyisége

n Ref = a referenciacél egy olyan futtatásban, amelynél az egyes mintákban egy vagy több
referenciacél található

n GOI = vizsgálandó gén (gene of interest, egyetlen cél)

Feltéve, hogy a referenciacélok expressziószintje nem változik az Ön biológiai rendszerében, a szoftver a
normalizált expresszió kiszámítása során figyelembe veszi az Ön egyes mintáiban jelen lévő betöltési
különbségeket vagy a sejtszám változását.
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Normalizált expresszió egy kontroll kiválasztásakor

A biológiai csoportokra vonatkozó expresszió és relatív
mennyiség
Amikor az Analyze Using (Elemzés a következő segítségével:) paraméter a Biological Groups Only (Csak
biológiai csoportok) értékre van állítva, a szoftver megjeleníti a biológiai csoporton belül található minták
átlagos expresszióját (a kiválasztott üzemmódtól függően a normalizált expressziót vagy a relatív
mennyiséget). Mivel az expresszió jellemzően lognormális eloszlású, a rendszer az expressziót a
geometriai középérték segítségével átlagolja:

Ahol:

n Exp1, Exp2, Expn = a biológiai csoportban található minták relatív mennyisége vagy normalizált
expressziója

n n = a biológiai csoportban található minták száma

Normalizált expresszió egy kontroll kiválasztásakor
Amikor kiválaszt egy kontroll mintát az Experiment Settings (Kísérlet beállításai) ablakban, a szoftver a
kontroll minta expressziószintjét 1-re állítja. Ebben a helyzetben a szoftver normalizálja az összes cél
(gén) expressziójának relatív mennyiségeit a kontroll mennyiségére (értéke 1). Ez a normalizált
expresszió egyenértékű a skálázatlan normalizált expresszió elemzésével egy kontroll kiválasztásakor.

Megjegyzés: ez relatív normalizált expresszió (RNE) és a változás szorzója néven is ismert.
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A normalizált expresszió szórása
A normalizált expresszió átméretezése a normalizált expresszió szórásának (a kiválasztott méretezési
opciótól függően) a legmagasabb vagy legalacsonyabb expressziószintekhez tartozó normalizált
expresszióértékkel való elosztásával történik. A normalizációs tényező szórásának (SD) képlete

Ahol:

n RQ = egy minta relatív mennyisége

n SD = szórás

n NF = normalizációs tényező

n Ref = referenciacél

n n = a referenciacélok száma

Ha ki van jelölve egy kontroll minta, nem szükséges végrehajtani ezt az átméretezési funkciót a szóráson,
amint az a következő képletben látható:

Ahol:

n NE = normalizált expresszió

n RQ = egy minta relatív mennyisége

n SD = szórás

n GOI = vizsgálandó gén (gene of interest, egyetlen cél)
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A legmagasabb expressziószintre skálázott normalizált expresszió

A legmagasabb expressziószintre skálázott normalizált
expresszió

Ha a futtatás nem tartalmaz kontrollokat, skálázza az egyes célok (gének) normalizált expresszióját
(rövidítve: NE) úgy, hogy az egyes minták (gének) expressziószintjét elosztja az összes mintában
előforduló legmagasabb expressziószinttel. A szoftver a legmagasabb expressziószintet az 1-es értékre
állítja, majd újraskálázza az összes minta expressziószintjeit. A legmagasabb értékre történő skálázás
képlete

Ahol:

n GOI = vizsgálandó gén (gene of interest, cél)

A legalacsonyabb expressziószintre skálázott normalizált
expresszió

Ha a futtatás nem tartalmaz kontrollokat, skálázza az egyes célok (gének) normalizált expresszióját
(rövidítve: NE) úgy, hogy az egyes minták (gének) expressziószintjét elosztja az összes mintában
előforduló legalacsonyabb expressziószinttel. A szoftver a legalacsonyabb expressziószintet az 1-es
értékre állítja, majd újraskálázza az összes minta expressziószintjeit. A legalacsonyabb méretezés
képlete

Ahol:

n GOI = vizsgálandó gén (gene of interest, cél)

Az átlagos expressziószintre skálázott normalizált expresszió
Ha a futtatás nem tartalmaz kontrollokat, skálázza az egyes célok (gének) normalizált expresszióját
(rövidítve: NE) úgy, hogy az egyes minták expressziószintjét elosztja az összes minta
expressziószintjeinek geometriai középértékével. A szoftver az átlagos expressziószintet 1-es értékre
állítja, majd újraskálázza az összes minta expressziószintjeit. Az átlagos értékre történő skálázás képlete:

Ahol:
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n GOI = vizsgálandó gén (gene of interest, cél)

n GM = az összes minta normalizált expresszióinak mértani középértéke
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A skálázott normalizált expresszió szórása

A skálázott normalizált expresszió szórása
A skálázott normalizált expressziós (NE) érték átméretezése a normalizált expresszió szórásának (SD) (a
kiválasztott méretezési opciótól függően) a legmagasabb (MAX) vagy legalacsonyabb (MIN)
expressziószintekhez tartozó normalizált expresszióértékkel való elosztásával történik.

Megjegyzés: ha ki van jelölve egy kontroll minta, nem szükséges végrehajtani ezt az átméretezési
funkciót a szóráson.

Ennek a képletnek a számítása:

Ahol:

n NE = normalizált expresszió

n SD = szórás

n GOI = vizsgálandó gén (gene of interest, cél)

n MAX = legmagasabb expressziószint

n MIN = legalacsonyabb expressziószint
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Hibasávok a szóráshoz (lg) és a középérték standard
hibájához (lg)

A konfidenciaintervallumok használatán kívül a rendszer a biológiai csoportoknál hibasávokat is
megjeleníthet az expresszió log2 értékének szórása vagy a középérték standard hibája alapján. A
rendszer a hibasávokat a következőképpen számítja ki:

RQ alsó hibasáv = 2RQ(lg)-SD RQ(lg) vagy 2RQ(lg)-SEM RQ(lg)

RQ felső hibasáv = 2RQ(lg)+SD RQ(lg) vagy 2RQ(lg)+SEM RQ(lg)

Ahol:

n RQ(lg) = a biológiai csoportra vonatkozó relatív mennyiség log2 értéke

n SD RQ(lg) = a relatív mennyiség szórása (log2)

n SEM RQ(lg) = a relatív mennyiség középértékének standard hibája (log2)

Exp. alsó hibasáv = 2Exp.(lg)-SD Exp.(lg) vagy 2Exp.(lg)-SEM Exp.(lg)

Exp. felső hibasáv = 2Exp.(lg)+SD Exp.(lg) vagy 2Exp.(lg)+SEM Exp.(lg)

Ahol:

n Exp.(lg) = a biológiai csoportra vonatkozó expresszió (normalizált expresszió) log2 értéke

n SD RQ(lg) = az expresszió szórása (log2)

n SEM RQ(lg) = az expresszió középértékének standard hibája (log2)
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Fold Change (A változás szorzója)

Fold Change (A változás szorzója)
A változás szorzója a célexpresszió növekedésének vagy csökkenésének mértéke egy kísérleti mintánál
egy kontroll mintához vagy biológiai csoporthoz képest, és a következőképpen van meghatározva:

Ha a kísérleti expresszió > kontroll expresszió:

Ha a kísérleti expresszió < kontroll expresszió:

Megjegyzés: A grafikus ábrázoláshoz az expresszió vagy a relatív mennyiségen, vagy a normalizált
expresszión alapul, a kiválasztott üzemmódtól függően (lásd: Grafikus ábrázolás a(z) 275. oldalon).
A szórásdiagramhoz és a klasztergramhoz a változás szorzóját a szoftver mindig a normalizált
expresszióból számítja.
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Korrigált értékek kiszámítására szolgáló képletek
Fontos: a jelen számítások kizárólag akkor alkalmazhatók, ha az Analyze Using (Elemzés a
következő segítségével:) paraméter a Samples Only (Csak minták), Sample Biological Group (Minta,
biológiai csoport) vagy a Biological Group Sample (Biológiai csoport, minta) értékre van állítva.

A korrigált és a nem korrigált értékek közötti különbség csak akkor látszódik, ha a rendszer a valós idejű
PCR-futtatás részeként létrehoz egy standard görbét. A szoftver három egyenlet segítségével határozza
meg a hibaterjedést:

n Standard hiba

n A normalizált expresszió standard hibája

n A normalizált releváns gén (cél) standard hibája

A standard hiba képlete:

Ahol:

n n = a referenciacélok (gének) száma

n SD = szórás

A normalizált expresszió képletében szereplő normalizációs tényező közepes hibája:

Ahol:

n n = a referenciacélok száma

n SE = standard hiba

n NF = normalizációs tényező

n RQ = relatív mennyiség

A normalizált vizsgált gén (GOI) standard hibájának képlete:

Ahol:

n SE = standard hiba
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Konfidenciaintervallum számítása biológiai csoport elemzéséhez

n GOI = vizsgálandó gén (gene of interest, egyetlen cél)

n NF = normalizációs tényező

n n = a referenciacélok száma

Konfidenciaintervallum számítása biológiai csoport
elemzéséhez

Biológiai csoportok elemzésekor (az Analyze Using /Elemzés a következő segítségével:/ paraméter a
Biological Groups Only /Csak biológiai csoportok/ értékre van állítva) a rendszer a
konfidenciaintervallumokat a relatív mennyiségre és a relatív normalizált expresszióra számítja.

A rendszer a konfidenciaintervallumokat logaritmus skálán számítja ki a t-eloszlás alapján, a következő
képlettel:

Ahol:

n = a biológiai csoportban található minták logaritmikusan skálázott expressziószintjeinek közepes
expressziója

n SD = a biológiai csoportban található minták logaritmikusan skálázott expressziószintjeinek szórása

n n = a biológiai csoportban található minták száma

n t = a t-eloszlásból a szabadságfok és a szignifikanciaszint alapján kapott érték

Megjegyzés: a szignifikanciaszint a Graphing (Grafikus ábrázolás) fülön található P-Value
Threshold (p-érték küszöbértéke) mezőben állítható be.

A rendszer a konfidenciaintervallumok kiszámítása után lineáris skálára konvertálja őket, majd
megjeleníti őket a Gene Expression (Génexpresszió) adattáblában és a Graphing (Grafikus ábrázolás)
fülön található oszlopdiagramon.

Dobozdiagram-számítások
A dobozdiagram az expressziós értékek eloszlását mutatja egy biológiai csoporton belül, az adatok
kvartilisként való ábrázolásával. Az 1. és a 3. kvartilist a doboz alsó, illetve felső határa jelenti. A medián a
dobozon keresztülhaladó folyamatos vonallal van megjelenítve. A szálak a minimum és maximum nem
szélsőséges értékeket képviselik az adatkészletben. Szélsőséges értékek azok, amelyek az 1. és 3.
kvartilist a kvartilisek közötti tartomány 1,5-szeresével meghaladják.
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Megjegyzés: Ha a biológiai csoportban csak egyetlen minta van, a szoftver egyetlen körként
ábrázolja, amely egyetlen adatpontot jelez.

A következő dobozdiagram ezeknek az adatoknak az ábrázolását mutatja.

1. Szélsőséges. Ennek a szélsőséges értéknek a nagysága > Q3 + (1,5 x [Q3 - Q1]).

Megjegyzés: helyezze a kurzort a kör fölé a leírás megtekintéséhez, amely a minta nevét
és a relatív mennyiséget vagy a normalizált expressziót jeleníti meg, attól függően, hogy
melyik üzemmód van kiválasztva.

2. Maximum nem szélsőséges jelzés

3. Felső/3. kvartilis (Q3). Az expressziós értékek 75%-a alacsonyabb, mint a Q3.

4. A rangsorolt expressziós értékek medián vagy középső értéke

5. Alsó/1. kvartilis (Q1). Az expressziós értékek 25%-a alacsonyabb, mint a Q1.

6. Minimum nem szélsőséges jelzés

7. Szélsőséges. Ennek a szélsőséges értéknek a nagysága < Q1 - (1,5 x [Q3 - Q1]).

JELMAGYARÁZAT
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B. függelék Auditnaplók
A CFXMaestro Dx szoftver, Security Edition auditnaplókat hoz létre az adat- és génvizsgálati fájlok
számára (.prcd és .mgxd fájlok). A biztonságos adatokban és génvizsgálati fájlokban végrehajtott
bármilyen változtatást vagy végrehajtott műveletet a fájl mentésekor rögzíti a fájl auditnaplójában. A
CFX Maestro Dx SE külön auditnaplót hoz létre minden fájlhoz.

A Fájl > Mentés másként lehetőséget kiválasztva a biztonságos, aláírt vagy aláíratlan adat- és
génvizsgálati fájlokat elmentheti egy másik mappába vagy más néven. Az új fájl örökli az eredeti fájl
auditnaplóját. Az új fájl auditnaplójába a Mentés másként művelet is belekerül. Az új fájl változtatásait
vagy a fájllal végrehajtott műveleteket a fájl saját auditnaplója rögzíti. Az eredeti fájl megőrzi auditnaplóját,
amely rögzíti a további tevékenységeket.

Az Auditálható események a(z) 321. oldalon ismerteti azokat az auditálható eseményeket, amelyeket a
szoftver rögzít.

Auditnaplók megtekintése
Minden auditnapló a következő információkat tartalmazza:

n Az auditfejléc adatai

o Fájlverzió – a fájl mentett verziója

o Dátum – az aktuális auditálható esemény dátuma

o Felhasználó – a bejelentkezett felhasználó Windows-tartománya és felhasználóneve

o Megjegyzés – az utolsó mentett megjegyzés

o Aláírás – a fájl utolsó aláírójának elektronikus aláírása

o Aláírás oka – az aláírás oka

o Alkalmazás – CFX Maestro Dx SE

o Alkalmazásverzió – az CFX Maestro Dx SE aktuális verziója

o Teljes felhasználó – a bejelentkezett felhasználó teljes neve

o Machine – az a számítógép, amelyre a CFX Maestro Dx SE telepítve van

n Az auditváltozás adatai
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o Objektum – a módosított elem (az auditált elem)

o Régi érték – az előző érték

o Új érték – az új érték

o Leírás – a változás leírása

Az auditnapló megtekintéséhez

u Amegnyitott adat- vagy génvizsgálati fájlban válassza ki a View > Audit Trail (Nézet > Auditnapló)
lehetőséget. Megjelenik a fájl auditnaplója.

Alapértelmezés szerint az adatok dátum és idő szerint vannak rendezve, és az összes esemény
megjelenik a kibontott nézetben. Szűrheti a nézetet felhasználónév és objektum alapján, és
összecsukhatja a kibővített nézetet, így bármilyen fejlécmező alapján könnyen rendezheti. Az
auditnaplót html-jelentésként is megtekintheti.

Felhasználónév szerinti rendezéshez

u Válassza ki a kívánt felhasználót a User Name (Felhasználónév) legördülő listából.

Objektum szerinti rendezéshez

u Válassza ki a kívánt objektumot az Object (Objektum) legördülő listából.

Az események teljes leírásának elrejtéséhez

u Kattintson a Collapse All (Az összes tétel összecsukása) elemre.
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Adatok rendezéséhez a változás adatait tartalmazó táblázatban

u Az adatoszlop fejlécében kattintson a gyémánt szimbólumra a növekvő rendezés végrehajtásához
(A-tól Z-ig, a legkisebb számtól a legnagyobbig vagy a legkorábbitól a legújabbig).

Az auditnapló kinyomtatásához

1. Kattintson a HTML jelentés elemre az auditnapló megjelenítéséhez egy webböngészőben.

2. A böngésző ablakában tegye a következők egyikét:

n Válassza ki a Fájl > Nyomtatás lehetőséget.

n Kattintson a jobb gombbal a jelentésre, és válassza ki a Nyomtatás parancsot.

Auditálható események
A CFX Maestro Dx SE a következő auditálható eseményeket rögzíti az adat- és a génvizsgálati fájlokban.

Auditálható események futtatás közben

n A futtatás megkezdésének ideje

n Lemezek szerkesztése futásidőben

n Protokoll szerkesztése futásidőben

n A futtatás befejezésének ideje

Auditálható események adatfájl létrehozásakor

n Adatfájl létrehozva

n A rendszer interpolált lemezolvasásokat vett fel

Auditálható események adatfájl mentésekor

n Általános

o Név

o Aláírás

o Lemezbeállítás

o Cellák megjelenítése

o Elemzett fluorofórok

o Lemezek szerkesztése

o Analysis mode (Elemzés üzemmód)
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o Aktív PCR cellacsoport

n Quantification (Mennyiségi vizsgálat) fül

o Aktív lépés

o Settings – Cq Determination mode (Beállítások – Cq meghatározási üzemmód)

o Settings – Baseline Setting (Beállítások – Alapérték beállítása)

o Sodródás-korrekció alkalmazása

o Settings – Cycles to Analyze (Beállítások – Vizsgálandó ciklusok)

o Settings – Analysis Mode (Beállítások – Analízis-üzemmód)

o Settings— Baseline Threshold (Beállítások – Kiindulási küszöbérték)

n Melt Curve (Olvadási görbe) fül

o Aktív lépés

o A csúcs típusának megjelenítése

o Csúcselemzési küszöbérték

n End Point (Végpont) fül

o Aktív fluorofór/cél

o Átlagolandó végciklusok

o Toleranciaszámítási módszer

o A tartomány százalékos aránya

n Allelic Discrimination (Alléldiszkrimináció) fül

o X és Y tengely fluorofór

o A ciklusszám kiválasztása

o Hívástérkép megtekintése

n Gene Expression (Génexpresszió) fül – Minden ábra

o Experiment Settings (Kísérlet beállításai) – Célreferencia

o Experiment Settings (Kísérlet beállításai) – Mintavezérlés

o Experiment Settings (Kísérlet beállításai) – Automatikus hatékonyság

o Experiment Settings (Kísérlet beállításai) – Hatékonyság
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n Gene Expression (Génexpresszió) fül – Grafikon

o Analysis mode (Elemzés üzemmód)

o Grafikonadatok

o X tengely

o Y tengely

o Skálázás opció

o Hibasáv

o A hibasáv szorzója

o P-Value Threshold (a P-érték küszöbértéke)

n Gene Expression (Génexpresszió) fül – Klasztergram

o Cluster By (Csoportosítás)

o Ismétlések szétosztása

n Gene Expression (Génexpresszió) fül – Szóródási diagram

o Control Biological Group (Kontroll biológiai csoport)

o Experimental Biological Group (Kísérleti biológiai csoport)

o Fold Change Threshold (A változási szorzó küszöbértéke)

n Gene Expression (Génexpresszió) fül – ANOVA

o P-Value Threshold (a P-érték küszöbértéke)

n Plate Setup (Lemez beállítása) – Lemez megtekintése/szerkesztése

o Settings (Beállítások) – PlateType

o Settings( Beállítások) – Egységek

o Editing Tools (Szerkesztőeszközök) – lemez átfordítása

o Cellacsoportok

o Fluorofórok a lemezen

n Plate Setup (Lemezbeállítás) – A lemez cseréje és PrimePCR fájlt alkalmazása

o Lemezbeállítás importálása

Felhasználói útmutató | 323



B. függelék Auditnaplók

A génvizsgálati fájlok auditjának változásai

Általános

n Név

n Study Setup (A vizsgálat beállítása) fül

o Adatfájlok létrehozása/törlése

n Study Analysis (A vizsgálat kiértékelése) fül
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C. függelék LIMS-integráció
A CFXMaestro Dx szoftver, Security Edition terméket beállíthatja laboratóriumi információkezelő
rendszerrel (LIMS) való használatra. A LIMS-integrációhoz a CFX Maestro Dx SE szoftvernek szüksége
van a LIMS-platform által generált lemezbeállítási információkra (LIMS-fájl, *.plrn), egy CFX Maestro Dx
SE termékkel létrehozott protokollfájlra (*.prcl), egy meghatározott exportálási helyre és egy
meghatározott exportálási formátumra.

A futás befejezése után a CFX Maestro Dx SE létrehoz egy adatfájlt (.pcrd), és elmenti egy meghatározott
adatexportáló mappába. A CFX Maestro Dx SE LIMS-kompatibilis adatfájlt is létre tud hozni .csv
formátumban, és ezt is elmentheti ugyanarra a helyre.

LIMS-kompatibilis adatfájlok létrehozása
Ez a függelék azt ismerteti, hogyan kell beállítani a CFX Maestro Dx SE szoftvert LIMS-kompatibilis
adatfájlok létrehozásához, elmentéséhez és exportálásához.

A LIMS-mappa és az adatexportálási lehetőségek beállítása
A CFX Maestro Dx SE alapértelmezés szerint ebbe a mappába menti a LIMS-protokollokat, fájlokat és
adatexport-fájlokat:
C:\Felhasználók\Nyilvános\Dokumentumok\Bio-Rad\CFX_Dx\LIMS

A CFX Maestro Dx SE szoftvert beállíthatja úgy, hogy a fájlokat egy másik mappába mentse, valamint
módosíthatja a LIMS-adatok exportálására vonatkozó beállításokat.

A LIMS-mappa és az adatexportálási lehetőségek beállításához

1. A Home (Kezdőlap) ablakban válassza ki a Tools > Options (Eszközök > Opciók) elemet.

2. Az Options (Opciók) párbeszédpanelen válassza ki a Data Export Settings (Adatexportálási
beállítások) elemet.
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C. függelék LIMS-integráció

3. (Opcionális) Jelölje be az Automatically export LIMS data at end of run (A LIMS-adatok automatikus
exportálása a futtatás végén) elemet.

A szoftver az egyes futtatások után automatikusan exportálja a LIMS-adatokat, és elmenti őket a
meghatározott helyre.

4. A LIMS-adatokra vonatkozó alapértelmezett exportálási beállítások módosításához kattintson a
LIMS Data Export Settings (LIMS-adatexportálási beállítások) elemre.

Fontos: a CFX Maestro Dx SE szoftverbe kizárólag olyan LIMS-adatok importálhatók vissza,
amelyeket eredetileg .csv kiterjesztésű fájlba exportált.

5. A LIMS Data Export Format Settings (LIMS-adatexportálási formátumra vonatkozó beállítások)
párbeszédpanelen válassza ki a szükséges exportálási beállításokat, majd kattintson az OK gombra.

6. Az Options (Opciók) párbeszédpanelen keresse meg és válassza ki azt az alapértelmezett mappát,
amelybe szeretné elmenteni a LIMS adatfájlokat. Az egyes fájltípusokhoz más és más helyet
választhat:

n Protokoll

n LIMS-fájl
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LIMS-kompatibilis adatfájlok létrehozása

n Data export (Adatexportálás)

7. A módosítások mentéséhez és az Options (Opciók) párbeszédpanel bezárásához kattintson az OK
gombra.

LIMS-protokoll létrehozása
Ha el szeretne indítani egy LIMS-futtatást, előbb hozzon létre egy protokollfájlt a CFX Maestro Dx SE
szoftverhez (*.prcl), és mentse el az erre a célra kijelölt LIMS-protokollmappába.

További információk: 7. fejezet, Protokollok létrehozása.

LIMS-fájl létrehozása
A LIMS-fájl (*.plrn) a lemezbeállítási adatokat és a protokollfájl nevét tartalmazza. Ezt a fájlt a belső LIMS
rendszer hozza létre. A CFX Maestro Dx SE a LIMS-fájl segítségével létrehoz egy lemezfájlt, amelyet egy
protokollfájllal használhat.

A CFX Maestro Dx SE lemezimportálási sablonfájlokat kínál, amelyek szerkesztésével Ön egyedi LIMS-
lemezfájlokat hozhat létre.

Tipp: ezt a feladatot LIMS-szakértőnek kell elvégeznie.

LIMS-fájl létrehozásához

1. A Home (Kezdőlap) ablakban válassza ki a View > Show > LIMS File Folder (Nézet > Megjelenítés >
LIMS-fájl mappája) elemet.

2. Nyissa meg a LIMS Templates (LIMS-sablonok) mappát, és válassza ki azt a .csv fájlt, amelyet
importálni szeretne az Ön belső LIMS-rendszerébe.

3. Szerkessze meg a sablonfájlt a 38. táblázat felsorolt mezők kitöltésével.

4. Tegye az alábbiak egyikét:

n Ha a módosításokat később szeretné használni, mentse el a fájlt .csv fájlként.

n Amódosítások mentéséhez és a fájl azonnali használatához mentse a fájlt .plrn kiterjesztéssel.

n Mentse el a sablont .plrn fájlnévkiterjesztéssel a LIMS-fájl mappájába.

Fontos: A CFX Maestro Dx SE kizárólag a .plrn fájlt képes megnyitni. A LIMS-futtatás
elindításához a .csv fájlt.plrn kiterjesztéssel kell elmentenie.
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C. függelék LIMS-integráció

Oszlop Sor Leírás Tartalom Cél

A 1 Plate Header
(Lemezfejléc)

Ne szerkessze Előre
meghatározott

A, B, C 2 Field/Data/Instruction
(Mező/adat/utasítás)

Ne szerkessze Előre
meghatározott

B 3 Version (Verzió) Ne szerkessze Előre
meghatározott

B 4 Plate Size (Lemezméret) Ne szerkessze Előre
meghatározott

B 5 Plate Type (Lemeztípus) Írja be a „BRWhite” (BR
fehér), „BR Clear” (BR
átlátszó) értéket vagy
egyéb kalibrált lemeztípust

Kötelező

B 6 Scan Mode (Leolvasási
üzemmód)

Írja be a „SYBR/FAMOnly:”
(Csak SYBR/FAM:), „All
Channels” (Minden
csatorna) vagy „FRET”
értéket

Kötelező

38. táblázat A LIMS .csv fájl tartalmi elemeinek meghatározása
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LIMS-kompatibilis adatfájlok létrehozása

Oszlop Sor Leírás Tartalom Cél

B 7 Units (Mértékegység) Írja be a következők
egyikét: „copy number”
(példányszám), „fold
dilution” (hígítási szorzó),
„micromoles” (mikromol),
„nanomoles” (nanomol),
„picomoles” (pikomol),
„femtomoles” (femtomol),
„attomoles” (attomol),
„milligrams” (milligramm),
„micrograms”
(mikrogramm),
„nanograms” (nanogramm),
„picograms” (pikogramm),
„femtograms”
(femtogramm), „attograms”
(attogramm) vagy „percent”
(százalék)

Kötelező

B 8 Run ID (A futtatás
azonosítója)

Írja be a futtatás
azonosítására szolgáló
rövid leírást vagy
vonalkódot (maximum 30
karakter hosszúságú lehet,
és vesszőt nem
tartalmazhat)

Opcionális

B 9 Run Notes (Jegyzetek a
futtatáshoz)

Írja be a futtatás leírását Opcionális

B 10 Run Protocol (Futtatási
protokoll)

Írja be a protokollfájl nevét
pontosan úgy, ahogyan a
listában szerepel.

Kötelező

A 11 Data File (Adatfájl) Írja be az adatfájl nevét Opcionális

A 12–15 Később kerül
meghatározásra / üres

Ne szerkessze Előre
meghatározott

38. táblázat A LIMS .csv fájl tartalmi elemeinek meghatározása, folytatás
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C. függelék LIMS-integráció

Oszlop Sor Leírás Tartalom Cél

A 16 Plate Data
(Lemezadatok)

Ne szerkessze Előre
meghatározott

A 17–113 Well Position
(Cellapozíció)

Ne szerkessze Előre
meghatározott

B-G Ch1 Dye, Ch2 Dye, Ch3
Dye, Ch4 Dye, Ch5 Dye,
FRET (1. csat. festék, 2.
csat. festék, 3. csat.
festék, 4. csat. festék, 5.
csat. festék, FRET)

Minden egyes használt
csatornához írjon be egy-
egy kalibrált festéknevet
(például „FAM”)

Kötelező

H Sample Type
(Mintatípus)

Írja be a következő
mintatípusok egyikét:
„Unknown” (Ismeretlen),
„Standard”, „Positive
Control” (Pozitív kontroll),
„Negative Control” (Negatív
kontroll), „NTC” vagy „NRT”

Kötelező

I Sample Name
(Mintanév)

Írja be a minta nevét Opcionális

J–O CH1 Target, CH2
Target, CH3 Target,
CH4 Target, CH5
Target, FRET Target
(Cél, 1. csat., Cél, 2.
csat., Cél, 3. csat., Cél,
4. csat., Cél, 5. csat.,
Cél, FRET)

Írja be az egyes használt
csatornákhoz a cél nevét

Opcionális

P Collection Name
(Gyűjtemény neve)

Írja be a biológiai sor nevét Opcionális

Q Replicate (Replikátum) Írjon be egy pozitív egész
számot az egyes
replikátumkészletekhez. Az
érték nem lehet nulla.

Opcionális

38. táblázat A LIMS .csv fájl tartalmi elemeinek meghatározása, folytatás

330 | CFX Maestro Dx SE szoftver



LIMS-kompatibilis adatfájlok létrehozása

Oszlop Sor Leírás Tartalom Cél

R–W CH1 Quantity, CH2
Quantity, CH3 Quantity,
CH4 Quantity, CH5
Quantity, FRET Quantity
(Mennyiség, 1. csat.,
Mennyiség, 2. csat.,
Mennyiség, 3. csat.,
Mennyiség, 4. csat.,
Mennyiség, 5. csat.,
Mennyiség, FRET

Írja be a
mennyiségértékeket az
esetleges standardokhoz.
A koncentrációt tizedes
formátumban írja be.

Az összes
standardhoz
kötelező

X Well Note (Megjegyzés a
cellához)

Írjon be egy megjegyzést a
cellához (maximum 20
karakter hosszúságú lehet)

Megjegyzés: Habár a
CFX Maestro Dx SE
20 karakterre
korlátozza a bevitelt,
amikor a jegyzeteket a
szoftveren keresztül
írja be aWell Note
(Megjegyzés a
cellához) mezőbe, ez
a mező maximálisan
500 karaktert
tartalmazhat, ha egy
importált .plrn fájl
tartalmazza. A
CFX Maestro Dx SE
szoftverben azonban
csak az első 20
karakter jelenik meg.
Az exportált .pcrd fájl a
mezőben levő összes
karaktert tartalmazza,
nem vesznek el
adatok.

Opcionális

38. táblázat A LIMS .csv fájl tartalmi elemeinek meghatározása, folytatás
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C. függelék LIMS-integráció

Oszlop Sor Leírás Tartalom Cél

Y–AD Ch1Well Color, Ch2
Well Color, Ch3Well
Color, Ch4Well Color,
Ch5Well Color, FRET
Well Color (1. csat.
cellaszíne, 2. csat.
cellaszíne, 3. csat.
cellaszíne, 4. csat.
cellaszíne, 5. csat.
cellaszíne, FRET
cellaszíne)

Írja be a felhasználó által
esetlegesen meghatározott
jelstílusszínt 32 bites egész
szám (argb) tizedes
formátumban

Opcionális

38. táblázat A LIMS .csv fájl tartalmi elemeinek meghatározása, folytatás

LIMS-futtatás indítása
LIMS-futtatás indításához

1. Egy .plrn kiterjesztésű LIMS-fájl megnyitásához tegye a következők egyikét:

n A Home (Kezdőlap) ablakban válassza ki a View > Show > LIMS File Folder (Nézet >
Megjelenítés > LIMS-fájl mappája) elemet, majd nyissa meg a kívánt (.plrn kiterjesztésű) fájlt.

n A Home (Kezdőlap) ablakban válassza ki a File > Open > LIMS File (Fájl > Megnyitás > LIMS-
fájl) elemet, majd nyissa meg a kívánt (.plrn kiterjesztésű) fájlt.

A rendszer megnyitja a fájlt a Run Setup (Futtatás beállításai) varázsló Start Run (Futtatás indítása)
fülén. A Start Run (Futtatás indítása) fülön a futtatni kívánt kísérletre vonatkozó információk láthatók.
Ezenkívül megjeleníti az(oka)t a csatlakoztatott műszerblokko(ka)t is, amely(ek)en Ön lefuttathatja a
kísérletet.

2. A Start Run (Futtatás indítása) fülön válasszon ki egy műszert, majd kattintson a Start Run (Futtatás
indítása) elemre.
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LIMS-kompatibilis adatfájlok létrehozása

Adatok exportálása egy LIMS rendszerbe
Amikor befejeződött a futtatás, a CFX Maestro Dx SE egy adatfájlt (.pcrd) hoz létre, és elmenti a
meghatározott adatexport-mappába.

Az adatfájl exportálásához LIMS-rendszerbe

u Nyissa meg a .pcrd fájlt, és válassza ki az Export > Export to LIMS Folder (Exportálás > Exportálás
LIMS-mappába) opciót.

Tipp: ha kiválasztja az Automatically Export Data after Run (Automatikusan exportálja az adatokat a
futtatás után) lehetőséget a LIMS Options (LIMS-beállítások) szakaszban, a CFX Maestro Dx SE
létrehoz egy LIMS-kompatibilis adatfájlt .csv formátumban, és elmenti ugyanabba a mappába.
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D. függelék A CFX Maestro Dx szoftver, Security
Edition termék hibáinak elhárítása

Ez a függelék javaslatokat kínál a CFX Maestro Dx szoftver, Security Edition frissítése vagy futtatása
során felmerülő problémák elhárításához.

Engedélyezőlista, a CFX Maestro Dx szoftver, Security Edition
fájljai és mappái

A vírusok és a rosszindulatú programok elleni védelem érdekében az informatikai részleg nagyon szigorú
szoftverbiztonsági intézkedéseket vezethet be. Ezek az intézkedések befolyásolhatják a CFX Maestro Dx
SE frissítésének vagy a futtatásának idejét.

A CFX Maestro Dx SE teljesítményének javítására a Bio-Rad azt javasolja, hogy az informatikai részleg
engedélyezze a következő fájlokat és mappákat a tűzfal beállításaiban a CFX Maestro Dx SE szoftvert
futtató számítógépre telepített víruskereső szoftverben:

Mappák

n C:\Program Files (x86)\Bio-Rad\CFX_MDx

n C:\ProgramData\Bio-Rad\CFX_MDx

n C:\Felhasználók\Nyilvános\Dokumentumok\Bio-Rad\CFX_MDx

Fájlok

n A C:\Program Files (x86)\Bio-Rad\CFX_MDx mappában található összes .exe fájl

n R.exe és Rscript.exe (a C:\ Program Files (x86)\Bio-Rad\CFX_MDx\R\
R-3.3.1 \bin mappában)
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D. függelék A CFXMaestro Dx szoftver, Security Edition termék hibáinak elhárítása

Alkalmazásnapló
Új futtatás megkezdése előtt a CFX Opus Dx rendszer öndiagnosztikai tesztet indít annak ellenőrzésére,
hogy a specifikációk szerint fut-e. A szoftver ennek a tesztnek az eredményeit a Run Log (Futtatási napló)
és Application Log (Alkalmazásnapló) fájlban rögzíti. Ha egy vagy több kísérletnél problémát észlel,
nyissa meg a futtatási és alkalmazásnaplókat, hogy kideríthesse, mikor kezdődött a probléma.

A(z) CFX Maestro Dx SE Dx az alkalmazásnaplóban nyomon követi a műszer üzemi állapotára
vonatkozó információkat. Ezek a naplók segítenek nyomon követni a műszereken és a szoftverben
történő eseményeket, valamint segítenek a hibák elhárításában.

Az alkalmazásnapló megnyitásához

u A Home (Kezdőlap) ablakban válassza ki a View > Application Log (Nézet > Alkalmazásnapló)
elemet.

Ha az alkalmazásnaplót HTML-fájlként szeretné megtekinteni, akkor kattintson a HTML Report
(HTML-jelentés) gombra.
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Hibaelhárítás

Az Alkalmazás és a Firmware naplófájljainak lekérdezése
Az alkalmazás és a firmware naplófájljai információkat tartalmaznak a szoftver használata közben
elvégzett műveletekre és a futtatások teljesítményére vonatkozóan. Ezek a naplók szintén rögzítenek
minden szoftver- és firmware-hibát, amely a szoftver vagy a műszer üzemeltetése közben felmerül.

Az alkalmazás és a firmware naplófájljait a következőképpen nyithatja meg:

1. A Detected Instruments (Felismert készülékek) panelen kattintson a jobb egérgombbal a műszerre.

2. Válassza a Retrieve Log Files (Naplófájlok letöltése) opciót.

3. A Browse for Folder (Mappa tallózása) párbeszédpanelen válassza ki azt a célmappát a hálózatán
vagy helyi merevlemezen, amelybe a naplófájlt menteni kívánja.

Megjegyzés: Amappa neve „Logs” (Naplók).

4. A fájlok elmentéséhez kattintson az OK gombra.

Fontos: Egy naplófájl elmentése ugyanazzal a névvel, amellyel egy meglévő naplófájl
rendelkezik, felülírja a meglévő naplófájlt.

Hibaelhárítás
A szoftver és műszer kommunikációs hibái általában megoldhatók a számítógép és a rendszer
újraindításával. Ügyeljen arra, hogy az újraindítás előtt elmentse a folyamatban levő munkákat.

Megjegyzés: Ellenőrizze, hogy a számítógépe elegendő RAM-mal és szabad tárterülettel
rendelkezik. A minimum RAM 4 GB, a minimum lemeztárhely pedig 128 GB.

Áramkimaradás
Áramkimaradás esetén a műszer és a számítógép leáll. Ha az áramkimaradás rövid ideig tart, a műszer
folytatni fogja a protokoll futtatását, de az Alkalmazásnaplóban (Application Log) szerepelni fog egy
megjegyzés az áramkimaradásról. A számítógép beállításaitól és az áramkimaradás időtartamától
függően a műszer és a szoftver megpróbálja folytatni a futtatást a protokoll adott lépésének megfelelően:

n Ha a protokoll éppen egy olyan lépésnél tart, amely nem tartalmaz lemezleolvasási műveletet, a
protokoll tovább fog futni, amint a műszer áramellátása helyreáll.

n Ha a protokoll éppen olyan lépésnél tart, amely tartalmaz lemezleolvasási műveletet, a műszer
megvárja, hogy a szoftver újrainduljon, és folytatja a kommunikációt az adatrögzítéshez. Ilyen
esetben a protokoll csak akkor folytatódik, ha a számítógép nem állította le a szoftvert. Amikor a
számítógép és a szoftver újból elindul, a protokoll folytatódik.
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D. függelék A CFXMaestro Dx szoftver, Security Edition termék hibáinak elhárítása

Fájlok átvitele a CFX Maestro Dx SE szoftvert futtató számítógépre
A berendezésen található adatokat és naplófájlokat átviheti a kapcsolódó, CFX Maestro Dx SE szoftvert
futtató számítógép merevlemezére.

Tipp: a készülék alapján levő valósidejű adatmappában levő összes fájl rákerül a számítógépre.

Megjegyzés: A CFX Opus Dx eszközökről csak naplófájlokat vihet át. A műszer összes naplófájlja
átkerül a számítógépre.

A fájlok letöltéséhez a készülékről

1. A Detected Instruments (Felismert készülékek) panelen a Home (Kezdőlap) ablakban a jobb
gombbal kattintson a célkészülékre, és válassza ki a Retrieve Log Files (Naplófájlok letöltése)
lehetőséget.

2. Válasszon ki egy mappát a letöltött fájlok elmentéséhez.

3. Kattintson az OK gombra.

A CFX Maestro Dx szoftver, Security Edition kézi telepítése
A CFX Maestro Dx SE kézi telepítéséhez

1. Szükség szerint válassza le a számítógépről az esetlegesen hozzá csatlakoztatott készülékeket.

Keresse meg a műszer USB-kábelét a CFX Maestro Dx SE szoftvert futtató számítógépen, és
válassza le ezt a kábelt a számítógépről. A kábel műszerhez csatlakoztatott vége a helyén maradhat.

2. Jelentkezzen be a CFX Maestro Dx SE szoftvert futtató számítógépre rendszergazdai
jogosultságokkal.

3. Helyezze a CFX Maestro Dx SE telepítőjét tartalmazó USB-meghajtót a számítógép USB-portjába.

4. A Windows Intézőben keresse meg és nyissa meg a CFX Maestro Dx SE USB-meghajtóját.

5. Nyissa meg a CFX mappát, és kattintson duplán a CFXMaestroDxSetup.exe fájlra a CFX Maestro Dx
SE telepítéséhez.

6. Kövesse a képernyőn megjelenő utasításokat a szoftver telepítéséhez.

Amikor a művelet befejeződött, a számítógép képernyőjén megjelenik a Bio-Rad CFX Maestro Dx
szoftver, Security Edition indulóképernyője, az Asztalon pedig megjelenik a Bio-Rad CFX Maestro
Dx szoftver, Security Edition ikonja.

7. Biztonságosan távolítsa el a szoftvert tartalmazó USB-meghajtót a számítógépből, majd indítsa el a
CFX Maestro Dx SE szoftvert.
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Az illesztőprogramok újratelepítése
A műszer illesztőprogramjainak újratelepítéséhez

u A Home (Kezdőlap) ablakban válassza ki a Tools > Reinstall Instrument Drivers (Eszközök > A
műszer illesztőprogramjainak az újratelepítése) elemet.

Megjegyzés: ha az illesztőprogramok újratelepítése és az USB-kapcsolat ellenőrzése után a
szoftver továbbra sem képes megfelelően kommunikálni egy valós idejű rendszerrel, vegye fel a
kapcsolatot a Bio-Rad műszaki támogatási osztályával.
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E. függelék Bio-Rad Free and Open-Source
Notices for PCR Products

This document includes licensing information relating to free, open-source, and public-source software
and data (together, the “MATERIALS”) included with or used to develop Bio-Rad products and services.
The terms of the applicable free, open-source, and public-source licenses (each an “OPEN LICENSE”)
govern Bio-Rad’s distribution and your use of the MATERIALS. Bio-Rad and the third-party authors,
licensors, and distributors of the MATERIALS disclaim all warranties and liability arising from all use and
distribution of the MATERIALS. To the extent the OSS is provided under an agreement with Bio-Rad that
differs from the applicable OSS LICENSE, those terms are offered by Bio-Rad alone.

Bio-Rad has reproduced below copyright and other licensing notices appearing within the MATERIALS.
While Bio-Rad seeks to provide complete and accurate copyright and licensing information for all
MATERIALS, Bio-Rad does not represent or warrant that the following information is complete, correct, or
error-free. MATERIALS recipients are encouraged to (a) investigate the identified MATERIALS to confirm
the accuracy of the licensing information provided and (b) notify Bio-Rad of any inaccuracies or errors
found in this document so that Bio-Rad may update this document accordingly.

Certain OPEN LICENSES (such as the Affero General Public Licenses, Common Development and
Distribution Licenses, Common Public License, Creative Commons Share-Alike License, Eclipse Public
License, Mozilla Public Licenses, GNU General Public Licenses, GNU Library/Lesser General Public
Licenses, and Open Data Commons Open Database License) require that the source materials be made
available to recipients or other requestors under the terms of the same OPEN LICENSE.

The corresponding open source software is available for download from the links in the section that
follows.
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Software Notices

ZedGraph
Project homepage/download site:

https://sourceforge.net/projects/zedgraph/

Bio-Rad source code site:

https://github.com/bio-rad-lsg-open-source/ZedGraph-5.0.1

External source code site:

https://github.com/ZedGraph/ZedGraph

Project licensing notices:

/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

/sources/ZedGraph/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

Standard Open License Text

LGPL-2.1
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 59 Temple
Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to
copy and distribute verbatim copies of this license document, but
changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]
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Standard Open License Text

Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public Licenses
are intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about
whether this license or the ordinary General Public License is the
better strategy to use in any particular case, based on the
explanations below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and
charge for this service if you wish); that you receive source code or
can get it if you want it; that you can change the software and use
pieces of it in new free programs; and that you are informed that you
can do these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the library or
if you modify it.

For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we
gave you. You must make sure that they, too, receive or can get the
source code. If you link other code with the library, you must
provide complete object files to the recipients, so that they can
relink them with the library after making changes to the library and
recompiling it. And you must show them these terms so they know their
rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there
is no warranty for the free library. Also, if the library is modified
by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's
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reputation will not be affected by problems that might be introduced
by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.

When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.

We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must
be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
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operating system, as well as its variant, the GNU/Linux operating
system.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter
must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms
of this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or
translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term
"modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output

Felhasználói útmutató | 345



E. függelék Bio-Rad Free and Open-Source Notices for PCR Products

from such a program is covered only if its contents constitute a work
based on the Library (independent of the use of the Library in a tool
for writing it). Whether that is true depends on what the Library
does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library. You may charge a fee for the physical act of transferring a
copy, and you may at your option offer warranty protection in
exchange for a fee.

2. You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge
to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses the
facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the
facility still operates, and performs whatever part of its purpose
remains meaningful. (For example, a function in a library to compute
square roots has a purpose that is entirely well-defined independent
of the application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must be
optional: if the application does not supply it, the squareroot
function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
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distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the
Library with the Library (or with a work based on the Library) on a
volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version
2, instead of to this License. (If a newer version than version 2 of
the ordinary GNU General Public License has appeared, then you can
specify that version instead if you wish.) Do not make any other
change in these notices. Once this change is made in a given copy, it
is irreversible for that copy, so the ordinary GNU General Public
License applies to all subsequent copies and derivative works made
from that copy. This option is useful when you wish to copy part of
the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine- readable source code,
which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange. If
distribution of object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source
code from the same place satisfies the requirement to distribute the
source code, even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled
or linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
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therefore falls outside the scope of this License. However, linking a
"work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of
the Library), rather than a "work that uses the library". The
executable is therefore covered by this License. Section 6 states
terms for distribution of such executables. When a "work that uses
the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the
Library even though the source code is not. Whether this is true is
especially significant if the work can be linked without the Library,
or if the work is itself a library. The threshold for this to be true
is not precisely defined by law. If such an object file uses only
numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it
is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications. You must give prominent
notice with each copy of the work that the Library is used in it and
that the Library and its use are covered by this License. You must
supply a copy of this License. If the work during execution displays
copyright notices, you must include the copyright notice for the
Library among them, as well as a reference directing the user to the
copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-
readable source code for the Library including whatever changes were
used in the work (which must be distributed under Sections 1 and 2
above); and, if the work is an executable linked with the Library,
with the complete machine-readable "work that uses the Library", as
object code and/or source code, so that the user can modify the
Library and then relink to produce a modified executable containing
the modified Library. (It is understood that the user who changes the
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contents of definitions files in the Library will not necessarily be
able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a copy
of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will
operate properly with a modified version of the library, if the user
installs one, as long as the modified version is interface-compatible
with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three
years, to give the same user the materials specified in Subsection
6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.

e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.

7. You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a
combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:
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a) Accompany the combined library with a copy of the same work based
on the Library, uncombined with any other library facilities. This
must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that
part of it is a work based on the Library, and explaining where to
find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated
so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are

prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the
Library subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance by
third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under
this License and any other pertinent obligations, then as a
consequence you may not distribute the Library at all. For example,
if a patent license would not permit royalty-free redistribution of
the Library by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this
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License would be to refrain entirely from distribution of the
Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended
to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a
licensee cannot impose that choice. This section is intended to make
thoroughly clear what is believed to be a consequence of the rest of
this License.

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published
by the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
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copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free
status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER MATERIALS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest
possible use to the public, we recommend making it free software that
everyone can redistribute and change. You can do so by permitting
redistribution under these terms (or, alternatively, under the terms
of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It
is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should
have at least the "copyright" line and a pointer to where the full
notice is found.
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<one line to give the library's name and a brief idea of what it
does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is
distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public
License for more details.

You should have received a copy of the GNU Lesser General Public
License along with this library; if not, write to the Free Software
Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307
USA

Also add information on how to contact you by electronic and paper
mail. You should also get your employer (if you work as a programmer)
or your school, if any, to sign a "copyright disclaimer" for the
library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the
library `Frob' (a library for tweaking knobs) written by James Random
Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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stability of DNA duplexes. (Továbbfejlesztett termodinamikai paraméterek és spiráliniciációs faktor a
DNS-duplexek stabilitásának előrejelzésére.) Nucleic Acids Research 24, 4501–4505.

2. Breslauer KJ et al. (1986). Predicting DNA duplex stability from the base sequence. (A DNS-duplex
stabilitásának előrejelzése a bázisszekvenciából.) Proc Nat Acad Sci 83, 3746–3750.

3. Hellemans J et al. (2007). qBase relative quantification framework and software for management and
automated analysis of real-time quantitative PCR data. (qBase relatív kvantifikációs keretrendszer és
szoftver valós idejű kvantitatív PCR-adatok kezeléséhez és automatizált elemzéséhez.) Genome
Biol 8, R19.

4. Livak JL et al. (1995). Towards fully automated genome-wide polymorphism screening. (Úton a
teljesen automatizált, teljes genomos polimorfizmusszűrés felé.) Nature Genetics 9, 341–342.

5. Pfaffl MW (2001). A new mathematical model for relative quantification in real-time RT-PCR. (Új
matematikai modell a valós idejű RT-PCR-vizsgálatokban végzett relatív kvantifikációhoz.) Nucleic
Acids Research 29, 2 002-2 007.

6. Vandesompele J et al. (2002). Accurate normalization of real-time quantitative RT-PCR data by
geometric averaging of multiple internal control genes. (Valós idejű kvantitatív RT-PCR-adatok
pontos normalizálása több belső kontroll gén geometriai átlagolásával.) Genome Biology 3, 1–12.

7. Fox J (2008). Applied Regression Analysis and Generalized Linear Models. (Alkalmazott
regresszióelemzés és általánosított lineáris modellek.) 2. kiadás (New York: SAGE Publications,
Inc.).

Minpack szerzői jogi közlemény (1999) University of Chicago (Chicagói Egyetem). Minden jog

fenntartva.

A forrás és bináris formákban történő, módosított vagy módosítás nélküli továbbadás és felhasználás
engedélyezett, feltéve, hogy a következő feltételek teljesülnek:

1. A forráskód továbbadott változatában meg kell maradnia a fenti szerzői jogi közleménynek, a jelen
feltétellistának, valamint az alábbi jogi nyilatkozatnak.

2. A bináris formában továbbadott változatoknál reprodukálni kell a fenti szerzői jogi közleményt, a jelen
feltétellistát, valamint az alábbi jogi nyilatkozatot a terjesztett változathoz mellékelt
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dokumentációban, illetve a terjesztett változathoz mellékelt egyéb anyagokban.

3. A továbbadott változat részét képező végfelhasználói dokumentációban (ha van ilyen) szerepelnie
kell a következő köszönetnyilvánításnak:

„This product includes software developed by the University of Chicago, as Operator of Argonne National
Laboratory.” (A jelen termék az Argonne Nemzeti Laboratórium üzemeltetőjeként eljáró Chicagói
Egyetem által kifejlesztett szoftvert tartalmaz.)
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